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There are some drawings in the C:\autosd\Bonus folder that you may find useful.  

 

CHARTS.DWG: Size: 24" x 36", Scale: 1" = 1'-0. 

This drawing has bolt length and bolt values, minimum edge distance, usual gages for angles, 

minimum weld sizes, pipe dimensions and C and MC dimensions.  

 

FRACTION.DWG: Size: 24" x 36", Scale: 1" = 1'-0. 

This drawing is used to convert decimals of an inch or of a foot to fractions.  

 

WSHAPES.DWG:  Size: 24" x 36", Scale: 1" = 1'-0. 

This is a drawing that shows the dimensions for W4 - W44 and minimum and maximum rows.  

 

13TH EDITION BOLT VALUES.DWG:  Size: 24" x 36", Scale: 1" = 1'-0. 

This drawing list ASD and LRFD bolt values from AISC 13th edition.  

 

KEYBOARD CARD.DWG: Size: 8 1/2" x 11", Scale: 1'-0 = 1'-0. 

This is a drawing of a keyboard layout showing the location of the custom characters.  

 

 

 

The following drawings are in the C:\autosd\menus folder. 

 

PULLDOWN MENU DIAGRAM.DWG: Size: 24" x 36", Scale: 1" = 1'-0. 

This drawing shows the layout of all commands in the AutoSD pulldown menu.  

 

RIBBON MENU DIAGRAM.DWG: Size: 24" x 36", Scale: 1" = 1'-0. 

This drawing shows the layout of all commands in the AutoSD ribbon menu.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Minimum screen resolution for displaying dialog boxes is 1280 x 960 
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QUICK START 
Read this first. 

 

If you are installing AutoSD for AutoCAD LT, you will need to install a Lisp Enabler. A lisp 

enabler that works with AutoSD and AutoCAD LT 2004 and later can be purchased from the 

following web site. http://www.cadsta.com/cadstamax.html. The product name is Cadsta Max. 

 

STEP 1: Un-Installing AutoSD Steel Detailing. (optional) 

You may uninstall the current copy of AutoSD Steel Detailing or install the new copy over the 

old. Uninstalling AutoSD is recommended and will not remove any drawings or customer 

configurations that you have created.  

Windows XP: From the task bar pick Start, Settings and Control Panel. Double click on Add or 

Remove Programs in the Control window. 

Windows 7: From the task bar pick Start and Control Panel. Click on Uninstall a program in the 

Control Panel window. 

Windows 8 & 8.1: Change to the desktop screen. Right click on the Windows icon and pick 

Control Panel. Click on Uninstall a program in the Control Panel window. 

Windows 10: Pick Start and Control Panel. Click on Uninstall program in the Control Panel 

window. 

 

Select AutoSD Steel Detailing and pick Uninstall. 

 

All files will not be removed. Some files and folders will remain. Do not delete the remaining 

files and folders. Install AutoSD over the existing files. 

 

Note: If you have customized your autosd.dwt template file located in your AutoSD\support 

folder you will need to save it to another folder or disk before un-installing AutoSD. 

 

STEP 2: Installing the program. 

Insert the CD-ROM into your CD-ROM drive and if the installation does not start, choose 

START, RUN. Type X:\AUTOSD_SETUP where X is your CD-ROM drive letter. Follow the 

on-screen prompts. 

 

Note: If you have customized your autosd.dwt template file, after installing AutoSD, copy your 

old autosd.dwt template file back into your AutoSD\support folder. 

 

STEP 3: Configure your CAD program. The two referenced in this manual are AutoCAD 

and BricsCAD. 

Start AutoCAD or BricsCAD.  

 

AutoCAD  

From the pulldown menu select TOOLS and then Options or type CONFIG and press enter. A 

dialog box is displayed. 

 

http://www.cadsta.com/cadstamax.html
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Pick the Files tab. 

Double click on Support file search path. 

Select the Add button and add the following line in the newly created box. 

  C:\AUTOSD\SUPPORT  

   Where:    

C: is the drive where AutoSD is installed. 

   AUTOSD is the name of the install folder. 

Tip: Use the Browse button to avoid typo errors. 

Pick the “Apply“ button. 

Do not close the dialog box yet if you have AutoCAD 2014 or later. 

 

AutoCAD Release 2014 and later configuration 

 

Add folders to “Trusted Locations” or set SECURELOAD value to 0. 

 

Set SECURELOAD to 0 

Close the dialog box to disable the warning feature by typing SECURELOAD at the command 

line. Press enter and the enter 0. 

 

Or add folders to “Trusted Locations”: 

You can add the following to your Trusted Locations to avoid constant warnings about loading 

files. 

 

For AutoCAD LT:  

Close the current dialog box. From the pulldown menu select CADSTA > CADSTA Tools > 

TrustedPaths Manager. 

 

Full version of AutoCAD: 

Double click on “Trusted Locations” or pick the plus sign next to it. 

 

Repeat the following steps for each folder below. If you did not purchase the complete AutoSD 

Steel Detailing program, some folders will not exist and AutoCAD will warn you of this. In 

those cases do not include that folder. 

Pick the “ADD” button and enter the following line in the newly created box or, to avoid 

typographical errors, pick the Browse button and select the folder. 

 

C:\AUTOSD  C:\AUTOSD\BM 

C:\AUTOSD\BONUS  C:\AUTOSD\BRACE 

C:\AUTOSD\CNC  C:\AUTOSD\COLUMN 

C:\AUTOSD\DATA  C:\AUTOSD\DATA\BACKUP 

C:\AUTOSD\HIP_VAL C:\AUTOSD\LADDER 

C:\AUTOSD\MENUS  C:\AUTOSD\RAILS 

C:\AUTOSD\STAIR  C:\AUTOSD\SUPPORT 

C:\AUTOSD\WELDS 
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Pick the “Apply“ button. 

Close the dialog box by picking OK. 

 

BricsCAD configuration 

Type CONFIG and press enter or pick Settings > Settings. A dialog box is displayed. 

 

Expand Program options 

Expand Files 

Select Support File Search path 

Pick the button at the right end of the line with the three dots... 

Double click on the blank line at the bottom of the Folder List and then pick the button at the 

right end of the line with the three dots...   

Expand My Computer 

Expand Local Disk (C:) 

Expand AutoSD 

Select Support 

Pick OK 

Pick OK again 

 

Expand Templates 

Select Template 

Pick the button at the right end of the line with the three dots... 

Change folders to C:\autosd\support and select Autosd.dwt 

Pick Open 

 

Select Template path 

Pick the button at the right end of the line with the three dots... 

Change folders to C:\autosd\support 

Pick OK 

 

Loading the menu 

 

Loading the AutoSD menu: 

At the command prompt type MENULOAD or CUILOAD and press enter. 

If the AutoSD menu was loaded from an earlier version of AutoSD select “autosd” from the 

“Loaded Customization groups” and pick Unload. 

Pick Browse. (BricsCAD: Pick button with three dots …) 

In the (AutoCAD: “Load/Unload Customization”) (BricsCAD: “Choose a Customization File”) 

box pick the arrow at the right end of the “Look in” box and select the drive where AutoSD is 

installed. In the large box, double click on AUTOSD, double click on MENUS. 

AutoCAD 2000 – 2002:  select autosd02.mnu 

AutoCAD 2004 – 2009:  select autosd.mnu (see Note below). 

AutoCAD 2010 – 2014:  select autosd.cuix 

AutoCAD 2015 and later:  select autosd15.cuix 
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BricsCAD 19 and earlier:  select autosd.cuix   

BricsCAD 20 and later:  select autosd.cuix if you are using the light theme and autosd15.cuix 

if you are using the dark theme. 

BricsCAD: An *.CUI file will be created from the *.CUIX file for Bricscad. Pick the *.CUI file 

if you need to load the menu file again unless you need to overwrite the CUI file with an update 

to AutoSD. 

Select Open. 

Pick Load   If a message box appears when loading autosd.mnu   

    warning that loading of a template file overwrites the  

    menu source file.  Pick YES to continue loading the 

menu file. 

 

For AutoCAD 2000 - 2005: 

Select AUTOSD from “Menu Groups” and pick the Menu Bar tab. 

Select where you want to place the AutoSD menu group in the Menu Bar list and pick Insert. 

Select Close 

 

Note. 

All versions of AutoCAD and BricsCAD can load the autosd.mnu file. You may need to change 

“Files of type” to “Legacy menu files (*.mnu)” at the bottom of the “Select Customization File” 

dialog box to be able to select the AUTOSD.MNU file. The MNU file does not have the ribbon 

menu in it. 

 

If you get “smiley faces” for the icons in your toolbars and have an older version of AutoCAD 

you need to do the following: 

Add C:\autosd\icons to the “Support file search path” 

Unload the autosd menu 

Load autosd02.mnu from c:\autosd\menus 

 

If you have BricsCAD 15 or AutoCAD 2010 or later and load the AUTOSD.CUIX menu file 

you can use the ribbon menu in AutoSD. The RIBBON command turns the ribbon menu on. The 

RIBBONCLOSE command turns the ribbon menu off. The ribbon menu can be used with or 

without the pulldown and toolbar menus. Pulldown menus can be turned on and off with the 

command MENUBAR. Set the value to 1 to turn it on and to 0 to turn it off. 

 

If there are clouds with a question mark for the icons in some of your toolbars, this is an 

AutoCAD “bug” and can be resolved by the following steps. 

 

To fix the missing icons for AutoCAD 2015 and later, light theme only. 

 

1) Open a drawing in AutoCAD 

2) Pick Tools > Options > Files tab 

3) Pick the plus sign next to “Support File Search Path”. 

4) Add a path for C:\autosd\icons 

5) Pick Apply > OK 
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6) Pick Tools > Customize > Interface 

7) Pick the Customize tab 

8) Pick the drop-down list for "All Customization Files" 

9) Pick autosd15.cuix 

10) Pick the plus sign next to Toolbars 

11) Pick a toolbar name under Toolbars. Look to the right in the "Toolbar Preview" window. 

12) If you have a question mark inside a cloud for an icon pick it. The properties for that 

command will be shown underneath the row of icons. Look at the last two items under properties 

for "Images" you will see a name for Small image and for Large image. 

13) Pick on the line for Small image. Most users will not be using the large image icons so you 

do not need to replace those. 

14) Add .bmp to the end of the name and press enter. This replaces the name with a bmp file of 

the same name. Repeat steps 11 - 14 until you have replaced all question marks in all toolbars. 

Pick Apply and OK when finished. 

 

STEP 4: Configure AutoSD. 

 

After configuring AutoCAD and loading the AutoSD menu, select the AutoSD pulldown menu 

and Customer Configuration. Select Detail variables. Select Unnamed and pick Edit. Change 

the settings in the dialog boxes as needed and select OK. Select Color list. Select AutoSD from 

the list of names and pick Edit. Use the dialog box to set each color by picking on the color of 

the item to be changed. Colors for weld symbols are set in the Weld Menu dialog box. Pick OK 

to close the Setting Colors dialog box. You can rename the file names and add more 

configurations if needed. Pick OK again to exit the configuration. 

 

STEP 5: Starting AutoSD. 

 

Start AutoCAD or BricsCAD. If you are using AutoCAD LT you need to use the Cadsta icon to 

start AutoCAD LT. 

 

Select File > NEW. Select "Use a Template" and select the autosd.dwt template. It is in your 

C:\autosd\support folder. 

Pick AutoSD > Format > SETUP or AutoSD I > Utilities > SETUP. 

Select a configuration from each of the four boxes. Select AutoSD for Detail Variables, 

Unnamed - 24x36 for Shop bill, None for Material list and  

AutoSD for Color list and pick OK. 

In the Setup box, accept the defaults which are: Architect for Unit type 1 = 1’ for Drawing scale, 

D - 24 x 36 for drawing size, horizontal for paper size and AutoSD. 

Pick OK and the drawing is created. 

Pick File > Save and save the drawing. 

You can start detailing now. 

 

A folder called C:\AUTOSD\CUSTOMER is created by the installation program. Where C: is 

the drive you installed AutoSD on and AUTOSD is the name of the folder you chose to install 

AutoSD in. You can use the shop bill drawings in this folder, (24x36BOM.dwg and 
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11x17BOM.dwg), to create your own shop bill. Open the drawing, change the name in the title 

box, save and close the drawing. Insert the shop bill drawing into your detail drawing by picking 

AutoSD > Shop bill > Insert Shop Bill. 

 

Useful commands 

 

RIBBON Turns ribbon menu on 

RIBBONCLOSE Turns ribbon menu off 

MENUBAR 1, turns menubar on. 0, turns menubar off 

-TOOLBAR Enter toolbar name or [ALL]: Turns on named toolbar. 

MENULOAD Opens the dialog box to load the AutoSD menu. 

OPTIONS Opens the Options dialog box to add support file search path. 

 

AutoSD reference manual 

The AutoSD reference manual is located in your C:\autosd folder. The file name is 

AutosdRefmanual.pdf. It is accessible by picking Help from the AutoSD pulldown menu or by 

picking the question mark in the Shop bill panel under AutoSD I of the Ribbon menu. If you 

would like a printed copy you may print the pdf file or order a copy from AutoSD, Inc. 

 

Uninstalling AutoSD. 

 

Open the Control Panel and pick Uninstall programs. Scroll down the list of programs until you 

find AutoSD Steel Detailing 2022. Select it and pick uninstall.





AutoSD Steel Detailing                                                                 Contents 

1 

TABLE OF CONTENTS 
 

QUICK START ...................................................... iv 

AutoCAD ...............................................................iv 

AutoCAD Release 2014 and later configuration .. v 

BricsCAD configuration ........................................vi 

Loading the menu ................................................vi 

Useful commands ................................................ ix 

AutoSD reference manual .................................... ix 

Uninstalling AutoSD. ............................................ ix 

TABLE OF CONTENTS ............................................1 

Chapter 1 - Introduction .......................................9 

MENUS ................................................................. 9 

FT.IISS or II.SS ....................................................... 9 

FT-II*SS ............................................................... 10 

FT-II S/S .............................................................. 10 

POSITIVE AND NEGATIVE ................................... 11 

ENTER ................................................................. 11 

FILE NAMES ........................................................ 11 

ROTATION .......................................................... 13 

SCALE .................................................................. 13 

CONVERTING OTHER DRAWINGS TO AutoSD .... 13 

DWG to SDS/2 DXF ............................................. 14 

STARTING A NEW DRAWING.............................. 14 

SETTING UP ........................................................ 14 

TEXT HEIGHT and PLOT SCALES ..................... 16 

FOLDERS ............................................................. 17 

CUSTOMER CONFIGURATION PROGRAM .......... 17 

EDITING A CONFIGURATION .............................. 18 

COUNTRY........................................................ 21 

BOLTS ............................................................. 21 

FLAT BARS & PLATES ...................................... 22 

STANDARD SHEAR BARS ................................ 23 

STANDARD CLIPS ............................................ 24 

BEAMS ............................................................ 25 

COLUMNS ....................................................... 27 

EDITING A COLOR CONFIGURATION .................. 28 

LINE WEIGHTS .................................................... 29 

ARROWHEADS .................................................... 30 

BOLT LIST ............................................................ 30 

Editing ............................................................ 32 

Merge File ...................................................... 33 

Open SDS/2 *.TXT .......................................... 33 

Open XSTEEL *.XSR ......................................... 33 

Chapter 2 - Erection Tools .................................. 35 

ANCHOR BOLT SIDE VIEW .................................. 35 

BEAM LINES w/DESC .......................................... 35 

BEAM ON PLATE w/AB ....................................... 36 

BEARING PLATE EDGE VIEW ............................... 36 

BRACE LINES w/DESC ......................................... 36 

BLOCK WALL SECTION ........................................ 36 

BRICK w/BLOCK WALL SECTION ......................... 37 

BRICK WALL SECTION ......................................... 37 

BLOCK WALL PLAN VIEW .................................... 37 

BRICK w/BLOCK WALL PLAN VIEW ..................... 37 

BRICK WALL PLAN VIEW ..................................... 38 

COL BASE PLATE w/AB ....................................... 38 

COLUMN w/BOLT PATTERN ............................... 39 

DECK EDGE VIEW ................................................ 39 

ELEVATION GENERATOR .................................... 39 

Main dialog box .............................................. 40 

Left side and Right side sections .................... 40 

Top center section .......................................... 40 

Bottom center section ................................... 41 



Introduction, Chapter 1                                             AutoSD Steel Detailing  

2 

Beams ............................................................. 41 

Braces ............................................................. 42 

CMU wall ........................................................ 42 

End Views ....................................................... 43 

Girts ................................................................ 43 

Joist ................................................................ 43 

Ladders ........................................................... 44 

Stairs ............................................................... 44 

Landing Setup ................................................. 45 

Column file configuration .............................. 46 

Girt configuration ........................................... 47 

Joist configuration .......................................... 47 

Draw ............................................................... 47 

GRID LINES w/DIM ............................................. 48 

JOIST LINES ......................................................... 48 

JOIST SIDE or END VIEW ..................................... 48 

LADDERS ............................................................. 49 

MARKS / SECT / TAGS ......................................... 49 

MEMBER ............................................................ 51 

REVISION CLOUD ................................................ 52 

SAFETY GATE ...................................................... 52 

SHAFT OPENING ................................................. 52 

STAIR PLAN ......................................................... 52 

TAGS ................................................................... 53 

TEXT DESCRIPTION ............................................. 53 

U-BLOCK SECTION VIEW .................................... 53 

WOOD END VIEW ............................................... 54 

Chapter 3 - Draw ................................................ 55 

@ LINE ................................................................ 55 

2 PT VECTOR ....................................................... 55 

ADD STUDS ......................................................... 55 

ADHESIVE ANCHOR ............................................ 55 

ANCHOR BOLT .................................................... 56 

ARCHED TEXT ..................................................... 56 

ASSEMBLY MARKS .............................................. 57 

BOLT CIRCLE ....................................................... 57 

BOLT EXPANSION ............................................... 59 

BOLLARD ............................................................. 59 

BOLT w/N&W ..................................................... 59 

CLEVIS ................................................................. 59 

CLIP ..................................................................... 59 

CONE .................................................................. 60 

CRANE RAIL ........................................................ 60 

DISTANCE ........................................................... 60 

DITTO .................................................................. 60 

DOOR FRAME ..................................................... 61 

EL. ....................................................................... 61 

EMBED FRAME ................................................... 62 

EMBED PLATE ..................................................... 62 

EXTRACT BOLTS (All Drawings) ........................... 63 

EXTRACT BOLTS (Current Drawing) .................... 63 

EXTRACT SUB MARKS (All Drawings) .................. 63 

FIND TEXT STRING .............................................. 63 

FLG HOLE ............................................................ 64 

HOLES ................................................................. 64 

HOLE SIZE ........................................................... 65 

SLOT SIZE ............................................................ 65 

LIBRARY MENUS ................................................. 65 

ADD TO LIBRARY ................................................. 66 

CLEAN SLIDES ..................................................... 66 

LEADER NOTES ................................................... 66 

LINTEL (loose) ..................................................... 67 

LINTEL (shop attached) ...................................... 67 

LIST FIELD BOLTS in SHOP BILL ........................... 68 

MEASURE 2D LINE .............................................. 68 

MULTILINE STYLE ................................................ 68 

NAILER ANGLE / Channel.................................... 69 

NAILER HOLES..................................................... 70 



AutoSD Steel Detailing                                                                 Contents 

3 

NAILER PLATE ..................................................... 70 

OBJECT INFO ...................................................... 70 

OFFSET ............................................................... 71 

OFFSET w/Select ................................................ 71 

OFFSET & CHANGE LINE TYPE ............................ 71 

OSNAP ................................................................ 71 

PIPE .................................................................... 72 

POUR STOP (Shop Attached) .............................. 72 

POUR STOP (Loose) ............................................ 73 

RECTANGLE ........................................................ 73 

ROTATE CROSSHAIRS ......................................... 73 

ROLLED ANGLE ................................................... 74 

ROOF FRAMES .................................................... 74 

SCALE SHAPE ...................................................... 75 

SHAPES ............................................................... 75 

WSHAPE.DWG: ................................................... 75 

SCHEDULE MAKER .............................................. 76 

STANDARD MTEXT ............................................. 77 

TAIL..................................................................... 77 

TAIL or TAIL DIM................................................. 77 

TEXT STRINGS ..................................................... 77 

TURNBUCKLE ...................................................... 77 

WEB HOLE .......................................................... 78 

WELD SYMBOLS ................................................. 78 

BLOCKS ........................................................... 78 

LEADER ONLY ................................................. 79 

SYMBOL ONLY ................................................ 79 

CLEAR ............................................................. 79 

SAVE/RESTORE ............................................... 79 

SETTINGS ........................................................ 79 

HATCH ................................................................ 80 

JOIST FORMS ...................................................... 80 

Chapter 4 - Edit .................................................. 83 

ADJUST DIMENSION ........................................... 83 

ARRAY ................................................................. 83 

ARROWHEADS TO TICKS .................................... 83 

BREAK LINE TYPE ................................................ 83 

CHANGE TEXT ..................................................... 84 

CHANGE TO PLINE .............................................. 84 

CHANGE TEXT TO MULTILEADER ....................... 84 

COLOR ................................................................ 85 

COLOR w/FILTER................................................. 85 

COPY AND ROTATE ............................................. 85 

DDCOPY .............................................................. 85 

DATABASE EDITOR ............................................. 85 

DIMENSION SIZE ................................................. 86 

EDIT ATTRIBUTE ................................................. 86 

LINE TYPE ............................................................ 86 

LINE WEIGHT ...................................................... 87 

RESET DWG SCALE .............................................. 87 

REPLACE DIMENSION ......................................... 87 

REPLACE TEXT ..................................................... 88 

RELOCATE TEXT .................................................. 88 

SCALE OF DRAWING ........................................... 88 

SCALE OF OBJECTS.............................................. 88 

SCALE OF BLOCKS/SOLIDS/TEXT......................... 89 

VIEWPORT SCALE ............................................... 89 

LAYERS ................................................................ 89 

CHANGE OBJECT'S LAYER ............................... 89 

FREEZE LAYER ................................................. 89 

ISOLATE LAYER ............................................... 90 

SET LAYER ....................................................... 90 

THAW ALL LAYERS .......................................... 90 

UNKNOWN DIMENSION ................................. 90 

Chapter 5 - Decimal & FT.IISS Calculators ............ 91 

ARCS ................................................................... 91 

CALC ................................................................... 91 

CAMBER ............................................................. 93 



Introduction, Chapter 1                                             AutoSD Steel Detailing  

4 

DECIMAL TO FEET   FEET TO DECIMAL ............ 94 

EXTEND WEIGHT ................................................ 94 

LOCATE WEIGHT COLUMN ................................. 95 

HANGER ............................................................. 95 

LOADS ................................................................. 96 

OBLIQUE TRIANGLES .......................................... 96 

RIGHT TRIANGLES............................................... 96 

ROLLED PLATE LENGTH ...................................... 97 

SECTIONAL PROPERTIES ..................................... 97 

SELECT DIM TO ADD ........................................... 98 

SELECT LINE TO ADD .......................................... 99 

TOTAL WEIGHT ................................................... 99 

NUMBER OF RISERS ........................................... 99 

Chapter 6 – Dimensioning ................................ 101 

CUSTOM FONT ................................................. 101 

DIMENSIONS .................................................... 103 

DIM. TEXT ..................................................... 103 

DIMENSIONING ............................................ 103 

Arrowheads .................................................. 104 

DYNAMIC LINEAR DIMENSION ..................... 104 

DIMENSION LINE OR SINGLE LINEAR 

DIMENSION .................................................. 105 

CONTINUE DIMENSION ................................ 105 

ARC DIMENSION ........................................... 105 

ARC CONTINUE ............................................. 105 

BEVEL............................................................ 106 

CROSSING ..................................................... 107 

LEADERS ........................................................... 107 

WORD WRAP ................................................ 107 

QUICK ........................................................... 107 

MULTI LINE ................................................... 107 

w/BUBBLE .................................................... 108 

DYNAMIC ...................................................... 108 

w/REVISION .................................................. 108 

Chapter 7 – Beams ........................................... 110 

CUTS, COPES AND BLOCKS ............................... 110 

FLANGE GAGE LEADER NOTE ........................... 111 

PROPERTY SYMBOL .......................................... 111 

END CONNECTIONS .......................................... 111 

Detail Beam .................................................. 111 

Support Member .......................................... 111 

Support is a Hip or Valley rafter ................... 112 

Slope in degrees from horizontal ................. 112 

Input skewed angle of end connection ........ 112 

Connection Type .......................................... 112 

Import column file data................................ 113 

Clip Connection ............................................ 113 

Bevel Flanges ................................................ 113 

Degrees ........................................................ 113 

Loads ............................................................ 114 

Bolts .............................................................. 114 

“T” connection ................................................. 117 

SEAT ANGLE, SEAT PLATE ................................. 118 

INTERNAL CONNECTIONS (MAIN and AUX.) .... 118 

Connections .................................................. 118 

Left, Center, Right ........................................ 119 

Import connection ........................................ 120 

Vertical hole spacing .................................... 123 

Add Symbol for Channel ............................... 123 

ANGLE BEAM .................................................... 125 

FINGER SHIM PLATE ......................................... 125 

VERTICAL PLATES .............................................. 125 

WING PLATE (side view) ................................... 125 

Plate & End View of Shape ........................... 126 

Plate Only ..................................................... 126 

Plate & End View of Shape ........................... 126 

Plate Only- on an existing W8 x 31 column 

flange ............................................................ 127 



AutoSD Steel Detailing                                                                 Contents 

5 

Plate Only - Skewed on Sloping Beam ......... 127 

STIFFENER PLATE (attached) ............................ 128 

STIFFENER PLATE (loose) .................................. 128 

SKEWED PLATE (top internal) .......................... 129 

TOP VIEW (skewed connection) ....................... 130 

MOMENT END PLATE ....................................... 130 

GIRTS ................................................................ 131 

SAG ROD ........................................................... 133 

SPLICE PLATE (Loose) ....................................... 134 

SPLICE PLATE (Attached) .................................. 134 

Chapter 8 - Bracing ........................................... 135 

CALCULATION OF GUSSET PLATES ................... 135 

Dimension #A ................................................... 136 

PRINTING FILE .................................................. 138 

VIEWING FILE ................................................... 139 

LIST .GUS FILES ................................................. 139 

EDIT GUSSET PLATE .......................................... 140 

DRAWING GUSSET PLATES ............................... 140 

DRAWING BRACES ........................................... 141 

Welded Brace ................................................... 145 

HSS IN FRAME .................................................. 146 

ROD BRACE ....................................................... 146 

PARALLEL BRACE TOWER ................................. 147 

CALCULATE GUSSET PLATE (Truss) ................... 147 

Chapter 9 - Columns ......................................... 149 

BASE PL EDGE VIEW ......................................... 151 

CAP PL EDGE VIEW ........................................... 151 

BASE/CAP PLAN ................................................ 151 

VIEW BASE/CAP FILE ........................................ 152 

SKEWED PL TOP VIEW ...................................... 152 

SPLICES ............................................................. 153 

EDIT COLUMN FILE ........................................... 153 

Import gusset ............................................... 155 

CONNECTIONS ................................................. 156 

 (1) Clip Angle ............................................... 156 

(2) Girt Angle ................................................ 156 

(3) Girt WT .................................................... 156 

(4) Joist Angle ............................................... 157 

(5) Joist Plate ................................................ 157 

(6) Seat Angle ............................................... 157 

(7) Seat Plate ................................................ 157 

(8) Split T ...................................................... 158 

(9) Wing Plate ............................................... 158 

(10) Stiff Plate ............................................... 159 

(11) Holes ..................................................... 159 

(12) Flange Plate ........................................... 159 

(13) Gusset Plate .......................................... 160 

(14) Saddle ................................................... 160 

(15) Stub ........................................................... 160 

Chapter 10 – Shop Bill ...................................... 161 

CREATING THE SHOP BILL ................................ 162 

CONFIGURING SHOP BILL ................................. 163 

Text Type: ..................................................... 164 

Sub Mark Type: ............................................ 165 

Weigh ONE Assembly Only: ......................... 165 

Describe Repeated Marks: ........................... 165 

Carry sub marks through: ............................. 165 

Descriptions .................................................. 165 

Multiple bills side by side ............................. 166 

Location from left border: ............................ 166 

Print: ............................................................. 166 

Sequence Properties: ................................... 166 

TITLE BLOCK CONFIGURATION ......................... 167 

Inserting the title block: ............................... 167 

EDIT SUB MARK LIST ......................................... 167 

EXTRACT SHOP BILL .......................................... 168 

CUSTOMIZING SHOP BILL EXTRACTION FILE .... 169 

MERGE EXTRACTED FILES ................................. 170 



Introduction, Chapter 1                                             AutoSD Steel Detailing  

6 

EXTRACT  > SMM .............................................. 171 

EXTRACT > KISS ................................................ 171 

EXTRACT > KISS Description ............................. 172 

FABSUITE *.KSS FILE ......................................... 173 

COMPILE QUANTITIES ...................................... 174 

EXTENDING WEIGHT ........................................ 174 

MATERIAL LIST ................................................. 177 

Chapter 11 - Trusses ......................................... 179 

Chapter 12 - Stairs ............................................ 181 

CREATING PAN TREADS with the Tread Builder

 ......................................................................... 186 

DIM PAN SUPPORTS ......................................... 187 

BOLTED TREAD END DETAIL ............................. 188 

PAN TREAD END VIEW ..................................... 188 

STAIR TREAD / RISER CALCULATOR .................. 189 

STAIR ELEVATION ............................................. 190 

PLAN VIEW OF STAIR ........................................ 191 

STRINGER BRACING .......................................... 192 

Header Beam ................................................... 192 

LANDING DECKING ........................................... 194 

LANDING FRAME .............................................. 194 

LANDING GRATING .......................................... 195 

LANDING PAN................................................... 195 

Chapter 13 - Rails ............................................. 197 

LEVEL HANDRAIL .............................................. 197 

RAMP or STAIR RAIL ......................................... 200 

WALL RAIL - Detail ............................................ 203 

Wall Bracket and Use End Return: ............... 204 

DETAIL PANEL ................................................... 205 

INSERT PICKETS ................................................ 206 

PICKET RAIL PANEL ........................................... 206 

RAIL PLAN - Erection ........................................ 207 

STAIR RAIL ELEVATION - Erection .................... 207 

WALL RAIL - Erection ........................................ 207 

Chapter 14 - Ladders ........................................ 209 

LADDERS WITH CAGE ....................................... 209 

LADDERS WITHOUT CAGE ................................ 210 

TOP HOOP (SECT B) .......................................... 211 

MID HOOP (SECT C) .......................................... 211 

BOT HOOP (SECT D) .......................................... 211 

SECTIONS .......................................................... 212 

SECURITY GUARD ............................................. 212 

ERECTION ELEVATION ...................................... 212 

Chapter 15 – Hip & Valley ................................. 213 

Chapter 16 - CNC Data ...................................... 217 

MAIN MARK...................................................... 218 

HOLES ............................................................... 218 

ASSOCIATE HOLES WITH TAIL ....................... 218 

CHANGE FACE ............................................... 218 

CHANGE GAGE .............................................. 219 

CHANGE OPTION .......................................... 219 

CHANGE SIZE ................................................ 219 

CHANGE SIDE ................................................ 219 

CHANGE SLOT ANGLE ................................... 219 

CHANGE SLOT LENGTH ................................. 219 

CHANGE SLOT WIDTH .................................. 219 

CHANGE TAIL ................................................ 219 

CHANGE HOLE TO SLOT ................................ 220 

CHANGE SLOT TO HOLE ................................ 220 

NOTE HOLES NS, FS or BS ............................. 220 

REPLACE TAIL DIMENSION ........................... 220 

BURNS .............................................................. 220 

CHANGE ANGLE ............................................ 221 

CHANGE BEAM END ..................................... 221 

CHANGE DEPTH “Y” ...................................... 221 

CHANGE LENGTH “X” ................................... 221 

CHANGE MARK ............................................. 221 

CHANGE NOTCH “D” .................................... 221 



AutoSD Steel Detailing                                                                 Contents 

7 

CHANGE SETBACK ........................................ 221 

CHANGE SIDE ............................................... 221 

CHANGE SURFACE ........................................ 222 

CHANGE TYPE ............................................... 222 

CHANGE LAYER ............................................. 222 

CHECK DATA ..................................................... 222 

Extracting CNC for: ........................................... 223 

EDIT Data .......................................................... 224 

PLATES: ......................................................... 224 

Scaled plates: ............................................... 224 

Burns: ........................................................... 225 

Clip: .............................................................. 229 

Common plates: ........................................... 229 

Holes: ........................................................... 231 

Ladder: ......................................................... 231 

Tee:............................................................... 232 

EDIT DSTV FILE ................................................. 232 

EDIT DXF FILE ................................................... 234 

FIND CNC .......................................................... 234 

GATHER MARKS ............................................... 234 

CNC FILE FOR .................................................... 235 

GET MISSING CNC FILE NAMES ........................ 235 

GRAPHICALLY CHECK CNC FILE ......................... 236 

SUB MARK ........................................................ 236 

Appendix A - Installation .................................. 239 

INSTALLING AutoSD STEEL DETAILING ............. 239 

AutoCAD Release 2000 - 2013 configuration ... 240 

AutoCAD Release 2014 and later configuration

 .......................................................................... 240 

BricsCAD 13 and later Pro/Platinum configuration

 .......................................................................... 241 

Loading the menu ............................................ 242 

STARTING A NEW DRAWING ............................ 243 

Appendix B - Support Files................................ 247 

ASD_CFG.LSP .................................................... 247 

SHAPE DATABASE ............................................. 247 

Appendix C - Gusset Plate Details ..................... 251 

GUSSET PLATE INPUT FORM ............................. 252 

Appendix D – Truss Panel Details ...................... 259 

INDEX .............................................................. 263 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Introduction, Chapter 1                                             AutoSD Steel Detailing  

8 

 

 

 

 

 

 

 

 



AutoSD Steel Detailing                                            Introduction, Chapter 1 

9 

Chapter 1 - Introduction 
 

Welcome to AutoSD Steel Detailing. 

 

AutoSD Steel Detailing, (AutoSD), is a steel detailing program that is designed to increase the 

production of the draftsperson and act as an aid for the checker. It is assumed that you have a 

working knowledge of steel detailing and AutoCAD or BricsCAD It is not designed to replace 

the draftsperson but is an enhancement. The draftsperson is always in control of the detailing. 

AutoSD will do most of the calculations and all the drawing normally done by the draftsperson 

in detailing beams, columns, bracing, gusset plates, stairs, handrails, ladders, erection plans, 

sections, details and more. 

 

MENUS  

AutoSD comes with four menus, autosd02.mnu, autosd.mnu, autosd.cuix and autosd15.cuix. All 

versions of AutoCAD can load the *.mnu file but you need BricsCAD or AutoCAD 2010 or 

later to load the *.cuix file. Autosd.cuix and autosd15.cuix are identical except for the name. 

Autosd15.cuix is used with AutoCAD 2015 and later for both light and dark themes. BricsCAD 

20 and later uses Autosd15.cuix for the dark theme and Autosd.cuix for the light theme. 

Autosd02.mnu is for AutoCAD 2000 – 2002. The icons for the toolbars in autosd02.mnu are 

saved as *.bmp files and are installed in the C:\autosd\Icons folder. The icons for the other menus 

are stored in *.dll files that are installed in the C:\autosd\menus folder. The difference between 

the *.mnu and the *.cuix files is the *.cuix files contain a ribbon menu and the *.mnu file does 

not. The ribbon menu has two tabs, AutoSD I and AutoSD II. In this reference manual you will 

see [AutoSD, AutoSD I or AutoSD II]. “AutoSD” refers to the pulldown menu. “AutoSD I” or 

“AutoSD II” refers to the ribbon menu tab. You can use the ribbon menu exclusively or just the 

pulldown menu. Toolbars can be used with either pulldown or ribbon menu. The AutoSD menu 

is an add-on to the standard AutoCAD menu. Ribbon menus can be turned on and off with the 

commands RIBBON and RIBBONCLOSE. Pulldown menus can be turned on and off with the 

command MENUBAR. Set the value to 1 to turn it on and to 0 to turn it off. 

 

FT.IISS or II.SS 

You will see this in most of the input prompts when you set up a drawing for AutoSD using 

[AutoSD > Format] or [AutoSD I > Utilities] > Setup > (AutoSD, SteelCAD or Xsteel). It is the 

default method of entering dimensions. If the current dimensional unit format is set to 

architectural the FT.IISS format will be used. If it is set to fractional the II.SS format will be 

used. 

 

Where: 

FT = number of feet II = number of inches  SS = number of sixteenths 
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Using the FT.IISS format:     Using the II.SS format:  

1'- 3 1/2" is entered as 1.0308   15 1/2" is entered as 15.08 

6'- 10 15/16" is entered as 6.1015   82 15/16" is entered as 82.15 

4'-0" is entered as 4     48” is entered as 48 

3 1/2" is entered as .0308    1/2" is entered as .08 

 

This manual uses the FT.IISS format in the examples. 

 

FT-II*SS 

You will see this in most of the input prompts when you set up a drawing for CVSpro using 

[AutoSD > Format] or [AutoSD I > Utilities] > Setup > CVSpro.  It is the standard method of 

entering dimensions for CVSpro. If the current dimensional unit format is set to architectural 

the FT-II*SS format will be used. A block called “ASD_CVSpro” will be inserted into the 

drawing. If this block is purged or renamed, the input format will revert to FT.IISS. 

 

Where: 

FT = feet  II = inches  SS = sixteenths 

 

Using the FT-II*SS format:  

1’- 3 1/2" is entered as 1-3*12 6’- 10 15/16" is entered as 6-10*15 

4'-0" is entered as 4-  5 1/2" is entered as 5*12 

3" is entered as 3   1/2" is entered as *12 

 

Feet are entered followed by a minus sign.  2’-0  = 2- 

Inches are entered as a whole number.  3”  = 3 

Fractions are entered preceded by an asterisk.  1/2”  = *12 

Fractions are as follows: 

1/16  = *1  5/16  = *5  9/16 = *9  13/16 = *13 

1/8  = *18  3/8  = *38  5/8  = *58  7/8  = *78 

3/16 = *3  7/16  = *7  11/16  = *11  15/16  = *15 

1/4 = *14  1/2 = *12  3/4 = *34 

 

FT-II S/S 

You will see this in most of the input prompts when you set up a drawing for SDS/2 using 

[AutoSD > Format] or [AutoSD I > Utilities] > Setup > SDS/2. If the current dimensional unit 

format is set to architectural the FT-II S/S format will be used. A block called “ASD_SDS2” 

will be inserted into the drawing. If this block is purged or renamed, the input format will revert 

to FT.IISS. 

 

Where: 

FT = feet  II = inches  S/S = fraction 

 

Using the FT-II S/S format:  

1’-3 1/2" is entered as 1-3 1/2  1’-0 1/2" is entered as 1-0 1/2 
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4'-0" is entered as 4-   5 1/2" is entered as 5 1/2 

3" is entered as 3    1/2" is entered as 1/2 

 

Feet are entered followed by a minus sign.  2’-0  = 2- 

Inches are entered as a whole number.   3”  = 3 

Fractions are preceded by a space.    2 1/2”  = 2 1/2  

There must not be any spaces in the text except between inches and fractions. 

 

POSITIVE AND NEGATIVE    

Many programs provide you with slide drawings or images in dialog boxes for user input. 

Positive input will go in the direction shown in the slide; negative input will go in the opposite 

direction from that shown in the slide. 

 

ENTER 

Most AutoCAD commands will repeat themselves when you press the ENTER key. This saves 

time by not having to go back to the menu to pick the command each time when you are 

repeating the same command over and over again such as the copy or erase command. AutoSD 

takes advantage of this same time saver in many of its commands such as editing and 

dimensioning, and many programs. 

 

FILE NAMES 

AutoSD uses several different file name extensions. All of these, except for the cfg, bak, dat and 

sld files, are saved in the folder of the current drawing. The extensions and their uses are as 

follows: 

 

.blt Bolt list extracted from your drawing. 

.bak Configuration backup files. 

 File name Folder Purpose 

 CUSTBOM.BAK  C:\autosd Shop bill program. 

 CUSTBOMM.BAK  C:\autosd  Metric shop bill program. 

 CUSTCLR.BAK  C:\autosd  Color list. 

 CUSTMAT.BAK  C:\autosd  Material list. 

 CUSTMATM.BAK   C:\autosd  Metric material list. 

 CUSTVAR.BAK   C:\autosd  Detail variable configuration. 

 CUSTVARM.BAK  C:\autosd  Metric detail variable configuration. 

 SCHMAKER.BAK   C:\autosd  Schedule maker 

 SDS2CLR.BAK   C:\autosd  SDS/2 colors 

 SETUP12.BAK  C:\autosd  Custom setup settings 

 WELD.BAK   C:\autosd\welds  Weld symbols 

 

.cfg Configuration files. 

 File name Folder Purpose 

 ASD_DATA.CFG   C:\autosd  List of data files for each shape. 

 CALCSTR.CFG C:\autosd\stair Stair calculator settings 
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 CUSTBOM.CFG  C:\autosd  Shop bill program. 

 CUSTBOMM.CFG  C:\autosd  Metric shop bill program. 

 CUSTCLR.CFG  C:\autosd  Color list. 

 CUSTMAT.CFG  C:\autosd  Material list. 

 CUSTMATM.CFG   C:\autosd  Metric material list. 

 CUSTVAR.CFG   C:\autosd  Detail variable configuration. 

 CUSTVARM.CFG  C:\autosd  Metric detail variable configuration. 

 DATLIST.CFG   C:\autosd  Stores values for dialog boxes. 

 DATLISTM.CFG   C:\autosd  Stores metric values for dialog boxes. 

 SCHMAKER.CFG   C:\autosd  Schedule maker 

 SDS2CLR.CFG   C:\autosd  SDS/2 colors 

 SETUP12.CFG   C:\autosd  Custom setup settings 

 TRDBILDR.CFG   C:\autosd\stair  Customer saved treads    

 WALLRAIL.CFG   C:\autosd\rail  Customer saved wall rail brackets 

 WELD.CFG   C:\autosd\welds  Weld symbol configuration 

 WELDSYM.CFG   C:\autosd\welds  Customer saved weld symbols   

  

.col Column files for the column program. 

.csv Shop bill extracted for SMM by E. J. E. 

.dat Data files for shapes and to store defaults for some programs. 

.dwg AutoCAD drawing. 

.dxf AutoCAD file. Used for CNC files for plates. 

.err Omissions from the .imp, csv or .kss file when extracting bill of material. 

.frm Roof frame file. 

.gus Gusset plate files for the bracing program. 

.hrl Level handrail file. 

.imp Shop bill extracted for SMM by E.J.E. 

.kss Shop bill extracted to the kiss format for Fabtrol or FabSuite. 

.lad Ladder file. 

.lst BMCONN.LST  Stores beam end connections used in beam to    

    beam connection matching. 

.mom Moment end plate files for a beam connection. 

.nc DSTV format cnc file. Extension can be changed in customer configurations. 

.pl List of cap and base plates. File name is BASECAP.PL. 

.ral Wall rail file. 

.srl Stair or ramp rail file. 

.sbl Shop bill extracted to a text file for viewing and printing. 

.sld Slides in the SLIDES folder of the drawings stored in the BLOCKS folder. 

.tbl SUBMARK.TBL.  For sub marks that carry through. 

 

If a problem occurs after editing a customer configuration file you can delete the associated cfg 

file and rename the bak for that configuration to cfg. 
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ROTATION 

Some programs give you the option of rotation. All angles are measured in a counter clockwise 

direction with right being 0 degrees. Up is 90 degrees, left is 180 degrees and down is 270 

degrees. Do not change this setting or the programs will not draw the pictures correctly. 

 

Angles are entered and displayed in degrees by default. You can, however, change the units of 

a drawing so degrees can be entered in any of the options offered by AutoCAD. 

 

When drawing the end view of a steel shape, such as a wide flange, a rotation of 0 degrees is in 

reference to the flange and the web will be drawn up and down. This is the position you would 

normally view the end of a beam. 

 

SCALE 

There are many different scales provided that you can set your drawing up to. However, when 

detailing beams, columns, or stairs you should use a scale of 1" = 1', (1:12 for metric). This is 

the standard scale for detailing steel and should be used for all detail sheets. A feature of AutoSD 

not found in most other CAD detailing software is that of being able to change the scale you are 

drawing to. Even though you have set your drawing up to 1" = 1' as the base scale you can use 

the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command and draw 

sections and details to a different scale. See chapter 3 for a list of some of the programs and 

commands affected by the change drawing scale command. 

 

The flange and web thickness on thin members will be exaggerated. Flanges will be drawn a 

minimum of 3/4" and webs a minimum of 1/2". 

 

CONVERTING OTHER DRAWINGS TO AutoSD 

If you have a drawing that was created by software other than AutoSD and want to edit the 

drawing with AutoSD certain variables need to be set in the drawing for AutoSD to work 

correctly. Set up a new drawing using AutoSD and insert your old drawing as a block into it and 

explode the inserted block. 

 

If you have a DWG file created by SDS/2, SteelCAD, CVSpro or Xsteel that was imported into 

AutoCAD from a DXF file you can convert it to AutoSD by opening the drawing and running 

[AutoSD > Format] or [AutoSD I > Utilities] > Setup. Select the drawing scale and paper size 

you want to use and select CVSpro, SDS/2, SteelCAD or Xsteel and pick OK. 

 

If you have a DXF file created by SDS/2, CVSpro or Xsteel you can import it into AutoSD. If 

you have an older version of SDS/2 that drew holes with an open circle in the AutoCAD DXF 

file then you must select the color used for the holes and it must be a different color from all 

other lines, otherwise select “Ignore” for the color choices. 

Start AutoCAD and start a new drawing using the autosd.dwt template. Do NOT run setup. From 

the [AutoSD > Tools] or [AutoSD I > Utilities] menu select SDS/2 DXF to AutoSD, CVSpro 

DXF to AutoSD or Xsteel DXF to AutoSD. You may select a single file or multiple files to 

import.  
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After importing the DXF files the drawing is moved so the lower left corner of the border is at 

the origin, (0, 0). The SDS/2 DXF file is scaled up by a factor of 12 to make the scale 1”=1’-0 

and the fractions are changed back to a stacked fraction. Xsteel DXF files are scaled to fit the 

margins set by the setup program for a 24” x 36” sheet. 

 

DWG to SDS/2 DXF 

Pulldown: AutoSD > Tools > Dwg to SDS/2 DXF 

Ribbon: AutoSD I > Utilities 

 

This command will convert your drawing and create a DXF file of the same name as the dwg 

file and save it to the same folder. All attributes will be replaced with text. Some information in 

the field bolts will be lost after converting. If you want to save this information you should make 

a backup copy of the dwg file to another folder before converting it. 

 

STARTING A NEW DRAWING... 

Starting a new drawing that is compatible in appearance to drawings created by SDS/2, 

STEELCAD, CVSpro or Xsteel. 

 

Select Files and New. Select "Use a Template". In the "Select a Template" window select the 

autosd.dwt template and pick OPEN. If the templates are not in the window, they can be found 

in your autosd\support folder. 

 

Pick [AutoSD > Format] or [AutoSD I > Utilities] > Setup. Select SDS/2, SteelCAD, CVSpro 

or Xsteel option at the bottom of the setup dialog box. 

 

SETTING UP 

Pulldown: AutoSD > Format > Setup 

Ribbon: AutoSD I > Utilities 

 

When you start a new drawing the first thing you 

must to do is set the scale, units and paper size. A 

dialog box is used for this purpose. Pick [AutoSD 

> Format] or [AutoSD I > Utilities] > Setup. Your 

next selection will be for the units. You may pick 

"ARCHITECTURAL", "DECIMAL", 

“ENGINEERING”, FRACTIONAL” or 

"METRIC”. Dimensions in architectural and 

fractional units will be rounded to the nearest 

1/16th, decimal units will be rounded to 2 decimal places and metric units to the nearest 

millimeter. After selecting units, you must pick the scale and the paper size. All detailing should 

be to 1''=1' scale, or 1:12 for metric. If you need a scale not listed, select "Type it". After picking 

the OK button you will be prompted to "Enter scale in inches per foot". If you want a scale of 
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7/32" = 1'-0" then divide 7 by 32. You would enter .2188 as the scale. The Plot scale would be 

the reciprocal x 12 = 54.8571. For a list of the scales and Plot scales provided see page 16. 

 

When you pick OK the drawing is set up. One border is drawn around the sheet if the border 

option is checked. Save the drawing and then you may begin 

drawing. 

Three layers are created for drawing, ASD_DRAW which is used 

for object lines, dimensions and text and ASD_SECT which is used 

for section symbols and ASD_MARK which is used for main 

marks. The color of layer ASD_DRAW determines the color of 

text. You can change the colors that are used by default by editing 

the colors with the “Customer Configuration” command. See page 

17 for more information. 

To change the drawing area and 

limits of a selected paper size 

pick the “Change settings” 

button. Enter the margin sizes 

in real world distances. The 

offset of the border inside the 

margins should be greater than 

0. If 0 is used the border may 

not plot if the drawing is plotted 

using limits. The lower left 

corner of the border will be 

placed at the origin of 0,0 and the border will be inside the limits 

by the amount of the offset.  

The border and drawing limits are smaller than the paper size. The chart below lists the paper 

sizes and the default drawing area. 

 

ARCHITECTURAL and DECIMAL   METRIC 

PAPER SIZE LIMITS   PAPER SIZE  LIMITS 

A-8.5x11  7.5"x10"   A-8.5x11  190x253 

B- 11x17  9.8"x16"   B- 11x17  253x402  

C- 22x34  20.8"x32"   C- 18x24  427x560 

C- 18x24  16.8"x22"   C- 22x34  529x814 

D- 24x36   22.8"x34"   D- 24x36   580x864 

D- 30x42  28.8"x40"   D- 30x42  732x1016 

E- 36x48  34.8"x46"   E- 36x48  884x1169  

       A4-210x297  190x247 

       A3-297x420  267x370 

       A2-420x594  390x544 

       A1-594x841  594x791 

       A0-841x1189  801x1139 

       A4-240x330  210x300 

       A3-330x450  300x420 
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       A2-450x625  410x595 

       A1-625x880  585x850 

       A0-880x1230  440x1200 

 

OTHER    You enter the paper size and margins 

 

Some dimension variables are stored in the Setup dialog box. If you want to change the arrow 

size, dimension text height, dimension line increment, extension line extension, extension line 

offset, size of center marks/lines, dimension line gap and default text height that will be set when 

you create a new drawing you must change the values here. If you want to change any of these 

values after the drawing is setup you change them in the Dimension Style dialog box for the 

AUTOSD dimension style. 

 

To change the font, pick the Font button. Select 

one of the seven fonts shown in the icon menu. 

The name of the font is listed at the bottom of 

each slide and will be shown to the right of the 

Font button. The font selected will become the 

default font used when you set up a new 

drawing. A different font may be saved with 

AutoSD, SDS/2, SteelCAD and Xsteel.  

 

TEXT HEIGHT and PLOT SCALES 

In order for the text to appear the same size when plotted using different drawing scales the text 

height must change with each scale. AutoSD will make this change automatically when you set 

up your drawing. The text will be 1/8'' in height when plotted. You can, however, change this 

setting each time you use the text command. The chart below shows the correct text height and 

plot scale for each drawing scale. 

 

ARCHITECT DECIMAL METRIC 

SCALE HEIGHT PLOT SCALE SCALE HEIGHT PLOT SCALE SCALE HEIGHT PLOT SCALE 

1/16''=1' 24 192.0 1''= 2000' 3000 24000.0 1:5000 15875 5000.0 

3/32''=1' 16 128.0 1''= 1000' 1500 12000.0 1:4000 12700 4000.0 

1/8'' =1'  12 96.0 1''= 500' 750 6000.0 1:2500 7938 2500.0 

5/32''=1'  9.6 76.8 1''= 250' 375 3000.0 1:1250 3969 1250.0 

3/16''=1'  8 64.0 1''= 200' 300 2400.0 1:500 1588 500.0 

1/4'' =1'  6 48.0 1''= 100' 150 1200.0 1:300 952 300.0 

5/16''=1' 4.8  38.4 1''= 80'  120 960.0 1:200 635 200.0 

3/8'' =1'  4  32.0 1''= 60'  90 720.0 1:100 318 100.0 

1/2'' =1'  3  24.0 1''= 40'  60 480.0 1:75 238 75.0 

5/8'' =1'  2.4  19.2 1''= 30'  45 360.0 1:50 159 50.0 

3/4'' =1'  2  16.0 1''= 20'  30 240.0 1:20 64 20.0 

1'' =1'  1.5  12.0 1''= 10' 15 120.0 1:12 38 12.0 
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ARCHITECT DECIMAL METRIC 

SCALE HEIGHT PLOT SCALE SCALE HEIGHT PLOT SCALE SCALE HEIGHT PLOT SCALE 

1 1/4''=1'  1  9.6 1''= 1' 1.5 12.0 1:10 32 10.0 

1 1/2''=1'  1  8.0 FULL 0.125 1.0 1:5 16 5.0 

3'' =1'  .5  4.0    FULL 3 1.0 

FULL  0.125  1.0 

 

You can also change the height of the text and dimensions by selecting [AutoSD > Format] or 

[AutoSD I > Utilities] > Text size and the size you want to use. 5 is normal (1/8"), 1 is half size 

and 10 is double size.  

 

FOLDERS 

Folders must exist before you can put something in them. It is a good idea that you use separate 

folders for each job to store your drawings. This will keep your hard drive well organized. When 

you start a new drawing at the main menu give the path to the folder where you want to save the 

drawing. If you want drawing number 1 to be saved in the folder C:\SSS\9501, where "SSS" is 

the customer and "9501" is your job number, the correct path for drawing number one is 

C:\SSS\9501\1. This will keep the drawings for one job and customer separate from those of 

another. 

 

CUSTOMER CONFIGURATION PROGRAM 

Before you begin using the program you should first create a customer folder and a job sub 

folder to be used to save drawing files. You can use Windows Explorer to do this. The root 

folder should be the name or abbreviation of the customer you are detailing for. A sub folder for 

each job will be set up inside this folder. 

 

Example:  C:\SSS    The customer folder SSS 

  C:\SSS\9501   The job sub folder 9501 

 

Refer to Windows Help on how to use Windows explorer. 

 

This example is for a customer called Superior Steel Services, job number 9501. When you start 

a new drawing for sheet number one, save it to the job folder created for this customer. In this 

case it will be C:\SSS\9501 for job 9501 for Superior Steel Services on drive C:. This keeps your 

hard drive well organized and enables you to have more than one drawing with the same name 

by keeping them in separate sub folders for each job. When AutoSD is installed a folder called 

CUSTOMER is created as a sub folder of your AutoSD and has a shop bill drawing file in it 

called 24x36BOM.dwg and 11x17BOM.dwg. You can edit and use these drawings to get started. 

This is intended as a temporary customer folder that you can use to save drawings in until you 

create your own. 
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The first time you select to detail something, a dialog 

box will pop up for you to select the detail variables 

configuration, shop bill configuration, material list and 

colors. The default file name for the detail 

configuration is “Unnamed”. The one for shop bill and 

material list is “None”. The file “None” is not a 

configuration but is a selection you can make if you do 

not want the program to fill out a bill of materials or 

use a materials list for standard marks. The default name for Colors is AutoSD. 

 

This dialog box allows you to select any combination of detail variables, shop bill, material list 

and color configurations. This allows you to have several paper sizes for one job and several 

different customers. 

 

You can import individual configurations from other custVAR.cfg, custBOM.cfg, custMAT.cfg 

and custCLR.cfg files or *.var, *.bom, *.mat and *.clr files that you may receive from other 

users. If you need to edit a file you will use “Customer Configuration” to do this. 

 

After selecting the configurations to use for this drawing pick OK. The names selected will be 

stored in the drawing in a block called asdcust. The next time the drawing is opened and edited 

you will not be asked to select the configurations to use unless the names stored in the drawing 

do not match any configuration files. This can happen if the file names were changed.  

 

EDITING A CONFIGURATION 

Pulldown: AutoSD > Customer Configuration 

Ribbon: AutoSD I > Shop bill 

 

Pick one of the buttons in the top section to display a list of 

configurations under “File name”. 

 

The first time you open the configuration box and pick “Detail 

variables” you will have one file in it called “Unnamed”. You can edit 

and use this file. You can rename it or copy it with the “Save as” button 

and make more files. If you have more than one file you can delete them 

but you cannot delete the last one. There will always be at least one file. 

You can import and export individual configurations.  

Select the configuration you want to use and pick “Set Current” to save 

the setting in the drawing. Select a configuration file for Detail Variables 

and pick the EDIT button. The Customer Detail Configuration box pops 

up. If you did not purchase the beam program, the Columns and 

Standard Clips buttons will be disabled. 
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     Marking styles for main marks 

 

    

    

  Mark/Qty Qty - Beam - Mark 

 

You can enter the character that you want to use as a separator 

between quantity and descriptor and between the descriptor and 

mark. The default separator is “ - ”. 

Putting a check in the box for “Use QTY – REQD” will put the 

text shown in the “Text for REQD” box after the quantity 

separated by the separator character. 

Putting a check in the box for “Use separate marks for Right and 

Left” will cause the program to put one main mark under the 

piece for the right mark and one for the left mark. 

 

Save CNC data in drawing: Check this box to save CNC data 

for holes and burns. Additional questions for holes will be asked 

when detailing if this box is checked. If this box is checked tail 

dimensions must be from end of material, not from the clip. 

 

File type for bars/plates: Select DSTV or DXF file format.  

 

DXF configuration: If using DXF file type, pick DXF configuration and 

give the names and colors of the layers for burns, holes, bend lines and 

text. If you put a check in the box for “Use hole diameter for name” under 

Holes, each hole will be placed on a layer name that is the diameter of the 

hole. A 13/16 diameter hole will be on layer 13_16. A 1 1/16 diameter hole 

will be on layer 1-1_16. This will give you an easy way of checking the 

diameter of a hole when you draw the plate from the DXF file. Uncheck 

that box and all holes will be placed on the layer given in the “Name” box. 

Putting a check in the boxes “Include” under Mark or Description will 

include those items as text in the DXF file. 

 

DSTV file name extension: Enter the file name extension you want to use 

for DSTV format files. Do not include a “.” here. You can enter more than 

one extension separated by a semi-colon to be able to read multiple file 

extensions. Example: NC1;NC. The first extension will be used when 

writing files but both extensions will be used when reading files. 

 

Exclude burns from DSTV file: If you have equipment that only punches holes and does not 

process burns, check this box. CNC data will still be saved in the drawing for burns but will not 

be included in the DSTV file when creating the cnc file. 
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Exclude bend lines from CNC file: Check this option if you do NOT want to include bend 

information in DSTV or DXF files. 

 

Include scribes. Check this box if you want to include scribe lines in CNC files for wing plates 

and stair pan supports. 

 

Bend radius = thickness times: Enter a value that will be multiplied by the plate thickness for 

the bend radius. 

 

Tail all holes: Check this box to put tail dimensions to every hole. Uncheck it to put tail 

dimension to the first hole only in a group. 

 

Dimensions: Select either "Ticks Only" or "Arrows and ticks". If Arrows and ticks is selected 

ticks will be used for dimensions that are smaller than 2.5 times the arrow size. Arrows will be 

used for dimensions that are 2.5 times the arrow size and larger. 

 

Place dimensions outside extension lines: When dimensions are less than:  

If this box is checked, dimensions smaller than the length given will be placed outside of the 

extension lines. 

 

When dimension contains fraction only: Put a check in this box if you want 1” and 2” 

dimensions to be centered. 

 

Extend dimension line: Put a check in this box if you want these dimensions to have the 

dimension line extended under them when they are offset outside of the extension line. 

 

Put Main member metric size on detail and in shop bill: If you have the drawing set up as 

architectural units, put a check in this box if you need the metric size of the main members 

shown in addition to the imperial size. If you have the drawing set up as metric units, put a check 

in this box if you need the imperial size of the main members shown in addition to the metric 

size. 

 

Put a space on each side of “x” in the material description: Check this box to have material 

descriptions written expanded like this, L3 x 3 x ¼. Un-check this box to have material 

descriptions written compressed like this, L3x3x¼. 

 

Include aluminum shapes in selections: Check this box so the aluminum shapes will be listed 

in the selection dialog boxes. 

 

Tail Symbol: Select the target or "TAIL" symbol to be placed at the left end of the detail or 

check the box "Use Custom Tail note" to change the word "TAILS" in the tail symbol to the one 

you type into the edit box to the right of "Note". 

 

Print: Print a hard copy of all of the configuration settings. 
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Create BOM files for: The options are Fabtrol and FabSuite. Each one imports a *.kss file but 

each uses a different shape designation. Choose the material management program you are 

using. 

File extension for SMM: The options are *.csv for the newer ASCII delimited file format and 

*.imp for the older fixed field file format. Choose the extension for the version of SMM that you 

are using. 

 

COUNTRY 

The country you select will determine which data base will 

be used for shapes and which design method will be used for 

connections. If you choose any country other than USA your 

drawing must be set up using metric units. 

 

 

BOLTS 

Type = ASTM bolt grade. Hole type = hole size or type. STD 

equals bolt diameter plus 1/16” Conn type = “SC” for friction 

connection and “N” or “X” for bearing connection. Bolt 

diameter = 5/8” – 1 1/2”. All of these values are used to get 

the bolt value used to calculate the number of bolts in a 

connection. The type, diameter and bolt spacing are also 

available on a per detail basis.  

 

Edit:  

Pick this button to edit the 

bolt values. Select a grade, 

Conn, Hole and Dia and 

then you may edit the Shear value for that selection. Note: not 

all combinations will have a shear value. Fv, (allowable shear 

stress ksi) and Ft, (allowable axial tensile stress ksi) are per 

grade. All values are ASD imperial ksi. 

 

Bolt length:  

“N” and “X”: “N” is for threads included; “X” is for threads excluded from the shear plane. 

Stick through: The length of bolt to extend past the face of the nut. 

Round up or down: Rounds the length of the bolt to the nearest 1/4” increment but may make 

the actual stick through 1/16” less. Variance for actual stick through is -1/16”, +1/8”. 

Round UP only: Rounds the length of the bolt UP to the nearest 1/4” increment. Variance for 

actual stick through is -0, +3/16”. 

 

Short slots: Putting a check in any of these boxes will draw a short slot in the connection 

material. CNC data will be saved in the piece mark. 

Show short slots in internal clips on beam web: 

Show short slots in wing plates on beam web: 
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Show short slots in split Tee on beam web:  

Show short slots in clips angle on columns: 

Show short slots in wing plates on columns:  

Show short slots in split Tee on columns: 

 

Shop bolted clips w/slots: 

Putting a check in “Slot in beam” will draw a slot in addition to the bolt head. The slot will 

contain the CNC data if CNC data is being saved. 

 

The default for X in number of rows to start using "X SPA @ Y = Z" is 8. Set this value 

to a very large number if you do not want the hole spacing dimensioned as shown to the 

left. 

 

 

 

Use the Bolt diameter list on the left side of the box to set the standard bolt size to use for 

connections. Use the Bolt diameter list on the right side of the box under "Edge distance" to 

change the edge distance for each bolt size. To edit an edge distance, select the bolt size and 

pick the edit box for the edge distance you want to change. 

Make the change in the box. The change is saved when you pick OK. If you pick Cancel your 

changes will not be saved.  

 

FLAT BARS & PLATES 

This dialog box is for configuring how the length of bent plates are 

calculated and for configuring the size of material you want to 

designate as Flat Bars.  

Calculate Bent Plate Length:  Options are to inside of bend regardless 

of thickness, to centerline using a radius based on the thickness and 

to inside of bend for thin plates and to centerline for thicker plates. 

 

Plates: This is for specifying the prefix used for plates. The default is 

“`P”. This will be shown as "PL" in the drawing. 

 

Bars: If you want all bars to use the prefix for plates, put a check in 

the box at the top of the “Bars” section or change the prefix for bars 

to the one shown for plates. 

 

Warning! If you change the prefix for bars to `P you should set the 

"Format" in "Shear Bars" to "Thick x Width". 

 

The "Width" box lists all of the widths that will be described using the prefix in the "Prefix 

descriptions with" box. Any plate that is the minimum thickness listed or thicker and whose 

width is in the "Width" list will be prefixed with the prefix shown. You can add, change and 

delete widths, set the minimum thickness and change the prefix. To change a width, select the 
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width you want to change, make the change in the box to the right of the word “Width” and pick 

“Apply”. 

 

STANDARD SHEAR BARS 

This box is for setting the marks for 

standard shear bars. The top row contains 

options you can turn on or off by checking 

or un-checking the option. Designation and 

Gage are global settings and apply to all 

marks. For example, you cannot have some 

marks with a gage and some marks without 

a gage. Prefix and Suffix, however, are 

applied separately to each bar. The row 

below these options labeled "Set Order" is for arranging the order of the components of the 

mark. To change the order, select the label you want to move. The current position will be shown 

in the "Position" drop-down list and in the "Label Position" box to the right. Select a new 

position and the label will be swapped with the one currently in that position. The row below 

"Set Order" shows how the mark is constructed and a sample of what the mark will look like. 

 

Checking "Designation" will include the text that is shown in the designation pop down list in 

the mark the text shown in the list can be changed using the "Add", "Chg" and "Del" buttons. If 

you delete a designation you will be deleting a description. If you add a designation you will be 

adding a description. The description for the new designation will be copied from the current 

description. Different descriptions can have the same designation. The number to the right of 

the designation indicates which description in the designation list you are editing. When editing 

an existing mark or creating a new mark you start with the designation list. The designation does 

not have to be part of the mark but is used to separate the descriptions from one another.  

 

"Format" is where you select which you want listed first, the thickness or the width. This setting 

is for all descriptions of standard shear bars and the descriptions of flat bars listed in the "FLAT 

BAR" configuration. 

 

The bar or plate size shown in the "Description" box will be used in the shop bill when a standard 

mark is used and will also be used to draw the bar to scale. The bar size shown for "Size 1" will 

be used up to the maximum rows selected. The bar size shown for "Size 2" will be used starting 

with the minimum rows selected. If the "Max rows" is blank the bar size shown for "Size 1" will 

be used for all rows and "Size 2" will be disabled. 

 

The values that determine which mark will be used are "Bolt dia", "No. of Columns", "Gage 

from edge of bar to center of hole" and if the bar has slots or not. A bar with slots will be selected 

ONLY if the "Use short slot" is checked and “Use standard shear bar with slots” in the 

“BEAMS” dialog box is checked. If you want the holes drawn as slots you need to check the 

options "Show short slots in wing plates on beams" and/or "Show short slots in wing plates on 

columns" in the "BOLTS/EDGE" dialog box. If all of your standard shear bars use short slots 

and none have round holes and you want to use your standard bars in combination with round 
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holes in wing plates you will need to make a copy of each description of standard bars, one with 

short slots and one without short slots.  

Checking "Prefix" will include the text shown in the "Prefix" edit box as part of the mark. 

Checking "Gage" will include the listed gage for a given web thickness. The gage will be in the 

format of inches and 16th's where 2 1/4 is 204. If you want the gage to be represented by a single 

digit enter it as .0001 for 1 or .0005 for 5.  

Checking "Suffix" will include the text shown in the "Suffix" edit box as part of the mark. 

 

STANDARD CLIPS 

This box is for creating the marks 

for standard bolted and welded 

clips, setting the angle descriptions 

and default c/c for beam end 

connections. Start in the upper left 

corner with the designation. The 

text shown in the designation list 

can be changed using the "Add", 

"Chg" and "Del" buttons. If you 

delete a designation, you will be 

deleting a description. If you add a 

designation, you will be adding a 

description. The description for the 

new designation will be copied 

from the current description. 

Different descriptions can have the 

same designation. The number to 

the right of the designation indicates which description in the designation list you are editing. 

The designation does not have to be part of the mark but is used to separate the descriptions 

from one another. The values that determine which mark will be used in the beam program are 

"Bolt dia", "C/C" in OSL", "Shop Weld", "Shop Bolt" and "Staggered". 

 

The angle size shown for "Size 1" will be used up to the maximum rows selected. The angle size 

shown for "Size 2" will be used starting with the minimum rows selected. If the "Max rows" is 

blank, the angle size shown for "Size 1" will be used for all rows and "Size 2" will be disabled. 

The angle size configured will be used in the shop bill when a standard mark is used and will 

also be used to draw the clip to scale. The first leg size will be the outstanding leg. The second 

leg size will be placed against the web of the beam. You can enter the angle description manually 

or pick "Select" and choose an angle from the list that pops up. 

 

The next row contains options you can turn on or off by checking or un-checking the option. 

Designation and Gage are global settings and apply to all marks. For example, you cannot have 

some marks with a gage and some marks without a gage. Prefix and Suffix, however, are applied 

separately to each angle. The row below these options labeled "Set Order" is for arranging the 

order of the components of the mark. To change the order, select the label you want to move. 

The current position will be shown in the "Position" drop-down list and in the "Label Position" 
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box to the right. Select a new position and the label will be swapped with the one currently in 

that position. The row below "Set Order" shows how the mark is constructed and a sample of 

what the mark will look like for a 3-row clip. 

 

Checking "Designation" will include the text that is shown in the designation pop down list in 

the mark. Checking "Prefix" will include the text shown in the "Prefix" edit box as part of the 

mark. Checking "Gage" will include the listed gage for a given web thickness. The gage will be 

in the format of inches and 16th's where 1 7/8 is 114. If you want the gage to be represented by 

a single digit enter it as .0001 for 1 or .0005 for 5. If you are not using slots in the clip or your 

mark requires the actual gage then check the box by "Use Actual Gage". Checking "Suffix" will 

include the text shown in the "Suffix" edit box as part of the mark. 

 

If the clip is shop welded, pick "Shop weld". If the clip is shop bolted, pick "Shop Bolt". If the 

shop bolts are staggered, check the box by "Staggered". 

 

The last items are the Default C/C for beam end connections. These settings should match one 

of the "C/C in OSL" that you set for one of the clips. Select OK when you have finished all of 

the changes. 

 

BEAMS 

 

Bevel Flanges: 

Enter values for the notches for 

“Bevel Flanges for field welds”. 

 

Shop bolted Clips and Stiff: 

#1 & #2 are the gages for shop bolted 

clips. #3 is the setback from the heel 

to end of web. #4 is the clearance 

between beams at the flange block. 

#5 is the clip thickness. Enter 0 for 

item #6 to make the length of 

stiffeners and wing plates that 

welded to both flanges equal to beam 

depth minus 2 times flange 

thickness. Otherwise, the length will 

be shortened by the amount you 

enter. 

 

Blocks 

Style: 

This applies to level beams only. Choose the style you want by picking the image. If you are 

saving CNC data, burn data for blocks will be saved with the block length dimension. 

 

Depth: 
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Here you select how the block depth is calculated. Select either to use the “k” dimension of the 

support or flange thickness, “tf”, plus a clearance value. If you use the second option and put a 

check mark in “Min “k” of blocked beam” the depth will be the greater of tf plus clearance and 

the “k” dimension of the blocked beam. 

 

Dimension blocks to: 

This controls where blocks, copes and cuts are referenced from at the ends. The location is for 

the horizontal dimension. If you are saving CNC, burn data for blocks will be saved with the 

horizontal dimension. The burn length will be the same as the horizontal dimension of the block. 

 

Wing PL block option: 

Extending beam block will cause wing plates to be cut square and the length of the block on the 

beam will be increased to clear the plate. Notching the wing plate will cause the wing plate to 

be cut to clear the beam flanges. 

 

Horizontal dimension are:  Work length is at:     Overall length is at: 

These three settings establish the location of control dimensions. The setting of the location of 

horizontal dimensions has no effect if the beam is slopping. In that case, the location is 

determined by the direction of the slope. Horizontal dimensions will be above beams slopping 

down to the right and below beams slopping up to the right. 

 

Conn for end of beam w/holes in web: 

Clearance for non-standard shear bar: 

This clearance will be used if you do not have a standard shear bar configuration for the bolt 

size in use. The clearance can be (1) from centerline of supporting web or the face of a column 

flange or (2) from the face of support. If a standard shear bar configuration can be used, the end 

clearance is the gage of the shear bar minus the end of beam edge distance. 

Shear bar configurations you can have standard marks for bars with round holes or bars with 

short slots. Put a check in the box “Use standard shear bar with slots” to use the mark for the bar 

with short slots. 

 

Chamfer: 

Pick the option you want for clipping the corner of plates connecting to the web and flange. The 

clip can be a 45-degree chamfer or a square block. The maximum size for a square block is 2 

½”. If the clip is greater than 2 ½” the clip will be chamfered. The detailed picture may show a 

chamfer even though you have selected to block the corner but the CNC output file will use the 

one selected. 

 

Extension and tails at left end: 

This controls where tail or running dimensions and the extension line for the overall length are 

referenced from at the left end. You can have both to beam, both to clip or extension to clip and 

tails to beam. 

 

 

Minus dimensions framing into beams: 
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This determines if you want to give an extra 1/16" clearance at the end of a beam with clips 

when framing into a beam web.  

 

Beams sloping up to the right: 

For this condition you select whether tail dimensions come from the left 

end of the beam along the top flange or the bottom flange. If you are 

saving CNC the default is bottom flange. 

 

Use max rows in end connection: 

Check this if you want to use maximum rows in all beam end 

connections. 

 

Dimension clip edge distance: 

Check this if you want to put a dimension to the bottom edge of end connection angles. 

 

Show beam properties: 

Check this if you want to put this symbol showing the depth and web thickness, (W), and 

the flange width and thickness, (F), under the main mark. 

 

Show support member size:  

Check this if you want to put the support member size at the end of the beam detail. 

 

Show loads on end of beam:  

Check this if you want to put the loads at the end of the beam detail on a layer called LOADS. 

 

Grade of steel and Grade of aluminum: 

Select the grade of steel and aluminum that you want as the default for Angles, Channels, Flange 

shapes, Plates/Bars, Pipes and Tubes. If you configure the shop bill to print the grade, only 

grades that are different from the value selected for “Typical UN” will be printed. 

Enter the grade for studs. 

 

COLUMNS  

This box is for setting the parameters for dimensioning 

columns. It controls where the overall length and tails 

are dimensioned to, the location of the overall length, 

the symbol to be used for finishing each end of the 

column and whether to put the mark at the end of the 

description line or not. 

“Connection plate to Beam flange” controls the gap 

between the beam flanges and the horizontal plates that 

will be welded to the column when you save the beam 

to column file while detailing the beam. If you put a 

check in “Extend wing plates through Tubes” or 

“Extend wing plates through Pipes”, all non-skewed 

wing plates will be detailed going through the tube or pipe column. 
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“Dim base/cap plate holes from CL” is for rectangular plates with four holes that are symmetrical 

about the horizontal and vertical center lines. Dimensioning to the center line is the default for 

all plates but if this is not checked, those plates that meet the requirement above will be 

dimensioned from edge to hole to edge.  

 

EDITING A COLOR CONFIGURATION 

Pulldown: AutoSD > Customer Configuration 

Ribbon: AutoSD I > Shop bill 

 

Pick Color list, select one of the names under “File name” and pick Edit.  

 

The first time you open the configuration box 

and pick “Colors list” you will have 5 

configuration files in it. You can edit and use 

these files. You can rename them or copy them 

and make more files. If you have more than one 

file you can delete them but you cannot delete 

the last one. There will always be at least one 

file. All of the color configurations are stored in 

one file called custCLR.cfg located in your 

autosd folder. You can also import individual 

configurations from other custCLR.cfg files. 

 

Select a color configuration file and pick the EDIT button. The Setting Colors Configuration 

box pops up. 

These files store the colors for dimension lines, extension lines, dimension text, section labels, 

text, holes, hidden lines, object lines, Main marks, Grab Rails Column Grid text, Column Grid 

bubble, Column Grid line, Color toolbar and Line toolbar. The color of layer ASD_DRAW is 

used to control the color of text, the layer ASD_SECT is used for the color of section labels and 

the layer ASD_MARK is used for the color of main marks. 

 

Substitute for Color toolbar: The color used for the Color and Line toolbars are controlled by 

these settings. The actual color of the icons in the toolbars will not change but you can vary the 

color used by each icon. The color used by the Red icon, for example, can be changed to any 

shade of red or any other color. 

 

To change a color, select a color swath to display the color choices. Pick a color and pick OK. 

 

The default color configuration files copied to your AUTOSD folder when AutoSD is installed 

are AutoSD, CVSpro, SDS/2, SteelCAD and XSteel. These are just arbitrary file names and 

have no association with the color configuration when importing DXF files into AutoSD for 

CVSpro, SDS/2 or XSteel. You can rename these files as you like. 

 

Save colors for importing DWG’s from: 
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Below the color choices is a row of check boxes. When you import a DXF file using the 

command “DXF into AutoSD” the colors of some of the objects will be changed to match the 

colors in the configuration. You can change the colors in these configuration files by putting a 

check in the box for CVSpro, SDS/2, SteelCAD or XSteel. 

 

When you pick OK, the colors will be saved to the file custCLR.cfg for the file name selected 

in the Color list box and to any and all names that are checked. 

 

The colors used for importing DXF files are saved in the following files. 

File name   Configuration use 

CFG-SDS2.LSP  SDS/2 

CFG-CVS.LSP  CVSpro 

CFG-SCAD   SteelCAD 

CFG-XSTL.LSP  Xsteel 

 

Exception: 

The file CFG-SDS2.LSP for SDS/2 is NOT used for converting colors when importing DXF 

files from SDS/2. It is only used to set the colors for detailing when you run [AutoSD > Format] 

or [AutoSD I > Utilities] > Setup and select the SDS/2 option. 

 

Converting colors when importing DXF files from SDS/2 

is handled by the command [AutoSD > Tools] or [AutoSD 

I > Utilities] > DXF into AutoSD > Configure SDS/2 

colors. The dialog box shown to the left is used to 

configure the colors. The list under SDS/2 is the color of 

the object in the DXF file. The colors under “To AutoSD” 

is what each color will be changed to for each type of 

object. Solids are for arrowheads. 

 

Names for specific line types under “Line types” will be 

changed to the name in the list next to each name. The 

color here will override the colors shown above Line types. 

 

After making changes, pick OK to save those changes. Picking 

Cancel will remove all changes made to colors and line weights. 

 

LINE WEIGHTS 

At the bottom of the customer colors configuration dialog box 

is a button that opens a line weight dialog box shown to the 

right. This option is for setting line weights for plotting lines of 

different thicknesses by line weight. Any settings here will 

override line weights based on color when plotting. 
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Putting a check in the box for “Enable Line weights” will cause the program to use the values 

set here for line weights. Un-checking the box will disable this feature.  

 

After making changes, pick OK to save those changes. Picking Cancel will remove all changes. 

 

ARROWHEADS 

Arrowheads in older versions of AutoSD used a block called Dimarrow. This has been changed. 

You will need to open the Dimension Style dialog box, pick the Lines and Arrows tab and set 

the 1st, 2nd and Leader arrowhead to Closed filled. You may select any of the arrowhead types 

from the list but Closed filled will look the same as the old Dimarrow block. If you do not change 

this setting your arrowheads my not be the correct color. 

 

BOLT LIST 

Pulldown: AutoSD > Tools > Bolt list 

Ribbon: AutoSD I > Utilities 

 

Create bolt lists and bolt summaries. Merge 

lists together, sort, edit and print. Each item 

is a multiple choice for quick and easy input. 

 

Starting a new file 

To start a new bolt list, select FILE and New. A dialog box will appear. Type the filename. The 

name may contain letters, numbers and spaces. Do not give an extension. The extension ".blt" 

will automatically be added. After typing the filename press enter or pick the Save button. You 

can select a different folder and drive to save the file in by double clicking in the drive and folder 

boxes. After the file is created you can add a note that will be saved with the file and printed on 

the outputs. There is a text box to the right of the File menu at the top of the screen called Note. 

Use your mouse to click on this box. The note has a maximum length of 29 characters. 

 

Adhesives 

Qty 

Input a number for adhesive cartridges. 

 

Location Mark 

Input a mark, if desired, that the adhesive cartridge is for. 

 

Description 

Choose one of the descriptions from the drop-down list or pick “OTHER” to add your own 

description. After the selection is made, your choice becomes the default. Selecting “OTHER” 

opens a dialog box where you can add, change, delete and select custom choices. To add a 

description, enter the text in the box above the “Add”, Change” and “Delete” buttons and pick 
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“Add”. A maximum of 90 characters is allowed for description. Pick OK to return to the bolt 

list input dialog box. 

 

Bolts 

Qty 

Input the number of bolts and press the tab key to advance to the next box. 

 

Type 

Type of bolt: Choose one of the types from the 

drop-down list or pick “OTHER” to add your own 

type. After the selection is made, your choice 

becomes the default and pressing the tab key will 

keep your selection and move the highlight to the 

next box to the right. Selecting “OTHER” opens 

a dialog box where you can add, change, delete 

and select custom choices. To add a type, enter the 

text in the box above the “Add”, Change” and 

“Delete” buttons and pick “Add”. A maximum of 

35 characters is allowed for type. Pick OK to return to the bolt list input dialog box. 

 

Finish 

Choose one of the finishes from the drop-down list or pick “OTHER” to add your own finish. 

After the selection is made, your choice becomes the default and pressing tab key will keep your 

selection and move the highlight to the next box to the right. Selecting “OTHER” opens a dialog 

box where you can add, change, delete and select custom choices. To add a finish, enter the text 

in the box above the “Add”, Change” and “Delete” buttons and pick “Add”. A maximum of 5 

characters is allowed for finish. Pick OK to return to the bolt list input dialog box. 

 

Dia  

Choose one of the diameters from the drop-down list or pick “OTHER” to add your own 

diameters. After the selection is made, your choice becomes the default and pressing tab key 

will keep your selection and move the highlight to the next box to the right. Selecting “OTHER” 

opens a dialog box where you can add, change, delete and select custom choices. To add a 

diameter, enter the text in the box above the “Add”, Change” and “Delete” buttons and pick 

“Add”. A maximum of 6 characters is allowed for diameter. Pick OK to return to the bolt list 

input dialog box. Select the custom diameter from the list. 

 

Nut 

Select 0, 1 or 2 from the list. 
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Washer   

Choose one of the washers from the drop-down list or pick “OTHER” to add your own washer. 

After the selection is made, your choice becomes the default and pressing tab key will keep your 

selection and move the highlight to the next box to the right. Selecting “OTHER” opens a dialog 

box where you can add, change, delete and select custom choices. To add a washer, enter the 

text in the box above the “Add”, Change” and “Delete” buttons and pick “Add”. A maximum 

of 9 characters is allowed for washer. For custom washers, you may include a quantity of 1 or 2 

at the beginning of the description. Example: 1 F436 or 1-F436. Leave a single space or a dash 

with no spaces between the quantity and description. 

Pick OK to return to the bolt list input dialog box. Select the custom washer from the list. LIW 

is for load indicator washer. SQW is for squirter washer. HD if for hardened washer. BEV is for 

beveled washer. 

 

Length 

Input the length or grip in inches where ".II" is inches and "SS" is sixteenths. Thus 2 1/2" = 

.0208. If you are entering the grip, include a “+” character at the right end of the length. The 

washer thickness will automatically be added to the grip and the grip will be converted to the 

bolt length for the bolt diameter used when you tab to the next column. If you are listing washers 

or nuts without a bolt then leave the length column blank.  

Mark 

The mark can have up to 15 characters and can consist of numbers, letters and spaces.  

 

Support 

The support mark can have up to 15 characters and can consist of numbers, letters and spaces. 

Press the delete or space key and then the tab key to leave the support column blank and move 

to the next column. Entering any text will remove any text from the Location column. 

 

Location 

Location of the bolts in the member. Choices are blank, LEFT, RIGHT, BOTH, TOP, BOT.  

LEFT is for the left end or the "piece mark" end of the member. Entering any value other than a 

blank will remove any text from the SUPPORT column. 

 

Editing 

Select the line you want to edit. Use page up, page down and arrow keys or the scroll bar and 

mouse to select the line to edit. The values in the input boxes below the list are changed to match 

the line selected. Any custom types, finishes, diameters and washers on the selected line are 

automatically added if they did not already exist in the pulldown menus. Change the item you 

want to change in the input boxes and pick the “Change line” button. 

 

You can delete the entire line by choosing the “Delete line” button. Choosing the “Delete 

Location” button will remove all of the items from the location column.  
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Save, Save as 

“Save” saves the file to its original location and file name. 

“Save as” saves the file to a new file name and optional new location. 

 

Merge File 

This allows you to copy an existing bolt list to the end of the list currently open. If you have 

several people making partial list on a large job or you use AutoSD Steel Detailing to extract a 

bolt list from a subset of your drawings you can merge the files together into one list to get a 

summary or itemized list for the entire job. 

 

Print Itemized 

Writes the list to the file boltitemized.txt and opens it in Notepad for printing. The file is located 

in the same folder as the bolt list file currently open. 

 

Print Summary 

Writes the summary to the file boltsummary.txt and opens it in Notepad for printing. The file is 

located in the same folder as the bolt list file currently open. 

 

Sort 

Sorting will put the list in order according to the mark and remove any blank lines from the file. 

 

Open SDS/2 *.TXT 

Open XSTEEL *.XSR 

If you have a bolt list file that was created by SDS/2 or Xsteel you can open it for editing, 

merging or printing. 
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Chapter 2 - Erection Tools 
 

ANCHOR BOLT SIDE VIEW 

Pulldown: AutoSD > Erection Tools > Anchor Bolt Side View 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

  

This program will draw the side view of any of 

the six different anchor bolts. The insertion 

point is the underside of the washer and the bolt 

can be rotated to any angle. The length may be 

entered as the embed and projection separately 

as shown or uncheck the “Use Embed dims” box 

and enter the overall length as a single 

dimension. The scale is affected by the [AutoSD 

> Modify] or [AutoSD I > Change] > Scale of Drawing command.  

  

BEAM LINES w/DESC  

Pulldown: AutoSD > Erection Tools > Beam Lines w/Desc 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws a line with several options. You can put a moment symbol, a solid 

filed triangle, at the ends. You can include the camber with a custom prefix. You can 

include shear studs with a custom bracket character on each side of the number. The stud 

count can be on the same side of the line as the member size or the opposite side. You 

can include the elevation. The member size is always printed, the camber, stud count and 

elevation are optional. 

 

Pick 1st end of beam or [Select line] <Select line>: 

Pick a point to draw just one beam from point to point or press Enter or “S” and enter to 

draw multiple beams between existing lines. The member size will be placed at the center 

of the line. Dimensions from beam to beam can be placed automatically for the multiple 

beam option. Three existing lines are required to start if you are drawing multiple beams. Select 

a line at each end of the beam for a start and stop point. They do not have to be parallel. Select 

a third line parallel to the beam to be drawn as a reference for the first beam and select which 

side of this reference line to draw the beams. The program will continue to ask for the distance 

to the next beam, the offset at the 1st end and the offset at the 2nd end. A positive offset is for a 

cantilevered condition. Enter the dimensions and select the member size of the next beam. When 

asked for the distance to the next beam you can enter 0, (zero) to end the command or press Ctrl 

C or Esc to stop the command. All beam lines will be placed on a layer called BEAM. The scale 

is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 
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BEAM ON PLATE w/AB  

Pulldown: AutoSD > Erection Tools > Beam on Plate w/AB 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program will detail the end view and web view 

of a beam sitting on a bearing plate with anchor 

bolts showing the projection, grout, bolt length, 

hook length, bolt diameter, hole pattern and plate 

size. This detail is used on anchor bolt setting plans. 

You can use any of the six anchor types shown in 

“Anchor Bolt Side View” on page 35. The scale is 

affected by the [AutoSD > Modify] or [AutoSD I > 

Change] > Scale of Drawing command. 

 

 

BEARING PLATE EDGE VIEW  

Pulldown: AutoSD > Erection Tools > Bearing Plate Edge View 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws the sectional end view of a typical bearing plate used for joists or beams 

when bearing on a masonry wall. You enter the plate width and stud length. You can have one 

or two studs. No dimensions will be shown. The scale is affected by the [AutoSD > Modify] or 

[AutoSD I > Change] > Scale of Drawing command. 

 

BRACE LINES w/DESC  

Pulldown: AutoSD > Erection Tools > Brace Lines w/Desc 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program will draw a line to represent a brace and place the member size at the center of the 

line and an option to place a solid filed triangle moment symbol at the ends. Select a member 

size and enter an offset at each end. A negative offset will pull the brace back from the selected 

point. Select a point at each end of the brace for a start and stop point. All information will be 

placed on a layer called BRACE. The scale is affected by the [AutoSD > Modify] or [AutoSD I 

> Change] > Scale of Drawing command. 

 

BLOCK WALL SECTION  

Pulldown: AutoSD > Erection Tools > Block Wall Section 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 
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This program draws a cross section of a 4", 6", 8", 10” or 12", (100mm, 150mm, 200mm, 250mm 

and 310mm), block wall. The first point you pick will be a corner point of the first whole block 

on one face. The second point may be above or below the first point. The third point picked 

determines if the face location picked was the right or left side. The blocks are drawn 7 5/8", 

(193.7mm), tall with a 3/8", (9.5mm), mortar joint. The scale is affected by the [AutoSD > 

Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

BRICK w/BLOCK WALL SECTION 

Pulldown: AutoSD > Erection Tools > Brick w/Block Wall Section 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program is like Block Wall Section above but combines brick and block into one program 

to draw a cross section of the wall. You input the total thickness of the wall. The scale is affected 

by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

BRICK WALL SECTION  

Pulldown: AutoSD > Erection Tools > Brick Wall Section 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws the cross section of a brick wall. The first point you pick will be a corner 

point of the first whole brick. The second point may be above or below the first point. The third 

point picked determines if the face location picked was the right or left side. The brick is drawn 

3 3/4", (95.25mm), wide with a 3/8", (9.5mm), mortar joint. 3 brick equals one block in height. 

The scale is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing 

command. 

 

BLOCK WALL PLAN VIEW  

Pulldown: AutoSD > Erection Tools > Block Wall Plan View 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws the plan view of a 4", 6", 8", 10” or 12", (100mm, 150mm, 200mm, 250mm 

and 310mm block), block wall. The first point you pick will be a corner point of the first whole 

block at one end of the wall. The second point will be the corner point at the other end of the 

block wall. The third point determines which side of the line between the first two points the 

blocks are on. The blocks are drawn 15 5/8" long with a 3/8" mortar joint. The scale is affected 

by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

BRICK w/BLOCK WALL PLAN VIEW  

Pulldown: AutoSD > Erection Tools > Brick w/Block Wall Plan View 

Toolbar: Erection Tools 
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Ribbon: AutoSD I > Erection Tools 

 

This program is like Block Wall Plan View above but combines brick and block wall plan view 

into one program. You input the total thickness of the wall. The scale is affected by the [AutoSD 

> Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

BRICK WALL PLAN VIEW  

Pulldown: AutoSD > Erection Tools > Brick Wall Plan View 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws the plan view of a brick wall. The first point you pick will be a corner point 

of the first whole brick at one end of the wall. The second point will be the other end of the brick 

wall. The third point determines which side of the line between the first two points the bricks 

are on. The bricks are drawn 3 3/4" wide, 7 5/8” long and with a 3/8" mortar joint. 2 brick equals 

one block in length. The scale is affected by the [AutoSD > Modify] or [AutoSD I > Change] > 

Scale of Drawing command. 

 

COL BASE PLATE w/AB  

Pulldown: AutoSD > Erection Tools > Col Base Plate w/AB 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program will detail the plan view and elevation view of a column base plate 

with anchor bolts showing the projection, grout, bolt length, hook length, bolt 

diameter, hole pattern, plate size and column size. This detail is used on anchor bolt 

setting plans. You can use any of the first five anchor types shown in “Anchor Bolt 

Side View” on page 35. 

The dimensions for the 

plate are entered in the 

dialog box to the left 

where they can be read 

from the file for other 

details. The scale is 

affected by the 

[AutoSD > Modify] or 

[AutoSD I > Change] 

> Scale of Drawing 

command. 
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COLUMN w/BOLT PATTERN  

Pulldown: AutoSD > Erection Tools > Column w/Bolt Pattern 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program will draw the end view of a column to scale and place 

a line at 45 degrees in the quadrant you select and place the member 

size on the top side of the line and up to two reference notes on the 

bottom side of the line. The size of this text is controlled by the “Text 

scale factor”. All of this is on a layer called “Column”. It will draw 

and dimension a bolt pattern with or without base plate and put this 

on a layer called “Anchors”. You have the option of drawing just the 

column, just the description line or just the bolt pattern. The scale is 

affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale 

of Drawing command and can be scaled up by entering a 

magnification factor greater than 1.  

 

DECK EDGE VIEW 

Pulldown: AutoSD > Erection Tools > Deck Edge View 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

This program will draw the edge view of floor and roof deck. The scale is affected 

by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

Deck descriptions are stored in the data file US_deck.dat in your autosd\data 

folder. You may edit this file to add more descriptions to it using the database 

editor. See chapter 4 and Appendix B.  

 

 

 

 

 

ELEVATION GENERATOR 

Pulldown: AutoSD > Erection Tools > 

Elevation Generator 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program is for creating elevation 

views for erection drawings and plan 

views of stairs. The information is 

entered into dialog boxes and saved to a 

file name and location of your choosing. 

One file holds one view. You can create 

elevation views showing beams, braces, 
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CMU walls, columns, end view of shape on column, girts, joist, ladders and stairs. The views 

can be drawn to various scales independent of the scale that your drawing is set up to. 

 

Input is entered in bays. One bay is the area between two adjacent columns. Bays are created 

from left to right. 

 

Main dialog box  

Open:  Lets you select existing elevation files to open for editing. 

Save As:  Lets you save a file that has not yet been saved or lets you save an existing file to a 

new file name. An elevation cannot be drawn until the file is saved. 

 

View title:  This is name of the elevation view and will be printed below the elevation detail. If 

you want additional text lines printed under the title, separate the text lines with the “|” character. 

 

Example: 

COLUMN LINE A | SCALE: `4” = 1’-0” Will be printed as: COLUMN LINE A 

                SCALE: 14 = 1’-0 

Note that the inch marks will be removed from the printed text. 

 

The main dialog box is divided into 4 sections. Left side, Right side, Top center and Bottom 

center. 

 

Left side and Right side sections  

These are for entering the column information of the current bay. The first edit box is for the 

optional column grid. If no grid designation is needed just leave this box blank. You can have 

up to three tiers. The “Piece mark” edit box is for the shipping mark of the column of the 

currently selected tier. If no piece mark is needed just leave this box blank. The “Top of Col 

EL” is the elevation at the top of the column or the column splice for multi-tier columns. Picking 

“Del Tier 2” will delete the column for tier 2 and tier 3 and puts you back to having only one 

tier. Picking “Del Tier 3” will delete the column for tier 3 and puts you back to having two tiers. 

Picking “Select Size” lets you pick a column size for the currently selected tier. Picking “Clear 

Size” will remove the column size for the currently selected tier. The “Bottom of Col EL” is the 

elevation at the bottom of the column or the column splice for multi-tier columns. “Orientation” 

lets you select how the column is viewed. “Show Cap PL” and “Show Base PL” toggles cap and 

base plates on if selected and off if cleared. 

 

Columns are optional. If a column is not required, you must leave the column size blank. If you 

have an elevation detail with no columns such as a stair elevation inside block walls you need 

to enter a “Top of Col” elevation for one of the columns that is the height of the block walls or 

higher and a “Bottom of Col EL” that is the elevation of the bottom of the lowest stair. These 

elevations determine where the bay width dimension is located. 

Top center section  

This is for adding or changing Bay information and entering the Main elevations. 
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Bay selection: Bays are numbered in sequence from left to right starting with #1. Picking “Add” 

will add a bay. The “Bay #” will increase by one and you will be place in the last bay at the right 

end of the elevation. You can add a bay at any time. Picking “Copy” will add a copy of the last 

bay to the right end of the elevation. “Copy” will only be available when you are viewing the 

last bay. Picking “Delete” will delete the current bay. To select a different bay, you can pick the 

“Next” or “Prev” buttons or you can pick the down arrow to the right of “Bay #”. This will drop-

down the list of all bays where you can select the number of the bay you want. All bays must 

have a width. Enter the width from center line of the column on the left to the center line of the 

column on the right in this edit box. 

Main Elevations:  Elevations entered here will be dimension on the left side of the elevation 

detail and apply to all bays. To enter an elevation, type a number in the edit box and pick “Add”. 

Repeat this until all elevations have been entered. To change an elevation, pick the elevation, 

type in a new number in the edit box and pick “Change”. Picking “Delete” will remove the 

currently selected elevation. 

EL. Note:  If you want to add a note such as “First Floor” or “2nd Floor” to the detail pick the 

elevation you want the note associated with and then enter the note in this edit box. 

 

Bottom center section  

This is for entering information in the current bay by picking a button that opens a new dialog 

box for that member. 

 

The following instructions are similar for Beams, Braces, CMU wall, End Views, Girts, Joist, 

Ladders and Stairs. 

 

The top of the dialog box will indicate which bay you are in by listing the column grids and the 

bay number. The default will be the current bay in the main dialog box. You can change bays 

by picking the “Next Bay” and “Prev Bay” buttons. Pick “Add” to add a member. A dialog box 

will pop up for you to select a member size and elevation. The elevations listed under “Main 

Elevations” will be in this dialog box for selecting or you can enter a different elevation in the 

edit box. If the member is sloping, simply put a different elevation at each end. The “Change” 

button lets you change the size and/or elevation of the currently selected member. The “Delete” 

button will remove the currently selected member. The size and elevations will be displayed in 

the list box. 

 

Beams  

If you have a beam attached to only one column you need to put a check in “Stub Beam” box 

and select either “On Left Col” or “On Right Col” of the current bay. Next, select which side of 

the column the beam is on and enter the “Length of beam” in the edit box. This is the distance 

from the center line of the column to the end of the beam. If you have a beam that extends over 

the top of a column you need to put a check in the “Cantilever” box. Next, select which column 

the beam cantilevers and enter the “Length of beam” in the edit box. This is the distance from 

the center line of the column to the end of the beam. 
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You can add a note to the left and/or right ends of a beam. This can be an end reaction, piece 

mark or other note. Separate the text lines with the “|” character to put multiple lines of text at 

one end. 

Example: 23k | 48B3 will be printed as: 23k 

48B3 

with the “23K” above the beam line and all other text below the beam line. 

 

Below this is the “Orientation”. The selections available will depend on the shape of the beam. 

“W” shapes will either be “Web” or “Flange” view. Channels can be toed Up, Down, NS or FS. 

The image above and at the right end of Orientation will show an icon of what has been selected. 

 

Braces  

Pick Add to add a brace to the current bay. The top and bottom elevation for 

the brace is normally the top elevation of the beam it frames to. 

Select the “Type” of brace by picking an icon image. Next select the 

“Orientation”. The icons available will depend on the shape of the brace. If 

the brace is an angle, select whether it is “1 Member” or “2 Members” and 

if you want a designation for the “Long Side Vertical” added to the detail 

put a check in that box. If you need to add additional text under the center 

of the brace put it in the “Note” edit box. Separate the text lines with the “|” 

character to put multiple lines of text. 

Example: (47k %%p) | 21D1 will be printed as: (47k +-) 

        21D1 

Work Point at Bottom: (of brace) and Work Point at Top: (of brace) 

Select where the work line of the brace will intersect the beam and column, 

either “Center” or “Face”. 

Work Line is at: Select where the work line of the brace is located. 

 

After making all selections for one brace pick “Add” to add another brace. The selections of the 

currently selected brace will be the defaults for the new brace. Pick OK to save and close the 

Brace dialog box. Pick Cancel to close the Brace dialog box without saving the changes. 

 

CMU wall  

The wall can include brick on either side. Dimension A 

can be referenced from either column line and from either 

side of the wall. Block widths available are 4, 6, 8, 10 and 

12. 

The dimension locating the wall from the column will be 

drawn above the top of the wall. If you have two walls the 

same height located from the same column the dimensions 

will overwrite. To avoid this, locate the left wall from the 

left column and the right wall from the right column. 
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End Views 

Putting a check in the box for “Note size” will add a leader with 

the member size to the detail. “Short Side Vertical” is for the 

orientation of tubes. Angles and channels can be toed left or 

right. Angles and Tees will have the leg or stem pointed up or 

down. The dimension locating the end view can be from the left 

or right column. 

 

Girts  

The left and right side of the 

dialog box show an image for a 

“Girt line”. If the girts extend past the column line at the left end 

enter a distance for the “Girt line” under the left side image. A 

negative distance will stop the girts short of the column line. The 

girt line information will be available no matter which bay you 

are editing but will apply only to the first and last bay of girts. 

 

After adding a girt, select the “Object Type”. It can be a Girt, 

Door or Window. The center image is changed to show which 

type is selected and the type is changed in the display list. If a 

door or window is selected the “Location”, Width of opening” 

and “Height of opening” are enabled to the left of the display list 

and values must be entered for each. The location can be from the left column or from the right 

column as selected under “Located from”.  

 

After making all selections for one girt pick “Add” to add another girt. The selections of the 

currently selected girt will be the defaults for the new girt. Pick OK to save and close the Girt 

dialog box. Pick Cancel to close the Girt dialog box without saving the changes. 

 

Joist 

The elevations entered for each end are to the joist bearing.  

 

The joist size is taken as a literal string for labeling. The Depth and 

seat height are entered in the joist dialog box for each joist. 

Remember to use the correct format for dimensions as shown at 

the top of the dialog box. 

 

After making all selections for one joist pick “Add” to add another 

joist. The settings of the currently selected joist will be the default 

for the new joist. Pick OK to save and close the Joist dialog box. 

Pick Cancel to close the Joist dialog box without saving the 

changes. 

 



Erection Tools, Chapter 2                                       AutoSD Steel Detailing  

44 

Ladders  

Under “Type” select “Caged” or “Non-caged” and “Side step” or 

“Step through”. Under “View” select “Front” “Left Side” or “Right 

Side”. The location can be from the left column or from the right 

column as selected under “Located from”. The dimension for the 

location is entered in the edit box for “Center of ladder from left 

column” 

After making all selections for one ladder pick “Add” to add another 

ladder. The selections of the currently selected ladder will be the 

defaults for the new ladder. Pick OK to save and close the Ladder 

dialog box. Pick Cancel to close the Ladder dialog box without saving 

the changes. 

 

Stairs  

To the right of the display list are selections for “Slope”, 

“Top” and “Bottom”. The slope orientation of the stair can 

be up to the left or up to the right. Changing it will change 

the images shown. Select the top and bottom condition and 

the image below will change to reflect your selections. 

Enter any Two: For dimensions #1, #2 and #3 you only 

need to enter 2 of these. Those two are subtracted from the 

bay width to get the third. 

Ends: Dimension #4 is from the work point at the bottom 

end to the end of the stringer and #5 is from the work point 

at the top end to the end of the stringer. 

Elevation view of stair image: 

#6 is from top of upper floor to top of frame member. 

#7 is from nosing line to top of stringer. 

#8 is from top of lower floor to top of frame member. 

#9 is from the work point at the bottom tread to the back of the header on 

the lower landing. This dimension is required even if this is the ground 

floor. It can be 0. 

#10 is from the work point at the upper floor to the back of the header 

beam. 

#11 is the depth of the landing on the left side from back of header to back 

of wall member.  

#12 is the depth of the landing on the right side from back of header to 

back of wall member. #11 & #12 locate the face of the CMU wall shown 

in the landing setup. 

#13 is a global dimension used for all stairs in one bay. The dimension 

can be the same as the bay width or inside distance of CMU walls at each 

end of stair. If the stair frames into a floor beam on the column center line 

on the left, for example, dimension #11 will not be used but must still be 

entered. You must select “None” for the frame type in the Landing Setup in this case. 
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Rails:  Select either Pickets or Rail or neither. If Rail is selected, you need to select the number 

of lines. 

Treads:  Select the type of Grating or Pan. The image to the right will change to reflect your 

selections.  

Enter the “Number of treads” in the edit box and press the enter key or tab key and the first riser 

will be calculated and put in the “First riser - R” edit box as the default. You can change it or 

leave it as-is. 

Stair is:  Either NS or FS. The image of the plan and elevation view will change to reflect your 

selection. 

 

After making all selections and entering all values for one stair, pick “Add” to add another stair. 

The selections of the currently selected stair will be the defaults for the new stair. Pick OK to 

save and close the Stairs dialog box. Pick Cancel to close the Stairs dialog box without saving 

the changes. 

 

Landing Setup  

Pick this button to configure the landings for both right and left side. 

There is only one landing configuration per elevation view. The 

same configuration is used on all floors in one elevation view. The 

configuration set here will be the default for the next elevation file. 

 

Frame location:  Left side, Right side: Select the side that you want 

to configure. When you have finished that side select the other side. 

If you want this side configured to be the same as the first side, pick 

”Same as other side” button. 

 

Frame type:  The frame type can be built up or mitered, (“dog leg” 

- shop welded to stringer) or none for framing the stringer to a floor 

beam. The one you select is reflected in the Plan input at the bottom 

of the dialog box. Fill out all information for both right and left 

sides. 

 

Section: This is enabled if you select either built up or mitered frame type. This shows a section 

through the frame showing the end view of the header beam with a CMU wall. In a built-up 

frame the header is one side of the frame so the header to stringer connection options are 

disabled. #1 is from face of CMU to back of wall member. #2 is from top of floor to top of 
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header. #3 is from top of wall member to top of floor. #4 is floor thickness. “A” is from back of 

header to center of holes if the frame type is mitered and the header to stringer connection is 

holes. 

 

Plan: Dimensions shown in plan for the landing. #5 & #6 are from back of frame end member 

to end of wall and header members. #7 & #8 are from back of built up frame end member to 

back of stringer or from back of wall member to ends of mitered stringer. Only one end at each 

corner should extend past for a mitered frame, so, one dimension at each corner should be 0. #9 

& #10 are from back of stringers to edge of floor opening or face of CMU walls. #11 is width 

of stairs. #12 is from edge to edge of floor opening or face to face of CMU walls. #13 & $14 are 

the thickness of the CMU walls. These can be 0 for no walls. #15 is from the column center line 

to the inside face of the CMU wall. The outside line of the CMU end wall is the center of the 

column line. Enter 0 for #15 for no CMU wall. 

 

The right side of the dialog box is for entering the landing member sizes and selecting which 

way the wall members are toed. 

Stringer to Header:  Enter dimension #1, #2 & #3 to locate the holes for this connection. 

 

Detail landing 

If landings are built-up as a frame, and you have the Stairs and Rails package, they may be 

detailed by picking this button. It will close the Elevation generator program and open the 

Landing Frame program. The input for the landing frame will be exported for the elevation 

selected and imported into the Landing Frame program. 

 

Draw plan 

Pick this button to draw a plan view of each landing. A list will be displayed for you to select 

an individual plan elevation or put a check in the box “Select all” to draw all plans. 

 

Export stairs  

If you have the Stairs and Rails package, pick this button to export all stringers in the current 

bay. They can be detailed by the Stringer program. The file name for each stringer will begin 

with the file name of the current open Elevation Generator file plus the bay number plus the 

bottom and top elevations of the stringer. 

 

Column file configuration 

If you have the Beam and Column package you can create column files from the elevation views. 

Pick the Bay that you want and then pick the “Write to column file” button under the right side 

or left side column. If the column is spliced, you will need to select the tier as well and make a 

separate file for each tier. After selecting an existing column file to append to or replace or 

creating a new column file, a configuration dialog box pops up. You can also open this box by 

picking the “Column file configuration” button on the main dialog box. This box pops up every 

time for you to select the proper column face, but it needs to be configured only once or when 

the need requires it. If you have girts, you will need to select the correct connection for the 

current column by picking the Girt configuration image button. 
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Pick OK to create the column file and return 

to the main dialog box or Cancel to abort. 

Picking cancel will also cause you to lose all 

changes made to the configuration. 

 

If you have two elevation views, you can 

create a single column file that contains 

the connections for members in both 

elevations. See the picture to the left that 

represents the plan view of a column at lines 

“1” and “A”.  If you are looking at line “1” 

the face on the left side of the column in the 

elevation view would be “D”. Looking at 

line “A” the face on the left side of the 

column in the elevation view would be “A”. 

After creating the column file for the first 

elevation view, append the results of the 

second view to the existing file. The two views may be processed in either order. 

 

Girt configuration 

Pick the Girt config image button and select the proper girt to 

column connection from the image icons on the left side. Enter 

the dimensions for the connection and select the angle and WT 

size. 

 

Pick OK to save the settings. Picking cancel will cause you to 

lose all changes made to the configuration. 

 

 

Joist configuration 

Select the Joist config button and select the seat type and enter 

values for all options available. Pick OK to save the settings. 

Picking cancel will cause you to lose all changes made to the 

configuration. 

 

Draw  

This will save all changes to the file and open the “Select Scale” 

dialog box. Pick the scale you want the elevation drawn to and 

pick OK. You will be prompted for the insertion point while a 

box is drawn around the cross-hair location. The box is the 

extents of the elevation view and will move with the cross hairs. 

After picking a point the box disappears and the elevation is 

drawn. 
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GRID LINES w/DIM  

Pulldown: AutoSD > Erection Tools > Grid Lines w/Dims 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program will draw grid lines with column grid bubbles and optional dimensions between 

grid lines. You draw the first grid line. The end you start with is the end the grid bubble will be 

on. After the first grid line and bubble has been placed you select one side of the line for the 

placement of other grid lines and bubbles and you select the location of dimensions if any are 

required. After that all you input is the distance to the next line and the designation for the grid 

bubble. Press ESC or enter 0 for the distance to the next grid line to end the program. Entering 

the Grid mark as “150|11” will stack the text with “150“ on top and “11“ underneath. The scale 

is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

JOIST LINES  

Pulldown: AutoSD > Erection Tools > Joist Lines 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program is like the beam lines program. This program will place joist inside a four-

sided area. The boundaries of this area do not have to be square or parallel. The joist lines 

will be put on a layer called JOIST. At the prompt “(FT.IISS) <Joist spacing>/Number of 

equal spaces:” you can enter a distance in the noted format for the spacing or the letter N, 

(upper or lower case), to enter the Number of equal spaces. The spacing is affected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

JOIST SIDE or END VIEW  

Pulldown: AutoSD > Erection Tools > Joist Side or End View 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws the side or end view 

of open web joist and joist girders. Joist 

sizes are (H, J or K), (LH or DLH), Girder 

and Other. If “Other” is selected you will be prompted to enter the size of 

the top chord, bottom chord and web member. 

 

Side View: You must pick the insertion point for the bottom of the seat at 

the edge of support and a point for the length of the joist before you can 

enter all of the variables. For the location of the end of seat from the 

insertion point, seat length, location of holes, top chord extension and 

bottom chord extension you can enter a length or pick a point. There are 

two types of top chord extensions. The one selected will be shown with a 

black background. 
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End View: Put a check in “Show seat” if you want the seat drawn. Insertion point can be at the 

top of the joist or bottom of the seat. You can select to put holes in the seat with a dimension to 

them. 

 

A reference elevation can be put on both side view and end view. 

The scale is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing 

command. 

 

LADDERS 

Pulldown: AutoSD > Erection Tools > Ladders/Gate 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This will display an icon menu for the selection of plan views of 

ladders with and without cages for use in creating erection 

drawings. The insertion point is the middle of the rung. The scale 

is affected by the [AutoSD > Modify] or [AutoSD I > Change] > 

Scale of Drawing command. 

 

MARKS / SECT / TAGS 

Pulldown: AutoSD > Erection Tools > Marks / Sect / Tags 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

 

 

 

 

 

 

 

 

 

This will display an icon menu for the selection of piece mark, section marks, break lines, north 

arrow, column bubble, column, AISC symbol, revision symbols and UP and DOWN arrows. 

 

This places attributes in the drawing for piece marking an item and giving its quantity. There 

are two formats: MARK over QUANTITY and QUANTITY - BEAM - MARK. If you are 

saving CNC data, the mark will also have two hidden attributes for the size and length. If you 

change the size of the member or the length in the detail view you will need to change the values 

of these attributes with the ATTEDIT command. The length will be in the FT.IISS format. There 

is one more attribute that is left blank. When you edit the attributes the prompt for this attribute 

is REF: and is used for inserting a single line reference note under the mark. 
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This is for drawing "break” lines. Pick the start and end points and the "break" line will be drawn. 

The line will extend 1 1/2", at a scale of 1" = 1', past each point picked. 

 

These two are for cutting sections. A letter or number of your choice is placed with the symbol. 

 

These two are for labeling a section or a detail. When either one is inserted, you are asked to 

give a mark letter or number to be put with the symbol. 

 

These three are for labeling a section, detail or elevation. When one is inserted, you are 

asked to give a mark letter or number a sheet number and a reference number to be put with 

the symbol. 

 

These two blocks are to be used with the block directly below. The insertion point is the center 

of the circle. After insertion, you pick the rotation and the block will be exploded and placed on 

layer “ASD_SECT”. The color is bylayer and is controlled by your customer color 

configuration. Since it is exploded you will be able to stretch it as needed. 

 

This block is for cutting a section and giving the section number and sheet number. This block 

has three parts. The outer circle is the first part. You may rotate it to any angle after insertion. 

The second part is the mark and sheet number. It will always be at a rotation angle of 0. The 

third part is the block shown above. It is automatically inserted at the center of this block. You 

pick the rotation and answer “Y” or “N” to mirror that block to make the triangle at the end point 

in the right direction. This last part will be exploded so you will be able to stretch it as needed. 

All the blocks will be placed on layer “ASD_SECT”. The color is bylayer and is controlled by 

your customer color configuration. 

 

This is the north arrow. The arrow may be rotated to any angle, but the "N" will always be at a 

rotation angle of 0.  

 

This is a bubble for column line identification. You are prompted for the Grid mark. The mark 

will automatically be placed in the center of the bubble. Once inserted, the bubble may be rotated 

to the desired direction, but the text will have a rotation of 0. Snap mode is automatically set to 

end snap for easy insertion. 

 

This bubble is for when the column line identification has at least 4 characters. The dots in 

the icons represent the insertion points. Rotation is always 0. You are prompted for the 

column mark. The mark will automatically be placed in the center of the bubble and will 

have a rotation of 0. Snap mode is automatically set to end snap for easy insertion. 

 

This is a bubble for column line identification where you would have a mark and a reference. 

The mark will be placed above the reference and will automatically be placed in the center of 

the bubble at a rotation of 0. Snap mode is automatically set to end snap for easy insertion. 
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This is for drawing a single line end view of a "W" shape. The insertion point is the center of 

the web. 

 

This is for drawing a “break line” with or without hatching in an existing circle to represent a 

pipe. 

 

These four are for labeling a section, detail, view or elevation. When one is inserted, you are 

asked to give a mark letter or number a sheet number and a reference number to be put with 

the symbol. The one for SECTION has options the other three do not have. The label 

SECTION is optional and the default. You can type any label you want. You are asked for 

a scale that will be placed under the label. Pressing enter instead will leave this option blank. 

After the block is inserted, pick the block to show the grips. You will see a triangular grip 

at the right end of the two horizontal lines. You can pick this grip to stretch the lines as 

needed. 

 

The AISC symbol is provided for your use for creating title blocks of customers that use the 

symbol. File: C:\autosd\sec\asd_aisc.dwg 

 

The AGC logo is provided for your use for creating title blocks of customers that use the 

symbol. File: C:\autosd\sec\agcoa.dwg 

 

 

The AISC Certified Fabricator logo is provided for your use for creating title 

blocks of customers that use the symbol. 

File: C:\autosd\sec\aisclogo-fab.dwg and C:\autosd\sec\aisclogo-fab.bmp 

 

This is a typical revision symbol. You are asked for a number when it is inserted. You may enter 

a number or letter. The attribute name ASD_REV 

 

These are direction arrows. The arrow may be rotated to any angle but the “UP” and 

"DN" lettering will always be at a rotation angle of 0. 

 

This is for drawing a "break” line in a round section. Pick the start and end points and the 

direction of the open end. 

 

MEMBER 

Pulldown: AutoSD > Erection Tools > Member 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program is for drawing a double line representation of a member 

on an existing single line. The program will break the line at the two 

points picked, erase that segment and draw the member picked from 

the icon menu. The scale is affected by the [AutoSD > Modify] or 

[AutoSD I > Change] > Scale of Drawing command. The different 
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member shapes are ANGLE, COLUMN FLANGE, COLUMN WEB, BEAM WEB and 

CHANNEL FLANGE. 

 

REVISION CLOUD 

Pulldown: AutoSD > Draw > Rev. Cloud 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

The revision cloud is for drawing a "cloud" around something. When 

drawing the cloud using the Arbitrary or Freehand option, move the 

cursor in a counter clockwise direction. In the Freehand option, the 

program will automatically close the cloud when the cursor is a short 

distance from the beginning. If the layer names are blank and 

“Append revision number to layer name” is unchecked, the cloud 

and delta will be drawn on the current layer. The delta will be the 

color of the current layer and not the color set in the configuration. 

Rectangular clouds will be drawn to the angle of the snap angle 

setting. 

 

SAFETY GATE 

Pulldown: AutoSD > Erection Tools > Ladders/Gate 

Ribbon: AutoSD I > Erection Tools 

 

This program draws a safety gate using a polyline from three points 

picked and a given opening size. The scale is affected by the [AutoSD 

> Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

 

SHAFT OPENING 

Pulldown: AutoSD > Erection Tools > Shaft Opening 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws a shaft by supplying the shaft 

dimensions, start point and orientation. Shafts can be drawn from a corner, center or midpoint 

of an edge and at any angle. The scale is affected by the [AutoSD > Modify] or [AutoSD I > 

Change] > Scale of Drawing command. 

 

STAIR PLAN 

Pulldown: AutoSD > Stairs > Erection > Complete Plan 

Pulldown: AutoSD > Stairs > Erection > Partial Plan 

Ribbon: AutoSD II > Stairs 
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The partial plan is shown to the left with a “break” line at one end. The complete plan 

will look just like the partial except both ends will be square and will not have a 

“break” line at one end. The insertion point is one end of one stringer. The stair plan 

can be drawn in any direction and the scale is affected by the [AutoSD > Modify] or [AutoSD I 

> Change] > Scale of Drawing command.  

Location of end point of one stringer:  Pick first point. 

Stair direction:      Pick second point or enter an angle. 

Side for other stringer:    Pick a point. 

(FT.IISS) Width of stair: 3 

(FT.IISS) Width of tread: .1 

Number of treads: 12 

Direction of Stair (Down/Up): D 

Insertion point:      Insertion point for direction indicator. 

Rotation: 1 found      Rotate indicator.  

TAGS 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This program is for inserting a circle, diamond, hexagon, square or triangle with an attribute in 

the center. These 4 symbols are tags and are provided for your use. They are like the revision 

symbol. The attribute name for each is listed below. 

 

Symbol  Attribute Name Symbol  Attribute Name 

CIRCLE      ASD_CIR  DIAMOND  ASD_DMND 

SQUARE  ASD_SQR  HEXAGON  ASD_HEX 

 

TEXT DESCRIPTION  

Pulldown: AutoSD > Erection Tools > Text Description 

Ribbon: AutoSD I > Erection Tools 

 

This program is for placing a text description parallel to a line on either side and centered at the 

point picked. Normally this would be the size of a beam, brace, column or some other member. 

 

U-BLOCK SECTION VIEW  

Pulldown: AutoSD > Erection Tools > U-Block Section View 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws a cross section of 6", 8", 10” and 12" block, (150mm, 200mm, 250mm and 

310mm block). The blocks are drawn 7 5/8", (193.7mm), tall. The scale is affected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 
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WOOD END VIEW 

Pulldown: AutoSD > Erection Tools > Wood View 

Toolbar: Erection Tools 

Ribbon: AutoSD I > Erection Tools 

 

This program draws the cross section of wood. Input the nominal size and the program will draw 

it to actual size. You enter the nominal width, nominal thickness, start point and orientation. The 

end view can be drawn from a corner, center or midpoint of an edge and at any angle. The scale 

is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 
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Chapter 3 - Draw 
 

@ LINE 

Pulldown: AutoSD > Draw > @ Line 

Ribbon: AutoSD I > Utilities  

 

This command is like AutoCAD’s line command. It operates in much the same way by starting 

with a point and asking for your next point. To enter the next point, you may pick a point or 

enter the distance with or without an angle. If no angle is given, the angle will be from the 

previous point to the cursor. The distance is entered in the FT.IISS format and is affected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. To draw a line 2’-

3 1/4” at an angle of 900 from the last point it would be entered in the following way.  

      command: (FT.IISS) To point: @2.0304<90 enter 

 

To draw a line using the cursor for direction: 

      command: (FT.IISS) To point: 2.0304  enter 

 

2 PT VECTOR  

Pulldown: AutoSD > Draw > 2 PT Vector 

Ribbon: AutoSD I > Utilities 

 

This program will draw the horizontal and vertical vectors of a sloping line. Pick the line and 

select side for the vectors. A horizontal and vertical line will be drawn from the end points of 

the selected line to form a triangle on the side of the sloping line that was selected for the vectors. 

 

ADD STUDS  

Pulldown: AutoSD > Add Studs 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will draw a side view or top view of any size threaded or headed stud along a 

selected line, with or without dimensions. The scale of the studs is affected by the [AutoSD > 

Modify] or [AutoSD I > Change] > Scale of Drawing] command. 

 

ADHESIVE ANCHOR  

Pulldown: AutoSD > Detail > Adhesive Anchor 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will draw a side view of any size bolt. The head will be solid lines; the shaft will 

be hidden lines with a “cloud” around the shaft representing the hole in the concrete. The 
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insertion point is the underside of the nut. The second point is the face of the concrete. The last 

point is the end of bolt inside the concrete.  The first and last points determine the rotation. The 

scale is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing 

command. 

 

ANCHOR BOLT 

Pulldown: AutoSD > Detail > Anchor Bolt 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will detail three different types 

of anchor bolts. The insertion point is at the 

top of the bolt or the underside of the top 

washer. The length may be entered as the 

embed and projection separately as shown or 

uncheck the “Use Embed dims” box and enter the overall length as a single dimension. The 

description and size of the standard plate washer used is set with the “Config Std Plate Washers” 

button. All threaded rod is an option for the center type. Select nut and washer options for each 

end of the bolt.  

 

You can add more Rod types by picking the “Edit rod types” button 

and entering the description in the edit box shown in the dialog box 

to the right. Pick ADD to add the description to the list on the left 

side which saves it. Pick Delete to delete a description from the list. 

To change an item in the list, pick it, edit the description and pick 

Change. Pick OK to update the default list of types with your 

custom list in the main dialog box.  

 

The scale is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing] 

command. 

 

ARCHED TEXT 

Pulldown: AutoSD > Arched Text 

Ribbon: AutoSD I > Utilities 

 

Arched text will produce text about a curve. Some examples are the AISC symbol and the slide 

in the ARCS program.  

Command:   Pick [AutoSD or AutoSD I] > Utilities > Arched text 

Command: ATEXT 

Pick radius point: 60,40 

Pick middle point of text: 60,7 

Text height: 1.5 

Is base of text towards radius point <Y>: 

Enter 
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Text: THIS IS ARCHED TEXT 

Command:        The text is written about an arch. 

ASSEMBLY MARKS 

Pulldown: AutoSD > Shop bill > Assembly Marks 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Shop bill 

 

This is used to place assembly marks on your drawing. It works the same as the LEADER 

command except it keeps track of marks for plates, angles, bars, rods, channels, and 

miscellaneous marks. You can choose to have notes such as (NS), (FS), (BS), (CTR'D), R, L, 

and R/L automatically added to mark. You can increment the mark each time or repeat the same 

mark multiple times. The CNC option will allow you to make a CNC file of a plain material 

piece. 

 

BOLT CIRCLE 

Pulldown: AutoSD > Draw > Bolt Circle 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This is a symbol that is used to add the bolts and adhesives for a field bolted connection. Select 

the proper options in the dialog box.  

 

The choices for location are: NONE, LEFT, RIGHT, TOP, BOT. The choices for standard types 

are: A307, A325, A490, ADHESIVE, ANCHOR, EXP., LIB, SELF TAP, SLEEVE and 

WEDGE. ANCHOR, SELF TAP and SLEEVE are abbreviated ANCH, STAP and SLEV 

respectively.  

 

Adhesive 

Pick the “Adhesive” button to add an adhesive to the bolt circle. This button opens another 

dialog box for adding, changing and deleting descriptions of adhesives. Select a description, 

enter a quantity and optionally enter the mark of the piece the adhesive is for. Pick OK to add it 

to the bolt circle. Pick the “Back” to abort the adhesive selection and go back to bolts. 

 

Bolts 

You can add more diameters, washers, types and finishes by picking the “More…” buttons and 

entering the description in the edit box shown in the dialog box below. Pick ADD to add the 

description to the list on the left side which saves it. Put a check in the box below the list if a nut 

is included when listed in the bill of material, (for Types only). Pick REMOVE to delete a 

description from the list. Pick OK to add the list to the diameters or types in the main dialog 

box. 
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The choices for washers are: 

(blank) for none 

1W  for 1 standard washer 

1HD  for 1 hardened washer 

2W  for 2 standard washers 

2HD  for 2 hardened washers 

BW  for beveled washer 

SBW  for 1 standard washer and 1 beveled washer 

SLW  for 1 standard washer and 1 load indicator washer 

SSQ  for 1 standard washer and 1 squirter washer 

SBL  for 1 standard washer, 1 beveled washer and 1 load indicator washer 

HDB  for 1 hardened washer and 1 beveled washer 

HDL  for 1 hardened washer and 1 load indicator washer 

HDSQ  for 1 hardened washer and 1 squirter washer 

LBW  for 1 load indicator and 1 beveled washer 

SQB  for 1 squirter washer and 1 beveled washer. 

 

The bolt circle uses attributes instead of text. The advantage of using attributes is the ability to 

extract the data to an ASCII file where it can be used by other programs. To extract information, 

you must have a template file. The one shown below is for use with the bolt list program.  

 

Attribute extract file \AUTOSD\BONUS\ASD_BLT.TXT 

(The file FLDBOLT.TXT is used for drawings created with version 4.0 and earlier. 

Do not modify these files. The information given below is for reference only.) 

 

ASD_FIELDBOLT  C040000 (Description, 40 characters max.) 

ASD_BLTMARK  C016000 (Main mark, 16 characters max.) 

ASD_BLTLOCATE C006000 (Location, which end, 6 characters max.) 

ASD_BLTFINISH  C006000 (finish, i.e., black, galv, S.S., 6 characters max.) 

 

(The comments must not actually be part of the template file.) Each line has two fields. The first 

field is the tag name. The tag name is the name of one of the tags in the ASD_FLDBOLT block. 

The second field contains the format for the data for that tag. All format fields start with a "C" 

denoting it as a character field. The next three digits are the field width characters. The last three 

are number of decimal places. All character fields have "000" for the last three digits. 

 

CAUTION: The first fields in the attribute extract template file MUST be spelled as shown 

above. 

 

NOTE: Do not use "tab" characters when constructing the template file. If you want to align the 

columns for readability, do so with ordinary spaces. 
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BOLT EXPANSION 

Pulldown: AutoSD > Detail > Bolt Expansion 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will draw a detailed side view of any size bolt. The head will be solid lines, the 

shaft will be hidden lines and tapered. The scale is affected by the [AutoSD > Modify] or 

[AutoSD I > Change] > Scale of Drawing command. 

 

BOLLARD 

Pulldown: AutoSD > Detail > Bollard 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will draw a pipe bollard, with or without anchors near the bottom. The scale is 

affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

BOLT w/N&W 

Pulldown: AutoSD > Detail > Bolt w/n&w 

Ribbon: AutoSD II > Detail 

 

This program will draw a detailed view of a variety of bolt types. You can draw a side view or 

end view of the head or nut, with or without washers. There is also a 3D option. The scale is 

affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

CLEVIS 

Pulldown: AutoSD > Draw > Clevis 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This will draw the side or edge view of a clevis. The insertion point is 

the center of the pin hole for the side view and the center of the pin 

midway of the grip for the edge view. The rotation is the angle from 

the insertion point to the center of the threaded end. The scale is 

affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale 

of Drawing command. 

 

CLIP 

Pulldown: AutoSD > Draw > Clip 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 
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This is for drawing clip angles. The clips can have any number of rows, in either or both legs, 

be drawn at any angle, and with or without dimensions. They will be drawn to the scale set by 

the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command.  

 

CONE 

Pulldown: AutoSD > Detail > Cone 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This is for drawing the top view, section view and 

layout of a right or oblique cone. Enter zero for input 

“D” for a right cone. There can be 1, 2 or 4 segments. 

Segments are the number of pieces used to make one 

cone. Increments are the number of flats for one 

segment. The perimeter of the layout will be drawn with a closed polyline so it can be used to 

make a CNC file only if you have AutoCAD 2010 or later. If you have an older version of 

AutoCAD you can use the PLINE command and trace over the perimeter lines, snapping to each 

end point. Erase to original lines and put the new polyline on the layer of the old line. 

 

CRANE RAIL 

Pulldown: AutoSD > Draw > Shapes > Next 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This is for drawing the end view of crane rails. The 

insertion point is the bottom center of the rail. These 

shapes will be drawn to the scale selected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of 

Drawing command. 

 

DISTANCE 

Pulldown: AutoSD > Tools > Distance 

Ribbon: AutoSD I > Utilities 

 

This is like AutoCAD's DISTANCE command. It returns the distance and angle between two 

points. The [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command will 

affect the lengths returned by this command. 

 

DITTO 

Pulldown: AutoSD > Draw > Ditto 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 
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This draws a "do". It is used in the shop bill as a ditto symbol. The insertion point is the top of 

the "d". The second point is the bottom of the "d". It can be placed at any rotation. 

 

DOOR FRAME 

Pulldown: AutoSD > Detail > Door 

Frame 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will detail door frames 

made from tubes, channels or bent plate. 

Anchor types are flat bar, holes in flanges 

(for channel or bent plate), or none. If you 

use a bar anchor it can be straight or bent. 

Section of jamb showing anchor can be cut and drawn or 

cut and not drawn. This is useful if you have other door 

frames on the same sheet with the same section detail. 

The clip at the bottom of the jamb is optional. Frames can 

be detailed as one piece or “knocked down” as two 

separate pieces. A reference not can be added that will be 

placed under the main mark. 

 

EL. 

Pulldown: AutoSD > EL (vert) 

Pulldown: AutoSD > EL (horiz) 

Ribbon: AutoSD I > Miscellaneous 

 

This command makes it easy to put an elevation dimension to an existing line. One command is 

for placing it vertically; the other is for placing it horizontally. 

 

Pick a horizontal line. 

Agree with the default or enter the elevation. 

Pick a point on or off of the existing line. 

If you pick off of the existing line a line will be drawn from the end of the existing line. 

If you enter an elevation the UCS will be changed. 

This program works with the Change Scale command so set it before using the EL Horz or EL 

Vert command. 

 

This command changes the UCS origin. To re-set the UCS origin type UCS at the command line 

and press enter. Type W and enter to set USC to World. The UCS will automatically be set to 

world when using a program that depends on the USC to be set to world such as the shop bill 

program. 
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EMBED FRAME 

Pulldown: AutoSD > Detail > Embed Frame 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will detail a single member or a frame 

consisting of two to eight sides. The sides may be 

angles or channels. The frame will be drawn to scale. 

Insertion is aided with the help of an outline box. If the 

selection is for a single member, pressing the minus key 

on the numeric keypad while the outline box is 

displayed will reduce the length the picture drawn. The 

default is to draw the length to scale and cannot be drawn longer. 

Anchors can be a deformed rod, FB, headed stud, hooked rod or holes. Nailer holes can be 

included with anchors. You can also have an edge bar on top of each side if the side member is 

an angle and is toed down or a channel. The program will automatically calculate the number of 

studs or holes that will fit a given length. The default for the first space is the same as the last 

space. 

Example: Overall length = 20'-0, Spacing = 1'-6 returns: 

13 SPA @ 1'-6 = 19'-6  Total remainder is 6" 

First Space 0.03 

Last space is 3" 

 

If 3" is too small for the first space, you can increase it and the number of spaces and the 

remainder will be re calculated. The first space is at the left end looking from the inside outward. 

Embed angle can have one hole by making Hole spacing and First space the same dimension 

and at the center of the angle. The length must be drawn to scale for this option. Gage GA1 and 

GA2 may be entered as a list of two numbers separated by a comma, e.g., .0208,.03 

 

EMBED PLATE 

Pulldown: AutoSD > Detail > Embed Plate 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will detail a plain plate or a plate with 

multiple rows and columns of holes or anchors on the far 

side with optional nailer holes in the corner and show the 

edge view of the plate. The scale is affected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of 

Drawing command. Insertion is aided with the help of an 

outline box. Press the minus key on the numeric keypad 

while the outline box is displayed to reduce the length the 

picture will be drawn. The default is to draw the length to scale and cannot be drawn longer. 

Anchors can be deformed rod, FB headed stud, bent rod. The program will automatically 
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calculate the number of studs that will fit a given length. The default for the first space is the 

same as the last space. You may reduce the number of vertical or horizontal spaces by one to 

increase the edge distance. 

 

EXTRACT BOLTS (All Drawings)  

Pulldown: AutoSD > Extract > All drawings > Bolts 

Ribbon: AutoSD I > Shop bill 

 

Use this command to extract the field bolts from all selected drawings in a folder. You can select 

one file or any number of files in the folder. It will create a file with a name like 

“Ext_2015_09_16_13-56-24.blt” and will be located in the “MISC files” sub folder of the 

drawing folder. The file will contain a list of bolts created with the Bolt Circle program from all 

selected drawings. 

 

EXTRACT BOLTS (Current Drawing)  

Pulldown: AutoSD > Extract > Bolts Current drawing 

Ribbon: AutoSD I > Shop bill 

 

Use this command to extract the bolts from the current drawing. The output file name is the 

drawing name with a “.blt” extension and will be located in the sub folder “MISC files” of the 

drawing folder. If you extract several drawings using the “Current drawing” option, you will 

have files with the same name as the drawings but with a “blt” extension. You can merge these 

files together into one file. Select “Merge Extracted files” from the menu and enter “B” for 

“BLT”. Change the drive and then the folder to the “MISC files” folder where the "blt" files are 

located. Select the files that you want to merge and select OK. The individual files will be deleted 

when merged and the new file will be named like “Ext_2015_09_16_13-56-24.blt”. The “*.blt” 

files can be used by the BOLT LIST program.  

 

EXTRACT SUB MARKS (All Drawings)  

Pulldown: AutoSD > Extract > All drawings > Print sub mark list 

Ribbon: AutoSD I > Shop bill 

 

Use this command to extract and print a list of all sub marks and the main mark each sub mark 

is on along with the quantity on each main mark. The file name created is Sub_marks.txt and 

will be in the “MISC files” sub folder of the drawing folder. This list can be useful when making 

gather sheets. 

 

FIND TEXT STRING 

Pulldown: AutoSD > Tools 

Ribbon: AutoSD I > Utilities 

 

This is used to find a given text string in the selected text. A “hand” pointer is placed on the text 

when a match is found. The pointer is on a layer called POINTER. 
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FLG HOLE 

Pulldown: AutoSD > Draw > Flg Hole 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This is used for putting holes in the flange of a beam or other member where the thickness of 

material is drawn as 3/4'' thick. It will put only one hole at a time. The scale is affected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

If you have configured your customer to save CNC data, you will be asked to select the tail 

dimension. If there is no tail dimension, select any line. The CNC editor will pop up for you to 

verify the gage, hole size, layer and tail dimension. Change it if needed, pick Apply and OK. 

 

HOLES 

Pulldown: AutoSD > Draw > Holes 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

If you have configured your customer to 

save CNC data, you will get the dialog 

box shown to the right. If not, you will 

get the smaller one shown below. More 

information is required for CNC data. If 

you have configured your customer to 

save CNC data but do not need it for this 

group of holes, uncheck the box "Save 

CNC data". 

 

Edge view of web holes will not have CNC data attached to them. 

 

Solid filed holes with CNC data attached will be created from a 

single polyline. Holes without CNC data attached will be made 

using several lines close together, so you can tell if you are saving 

CNC data with a hole just by looking at it. 

 

Select whether the holes are for a beam or column. If the detail is 

a beam, brace, loose angle or anything other than a column then 

you would select Beam. It must be a column for you to select the 

Column option. 

 

 Draw spacing to scale/Insertion point at last hole: 

 

You will see the prompt above if the number of rows is greater than one. If you want the spacing 

between holes to be to scale type the letter “D” and press enter. If you want the holes to be 
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evenly spaced between two points pick the second point, this also sets the rotation of the 

connection. 

 

The HOLES command can draw a round hole, a 1/2" x 3/4" rectangular, 3/4" x 3/4" square, slots 

of the size you input and a hex or square head bolt. The 1/2" x 3/4" hole is used in edge view of 

clip angle legs or webs and the 3/4" x 3/4" hole is used in edge view of flanges. The “Var Size” 

hole will draw a rectangular hole of the size entered and the thickness is set by picking the start 

point and end point. The holes will be drawn to the scale set by the [AutoSD > Modify] or 

[AutoSD I > Change] > Scale of Drawing] command. Select the options you want and the layer 

you want the objects drawn on and pick OK. 

 

HOLE SIZE 

SLOT SIZE 

Pulldown: AutoSD > Draw > Hole Size 

Pulldown: AutoSD > Draw > Slot Size w/Leader 

Pulldown: AutoSD > Draw > Slot Size wo/Leader 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

These are for labeling hole and slot sizes. There are two slot commands; one with a leader and 

one without. The insertion point for the one without the leader is the left end of the symbol. For 

the hole and slot command with leader you start with the location for the arrow. The "NEAR" 

snap is automatically activated for this selection. Pick the next point for the leader line and 

continue picking points. Press Enter after selecting the last point. If the first leader segment 

crosses any lines you will be asked if you want to select lines to omit arrowheads. If you answer 

No, arrows will be put at each intersection between the first leader segment and each line it 

crosses. If you want to select lines to omit arrowheads you should use 

"crossing" to select them in case there are two lines in the same location, (one 

on top of the other). The symbol is placed in the drawing at the end of the last 

leader segment. After entering the slot size, you are prompted for a note. 

This note is placed under the word "slot" as shown in the example to the left. To leave the note 

blank press the space bar. After the symbol is completed you are prompted for <Rotation 

angle>/Reference: for the symbol. You may pick a point or enter an angle. If this is a round hole 

and you are saving CNC data, you are prompted to "Select objects". You should select all the 

holes that this symbol references. The hole size will be associated with the holes so if you change 

the hole size the CNC data will be automatically updated. 

 

 LIBRARY MENUS 

Pulldown: AutoSD > Insert > Library Menus 

Ribbon: AutoSD I > Utilities 

 

Library menu is an icon menu that will display your blocks using icons allowing you to insert 

your block from the library by selecting the icon of the block. This gives you a visual reference 

to select from. The category SCALED will insert the block at the scale set by the [AutoSD > 

1 2 3 

4 5 6 

7 8 9 
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Modify] or [AutoSD I > Change] > Scale of Drawing command. If the block was saved in a 

drawing set up to a scale of 3/4" = 1'-0 and you are inserting it into a drawing set up to a scale 

of 1/8" = 1'-0 set the scale to 3/4" = 1'-0 to have it inserted the same. Select the icon picture and 

select OK. Enter “I” to insert or “D” to delete the block from the menu. The menu can contain 

an unlimited number of blocks. There is a "Next" button for advancing one menu at a time and 

a "Previous" button for backing up one menu at a time and a "Go To" button where you can go 

directly to the menu number you enter. 

 

 ADD TO LIBRARY 

Pulldown: AutoSD > Insert > Add to Library 

Ribbon: AutoSD I > Utilities 

 

You can add new or existing blocks to the library menu by selecting "Add to library" from the 

menu. You should be zoomed in on the objects that you want to add to the library. What shows 

on your display screen is what will be shown in the icon menu. The icons in each library are 

numbered starting with number 1 in the upper left corner and counting from left to right, top to 

bottom. There are 10 categories with an unlimited number of libraries in each category and 9 

items in each library. The categories are: Beam, Brace, Column, Erection, Ladder, 

Miscellaneous, Rail, Scaled, Stair and Views. 

 

CLEAN SLIDES 

Pulldown: AutoSD > Insert > Clean Slides 

Ribbon: AutoSD I > Utilities 

 

This program will insert the blocks of the selected category one at a time, center the block, zoom 

to the extents of the block and make another slide. This will "clean" any garbage that may have 

been in the slide from surrounding lines when it was first made. This program will change only 

the slide picture that is displayed in the icon menu and will not affect the block itself. The 

program will erase all entities in the current drawing; therefore, you should start a new drawing 

to use this program and then quit the drawing when it is finished. 

 

LEADER NOTES 

Pulldown: AutoSD > Draw > Leader notes 

Ribbon: AutoSD I > Dimension 

 

This is for adding standard notes using a leader line. The 

notes available in the list box can be added to, removed, 

edited and reset back to the original defaults. Multi-line 

notes can be created by using the "|" character to separate 

the notes as shown in the last example in the list.  

 

Add note  Select the box under Add Note: Enter the text 

for your note and pick Add. 
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Remove  Select a note and pick Remove to delete the note. 

Edit   Select a note and pick Edit. The note is now displayed in the edit box at the top. 

Make the changes in this box and pick Save to save it back to the list. It does not save the list to 

the file. You will need to pick Save a second time to save to the file. If you decide not to save 

the edited changes back to the list just pick any note in the list to cancel the edit function and 

clear the edit box. 

 

Save  Saves the changes made to the list back to note.dat. 

Default  This will replace the list with the original list from note.def. 

Sort  This will put the list in alphabetical order. 

 

LINTEL (loose)  

Pulldown: AutoSD > Detail > Lintel (loose) 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program draws a lintel with a main shipping mark.  

Options are:   One angle, 2 angles back to back with or 

without bottom plate, 2 angles toed inward with bottom 

plate and 2 plates, one vertical and one horizontal. Set 

Bearing to 0 to make bottom plate the same length as 

angles. 

 

LINTEL (shop attached)  

Pulldown: AutoSD > Detail > 

Lintel (shop attached) 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program draws a lintel and/or 

masonry anchors on an existing 

beam detail. The lintel can be on 

the top flange, bottom flange or 

both. It can be a plate or angle or 

both. Angles can be near side, far 

side or both sides. You can draw 

any combination of side view, top 

view and end view. The end view 

can be on an existing end view of a beam or you can draw the end view of the beam too. The 

top view can only be drawn if a lintel is on the top flange. If there is a plate on the bottom flange 

it can be suspended below the beam or welded directly to the flange. 
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The beam length is required only if the side 

view is drawn. The lintel and anchor 

material description will be put in the shop 

bill only if the side view is drawn. You 

enter the beam length as the length shown 

on the detail from dimension line to 

dimension line, not the cut length or work 

length. The space at left and right end is 

entered as the distance from the dimension 

line on the beam to the end of the lintel. 

Enter a negative dimension if the lintel 

extends beyond the end of the beam. 

To enter an angle size, you can pick the 

“Select Angle” button or enter the leg size 

and thickness directly in the three boxes to the right of this button. If you need to swap the 

vertical and horizontal leg sizes just pick the “Reverse Legs” button. 

Top flange anchors will be placed horizontally on one angle. If no angle is used, the anchors 

will be placed vertically on the top flange. 

Enter values in all boxes that are not disabled by picking the box and typing the value needed 

using the FT.IISS format of input. 

 

LIST FIELD BOLTS in SHOP BILL 

Pulldown: AutoSD > List Field Bolts in Shop Bill 

Ribbon: AutoSD I > Shop bill 

 

This command will total, summarize and list the summary of field bolts in the shop bill giving 

a total of each different bolt, nut and washer listed in the current drawing. 

 

MEASURE 2D LINE 

Pulldown: AutoSD > Tools > Measure 2D Line 

Ribbon: AutoSD I > Utilities 

 

This command works the same as AutoCAD’s Measure command except that the spacing is 

controlled by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

The command places point objects or blocks on a line at measured intervals using the FT.IISS 

format of input. 

 

 

MULTILINE STYLE 

Pulldown: AutoSD > Format > MultiLine Style 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Utilities 

 

Use preset or create custom MultiLines. 
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Display joints: Draw a line at each joint. 

Fill: Fills the mline with a solid color. 

Justification: Sets the location of the end points. 

Line Type: The hidden option makes all lines hidden. 

Select Scale: Sets the scale the mline will be drawn. 

MLine Scale: Applies a scale factor to the mline. 

Left end & Right end: Sets the closure style for the 

ends. 

Standard MLine: Select to draw a preset mline.  

Scaled shapes: Select a shape for a preset mline and 

select the options for the mline. Exaggerating the 

thickness will draw the flange thickness a minimum of 

¾” and all other thicknesses a minimum of ½”.  

Custom MLine: Use an existing mline by selecting it from the list or create a new mline. 

Selecting a mline from the list will populate all boxes so you can see the properties of the line. 

If you edit the boxes below “Create new MLine” you must select “Create new MLine” for those 

changes to be used. 

 

A sample mline using the options selected will be shown in the lower right corner of the Custom 

MLine section. 

 

Buttons: 

OK: will close the dialog box, create a new MLine and set the new MLine current. You can use 

the mline command or pick MultiLine from the AutoCAD menu to draw the line. 

Cancel: will close the dialog box and void all changes. 

Multiline: will close the dialog box, create a new MLine, set the new MLine current and start 

the mline command. After finishing you can press the enter key to open the dialog box. 

MultiPolyline: same as the Multiline button but the lines will be drawn using polylines.  

 

You can use the Tube 1” MLine and the MLine Scale to create any size pipe or tube mline. If 

you need a 1 ¾” tube, use a MLine Scale of 1.75 and the Tube 1” standard MLine. 

 

NAILER ANGLE / Channel 

Pulldown: AutoSD > Detail > Nailer Angle 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will detail an angle that is to be shipped 

loose with holes or slots in one leg. The angle length 

may be drawn to scale. Insertion is aided with the 

help of an outline box. Press the minus key on the 

numeric keypad while the outline box is displayed to 

reduce the length the picture will be drawn. The 

program will automatically calculate the number of holes that will fit a given length. The default 
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for the first space is the same as the last space. Gage may be entered as a list of two numbers 

separated by a comma, e.g., .0208,.03 

 

NAILER HOLES 

Pulldown: AutoSD > Nailer Holes 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This command will automatically draw an 

anchor or hole on a selected line and optionally 

dimension the spacing and put tail dimensions to 

each anchor or hole. If you are putting holes in 

the web of a beam you may enter the gage as a 

list, e.g., .03,.03 to put two lines of holes. The 

maximum number of gages is two. In this case 

you would select the top line. 

 

You have the option of having an odd space at 

each end. Put a check in the box for “Extra space 

at left end” and/or “Extra space at right end” and enter a value for that space.  

The length of the first and last spaces will be drawn to scale if the overall length is to scale 

otherwise, the spaces will be drawn a maximum of 12”.  

The distance left for the equally spaced holes will be divided evenly. 

 

Two different dialog boxes are used. One for CNC and another if you are not saving CNC data. 

The dialog box shown to the left is for CNC. 

 

NAILER PLATE 

Pulldown: AutoSD > Detail > Nailer Plate 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This program will detail a plate that is to be shipped loose with 

one or two lines of holes or slots. The plate length may be 

drawn to scale. Insertion is aided with the help of an outline 

box. Press the minus key on the numeric keypad while the 

outline box is displayed to reduce the length the picture will be 

drawn. The program will automatically calculate the number of 

holes that will fit a given length. The default for the first space 

is the same as the last space. 

 

OBJECT INFO 

Pulldown: AutoSD > Tools > Object Info 

Ribbon: AutoSD I > Utilities 
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This is like AutoCAD’s LIST command. If you pick a line you will be given the length, bevel, 

angle of the bevel, horizontal vector, vertical vector and layer. The [AutoSD > Modify] or 

[AutoSD I > Change] > Scale of Drawing command will affect the lengths returned by this 

command. 

 

OFFSET 

Pulldown: AutoSD > Modify > Offset 

Toolbar: Modify 

Ribbon: AutoSD I > Modify 

 

This command works the same as AutoCAD’s except that the distance is controlled by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. By changing the 

scale of the drawing with the SCALE OF DRAWING command you can use OFFSET to draw 

to different scales. This offset command uses the FT.IISS format of input. 

 

OFFSET w/Select 

(Icon has yellow background) 

Pulldown: AutoSD > Modify > Offset w/select 

Toolbar: Modify 

Ribbon: AutoSD I > Modify 

 

This command works the same as the offset command shown above except 

it uses a dialog box that allows you to select from the last 10 offset distances 

used or enter a new offset. The distance is controlled by the [AutoSD > 

Modify] or [AutoSD I > Change] > Scale of Drawing command. By changing the scale of the 

drawing with the SCALE OF DRAWING command you can use OFFSET to draw to different 

scales. This offset command uses the FT.IISS format of input. 

 

OFFSET & CHANGE LINE TYPE 

Pulldown: AutoSD > Modify > Offset & Change Linetype 

Toolbar: Modify 

Ribbon: AutoSD I > Modify 

 

This command works the same as the offset command shown above except you are prompted 

on the first pick to select a linetype that the offset line will be changed to. This is useful in 

creating the hidden lines on pipe or tubes. 

 

OSNAP 

Menu: Ctrl > Right click or Shift > Osnap Settings 

Toolbar: Object Snap 
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These are AutoCAD’s commands for object snap and pick options. To draw a line from one line 

to another line you must use object snaps. If you don't, your lines will not be exactly where you 

want them to be. Some programs use object snaps and if you cancel the program in the middle 

of it you may find yourself locked into an object snap. If this happens pick NONE to get rid of 

it.  

 

PIPE  

Pulldown: AutoSD > Draw > Pipe 

Ribbon: AutoSD I > Miscellaneous 

 

This program will convert a single polyline to a double line representation of a pipe with the 

option of drawing the inside wall. The scale is affected by the [AutoSD > Modify] or [AutoSD 

I > Change] > Scale of Drawing command. 

 

POUR STOP (Shop Attached)  

Pulldown: AutoSD > Detail > Pour Stop (shop attached) 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This draws a pour stop on top of a 

beam and/or a section view. The 

pour stop can be a bent plate, steel 

or aluminum angle, toed near side or 

far side. The aluminum option is not 

enabled unless you elect to include 

aluminum shapes in the customer 

configuration. You can draw just the 

side view, (on top of an existing 

beam), just the end view, (on top of 

an existing section or draw the 

section too) or draw both side view and end view. You can also have horizontal studs on the 

pour stop and kickers supporting the pour stop. 

 

Under "Material" select either "Bent Plate" or "Angle". If you select Bent plate you will need to 

enter the size of the vertical and horizontal legs and thickness in the edit boxes under the 

dropdown list for angles. If you select "Angle" these edit boxes will be filled in automatically 

from the angle size selected. 

If you use the [AutoSD > Modify] or 

[AutoSD I > Change] > Scale of Drawing 

command to set the scale to a larger scale the 

side view will be drawn to the scale of the 

drawing, but the end view will be drawn to 

the larger scale. 
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POUR STOP (Loose)  

Pulldown: AutoSD > Detail > Pour Stop (loose) 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

This draws a pour stop as a main member. The pour stop can be a bent 

plate, steel or aluminum angle, toed near side or far side. You can draw just the side view or 

draw both side view and end view. If it is a bent plate you can also draw the foldout view. The 

aluminum option is not enabled unless you elect to include aluminum shapes in the customer 

configuration. 

 

If a notch is required in either end in the horizontal leg, a top view 

will be drawn. You can also have horizontal studs on the vertical leg 

of the pour stop. Under "Material" select either "Bent Plate" or 

"Angle". If you select Bent plate you will need to enter the size of 

the vertical and horizontal legs and thickness in the edit boxes under 

the dropdown list for angles. If you select "Angle" these edit boxes 

will be filled in automatically from the angle size selected. 

 

If you use the [AutoSD > Modify] or [AutoSD I > Change] > Scale 

of Drawing command 

to set the scale to a 

larger scale the side 

view and end view will 

be drawn to the larger scale. 

 

Main mark: 1A2 

Are marks RIGHT and LEFT (Yes/No) <N>: Enter 

            Quantity: 1 

Shop bill information on mark 1A2 

Place shop bill text on LINE <4>: Enter 

 

RECTANGLE 

Pulldown: AutoSD > Draw > Rectangle 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This draws a rectangle using a POLYLINE with a width of 0. 

The insertion point can be any corner, the midpoint of any 

edge, the center or two opposite corners.  

 

ROTATE CROSSHAIRS 

Pulldown: AutoSD > Tools > Rotate Cross hairs 

Toolbar: Rotate Cross hairs 
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Ribbon: AutoSD I > Modify 

 

 Select option (0/45/Angle/Bevel/Control/Select) <S>: 

This allows you to quickly set the angle of the cross hairs to match the angle of a line by picking 

the line if you choose the Select option. Other options are to input the Angle, Bevel, Controls, 

(horizontal & vertical vectors), 0 or 45 degrees. 

 

ROLLED ANGLE 

Pulldown: AutoSD > Detail > Rolled Angle 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

 

This will detail an angle rolled 

to a radius. Input any two of arc 

length, angle, radius, chord & 

height. Pick the “Calculate” 

button to find the other values. 

The angle may be toed toward 

or away from center. If embed 

anchors are included they may 

be on either side of the angle. If 

anchor type is not a hole, nailer 

holes may be included. 

An outline box is used for 

placement of the main detail. If 

“Draw Section” is checked, an 

outline box is used for 

placement of the section and the section will be drawn at a scale of 1 ½” = 1’-0, assuming you 

are drawing at 1” = 1’-0. No CNC data will be saved with rolled angles. 

 

ROOF FRAMES 

Pulldown: AutoSD > Detail > Roof frames 

Toolbar: Detail 

Ribbon: AutoSD II > Detail 

 

There are eleven different types of frames available as shown to 

the right. All frames can be drawn using angles or channels. The 

frames with vertical struts can be detailed with one or more 

vertical members. Enter 0 for the location of each vertical 

member that is not required. Frames 1, 4, 6, 7, 8 and 9 may have 

holes in the top leg of the frame. The frames must have four 

members present to enable the holes option. You enter the hole 

spacing and the hole will be centered between the members on 
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each side. Check the “Save file” option in the roof frame input dialog box to save your input to 

a file. This file can be opened by the roof frame input dialog box. The frame type saved in the 

file being opened does not have to be the same type currently being viewed. 

 

SCALE SHAPE 

Pulldown: AutoSD > Draw > Shapes 

Toolbar: Miscellaneous 

Ribbon: AutoSD II > Miscellaneous l 

 

This is for drawing shapes to exact scale. The shapes 

available are "C", "HP", "M", "MC" "S", "W", “L”, “PS”, 

“TS” and “CF”. “CF” is for Cold Formed shapes made from 

light gage metal. Flanges that slope will be drawn at 9o. 

These shapes will be drawn to the scale selected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of 

Drawing command. A dialog box is used to select the shape. 

Just pick the type of member and size and then pick the OK 

button.  

 

The three views that can be drawn are TOP VIEW, 

ENDVIEW and WEBVIEW. 

The insertion point for each view is as follows: 

END VIEW: At the top on the center line or at the middle 

of the web on the center line. 

TOP VIEW: Each end on the center line.  

WEB VIEW: Each end at the top 

 

SHAPES 

Pulldown: AutoSD > Draw > Shapes 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This menu is for drawing the end view, side view and top view of 

various shapes. This will draw the shapes with a flange and web 

thickness that will look attractive when plotted. The flange will be 3/4'' 

thick and the web and angles will be 1/2'' thick at a scale of 1"=1'. ZEE 

and CEE shapes are drawn 1/4” thick. Scaled Shapes will draw various shapes to exact scale and 

thickness. 

ZEE and CEE sizes are listed by depth x width x thickness. 

 

WSHAPE.DWG: 

 

Drawing “Wshape.dwg”, located in your C:\autosd\sec folder, is a special dynamic block. Once 

inserted it may be changed to represent any size “W” shape. You must be using AutoCAD 2010 
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or later to use this block. The insertion point is the mid-point of the top flange. To change the 

size, select the block and click on the triangle at the insertion point and select the depth and 

weight. 

 

SCHEDULE MAKER 

Pulldown: AutoSD > Draw > Schedule Maker 

Ribbon: AutoSD I > Utilities 

 

This is for creating, drawing and adding text to a 

schedule. Select the File name from the list and 

then pick the operation. 

 

New: This will add a new schedule file to the list and open it for editing. 

Copy: This will copy an existing schedule file and open it for editing. 

Delete: This will delete the selected schedule file. 

Edit: This will open the selected schedule file for editing. 

Colors: Pick the color swath to change the color. 

Draw: This will draw the selected schedule and prompt for text to be placed on the first line. 

Add Rows: This is for adding rows to an existing schedule. 

Add Text: This is for adding text to an existing schedule. 

 

The dialog box shown to the right is for editing a 

schedule file. Enter a file name and the title that 

will be placed at the top of the schedule. You can 

have up to 10 columns with column 1 on the left 

side. Enter the text you want for the heading of each 

column. Multi-line headings can be created by 

using the "|" character to separate the headings. 

Enter the width of the column, select the 

justification for the text and pick if the input is for 

text or a dimension. 

 

When selecting the insertion point for the schedule, 

an image of the outline of the schedule will be drawn to allow for easy placement. Press the “+” 

key to make the schedule taller. Press the “-“ key to reduce the height of the schedule. After the 

schedule is drawn you are prompted for the text for the first column. An “X” is drawn at the 

insertion point of the text. After the text is entered it is 

placed in the column and the “X” moves to the insertion 

point of the text for the next column and you are prompted 

for the text. After the last column is entered the “X” 

moves to the intersection of the next line down and the 

left border of the schedule. You are given the options to 

Continue, Skip or eXit. The default is to continue. Pressing Enter moves the “X” to the insertion 

point of the text in the first column and you are prompted for the text. If you choose to Skip, the 
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“X” will move down one line and the options to Continue, Skip or eXit will be repeated. Entering 

X at this prompt will exit the program. 

 

STANDARD MTEXT 

Pulldown: AutoSD > Draw > Standard Mtext 

Toolbars: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This program will open a dialog box and give you three text sizes to choose from, 1/8”, 3/16” 

and ¼”. Pick the button for the size you want and pick OK. Select two corners and a dialog box 

for the mtext opens. You enter your text here as well as set the color. 

  

TAIL 

Pulldown: AutoSD > Draw > Tail to Here 

Ribbon: AutoSD I > Miscellaneous 

 

 

This places a block to indicate where dimensions are referenced from. You set which block you 

want to use in the customer configuration and the text that you want to use if you select the block 

with text. The block can be a target that looks like the picture to the left or text on an arrow.  

 

TAIL or TAIL DIM 

Pulldown: AutoSD > Dimension > Tail Dim 

Toolbars: Dimension I 

Ribbon: AutoSD I > Dimension 

 

This Places a tail, or stub dimension with a line under it. If you use “Select Dim to Add” under 

AutoSD > Calculator, the default dimension will be the result. Input is in the FT.IISS format. 

 

TEXT STRINGS 

Pulldown: AutoSD > Draw > Text Strings 

Ribbon: Not included 

 

These are for placing common notes in response to a text prompt issued by another program. 

Most of these are for the description of material for the shop bill such as pipe and grating. They 

will not work when using the text command. 

 

TURNBUCKLE 

Pulldown: AutoSD > Draw > Turnbuckle 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 
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This will draw the side view of a turnbuckle. The insertion point is 

the center of the turnbuckle. The rotation is the angle from the 

insertion point to the center of the threaded end. The scale is 

affected by the [AutoSD > Modify] or [AutoSD I > Change] > 

Scale of Drawing command. 

 

WEB HOLE 

Pulldown: AutoSD > Draw > Web Hole 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Miscellaneous 

 

This is used for putting holes in the web of a beam or other member where the thickness of 

material is drawn as 1/2'' thick. It will put only one hole at a time. The scale is affected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

WELD SYMBOLS 

Pulldown: AutoSD > Draw > Weld Menu 

Toolbar: Miscellaneous 

Ribbon: AutoSD I > Weld 

 

This program is for creating and placing weld 

symbols. This command uses a dialog box to select 

the weld symbols. The weld types include Fillet, 

Bevel, Bevel + Fillet, Bevel Flare, J, J + Fillet, 

Square, Square + Fillet, U, V, V-Butt w/Insert, V-

Flare, V-T w/Insert, Plug or Slot, Seam, Spot or 

Projection, Stud and Surfacing. Select a weld type 

by clicking on the down arrow next to Type, then 

click on the weld type desired. The weld symbol displayed in the window will be updated 

automatically. 

 

The properties available for each weld type vary. For example, Back, Consumable Insert and 

Joint w/Backing are only available when one of the grove welds is selected. Staggered is only 

available when Fillet is selected for arrow side and other side. You can place a complete weld 

symbol or add a leader, all around symbol, field weld symbol, or tail note to an existing weld 

symbol. Use the stretch command if you need to move a weld symbol after drawing it. Place the 

window around the entire symbol, only enclosing the ends of the leaders where the attach to the 

symbol, and move the symbol. The leaders will stretch and the arrows will rotate to match the 

leader lines. 

 

BLOCKS  

Pulldown: AutoSD > Draw > Weld Blocks  

Toolbar: Miscellaneous 
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Ribbon: AutoSD I > Weld  

 

This allows you to place a simple weld block quickly or add 

an all-around, field weld or tail note to an existing weld 

symbol. You can add one of these blocks to an existing symbol 

by picking the "SYMBOL ONLY" icon from the second page 

of blocks and then select the block. This prevents the leader 

from being drawn again and will insert only the block. The 

insertion point is the left end of the block. "ENDPOINT" snap 

is automatically selected. 

 

LEADER ONLY  

This draws only the leader. It is useful for adding more leaders to an existing weld symbol. Pick 

the location for the arrow. The "NEAR" snap is automatically activated for this selection. Pick 

the next point for the leader line and continue picking points as needed. The last point should be 

one end of the weld symbol. Press enter, and you are then prompted for additional leader lines. 

Press enter for none. If you select to put additional leaders the near snap is activated, and you 

pick where the leader arrow starts. Press enter, and a line is drawn from the last pick point to the 

weld symbol. Press enter again to exit drawing leader lines. 

 

SYMBOL ONLY  

This draws the symbol shown in the dialog box without adding a leader. 

 

CLEAR  

Selecting the Clear button will clear all selections and labels. 

 

SAVE/RESTORE  

This button opens another dialog box that allows you to save, delete 

or restore a weld symbol. The symbol in the main dialog window is 

shown in a window in this box. Click on the box to the right of 

Description to save this symbol. Type in a name for the symbol, press 

enter and click the Save button. The name will be displayed in the 

Select Symbol list box and the configuration will be saved in the file 

weldsym.cfg. You can use any characters in the name and the name 

can be any length. If you have some names in the list box you can restore one of these by 

selecting it from the list box. The window is updated to display the selected symbol. Pick the 

Restore button and you are returned to the main dialog box and the weld symbol settings will be 

set to those defined by the configuration you restored. 

 

SETTINGS  

This button opens another dialog box that allows you to change the layer the symbol is drawn 

on, the block used for the arrow head, (for AutoCAD 2007 and older use ASD_WARO from 
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your C:\autosd\welds folder), the style used for the text, the 

colors used for the lines and text, the size of the text, the scale 

factor for the symbol, whether to use multiple leaders or not, 

whether to draw the leader in two segments or not when drawn 

by another program and whether to rotate the symbol or not. The 

settings are saved to the file weld.cfg located in your autosd 

folder. If you choose the option to draw the leader in two 

segments when drawn by other programs you will be able to 

select the mid-point of the leader line and move it, bending the 

leader. The arrow will rotate to follow the line. This feature is 

available in BricsCAD and AutoCAD 2008 and later only. 

 

HATCH 

AutoCAD command. Pulldown: Draw > Hatch 

 

There are three custom hatch patterns installed with AutoSD. They are in your autosd\Support 

folder. The names of the pattern files are checkpl.pat, mesh.pat and wire.pat. A sample of each  

is shown below. 

 

 

 

 

 

 

Checkpl.pat    Mesh.pat    Wire.pat 

 

You can use these with the bhatch command. Type Bhatch. Change the Type to Custom and 

click on the Swatch box select the pattern from the Custom pattern box.  

 

JOIST FORMS 

Forms for Valley Joist can be downloaded from this web site. 

http://www.valleyjoist.com/downloads/valleyjoisteast 

 

The following form drawings are in your C:\autosd\bonus folder. The drawings are 8 1/2" x 11". 

The dash marks in each field can be changed using the Replace Text command to automatically 

position the text when filling out the form. 

http://www.valleyjoist.com/downloads/valleyjoisteast
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 SMI JOSMI.DWG   SOCAR JOIST.DWG 

 

 

 

 

 

 

 

 

 

 

 

CANAM JOIST.DWG   TEX-ARK JOIST.DWG 

 

 

 

 

 

 

 

 

 

 

 

 

 

VULCRAFT GIRDER.DWG  VULCRAFT LONG SPAN.DWG 
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VULCRAFT SHORT SPAN.DWG 

 

 

 

 

 

         NUCHOR TOP CHORD HOLES.dwg 
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Chapter 4 - Edit 
 

ADJUST DIMENSION 

Pulldown: AutoSD > Modify > Adjust Dimension 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

This command will change a dimension by the amount entered. All dimensions selected will be 

changed, either increased or decreased. Select one or multiple dimensions and then enter the 

amount to add using a positive or subtract using a negative. If the dimension is a “tail” dimension 

associated with the CNC data for a hole then the CNC data will be changed. It takes a number 

for input in the FT.IISS format. 

  

ARRAY 

Pulldown: AutoSD > Modify > Array 

Toolbar: Modify 

Ribbon: AutoSD I > Modify 

 

The array command is like the standard 

AutoCAD array command. The exceptions 

are you can enter the row and column offsets 

in FT.IISS, IIII.SS, DECIMAL, FT-II*SS  or 

FT’-II S/S format and these offsets are 

affected by the [AutoSD > Modify] or 

[AutoSD I > Change] > Scale of Drawing 

command. 

The PREVIEW button allows you to see the result before you make it final. 

 

ARROWHEADS TO TICKS 

Pulldown: AutoSD > Modify 

Ribbon: AutoSD I > Change 

 

This command will change all selected arrowheads to ticks.  

 

BREAK LINE TYPE 

Pulldown: AutoSD > Modify > Break > Break Line Type 

Toolbar: Modify 

Ribbon: AutoSD I > Modify 

 

This will break a line at two selected points and then change the segment that was picked first 

to the line type selected from a dialog box. It is normally used to break a continuous line to make 
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part of it hidden. Select the line where the hidden segment will be, then picked a point on each 

side of the selection point. Select HID or HIDDEN from the dialog box.  

 

CHANGE TEXT 

Pulldown: AutoSD > Modify > Change Text 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

Change text is used to change part of a word or number by typing in the old string, the part you 

want to change, and then typing in the new string, what you want to change it to. 

For example: To change "THIS BROWN COW" to "THIS BLACK COW" pick change text 

from tablet.  

Command: 

Select objects: 1 selected, 1 found. 

Select objects: Enter 

Old string: ROWN 

New string: LACK  

Changed 1 text lines. 

Command:  

Change Text command will change more than one string of text at a time. For example, if you 

are using the sheet number as part of the piece marks you can change as many as you can pick 

by typing in the old number and then the new number. Change Text also works on attributes like 

the main piece mark and bolt description but must be used with caution. It will change ALL 

attributes in a block where a match is found. If the text is a “tail” dimension associated with the 

CNC data for a hole then the CNC data will be changed. 

  

CHANGE TO PLINE 

Pulldown: AutoSD > Modify > Change to Pline 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

This command will change lines to polylines. It will also join lines and polylines together to 

form one continuous polyline. Polylines are used in hatching and for calculating area. After 

picking the first line the remaining lines may be picked one at a time or with window or crossing. 

 

CHANGE TEXT TO MULTILEADER 

Pulldown: AutoSD > Modify > Change text to Multileader 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

For AutoCAD 2010 and later. Select text that you want to change to multileader text. It will also 

prompt for multiple leaders or press enter after the first leader to stop the routine. If you are 
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converting a leader to a multileader, the existing leader will need to be deleted because it does 

not convert. 

You should run AutoSD > Format > Setup before you use this command. If you don’t, the text 

and arrow size will not match the text being changed to multileader. Once you run Setup, a 

multileader style called AutoSD_MStyle is created for use with AutoSD. 

This command is a flyout on the Change toolbar. The other two commands on the flyout are 

AutoCAD commands to add and remove leaders from a multileader and are included in the 

flyout for convenience. 

 

COLOR 

Pulldown: AutoSD > Modify > Color 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

This will change the color of the objects selected to the color selected and change the line weight 

to that of the new color if Line weights are enabled for the customer colors. 

 

COLOR w/FILTER 

Pulldown: AutoSD > Modify > Color > Color w/filter 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

This will change the color of lines or text of one color to the color selected. 

 

COPY AND ROTATE 

Pulldown: AutoSD > Modify > Copy and Rotate 

Ribbon: AutoSD I > Modify 

 

Copies objects and rotates the copy about a selected point. 

 

DDCOPY 

Pulldown: AutoSD > Modify > DDcopy 

Ribbon: AutoSD I > Modify 

 

Copies objects from other layers to the current layer. It will not copy objects on the current layer. 

 

DATABASE EDITOR 

Pulldown: AutoSD > Modify > AISC database 

Ribbon: AutoSD I > Modify 

 

This program will allow you to edit all information in the AutoSD AISC database of US shapes. 

The example to the left shows the dialog box for editing “W” shapes but all dialog boxes work 
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the same. First, select the type of shape then the size that you want to 

edit. This is selected from a dropdown list. The metric equivalent is 

given in an edit box below the dropdown list. Click on any edit box and 

make your change. All dimensional input is in decimal inches. After all 

editing is finished pick OK to save the changes back to the file. Picking 

Cancel will cause you to lose all changes for that shape type. 

Save: This will save changes to the current size. Selecting a different 

size will also save any changes to the current size. 

Save as: This will save the current size to a new size. All changes made 

before picking “Save as” will be saved to the new size and not the 

current size. 

Delete: This will delete the current size from the database. If it exists 

in the original data base it can be retrieved otherwise it cannot. 

If you are upgrading from an older version, your changes to the 

database will not be overwritten when you install the new version of AutoSD. The New version 

will install the database files in your C:\autosd\data\backup folder. The database files that you 

edit are saved in your C:\autosd\data folder. If any new shapes are added to the database on the 

installation CD, they will be listed in a dialog box that will allow you to add them to your 

database files when you use the AISC database editor for the first time. The editor only works 

on US shapes. It will not edit the data base files for shapes from other countries. 

 

DIMENSION SIZE 

Pulldown: AutoSD > Modify > Dimension Size 

Toolbar: Modify 

Ribbon: AutoSD II > Modify 

 

This function is for working in Model space by changing the size of dimension text and arrows 

for a specific scale that will be shown in a viewport in paper space. Select the scale from a dialog 

box. This is useful when you draw in model space and use paper space for plotting. All details 

in model space are drawn at the scale of the drawing and paper space is used to present details 

at different scales. Use the Dimension size command before dimensioning the details in model 

space so the text size will be consistent when you scale the viewport in paper space. 

 

EDIT ATTRIBUTE 

Pulldown: AutoSD > Modify > Attribute 

Ribbon: AutoSD I > Modify 

 

These commands are for editing attributes. Some places you will find attributes are in the title 

block and in section symbols. 

 

LINE TYPE 

Pulldown: AutoSD > Modify > Line Types 

Toolbar: Change 

Ribbon: AutoSD I > Change 
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These 8 commands will change the line type of the lines picked to the type selected. The line 

types are continuous, dashed, hidden, center, phantom, dot, dashdot and border. 

 

LINE WEIGHT 

Pulldown: AutoSD > Modify > Line weights 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

This command will change the line weight of the line or text or both. The selection can be filtered 

by color or all selected can be changed. The line weights will be changed to the weights stored 

in your customer configuration for colors.  

 

RESET DWG SCALE 

Pulldown: AutoSD > Modify > Reset DWG Scale 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

This command will reset the scale of the drawing back to the original scale and will place the 

scale in the left end of the status bar. 

 

REPLACE DIMENSION 

Pulldown: AutoSD > Modify > Replace Dimension 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

This command will replace a dimension or a string of text with a dimension. It takes a number 

for input in the FT.IISS format or two points.  

Command:         Pick Replace dimension  

Select objects: 1 selected, 1 found    Pick text 

Select objects: Enter 

(FT.IISS) Spacing/Pick/Dimension: 10.0312   10'-3 3/4 

Command:         Dimension is changed to 10'-3 3/4. 

Enter “S” to enter number of spaces and length of space. 

(FT.IISS) Spacing/Pick/Dimension: S 

   SPA @ ___ = 

Enter number of spaces: 2 

(FT.IISS) Length of each space: .03   Result is “2 SPA @ 3 = 6” 

Enter “P” to enter distance by picking two points. 

(FT.IISS) Spacing/Pick/Dimension: P 

Pick first point 

Pick second point   Result is the scaled distance between the two points. 
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Using the “P” option the distance picked is affected by the [AutoSD > Modify] or [AutoSD I > 

Change] > Scale of Drawing command. 

 

Dimensions can be put on the drawing more easily with AutoSD > Dimension > DIM. TEXT 

than with the TEXT or DTEXT command. It works like the text commands except the input is 

FT.IISS only. If the dimension is a “tail” dimension associated with the CNC data for a hole 

then the CNC data will be changed. 

 

REPLACE TEXT 

Pulldown: AutoSD > Modify > Replace Text 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

Replace text is like change text except that you are asked only for the new text and all of the old 

text that was picked is replaced with the new text. If the text is a “tail” dimension associated 

with the CNC data for a hole then the CNC data will be changed. 

 

RELOCATE TEXT 

Pulldown: AutoSD > Modify > Relocate Text 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

Relocate text is for moving dimensions that have been mirrored and need to be moved back to 

the other side of the dimension line. Multiple selections are possible using window or crossing 

or select one at a time. 

 

SCALE OF DRAWING 

Pulldown: AutoSD > Modify > Scale of Drawing 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

The Scale of Drawing command will enable you to draw to a different scale in the same drawing. 

After picking Scale of Drawing you are asked to "Select the scale from the dialog box: ''. 

Selecting a scale will change the drawing to the scale selected. The scale that you select will 

appear in the left end of the status bar. 

Commands affected by the Scale of Drawing command are "Distance", "Object info", dimension 

commands and "Offset". This will enable you to draw to different scales in the same drawing 

when using the OFFSET command. 

 

SCALE OF OBJECTS 

Pulldown: AutoSD > Modify > Scale of Objects 

Toolbar: Change 

Ribbon: AutoSD I > Change 
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This is for changing objects from one scale to another. This command 

can be useful if you draw or insert a section to one scale and decide 

that it needs to be bigger or smaller. If the check boxes for text and 

arrows are left unchecked, the size of text and arrows will remain 

unchanged after scaling. This function also works in Paper space by 

changing the zoom scale of the selected viewport. 

  

SCALE OF BLOCKS/SOLIDS/TEXT 

Pulldown: AutoSD > Modify > Scale of Blocks/Solids/Text 

Toolbar: Change 

Ribbon: AutoSD I > Change 

 

This command is like the Scale of Drawing command except the base 

point is the insertion point of the solid, block or text. When you pick this command, you are 

prompted for "Which items to scale (All/BLocks/Solids/Text)". Type the letter of the choice 

shown by the capitol letter and then select the objects. Arrow heads and ticks are solids. You are 

then asked to input a scale factor. If you enter 2, the items picked will be made twice as big and 

will be scaled out from their individual insertion points. 

 

VIEWPORT SCALE 

Pulldown: AutoSD > Modify > Viewport Scale 

Toolbar: Modify 

Ribbon: AutoSD II > Modify 

 

This function works in paper space by changing the zoom scale of the selected viewport. Select 

the scale from a dialog box and then select the viewports to be scaled. This is useful when you 

draw in model space and use paper space for plotting. All details in model space are drawn at 

the scale of the drawing and paper space is used to present details at different scales. Use the 

Dimension size command before dimensioning the details in model space so the text size will 

be consistent when you scale the viewport in paper space.  

 

LAYERS 

 

CHANGE OBJECT'S LAYER 

Pulldown: AutoSD > Format > Change Object’s Layer 

Ribbon: AutoSD I > Utilities 

 

This will change all objects to the current layer. 

 

FREEZE LAYER 

Pulldown: AutoSD > Format > Freeze Layer 
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Ribbon: AutoSD I > Utilities 

 

This will freeze all layers that belong to the objects you pick. 

 

ISOLATE LAYER 

Pulldown: AutoSD > Format > Isolate Layer 

Ribbon: AutoSD I > Utilities 

 

This will freeze all layers except the ones that belong to the objects you pick. 

 

SET LAYER 

Pulldown: AutoSD > Format > Set Layer 

Ribbon: AutoSD I > Utilities 

 

This will set the current layer to that of the object you pick. 

 

THAW ALL LAYERS 

Pulldown: AutoSD > Format > Thaw All Layers 

Ribbon: AutoSD I > Utilities 

 

This will thaw all layers 

 

UNKNOWN DIMENSION 

Pulldown: AutoSD > Modify 

Ribbon: AutoSD I > Change 

 

This will change all dimensions selected to the text of your choice. The default text is ??’-? It is 

useful when a detail needs dimensions to be furnished by the contractor, architect or engineer. 
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Chapter 5 - Decimal & FT.IISS Calculators 
 

There are several different programs of each type of calculator. The only difference between the 

two types is the type of input. The decimal calculator requires decimal numbers for input and 

the output will be in decimals. The FT.IISS calculator requires that numbers be input in the 

FT.IISS, FT’-II S/S, FT.II*SS or II.SS format. 

 

ARCS 

Pulldown: AutoSD > Calculator > Arcs 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

The arc program is for calculating the height, (mid ordinate), 

arc length, angle, chord, radius and the rise from the chord to 

the arc at any distance from one end of a circular segment. 

Select the two values to enter from the list on the right side. 

Select the Input Unit type. Enter the two values in the format 

of the unit type and pick Calc. The answers are given in the 

lower right of the dialog box. If you want a written record in 

your drawing, pick “Print results to screen” and pick a point. 

 

Arc Length 12’-0 

Angle:  44.9999 Chord:  11'-8 5/16" 

Height:  1’-1 15/16" Radius: 15'-3 5/16" 

 

Pick OK to close the program. The next time the program is opened the previous input and 

answers are given. 

 

CALC 

Pulldown: AutoSD > Calculator > Calc > Decimal  

Pulldown: AutoSD > Calculator > Calc > FT.IISS 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

This is a calculator. It's basic functions are add, subtract, multiply, and divide. It uses the RPN, 

(reverse polish notation), method. You type in a number, press enter, type in another number 

and then press the function key, either +, -, * or /. To continue adding a chain of dimensions type 

in the next number and press the function key.  

Command:  Pick [AutoSD > Calculator] or [AutoSD I > Miscellaneous] > FT.IISS > Calc 

FT.IISS CALCULATOR Press SPACE bar or Esc to exit 

10.0208 Enter 

5.0304 +   RESULT 10.0208 + 5.0304 = 15.0512 
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15.0512 

6.03 Enter 

20.11 +   RESULT 6.0300 + 20.1100 = 27.0200 

27.0200 

6 +    RESULT 6.0300 + 20.1100 = 27.0200 

27.0200 x 6.0000 = 163.0000 

163.0000 

5 +    RESULT 163.0000 + 5.0000 = 168.0000 

168.0000   Press SPACE bar to exit 

Command:  

For those of you not accustomed to the RPN style and would prefer the standard entry format 

there is another version of the calculator in the BONUS folder. The file name is CALC.LSP. If 

you like a calculator that works the same way you would write a math problem out by hand (If 

you want to add 2+2, you type in 2+2 Enter) you can copy this file to your AUTOSD folder 

using Windows Explorer. 

 

Other functions of the calculator include 1/X, CHS, X<>Y, SQUARE ROOT and EXPONENT 

 

• 1/X 

This is the reciprocal of x. To take the reciprocal simply press the X key, either upper or lower 

case. 

 

• CHS 

This is the change sign function. Press the letter C to change signs. 

 

• X<>Y 

This function swaps "X" with "Y". Press the “<” or “,” key. X<>Y will swap two numbers on 

the screen. If only one number is on the screen then the number on display will be swapped with 

the number in the "X" register. 

 

The CALC calculator (RPN type only) has three "stack" registers called "X", "Y" and "Z" and a 

fourth register which is the display. Stack registers enable you to solve complex equations 

without actually rewriting them. For example, to solve the equation (5 + 3) + (6 x 2) - (15 - 1), 

use the following keystrokes: 

 

5 Enter 3 + 6 Enter 2 * 15 Enter 1 - - + 

 

"5 Enter 3 +" results in 8 in the display. 

"6 Enter 2 *" results in 12 in the display and 8 in the "X" register. 

"15 Enter 1 -" results in 14 in the display, 12 in the "X" register, 8 in the "Y" register and 8 in 

the "Z" register. 

 

"-" subtracts the display (14) from the "X" register (12) resulting in -2 and moves the number in 

the "Y" register (8) down to the "X" register. 
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"+" repeats the same process. It adds the display (-2) to the "X" register (8) resulting in the final 

answer of 6. 

 

The same equation could have been input using only two storage register as: 

 

5 Enter 3 + 6 Enter 2 * + 15 Enter 1 - - 

 

Every time you press Enter you move the numbers up one register and when you press +, -, * or 

/ you move the numbers down one register. 

 

 

• SQUARE ROOT 

To take the square root of a number, press the letter N (upper or lower case). The square root 

functions will only work in the decimal calculator. 

 

• EXPONENT 

To raise a number to a power, type the exponent and then press the letter M (upper or lower 

case). For example, to solve for 6 raised to the power of 3 follow these key strokes: 6 Enter 3 

M. The exponent function only works in the decimal calculator. 

 

You can switch over to the "RIGHT TRIANGLES" program while you are in the calculator by 

pressing the letter S (upper or lower case). After getting your information,  it will switch back 

to where you left off in the calculator. 

 

CAMBER 

Pulldown: AutoSD > Camber 

Ribbon: AutoSD I > Utilities 

 

The CAMBER program is used to find the camber in a beam or truss at any given point and for 

drawing a camber diagram. After picking CAMBER you are prompted to enter the truss span, 

(or beam length). A slide drawing is displayed for your reference. After entering the truss span 

you are prompted to enter the amount of camber at mid span. Next, the program asks for the 

"Number of panel points from end to center (including end)" and then the "Distance from end 

to first panel point:" Enter the number of panel points and then the distance from the end to the 

first point where you want the camber given. The answer will be given in the FT.IISS format 

and you will be prompted for the distance to the next panel point. This distance should be input 

as the distance from the previous point to the new point (length of panel of truss). Continue 

entering the panel spaces until all points are given.  

Command: 

(FT.IISS) Truss span: 100 

(FT.IISS) Camber at mid span: .0204 

Number of panel points from end to center (including end): 6 

(FT.IISS) Distance from end to first panel point: 10 

Length = 100.0000,       A = 0.0013 
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(FT.IISS) Distance to next panel point <10'-0">: Enter 

B = 0.0107 

(FT.IISS) Distance to next panel point <10'-0">: Enter 

C = 0.0114 

(FT.IISS) Distance to next panel point <10'-0">: Enter 

D = 0.0203 

(FT.IISS) Distance to next panel point <10'-0">: Enter 

E = 0.0204 

Do you want a camber diagram (Y/N) <Y>:  Enter 

Pick point for left end: 

Enter Shipping Mark associated with this camber diagram. 1B1 

 

 

 

DECIMAL TO FEET   FEET TO DECIMAL 

Pulldown: AutoSD > Calculator > Dec to Ft 

Pulldown: AutoSD > Calculator > Ft to Dec > FT.IISS 

Pulldown: AutoSD > Calculator > Ft to Dec > FT-II S/S 

Pulldown: AutoSD > Calculator > Ft to Dec > FT-II*SS 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

These two programs are conversion programs. The first one converts decimals of a foot to the 

Architectural format while the second one converts from FT.IISS, FT-II S/S or FT-II*SS format 

to decimals of a foot. 

 

EXTEND WEIGHT 

Pulldown: AutoSD > Calculator > Extend Weight (All) 

Pulldown: AutoSD > Calculator > Extend Weight (One line) 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

This command will calculate the weight of an item in the shop bill just by picking the text, (or 

attribute), for the quantity, description, feet and inches. If you have the shop bill configured with 

the location of inches as 0 where the length is written as a single text item you will be asked to 

select the length instead of feet and inches. 

 

If you do not have a configuration selected for the shop bill and this is the first time you use this 

program in the current drawing session you will be asked to pick a point for the right side of the 
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weight column. Pick any point where the vertical cross hairs of the cursor will be the right end 

of the text for the weight. If you need to change this point choose the "Locate Weight Column” 

command from the menu. The weight will be written on the same line as the description. 

 

See chapter 10 for information on valid material descriptions. 

 

LOCATE WEIGHT COLUMN 

Pulldown: AutoSD > Calculator > Locate Weight Column 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

This command will change the location of the weight column by picking a point. The location 

is not saved. It is valid only during the current drawing secession. Useful if you do not have the 

shop bill configured to extend weights but you want to extend some weights afterwards. 

 

HANGER 

Pulldown: AutoSD > Hanger 

Ribbon: AutoSD I > Utilities 

 

The hanger program is for calculating the thickness of a connection angle or end plate when the 

connection has a tension and or shear load.  

Command:      Pick [AutoSD or AutoSD I] > Utilities > Hanger 

 

Make the selections for bolt type, if threads are included in shear 

plane (N) or excluded (X), connection type, grade of steel used for 

the connection material and design method. 

 

Enter values in each edit box for your specific connection. If there 

is no shear load you can enter a value of 0 or leave the box blank. 

All other boxes must have a value. 

 

After entering all values pick the calculate button. 

If prying action is exceeded a dialog box pops up to select how to 

modify the output. 

 

 

Option 1 will keep the thickness the same and increase the number of bolts. 

Option 2 will keep the number of bolts and increase the thickness. 

Option 3 will keep the length and increase the number of bolts and thickness. 

 

Picking the calculate button again will recalculate and let you choose another 

option if prying action is exceeded. 
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LOADS 

Pulldown: AutoSD > Loads 

Ribbon: AutoSD I > Utilities 

 

This command is for getting the loads on a member. You input the member shape, size, un-

braced length, percent of uniform load and grade of steel and you will be given the load in 

compression, the load in tension, maximum web shear and end reaction in kips and area of 

member. If you are looking for the end reaction you must give the length from center of support 

to center of support as the un-braced length. 

If you put a check in the box for Conventional single-plate connection, it will develop a 

connection using the tables from the AISC 13th edition manual. The shear bolt value has no 

affect in determining the number of bolts in this case. 

 

OBLIQUE TRIANGLES 

Pulldown: AutoSD > Calculator > Oblique Triangles 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

The oblique triangle program will solve any triangle given 

one side and two angles, two sides and one angle or three 

sides. It uses icon menus and slides for user information. 

Select the Units. Changing the units will change the format 

of the input and results. Select the Option, either 1 Side 2 

Angles, 2 Sides 1 Angle or 3 Sides. Under Sides, select which 

side you want to enter by putting a check in the box and 

uncheck the others.  Do the same for Angles. Enter values for the options selected and pick Calc. 

If you want to save the results in your drawing, pick “Print results to screen” and pick an 

insertion point for the text. Press Enter to run the program again. 

 

RIGHT TRIANGLES 

Pulldown: AutoSD > Calculator > Right Triangles > Decimal input 

Pulldown: AutoSD > Calculator > Right Triangles > FT.IISS input 

Pulldown: AutoSD > Calculator > Right Triangles > FT-II S/S input  

Pulldown: AutoSD > Calculator > Right Triangles > FT-II*SS input  

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

This program is used to solve right triangles. The input can be either one side and the acute angle 

or two sides. To input two sides you must input the angle as 0. To activate the program you may 

either pick RIGHT TRIANGLES or type the letter "S" at the keyboard and press Enter.  

Command: Pick [AutoSD > Calculator] or [AutoSD I > Miscellaneous] > FT.IISS > Right 

Triangles 

Input numbers as FT.IISS 
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Angle <33.1604>:      From previous run 

Base:  

Rise:  

Slope: 25.0510 

BASE: 21'-3 7/8"    RISE: 13'-11 3/16"   SLOPE: 25'-5 5/8 

BEVEL: 7 13/16"    ANGLE: 33.1604  

Command:  

Input numbers as FT.IISS 

Angle <33.1604>: 0 

Base:  

Rise: 13.1103 

Slope: 25.0510 

BASE: 21'-3 7/8"   RISE: 13'-11 3/16"   SLOPE: 25'-5 5/8 

BEVEL: 7 13/16"   ANGLE: 33.1638 

Command:  

You may enter a different angle at the "Angle:" prompt or use the default angle by pressing 

Enter. The BASE:, RISE:, and SLOPE: prompts will continue to toggle as long as you press 

Enter without entering a number. 

 

ROLLED PLATE LENGTH 

Pulldown: AutoSD > Calculator > Rolled Plate Length > Decimal input 

Pulldown: AutoSD > Calculator > Rolled Plate Length > FT.IISS input 

Pulldown: AutoSD > Calculator > Rolled Plate Length > FT-II S/S input  

Pulldown: AutoSD > Calculator > Rolled Plate Length > FT-II*SS input  

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

Enter the inside radius, thickness and included angle and the 

program will return the length of plate required. 

 

 

SECTIONAL PROPERTIES 

Pulldown: AutoSD > Sectional Properties 

Ribbon: AutoSD I > Utilities 

 

This is a data table program that is used for reference. It will list the dimensional properties of 

the following shapes: 

 

US -  C, MC, MT, ST, WT, TS, PS, HSS, HP, M, S, W, CF, L, Turnbuckles, Clevis, 

Sleeve Nuts 

Canada -  C, MC, WWT, MT, ST, WT, TS, HSS, DN, HP, M, S, W, WWF, WRF, CF, L 

UK -  C, BT, CT, RHS, SHS, CHS, ERW, L, J, UB, UC, UBP 

Europe -  UAP, UPN,  HSS, L, HD, HE, HL, HP, HX, IPE, IPN, IPEA, IPEO, IPER, IPEV, 

DIL, U 
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Australia -  PFC, TFC, BT, CT, RHS, CHS, WB, WC, UB, UC, TFB, EA, UA 

 

The shape files are in the “DATA” sub folder of your AutoSD folder. 

Canada, UK, Europe and Australia are available only if the drawing is setup for metric. 

 

This program uses dialog boxes for selecting shapes and displaying the dimensions. If you pick 

OK, the size shape selected will be saved and recalled the next time the program is selected from 

the menu in the current drawing session. If you pick CANCEL, the size shape that was last saved 

will be recalled the next time.  

Command:    Pick [AutoSD or AutoSD II] > Beams > Sectional Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

SELECT DIM TO ADD 

Pulldown: AutoSD > Calculator > Select Dim to Add > Decimal output 

Pulldown: AutoSD > Calculator > Select Dim to Add > Architectural output 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

This command will calculate the sum of all numbers picked. You may select the numbers one 

at a time or use crossing or window or a combination of each. If you select a non-legal text string 

or any non-text entity it will be given a value of 0 and not affect the total. 

 

Using the DECIMAL format of this program is a quick way to get a total of the weight for a 

completed assembly. You can use "window" or "crossing" to make selections. Non-text items 

selected will be filtered out. Text strings that contain letters will evaluate to 0. The total is also 

the default number the next time the CALCULATOR is used. 
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All numbers may be positive or negative and may be enclosed in parenthesis but must not 

include any letters. 

 

After selecting and adding dimensions the total is shown on the command line in the format for 

the one selected. If architectural dimensions are added using the DECIMAL format the answer 

will be in inches. If decimal dimensions are added using the architectural format the answer will 

be in architectural units. This can be used to convert a number by selecting only one number to 

add. 

 

SELECT LINE TO ADD 

Pulldown: AutoSD > Calculator > Select Line to Add > Decimal 

Pulldown: AutoSD > Calculator > Select Line to Add > Architectural 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

This command will calculate the total length of all lines and polylines picked. You may select 

the lines one at a time or use crossing or window or a combination of each. The length is affected 

by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

TOTAL WEIGHT 

Pulldown: AutoSD > Calculator > Total Weight 

Toolbar: Calculator 

Ribbon: AutoSD I > Miscellaneous 

 

This command will total all of the weights selected and write the total in the shop bill. 

 

NUMBER OF RISERS 

Pulldown: AutoSD > Calculator > Number of risers 

Ribbon: AutoSD I > Miscellaneous 

 

This command will ask for the height from floor to floor and then a riser height to try. After 

entering the riser height, you are given the number of risers, the actual rise height required and 

any gain or lose. You are again prompted for the number of risers using the previous number as 

the default. Press enter to end the command or enter a different number for a new result. 
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Chapter 6 – Dimensioning 
 

CUSTOM FONT 

When you start a new drawing a custom text style is loaded called ASD_BKAP. ASD_BKAP 

uses the backward apostrophe (`) character to make custom characters. 

  

Another style that is now obsolete and no longer supported is called ASD_FONT. ASD_FONT 

used the tilde (~) character. If you were using the ASD_FONT style you can change styles in 

your existing drawings to ASD_BKAP. When you open an existing drawing, use the program 

ASD_STYLE located in the AutoSD > Modify pulldown menu or the AutoSD I > Utilities 

ribbon menu to change the existing text in the current drawing. The fonts for the style 

ASD_FONT are still installed for backward compatibility. 

 

The following describes the style ASD_BKAP. This text style gives you custom fractions, 

symbols, superscript and subscript text. Type a backward apostrophe (`) and then the character 

to type in a custom character. For example, if you want a center line symbol type `C. A fraction 

is typed as `1 for 1/16, `4 for 1/4 etc. Listed below are the symbols and tilde character. 

1316O would be entered as `E`O 

Superscripts and subscripts are made by preceding the word or letters with a `S for superscript 

or `s for subscript. `SSUPERSCRIPT will look like SUPERSCRIPT. `sSUBSCRIPT will look 

like SUBSCRIPT.  To type 30o you would enter it as 30`So. 

 

A card is provided for your use showing the location of each symbol on the keyboard.  

 

Some of the symbols are for use with the calculator. The locations of these symbols are shown 

to the left. 

There is one text style and seven different 

fonts supplied with AutoSD. The style name 

is ASD_BKAP. The fonts used with 

ASD_BKAP are asdfrc96, asdram96, 

asdros96, asdrom96, asdsim96, asdtxt96 and 

cvspro`.  



Dimensioning, Chapter 6                                         AutoSD Steel Detailing  

102 

 

The default style is ASD_BKAP and the default font is asdros96. The fonts are called 

BIGFONTs. These bigfonts are used in association with fonts supplied with AutoCAD. The 

bigfonts asdram96, asdros96 and asdrom96 are used with the AutoCAD font romans. The 

bigfont asdsim96 is used with the AutoCAD font simplex. The bigfonts asdfrc96 and asdtxt96 

are used with the AutoCAD font txt. The bigfont and cvspro` is used with the font cvspro 

supplied by AutoSD. 

 

To change fonts, use the STYLE command. 
 

Command: -STYLE or STYLE to open the dialog box. 

Text style name (or ?) <ASD_BKAP>: 

Existing Style. 

Font file <romans,asdros96>: romans,asdsim96  New font. Do not include any spaces. 

Big font asdsim96.shx 

Height <0'-0">: Enter      The height must always be 0. 

Width factor <0.86>: Enter 

Obliquing angle <0.0000>: Enter 

Backwards? <N>: Enter 

Upside-down? <N>: Enter 

Vertical? <N>: Enter 

ASD_BKAP is now the current text style 
 

The different fonts are shown below. 

 

Style ASD_BKAP, font: SIMPLEX,ASDSIM96 

   

  

 

Style ASD_BKAP, font: ROMANS,ASDROS96 

 

 

Style ASD_BKAP, font: TXT,ASDTXT96 

 

 

Style ASD_BKAP, font: TXT,ASDFRC96 

 

 

 

Style ASD_BKAP, font: ROMANS,ASDROM96 

 

 

Style ASD_BKAP, font: ROMANS,ASDRAM96  
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Style ASD_BKAP, font: CVSPRO,CVSPRO` 

 

  

DIMENSIONS 

 

DIM. TEXT 

Pulldown: AutoSD > Dimension > Dim Text 

Toolbar: Dimension I 

Ribbon: AutoSD I > Dimension 

 

DIM. TEXT is a text command that puts dimensions on without any dimension lines. It operates 

the same as the TEXT command but uses the FT.IISS format and is for dimensions only. 

 

DIMENSIONING 

Pulldown: AutoSD > Dimension 

Toolbars: Dimension I, Dimension II 

Ribbon: AutoSD I > Dimension 

 

AutoSD uses a custom dimension program. The dimensions will be placed centered between the 

extension lines and above the dimension line. If the dimension is less than 2 1/2" at a 1"=1' scale 

it will put tick marks and the dimension text will be placed outside of the extension lines on the 

side that was picked first, otherwise it will put arrowheads or ticks, per your customer 

configuration, and the text will be centered. The dimension height will be the same height as the 

text and will be plotted 1/8'' in height no matter what scale you are drawing to. These are pre-

set when you run SETUP and are saved with the drawing in a dimension style called AUTOSD. 

All dimensions are affected by the "MODIFY > SCALE OF DRAWING" command. 
 

Command: DIMENSIONS     Pick from pulldown, toolbar or ribbon menu.  

First point or RETURN to select:    Pick a point 

Next point:       Pick another point. 

Enter 

Dimension line location:    Pick a point. 

    

     

A dialog box pops up to select the orientation of the dimensions. 

Select Horizontal. 

 

 

(FT.IISS) Spacing/Text/Dimension <4'-6 11/16">: Enter If only two points were picked. 

Command: 
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If only two points were picked you get the prompt Spacing/Text/Dimension. Typing a T allows 

you to enter text instead of a dimension. Typing an S allows you to dimension spaces. 

 

If you picked Aligned, you would get the prompt “Reference/Enter to use points selected:” Press 

the enter key and the dimension line will be parallel to the two points picked. Press “R” and 

enter and you are prompted to select a reference line. The dimension line will be parallel to the 

line you pick. 

 

If you picked Rotated, you would get the prompt “(Decimal) ROTATED dimension line angle 

<0.0000>:” Enter the angle for the dimension line and press enter 

 

Changes to arrowhead type and size, leader arrowhead, extension line start, extension line end 

location and text height are controlled through the Dimension Style dialog box. Colors are 

controlled through the Customer configuration dialog box. The dimension program uses a 

custom dimension style. The style name is AUTOSD. For changes to any variables to take affect 

the changes must be saved to this dimension style. 
 

Command: dimstyle 

dimension style: AUTOSD 

Dimension Style Edit (Save/Restore/STatus/Variables/Apply/?) <Restore>: S 

?/Name for new dimension style: AUTOSD 

That name is already in use, redefine it? <N> Y 
 

Arrowheads 

AutoSD uses arrowheads that match AutoCAD’s, but you can also use your own custom 

arrowhead. When creating the arrowhead, draw it pointing to the right with the insertion point 

at the right end. The color for dimension arrowheads must be 5 (blue). If you want to use it for 

leaders, you will need to save it with a different file name and make the color 10. The actual 

color used is set in the Customer configuration dialog box for colors. 

 

DYNAMIC LINEAR DIMENSION  

Pulldown: AutoSD > Dimension > Dynamic Linear Dimension 

Toolbars: Dimension II 

Ribbon: AutoSD I > Dimension > Dynamic Linear Dimension 

 

Dynamic Linear dimensions can be horizontal, vertical, aligned or rotated with extension lines. 

After picking all points and pressing enter or pressing enter and selecting a line you get the 

following options. 

“Specify dimension line location or /Align/Horizontal/Point/Rotated/Vertical:” 

 

Align: Reference/Enter to use points selected. Enter R to select a line parallel to dimension line 

or press enter.  

Horizontal: Forces the dimension to be horizontal. 

Point: Select point for dimension line location. 
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Rotated: (Decimal) Specify angle of dimension line. 

Vertical: Forces the dimension to be vertical. 

 

If only two points are picked, you get the following prompt. 

(FT.IISS) Spacing/Text/Dimension <2'-2 11/16">:  

 

Spacing: Prompts for number of spaces and length of each space. 

Text: Prompts for text instead of a dimension. 

Dimension: Prompts for dimension text in the FT.IISS format. 

 

DIMENSION LINE OR SINGLE LINEAR DIMENSION  

Pulldown: AutoSD > Dimension > Dim Line 

Toolbars: Dimension II 

Ribbon: AutoSD I > Dimension 

 

This is for dimensions at any angle, horizontal and vertical with no extension lines. 

 

CONTINUE DIMENSION 

Pulldown: AutoSD > Dimension > Continuous 

Toolbars: Dimension I 

Ribbon: AutoSD I > Dimension 

 

This command is for continuing dimensions in a straight line. The dimensions will continue 

from the last point of the previous dimension in the same direction. Once picked, simply press 

the enter key to keep continuing. 

 

ARC DIMENSION 

Pulldown: AutoSD > Dimension > Radial > Arc 

Toolbars: Dimension I 

Ribbon: AutoSD I > Dimension 

 

This command is for dimensioning the length of an arc or an arc distance on a circle. It works 

the same as the dimension command for straight lines. The arc will be measured in a counter 

clockwise direction between the two points that you pick. 

 

ARC CONTINUE 

Pulldown: AutoSD > Dimension > Radial > Arc Continue 

Toolbars: Dimension I 

Ribbon: AutoSD I > Dimension 

 

This command is for continuing an arc dimension on an arc or on a circle. It works the same as 

the CONT dimension command for straight lines. The dimensions will continue in a counter 

clockwise direction. 
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STATUS, DIMVARS, UNDO, RADIUS, DIAMETER, and ANGULAR are AutoCAD’s 

dimensioning commands. LEADER is a custom leader command that works just like 

AutoCAD’s. 

 

BEVEL 

Pulldown: AutoSD > Dimension > Bevel (align) 

Pulldown: AutoSD > Dimension > Bevel (horiz) 

Pulldown: AutoSD > Dimension > Bevel (miter) 

Toolbars: Dimension I 

Ribbon: AutoSD I > Dimension 

 

BEVEL (horiz.) calculates the bevel and angle of a line in reference to the horizontal. 

BEVEL (align) calculates the bevel and angle in reference to another line. 

BEVEL (miter) calculates the bevel and angle in reference to two other lines. 

Each one places the bevel and angle on the line on the side of your choice.  For metric, the bevel 

base reference is 250. 

 

After starting the command, you can pick the reference line to continue the command or type 

the letter C to configure the symbol size. The default size is 1. A number less than one will scale 

the default size downward by the amount you enter, and that value will be saved and used until 

you change it. A value of .75 will make the symbol 3/4 the size of the default size. 

 
 

Command: BEVEL, horiz 

Command: BEVEL 

Pick line or [Configure]:    Pick a line that is sloping 

Select side for symbol:     Pick one side of the line 

Bevel <4 5/8">: Enter 

Angle <21.1810>: Enter       

Command:        Finished 
 

The symbol is drawn and the “move” command is started. Place the 

symbol. If you place it beyond the end of the line selected for the bevel, 

a line will be drawn extending the bevel line. 

 

 

In response to the "Bevel:" prompt, you may type in a dimension in the 

FT.IISS format if you don't want to use the default value. You may also 

type in a different angle at the "Angle:" prompt to be put in the symbol. 

 

 

 

 



AutoSD Steel Detailing                                        Dimensioning, Chapter 6 

107 

CROSSING 

Pulldown: AutoSD > Dimension > Crossing 

Toolbars: Dimension I 

Ribbon: AutoSD I > Dimension 

 

This Crossing command allows you to dimension the distance between two or more lines by 

picking two points on the outside of the lines. A "rubber band" line is stretched between the two 

points you pick and all spaces between lines that are crossed by this rubber band line will be 

dimensioned. You are given the option to unselect lines that you do not want dimensioned. The 

group of lines selected should be parallel. 

 

LEADERS 

WORD WRAP 

Pulldown: AutoSD > Dimension > Leader (word wrap) 

Toolbars: Dimension I, Leader 

Ribbon: AutoSD I > Dimension 

 

This leader command can place the text on a single line or wrap it for multiple lines. It can have 

one leader or multiple leaders 

 

Leader start: 

to point: 

to point: 

Rotation/Leader note:  NO PAINT WITHIN 3” OF HOLES 

Single Line or Word Wrap? (SL/WW) <SL>: WW 

Maximum characters per line <0>: 15 

2nd Leader start point (Press [Enter] to exit) Enter 

 

QUICK 

Pulldown: AutoSD > Dimension > Leader  

Toolbars: Dimension I, Leader 

Ribbon: AutoSD I > Dimension 

 

This is AutoCAD’s multi-line leader command 

 

MULTI LINE 

Pulldown: AutoSD > Dimension > Leader (multi line) 

Toolbars: Dimension I, Leader 

Ribbon: AutoSD I > Dimension 

 

This leader command can place a single line of text or multiple lines. It can have one leader or 

multiple leaders 

 

Type an R and press enter to 

rotate the text to any angle. 

The default angle is 0 

degrees. 
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Leader start: 

to point: 

to point: 

Rotation/1st Leader note: NO PAINT WITHIN 3” OF HOLES 

2nd Leader note (Press X to exit): Enter    

2nd Leader start point (Press [Enter] to exit) Enter 

 

w/BUBBLE 

Pulldown: AutoSD > Dimension > Leader (w/bubble) 

Toolbars: Dimension I, Leader 

Ribbon: AutoSD I > Dimension 

 

This leader command can place text in a circle. It can have one leader or multiple leaders 

 

Leader start:  

to point: 

to point: 

1st Leader note (Press X to exit) <>: 1 

2nd Leader start point (Press [Enter] to exit) Enter 

 

DYNAMIC 

Pulldown: AutoSD > Dimension > DLeader 

Toolbars: Dimension I, Leader 

Ribbon: AutoSD I > Dimension 

 

This leader command can place a single line or multiple lines of text while you view the text on 

screen as it is typed. It can have one leader or multiple leaders 

 

Leader start:  

to point: 

to point: 

Enter text: NO HOLES WITHIN 

Enter text: 3” OF HOLES 

Enter text: 

2nd Leader start point (Press [Enter] to exit) Enter 

 

w/REVISION 

Pulldown: AutoSD > Dimension > w/revision 

Toolbars: Dimension I, Leader 

Ribbon: AutoSD I > Dimension 

 

This leader command will place a single line of text with a delta revision symbol under the text. 

It can have one leader or multiple leaders 

 

Type an R and press enter 

to rotate the text to any 

angle. 
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Leader start: 

to point: 

to point: 

Leader note: OK 

Revision label: 1 

Leader start point (Press [Enter] to exit) Enter 
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Chapter 7 – Beams 
All programs in this chapter are under the AutoSD > BEAMS pulldown 

menu, Beams toolbar and AutoSD II > Beams ribbon menu. 

Automatically calculate end reaction, rows of bolts, block sizes, flange 

width cuts, minus dimension, tail dimensions, overall length, cut length. 

 

Create configurations for each customer that are automatically loaded 

when you open a drawing. 

 

 

 

 

 

 

CUTS, COPES AND BLOCKS  

 

This program will add a cut to an existing beam detail. The options are 

Block, Cut & chip or Cut flange width. The way the block is 

dimensioned is set in the customer configuration for beams. If you 

enter 0 for the width for “cut flange Width” the detail note will change 

to “CUT & CHIP (BS)”. For “Cut & chip” or “Cut flange width” the 

cut will be hatched for AutoCAD 2010 and later only.  

Select - Block/Cut & chip/cut flg Width (B/C/W) <B>: 

Select top flange of beam: 
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Select left end of beam: 

Pick location of horizontal dimension line: 

Pick location of vertical dimension line: 

(FT.IISS) Block length: .0308 

(FT.IISS) Block depth: .0104  

 

FLANGE GAGE LEADER NOTE 

This program is for adding the gage to an existing beam. The default will be the gage of the last 

member selected. 

 

PROPERTY SYMBOL 

This program will put the symbol, shown to the left, showing the depth and web thickness, 

(W), and the flange width and thickness, (F) at your insertion point. It uses a dialog box to 

select the member size. 

 

 

END CONNECTIONS 

Selections for the end connection are made from a dialog box. 

 

Detail Beam  

Choose the beam type, grade, depth 

and weight. If you choose “Girder” for 

the type, enter the depth in inches or 

mm for metric. 

 

End connection and Elevation are from 

bottom of beam:  Put a check in this 

box if you want the reference elevation 

and the connection to be detailed from 

the bottom of the beam. If the support 

member is a beam, the reference 

elevation will also be at the bottom for 

the support. 

 

Support Member 

Next, choose the support type. This can be beam web, column flange, column web, pipe column, 

tube column, tube beam or user type. User type can be selected if the beam is framing to a 

masonry wall. If user type is not selected you would then choose the shape, depth and weight. 

If you chose pipe or tube column the weight selection is disabled. For non-square tube columns, 

choose the depth that you are framing into. This selection is for determining the “minus” 

dimension. 
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Support is a Hip or Valley rafter 

 If you are detailing a beam that slopes and is framing into a hip 

or valley beam you need to check this box. Doing so will adjust 

the block depths and lengths based on the assumption that the hip 

or valley rafter and the beam you are detailing are in the same 

plane. If you are framing into a hip beam the program will also 

recommend the amount to lower the support so the edge of the 

flange is in the plane of the beam being detailed. The offset cannot be 0 and the angle cannot be 

90. 

 

Slope in degrees from horizontal 

 Normally, the support beam is assumed to be level. If it is sloping, 

you can enter the degrees of slope for the program to calculate the 

block depths correctly. This is different from the Hip or Valley 

rafter condition above. The support will not be lowered. If the 

support is higher far side of the beam enter the angle as positive. If 

it is higher near side, enter the angle as negative. This is important 

only if the beam being detailed is skewed. 

 

Input skewed angle of end connection  

The default setting is Auto. This setting will skew the end 

of the beam automatically based on the offset dimension 

or angle shown in the plan view on page 114. Auto will 

keep both ends parallel with each other in plan view. If 

you need one end skewed and the other end square or at 

some other angle check Manual to input the angle. 

Positive angles rotate counterclockwise and negative 

angles rotate clockwise. 

 

Connection Type 

 The top and bottom flanges can have nothing, holes, a clip or, if you have purchased the bracing 

package, you can import a gusset plate that has been previously calculated and saved.  
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Import column file data 

 If you have created column files you can use them to 

import the data for certain types of connections. A dialog 

box opens up with all of the *.col files for the job listed in 

the box labeled Column Files. Select a column file and 

select the round radio button to the left of one of the boxes 

below. If you selected the one for web connections all of 

the available web connections in the column file will be 

listed under Connections. Select a connection and the 

information for that connection will be shown in the Web 

connection box. Pick the Remove button to remove the 

information if you do not need that connection. Pick OK 

after selecting all appropriate options. 

 

Clip Connection 

 If a clip is chosen for the web connection you need to select 

whether it is on the Near Side, Far Side or on Both Sides 

and the setback from the heel of the clip to the end of the 

beam. The setback defaults to the setting in the customer configuration but is provided here for 

a per beam setting. If a shop bolted clip is chosen you can change the “1st gage for shop bolts” 

dimension. The default is from the customer configuration. This is the distance from the heel of 

the clip to the first shop bolt in the web of the beam. If the support is a beam, column web or 

user type and the clip is field bolted you have the option of selecting to “Use Safety Connection”. 

This option will stagger the near side and far side clips. At the left end the far side clip will be 

dropped down 3” below the near side clip. At the right end the near side clip will be dropped 

down 3” below the far side clip. 

 

If the support is a column web, column flange or user type and the 

connection is a field bolted clip, bent plate or end plate, (not moment), 

you have the option to “Add row above AND/OR below beam”. This 

option allows you to extend the connection above or below the beam 

to connect to a gusset plate. The dialog box shown to the right will be 

displayed to select options and enter number of rows. If you pick 

“Cancel”, the connection will be detailed without being extended. 

 

Bevel Flanges  

This is set to “No” by default. If you need the flanges to be beveled for 

a full penetration weld, select yes. 

 

Degrees 

 If Bevel Flanges is set to Yes, you can select the bevel to be 45 or 30 degrees. The default is 45 

and will give a clearance of 1/4" from the end of the flanges and 1/2" from the web for wing 

Safety 

connec

tion 
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plate connections. 30 degrees will give a clearance of 3/8" from the end of the flanges and web 

for wing plate connections. 

 

Loads 

 The end reaction will be determined using the beam size, length, grade, design method for 

country and percent of uniform load from the customer configuration. This load will be 

compared to the load you enter for the shear load and the greater of the two will be used to 

calculate the number of bolts in the web connection. The shear load may be left blank if it is not 

known. The tension load is used to calculate the thickness of the web connection. It may be left 

blank if there is no tension load. 

 

Bolts 

 The values in this section are the defaults from the customer configuration but may be changed 

here on a per beam basis. If you cannot find the shear value, you need in the pop down list select 

“Other” in the list and enter the value in the edit box below the pop down list. 

 

After making all your selections pick the OK button. At each prompt you may press the enter 

key to accept the default shown or type in your own dimension.  

Main mark: 1B1 

Are marks RIGHT and LEFT (Y/N) <N>: Enter 

Quantity: 1 

(FT.IISS) Elevation of beam at CL of LEFT end support <0">: Enter 

(FT.IISS) Elevation of beam at CL of RIGHT end support <0">: 3  

If the beam is not level, the slide picture shown to the left will be 

displayed. You are asked to select the method of entering control 

dimensions. The method you select will be used to calculate the true 

length of the beam and the true lengths between connections. For 

example: If method #1 is selected as in this case, the slope length, 

#2, is calculated using the dimension entered as dimension #1 for 

the base and the difference in elevations for the rise. If an offset is 

entered and is not 0 the true length, #4, is calculated using 

dimension #2 for the base and the offset for the rise.  

Number of dimension to input (1/2/3/4) <1>: Enter 

(FT.IISS) Input dimension #1: 15.06 

(FT.IISS) Angle/Dimension of Offset of right end in plan, (- is far side) <0>: -2.03  

Instead of entering an offset dimension you can enter an angle by entering the letter A, press 

enter and at the angle prompt enter the angle  

Cut flanges square (Yes/No) <N>: Enter 

Extend skewed flange cut beyond end of web (Y/N): N 
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Answering Y to extend skewed flange will result in the 

picture to the far left. Answering N will result in cutting the 

flange off at the web as shown to the left.  

Flanges will be extended by default if the “Bevel flanges” option is selected. 

 

For sloping beams, an icon menu is displayed to select the 

configuration of the end of the beam. As shown in the icon menu 

to the left there are three choices. (1) The clip and beam end can 

both be vertical. (2) The clip can be vertical, and the beam end 

can be square. (3) The clip and beam end can both be square. 

Caution should be exercised when selecting to cut the beam 

square if the clip is bolted or if the beam has holes in the web. 

 

Insertion point: 

 

When prompted for the insertion point of the left end an image will be drawn representing 

the depth and slope angle of the beam. This will enable you to position the beam so that 

it will not interfere with other details already drawn. 

 

For End Plates without holes enter 0 for number of rows. You MUST pick "YES" for "Plate 

length = beam depth".  

End reaction used is 23.44 kips. 

Enter number of rows in web <3>: Enter 

(FT.IISS) Elevation of top of support beam at connection's vertical work line <0">: 

Enter 

(FT.IISS) Horiz. Minus dimension <-3/16">: Enter 

NOTE: Minimum Top flange block depth is 1 1/8". 

(FT.IISS) Vert. Distance down to first hole in outstanding leg from W.P. <3">: Enter 

Stagger gages of clips (Y/N) <N>: Enter  This is due to the offset dimension. 

(FT.IISS) Hole C/C for web connection <6">: Enter 

Near Side clip... Since the connection is skewed, the angle size is selected from a dialog box. 

NOTE: Leg on web is 4", Outstanding Leg is 3". 

Do you want to reverse legs (Y/N) <N>: Enter 

Enter angle mark or use <aa>: Enter 

 

          Far Side clip... 

NOTE: Leg on web is 4", Outstanding Leg is 3". 

Do you want to reverse legs (Y/N) <N>: Enter 

Enter angle mark or use <ab>: Enter   Bent clips default to nonstandard marks 



Bracing, Chapter 8                                                  AutoSD Steel Detailing  

116 

Start shop bill text on LINE <4>: Enter 

Number of field bolts in Web (Line 1 of 2) <6>: Enter  

 

  A dialog box is used to select the bolt type and washers. 

 

(.IISS) Total grip less washers <5/8">: Enter 

Number of field bolts (Line 2 of 2) <0>: Enter 

Shop bill information on mark aa 

Total sub quantity: 1 

Shop bill information on mark ab 

Total sub quantity: 1      

Add connection to beam file (Y/N) <Y>: Y    

The left end is drawn. A top view of the connection and top flange is automatically drawn if the 

beam is skewed, (offset is not 0). A section showing the bottom flange looking down from the 

top is automatically drawn if the beam is skewed. 

 

If the support is a beam you will be asked if you want to add the connection to beam file. The 

default answer is “Y”. Saving the connection will allow you to import the connection as an 

internal connection when you detail the support member. To take advantage of this connection 

matching you should start detailing the beams with the least number of internal connections first. 

 

If the support is a column you will be asked if you want to add the connection to a column file. 

 

If the connection is a one-sided clip or bent plate and the offset is not 0 a slide will be displayed 

showing the options available for a one-sided connection as below to the left. If the dimension 

from the work point to the first hole is negative the clip will be wrapped.  

The connection is welded on the near side 

(FT.IISS) Horiz. WP to hole for web connection <2 7/8">: Enter 

(FT.IISS) Horiz space to 2nd column of holes <0">: Enter 

(FT.IISS) Minimum edge distance to sides of bent clip <1 1/4">: Enter 

        GOL = 2 13/16" 

The angle size is selected from a dialog box for nonstandard clips. 

NOTE: Leg on web is 6", Outstanding Leg is 4". 

Do you want to reverse legs (Y/N) <N>: Enter 
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If the angle size selected has unequal legs the long leg, by default, 

will be shop attached to the beam web. You can reverse this by 

answering “Y” when prompted to do so. 

 

If you have a skewed beam framing into a column and you want the connection 

to be to the column flange instead of the web as shown in the sketch to the left, 

you need to select Column flange for the support member. This will give you the 

correct minus dimension and the plate will be bent to fit the flange. 

 

Clipping the lower end of a sloping beam is accomplished by 

selecting a column, tube beam or user type for the support. Enter “Y” 

when asked to block the bottom flange. Enter a block length that is 

greater than the “Min Length” shown in the picture to the left. The 

program will then ask the following question. 

 

 

(FT.IISS) DEPTH of web cut from top of beam <1 1/8">: .0805    

This will produce the result shown.  

“T” connection 

This connection is for tube shapes. The 

connection can be made from plates or a split 

“T”. It can have two clips or one column or 

holes. 

 

The tube must be level and square with the 

supports. Skewed and sloping are not options 

with this connection. 
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SEAT ANGLE, SEAT PLATE 

This connection is for creating a seat using angles or a plate.  

The connection may have 0, 2 or 4 bolts. 

You may elect to draw a top view or not. 

Do not add “R/L” to the mark if using an angle with holes. It will be added 

automatically. 

#8 will be calculated for you if you start with #1 

and tab your way down. You can override #8 by 

clicking on #8 and changing the value. 

#10 is from the end of the beam to the work line. 

There are basically two different configurations. 

One where the support is a beam with 4 bolt 

connection and one for all other supports. The 

first, shown in the dialog box to the left, has the 

work line between the holes. The second, shown to the right, has the 

work line outside the holes. 

 

INTERNAL CONNECTIONS (MAIN and AUX.)  

 

The MAIN internal connections are used after the left end of the beam is detailed and before the 

right end is detailed. 

 

The AUX internal connections are 

used after the right end of the beam is 

detailed to add connections after a 

beam is detailed such as handrail holes 

or because of a revision. It can be a 

single connection, or you can "chain" 

them together by pressing enter after 

the first connection is completed to 

repeat another connection. If you 

repeat, you can select the same 

connection or use a different one. If you select the command from the menu the connection will 

not be “chained” to the previous one. You cannot alternate between MAIN and AUX internal 

connections. You must complete the beam with MAIN before using AUX. 

 

Now let's put some internal connections in the beam. Choose the appropriate box in each section. 

To recall the last internal connection used pick the “Previous” button. Pick OK when finished.  

 

Connections 

You can make one selection from each connection.  

Web NS and Web FS for holes in a tube beam: If you have holes in the web, using “Web NS” 

will put the holes in both webs of the CNC file. Using “Web FS” for holes will put them in the 
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far side web only of the CNC file. If you want the holes in the near side web only then put the 

holes in “Web FS” and change the CNC data for the holes to web NS. 

For wing plates, an optional side view section can be drawn. This view is affected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. Only the side view 

will be scaled. If you change the drawing scale before starting the connection, you can have the 

side view drawn larger. This is very helpful on small beams. Holes placed using Web NS will 

be in both NS and FS web of tubes. Holes placed using Web FS will be in FS web only of tubes. 

 

Left, Center, Right 

After selecting the connection type, you should enter a dimension in one or possibly two of these 

boxes. You can enter a dimension in the Right and Left boxes or in the Center box. You cannot 

have a dimension in the Center box and the Right or Left box. The program will check for this 

when you pick the OK button and will display an error message advising you of the problem. 

Entering a Left dimension will draw the connection on the left side of the work line. Entering a 

Right dimension will draw the connection on the right side of the work line. Entering a Center 

dimension will draw the connection on the left and right side of the work line. 

 

Some connections allow you to enter the Left and Right dimension as a list. Lists are dimensions 

separated by commas. Example: .0708,.03,.03 or .0708,2@.03. Connections which allow lists 

are holes in flanges, holes in web and stiffener plates. Lists allow you to space holes or stiffeners 

horizontally. If the dimension is not entered as a list it must be entered using the FT.IISS format 

if the drawing was setup for architectural units. The example to the left was created 

using a single Center dimension for holes in the near side web with a row of three 

down 3” and the list noted above for the Left dimension for holes in the far side web 

with a row of one down 4 1/2”. This is a typical beam connection for a horizontal 

brace. 

 

The table below shows the result of entering dimension as a positive and negative. 

As you can see in the examples, left dimensions move the connection left and right 

dimensions move the connection right of the work line regardless of being positive or negative. 

A positive dimension, however, continues to go in the same direction with the connection and a 

negative dimension reverses the direction of the connection. The exception to this is skewed 

wing plates. Skewed wing plates are placed on the opposite side of the work line as viewed from 

the top if the dimension is negative. Entering the angle as negative has no affect. A left 

dimension rotates the plate left of vertical and a right dimension rotates the plate to the right side 

of vertical. 

 

To make a list negative enter the first number as negative. The remaining numbers can be 

positive. Example: -.04,.03,.03 or -.04,2@.03  

 

The examples below show the result of entering dimension as a positive and negative for vertical 

plates on top and bottom flange. Left dimensions move the connection left and right dimensions 

move the connection right of the work line regardless of being positive or negative. A positive 

dimension, however, continues to go in the same direction with the connection and a negative 
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dimension reverses the direction of the connection. The front view does not have a Right or Left. 

It will always be centered. 

 

 Both edge view and front view plates will have either 1 or 2 columns of holes.  

 

If the beam is sloping, the plates can be either vertical or square with the beam flange. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Holes and skewed wing plates may be rotated to 

any angle in the web of a sloped beam. The angle 

of rotation is measured from a line that is square 

with the flange. Positive angles are rotated 

counterclockwise. Negative angles are rotated 

clockwise. 

 

 

 

 

Import connection 

If a web connection is set to None in the Connection section an import button is enabled. Picking 

Web NS or Web FS will open the dialog box shown to the left. This box will list all the end 

connections by beam marks that have been saved for the customer you are currently detailing 

for. To select, pick a beam mark and look at the information presented to the right of the list. 

The first item will be the end of the beam that connection was detailed for. The left end is the 

piece marked end. The right end would be the other end. 
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As you detail and save connections, most of the beam 

marks will be listed twice, one listing for each end. This 

same box is used to edit connections in the list and can be 

accessed from the beam menu by selecting Edit Internal 

Connection List. You can edit the dimension by picking on 

an edit box and changing the dimension. The "Center" 

dimension is used to put a wing plate or shear lug on the 

center of the work line for a tube or pipe framing 

connection. Select Cancel to close the box without saving 

any changes. The default list displayed in the box is from 

the current customer. Pick the Browse button to open 

bm_conn.lst files that you have saved in other folders. The 

Delete button will delete the currently selected connection 

from the file. If the correct end is shown pick the OK 

button.  

 

The plate connections shown below are available from Internal Connections (Main), Internal 

Connections (Aux) and from Beams/Plates/Vertical Plate on flange. They can also be used on 

top of a column cap plate. 
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Examples showing the result of entering dimensions as positive and negative for vertical plates 

located on top and bottom flange or column cap plate. 
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Vertical hole spacing 

 The defaults are from the customer configuration but may be changed here on a per detail basis. 

 

Add Symbol for Channel 

 Selecting Toed left or Toed right will cause the program to draw the end view of a channel toed 

in the direction selected and place beside the work line. 

 

After all necessary information has been entered in the Internal Connections dialog box pick the 

OK button. The insertion point for internal connections is where the vertical cross hair intersects 

the top flange.  

(FT.IISS) Center of left support to work line of connection - based on control dim 

#1: 3 

Web connection is (1)Square with flange, (2)Vertical: 1  

The true length dimension to the work point of the connection from the previous connection is 

calculated based on the input method selected when the left end was detailed. In this example it 

is based on control dim #1. If the beam is sloping the connection can be vertical or square with 

the flanges. 

 

If you insert an internal connection and erase it, you must reset the tail dimension. Pick Reset 

Tail Dim from the BEAMS menu or toolbar and select a number in the Conn list box. 

The numbers represent the connections in the order in which they were detailed. The 

highest number is the last connection. Selecting a number will display a dimension in 

the box above the Delete button. This is the tail dimension for that connection. Pick 

Delete to reset the tail dimension to the connection number shown above the one 

selected. This will delete the connection selected and all others below it. Once deleted, 

they cannot be restored. 

 

Now we can put the right end on the beam. This uses the same dialog box as the left end but the 

selections for Detail Beam have been disabled. Choose the appropriate box in each section. 

Choose OK when finished.   

Cut flanges square (Yes/No) <N>: Enter 

Extend skewed flange cut beyond end of web (Yes/No): N 

Insertion point:      The Insertion point is the face of the clip. 

End reaction used is 23.44 kips. 

Enter number of rows in web <3>: Enter 

(FT.IISS) Elevation of support beam at connection's vertical work line <3'-0">: Enter 

(FT.IISS) Horiz. Minus dimension <-1/4">: Enter 

(FT.IISS) Vert. Distance down to first hole in outstanding leg from W.P. <3">: Enter 

Stagger gages of clips (Y/N) <N>: Enter 

(FT.IISS) Hole C/C for web connection <6">: .0508 

          Near Side clip... 

  NOTE: Leg on web is 4", Outstanding Leg is 3". 

Do you want to reverse legs (Y/N) <N>: Enter 
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Enter angle mark or use <ac>: Enter 

          Far Side clip... 

  NOTE: Leg on web is 4", Outstanding Leg is 3". 

Do you want to reverse legs (Y/N) <N>: Enter 

Enter angle mark or use <ad>: Enter 

Number of field bolts in Web (Line 1 of 2) <6>: Enter 

(FT.IISS) Total grip less washers <5/8">: Enter 

Number of field bolts (Line 2 of 2) <0>: Enter 

Do you want to add ac to the shop bill (Y/N) <Y>: Enter 

Do you want to add ad to the shop bill (Y/N) <Y>: Enter 

Shop bill information on mark 1B1 

Add connection to beam file (Y/N) <Y>: Enter  

The beam is finished.  

 

NOTE: 

 

• The beam is drawn to actual depth.  

• Flange thickness is drawn to 3/4” at 

a 1” = 1’-0 scale. 

• Blocks are drawn to scale. 

• Holes are located above (negative) or 

below (positive) the top flange to 

scale. 

• The elevation will be written at both 

ends if the beam is sloping. 

• The minimum block depth is 1", 

(25mm). 

• You must finish one beam before 

starting another and before closing 

the drawing. 

• (FT.IISS) Total grip less washers <5/8">: This prompt shows the grip for the bolts in the end 

connection. It is equal to the clip angle thickness and the web or flange thickness of the support 

member. If you are framing into a web and you have a beam connecting on the other side, increase 

the grip by the clip thickness for the other beam. If you are detailing a beam for a wing plate 

connection the program assumes 3/8" for the wing plate to determine the grip.   

• All material is automatically put in the shop bill. 

• Inserting an internal connection without selecting a connection will place dimension lines at the 

insertion point. To be used to add something latter. 

• Connections to a beam or column can be saved to a file to be used to detail the beam connection or 

column. 

• Channels must be drawn toed far side only when CNC data is saved. 

• The angle entered for skewed wing plates is the angle in the plane that is square with the edge of the 

plate attached to the web of the beam. 
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ANGLE BEAM 

 

This draws an angle with either holes or end plates at 

either end. You can have 2 or 4 holes at both ends. 

 

The angle beam will be drawn to the scale set by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of 

Drawing command. 

 

 

 

 

FINGER SHIM PLATE 

 

This program will draw a detail of a shim plate, place a main 

mark under the detail and fill out the shop bill. Pick OK to draw 

the plate and end the program. The shim plate will be drawn to 

the scale set by the [AutoSD > Modify] or [AutoSD I > 

Change] > Scale of Drawing command. 

 

 

VERTICAL PLATES 

 

This program will draw one or two vertical plates or one bent 

plate on top of or below a level or sloping line. You can draw 

an edge view or a front view. To omit the plate on the left in the 

edge view, select Single and Right Plate. To omit the plate on 

the right, select Single and Left Plate. To draw a single plate 

centered on the work line, Select Single and Both Plates and 

enter #9 and #10 as 0. To have the plates dimensioned to the 

outside surface, enter #9 and #10 as a negative. If you change 

the bolt diameter from the default, the hole size will be noted. 

 

WING PLATE (side view)  

 

Plate Only or Plate and End View of Shape. The wing plate program is for drawing the side view 

of a shear lug on an existing column detail or end view section. The end view can also be drawn 

at the same time. The lug can be on either side or both sides and will be dimensioned down from 

the top. You can have 1 to 14 rows and one or two columns of holes. The plate can be square or 

skewed with the web of a beam and the beam can be level or sloping. All sections for plates on 

beams are cut looking to the left. 
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The wing plate will be drawn to the scale set by the [AutoSD > Modify] or [AutoSD I > Change] 

> Scale of Drawing command.  

Plate & End View of Shape 

 

 

 

 

 

 

 

 

 

 

 

Insertion point at top center of tube: 

 

  

Plate Only 

 

Draw plate on Beam web 

Left, near side 

Member = W14x22 

#1 = .03 

#2 = .03 

#3 = .03 

#4 = .0012 

#5 = .0013 

#6 = .0104 

#7 = .0104 

#8 = .03 

#9 = 3    Pick center of beam end view on top flange:  

 

Entering a positive number for the vertical distance from the W.P. to the first hole will place the 

first hole below the W.P. A negative distance will place the first hole above the W.P. 

The following example uses a negative distance from the top of the beam to the first hole.  

Plate & End View of Shape 

 

Draw end view of member 

Draw plate on Beam web 

Left, near side 
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Member = W14x22 

#1 = .05 

#2 = 0 

#3 = -.0208 

#4 = .0012 

#5 = .0013 

#6 = .0104 

#7 = .0104 

#8 = .03 

#9 = 3 

      Insertion point at top center of end view:  

Plate Only- on an existing W8 x 31 column flange 

 

Draw plate on Column flange 

Right, far side 

Member = W8x31 

#1 = .0608 

#2 = 0 

#3 = .03 

#4 = .0012 

#5 = .0013 

#6 = .0104 

#7 = .0104 

#8 = .03 

#9 = 3    Pick center of column web view at elevation line:  

Plate Only - Skewed on Sloping Beam 

 

Draw plate on Beam web 

Left, near side 

Member = W16x26 

Connect plate to top flange 

Connect plate to bottom flange 

Slope of support beam from horizontal = 19.9831 

#1 = .05 

#2 = 0 

#3 = .04 

#4 = .0012       Pick center of beam on top flange: 

#5 = .0013 

#6 = .0104  

#7 = .0104 

#8 = .03 

#9 = 3     
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#10 = .0002 

Thickness of plate = .0006  

The slope of the beam may be entered as positive or negative as shown above 

 

Note 1: The angle entered can be from the web of the support beam or from a line that is 90o 

from the web.  

 

Note 2: As you look down on the beam as detailed that the plate is attached to, entering Left 

would mean the plate is on the left side of a vertical line through the work point. Right would 

mean the plate is on the right side of a vertical line through the work point. 

 

Note 3: #10 is the half web thickness of the beam framing into the plate. 

 

The end view of the beam will not be drawn if the plate is skewed even if you select to draw the 

end view. 

 

STIFFENER PLATE (attached)  

 

This will draw the edge view of a stiffener plate on an existing detail. It will not put any 

dimensions.  

 

The stiffener plate will be drawn to the scale set by the [AutoSD > Modify] or [AutoSD I > 

Change] > Scale of Drawing command.  

Select a line at one end of stiffener plate: 

Select a line at the other end of stiffener plate: 

Location of center of stiffener plate:  

The stiffener plate will be drawn square to the second line picked and will be bounded at the 

ends by the two lines picked. 

 

STIFFENER PLATE (loose)   

 

This will draw a side view detail of a stiffener plate 

with a main mark. The corner of the plate where it 

connects to the web and flange will either be 

chamfered or blocked based on your customer detail 

variable configuration settings. 

Check the box for “Plate is skewed” if the stiffener 

is not square with the web and enter the angle, bevel 

or two control dimensions to calculate the angle. 

Pick “Select” to select a member size for values d, 

bf, tf, tw k and T. If the beam is sloped, enter the 

angle from horizontal. The length of the plate, value 
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“B”, will be affected by value #6 under “Shop bolted Clips and Stiff” in your customer detail 

variable configuration. The width of the plate, value “A”, will be affected by the value for 

“Round Stiffener Plate width to nearest” in your customer detail variable configuration. 

Pick OK to draw the plate and end the program. The stiffener plate will be drawn to the scale 

set by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

SKEWED PLATE (top internal)  

 

The skewed plate program is for drawing the top view of a skewed plate on the web of a beam. 

The beam must be placed horizontally on the sheet. The plate can be on either side in any 

direction including 90o to beam, (input angle as 0), and you can have any number of holes. Also, 

you get to locate where the horizontal, vertical and slope dimensions are to be placed. The 

skewed plate will be drawn to the scale set by the [AutoSD > Modify] or [AutoSD I > Change] 

> Scale of Drawing command.  

Command: Pick [AutoSD > Beams > Plates] or [AutoSD II > Beams] > SKEWED PL (TOP INTERNAL) 

Work point location:      Pick a point 

Pick quadrant wing plate is in:    Pick another point 

Number of columns: 2 

Select to input (Angle/Bevel/Controls) <A>: C 

(FT.IISS) Horiz. control dimension: 6.0804 

(FT.IISS) Vert. control dimension: 4.1008 

Framing into channel (Y/N) <N>: Enter 

(FT.IISS) Half web thickness of support beam .........: .0003 

(FT.IISS) Offset of plate from work line ..... <3/16">: Enter  May be positive or 

negative 

(FT.IISS) Plate thickness ..................... <3/8">: Enter 

(FT.IISS) Slope distance from W.P. to first hole. Min = <3 7/8">: .04 

(FT.IISS) Distance from first hole to second hole <3">: Enter 

  The plate is drawn 

Location of horiz. dimensions:   Pick a point 

  Dimensions are drawn 

Location of vert. dimensions:   Pick a point 

  Dimensions are drawn 

Location of slope dimensions:   Pick a point 

  Dimensions are drawn 

 Placing bevel 

Select line:   Pick a point on the slope 

Select side for symbol: 

(FT.IISS) Bevel <8 3/4">: Enter 

(FT.IISS) Angle <36.0910>: Enter  

Command:       Finished  

The horizontal and vertical control dimensions may be the actual control dimensions, or they 

can be the bevel. If you select to input the angle or bevel you will be asked if the angle or bevel 

is in reference to a horizontal or a vertical line. 
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The picture above is how the plate will be drawn if the offset is positive. If the offset is negative 

the plate will be on the opposite side of the work line. The offset locates the side of the plate 

next to the work line in either case.  

 

TOP VIEW (skewed connection)  

Right end or Left end. 

 

This program is for drawing the top view of a skewed end connection on the web of a beam. The 

connection can be on either end or any angle. It uses the same dialog box as the one for detailing 

the end of a beam, so all the web connection options are available. The first example uses an 

end plate with the skew angle entered manually. Positive angles rotate counterclockwise and 

negative angles rotate clockwise.  

(FT.IISS) Elevation of beam at CL of LEFT end support <0">: Enter 

(FT.IISS) Elevation of beam at CL of RIGHT end support <0">: Enter 

Enter angle: 36   A slide is displayed to show positive and negative angle rotation. 

(FT.IISS) End plate thickness: .0006 

Stagger gage of end plate (Y/N) <Y>: N 

(FT.IISS) Horiz. Minus dimension <-1/4">: Enter 

(FT.IISS) Elevation of support beam <0">: Enter 

Insertion point:                                         Pick a point. 

(FT.IISS) Hole C/C in end plate <6">: Enter 

(FT.IISS) Edge distance to sides of end plate <1 1/4">: Enter  

 

The following example uses bent plates on both sides of the web with the skew angle entered 

automatically by entering an offset.  

(FT.IISS) Elevation of beam at CL of LEFT end support <0">: Enter 

(FT.IISS) Elevation of beam at CL of RIGHT end support <0">: Enter 

Number of dimensions to input (1/3): 1  A slide is displayed to show for user reference 

(FT.IISS) Input dimension #1: 11 

(FT.IISS) Angle/Dimension of Offset of right end in plan, (- is far side) <0>: -4 

(FT.IISS) Thickness bent plate: .0005 

(FT.IISS) Horiz. Minus dimension <-3/16">: Enter 

(FT.IISS) Elevation of support beam <0">: Enter 

Insertion point: Pick a point. 

Stagger gages of clips (Y/N): N 

(FT.IISS) Hole C/C for web connection <6">: Enter 

(FT.IISS) Edge distance to sides of plate <1 1/4">: Enter  

 

MOMENT END PLATE 

 

This program is for drawing an end plate for a moment connection. There are four types to 

choose from. The moment end plate can be designed and saved in your customer job folder 
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before you detail a beam, or it can be designed and saved as it is needed while you detail a beam. 

The plate can be added to an existing beam detail. One moment end plate design will fit any size 

beam. 

 

The moment end plate will NOT be drawn to the scale set by 

the [AutoSD > Modify] or [AutoSD I > Change] > Scale of 

Drawing command. 

 

Type 1: Holes will be spaced a given distance below the top 

flange, above and below the bottom flange. The remainder of 

the plate will be filled with holes at a given spacing. 

 

Type 2: Holes will be spaced a given distance above and below 

the top flange, above and below the bottom flange. The 

remainder of the plate will be filled with holes at a given 

spacing. 

 

Type 3:  Holes will be spaced a given distance below the top flange and below the bottom flange. 

The remainder of the plate will be filled with holes at a given spacing or you can enter the 

number of rows to use. 

 

Type 4:  Holes will be spaced a given distance above and below the top flange and below the 

bottom flange. The remainder of the plate will be filled with holes at a given spacing or you can 

enter the number of rows to use.  

Command:  Pick [AutoSD > Beams > Plates] or [AutoSD II > Beams] > Moment End Plate 

(FT.IISS) Flange to outside hole ...... "A": .0108 

(FT.IISS) Flange to inside hole ....... "B": .0204 

(FT.IISS) Spacing of remaining holes .. "C" <3>: Enter 

(FT.IISS) Thickness of end plate ..........: .01 

(FT.IISS) Edge distance at end of plate ...: .0108 

Enter selection: (Save/Quit): S 

Customer folder <C:\SSS|95-01\>: Enter 

End plate number: 1 

Writing output to file ... Done.  

 

GIRTS 

Pulldown: AutoSD > Beams > Girts  

Toolbars: AutoSD > Beams > Girts 

Ribbon: AutoSD II > Beams 

 

This program is for detailing girts. The girt may have holes, 

plate or clip in the web for the connection to column, door 

jamb or another girt or can be field welded. You can have 

holes for sag rods and door jambs. The ends can be blocked 
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as needed. You must have a customer job folder created and configured for detailing beams 

before you can detail girts.  

The last mark was 1B1 

 Main mark: 1B2 

Are marks RIGHT and LEFT (Y/N) <N>: Y 

 Quantity of RIGHTS: 1 

 Quantity of LEFTS: 1  

The dialog box above is used to select the left end, enter values for the location of holes, select 

the girt size, which way the flanges are toed if not saving CNC, enter the length from column to 

column and select if the length is drawn to scale. Pick OK to enter values for the right end. If 

the girt is a tube it may be mitered at a corner or cut square 

with an optional end plate. If the tube does not have equal 

sides you can select which will be the horizontal side. 

Positive dimensions will draw the girt as shown in the 

slides. Negative dimensions will move holes and the end 

of the girt in the opposite direction from that shown. 

 

The dialog box to the right is used to select the right end 

and enter values for the location of holes. Pick OK to 

continue.  

How many rows of sag rods: 2 

Do you want to enter any SPECIAL block size (Y/N) <N>: Enter 

Pick point, top of girt left end: 

(FT.IISS) Distance from girt line to C/L of sag rod <4">: Enter 

(FT.IISS) Distance from C/L to C/L of sag rods in one group <3">: Enter Can be 0 for 

one hole. 

(FT.IISS) Hole size for sag rods (Enter 0 if holes are standard size): 0 

Do you want equal spacing for sag rods (Y/N) <Y>: Enter 

Do you have any internal connections (Y/N): Y  

This dialog box is used to select the internal connection and enter 

values for the location of holes. Pick OK to continue.  

Pick location for left jamb:  Pick a point 

Pick location for right jamb:  Pick a point 

Pick a "CLEAR" area between holes for vertical dimensions 

Do you have another internal connection (Y/N): N 

Place shop bill text on LINE <9>: Enter 

(FT.IISS) Thickness of connection material at left end 

<5/16>: Enter 

(FT.IISS) Thickness of connection material at right end <5/16>: Enter 
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Command: 

 

 

SAG ROD 

The SAG ROD program is in the AutoSD > BEAMS 

pulldown menu. The sag rod can be straight or bent. Sag 

rods are put in a schedule, the straight ones in one 

schedule and the bent ones in another. For this reason, 

when you are detailing sag rods you should detail all the 

same type at one time. If you quit the program and come 

back to detail sag rods later the program will let you add 

new sag rods to an existing schedule. 
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SPLICE PLATE (Loose)  

This program is for drawing a splice plate with a main mark 

to be shipped loose. You can have any number of rows and 

columns of holes from 1 to 13. It will put the horizontal 

dimensions and vertical dimensions. Pick OK to draw the 

plate and end the program. The splice plate will be drawn to 

the scale set by the [AutoSD > Modify] or [AutoSD I > 

Change] > Scale of Drawing command. 

 

Insertion point at top left corner of plate: 

 Main mark: 1P1 

Are marks RIGHT and LEFT (Y/N) <N>: Enter 

 Quantity: 1 

Shop bill information on brace 1P1 

Place shop bill text on LINE <9>: Enter 

 

 

SPLICE PLATE (Attached)  

Pulldown: AutoSD > Beams > Plates 

 

This program is for drawing a shop welded or shop bolted 

splice plate at either end of a beam. You can have from 1 

to 13 rows and columns of holes. It will put the horizontal 

dimensions and you can choose to put the vertical 

dimensions. This splice plate offers more options than the 

one above but is not affected by the [AutoSD > Modify] 

or [AutoSD I > Change] > Scale of Drawing command. 

Pick OK to draw the plate and end the program. 

 

Insertion point, top flange at end of beam: 

Location of horizontal dimensions: 

Location of vertical dimensions: 

      Mark for plate 

Enter mark or use <pd>: Enter 

Add piece pd to shop bill (Y/N) <Y>: N 
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Chapter 8 - Bracing 
All programs in this chapter are under the AutoSD > BRACING pulldown menu, Bracing 

toolbar and AutoSD II > Bracing ribbon menu. 

 

The bracing portion of AutoSD consists of a program to calculate and save gusset 

plates, a program to edit gusset plate files, a program to view existing gusset plate 

files, a program to draw gusset plates and a program to draw braces. These 

programs are supported by icon menus and dialog boxes to select the type of gusset 

plate and the type and orientation of the brace. A view of the gusset plate type or 

brace type in the orientation selected is provided for your reference in entering the 

necessary data for calculations to be made. 

 

 

Gusset plates should be calculated first. This gives you the information needed to detail the 

gusset plate and brace. You can calculate all the gusset plates first on a job and save the 

information to be used later or you can calculate them as needed. 

 

 

CALCULATION OF GUSSET PLATES 

Determining the number of bolts: 

There are four different ways to determine the number of bolts. They are as follows: 

 

1:  Load > 0 

 Area = 0 

The number of bolts will be determined by the load. 

 

2: Load = 0 

 Area > 0 

The load will be determined from the area based on the strength of the member. If your brace is 

double angles you must give the total area of both angles to determine the correct load. 

 

3:  Load > 0 

 Area > 0 

The load used will be the greater of the load given or the load as determined in condition number 

2. 

 

4:  Load = 0 

 Area = 0 

You will be asked to furnish the number of bolts in the brace. The load will be determined by 

the number of bolts times bolt value times number of shear planes. The number of bolts for the 

horizontal and vertical vectors will be determined from this load. 
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Note! 

The tear out of the brace and gusset plate will not be checked if the load and area are input as 0. 

The number of bolts input will be the number used. The design method used for calculating 

loads is set in your customer configuration. 

 

Dimension #A 

This is the dimension from the work point to the first hole in the brace. If you leave it blank, the 

dimension will be determined for you based on the rule of thumb clearance method. If you input 

a dimension, you will be asked to give the desired clearance. If the dimension you input works 

with the given clearance, then it will be used. If it does not work the correct dimension will be 

calculated based on the given clearance and that will be used. This means that the program can 

be used to check as well as detail a gusset plate by entering the dimension the detailer used. 

 

If you prefer using a specific clearance rather than the rule of 

thumb clearance method, simply enter 0 (zero) for "A". 

 

The rule of thumb clearance method: 

"A" is based on "B" + 1 1/2" to nearest interference. 

 

Remember, positive dimensions will be in the direction of the 

picture and negative dimensions will be in the opposite direction. 

 

At the end of the program you will be able to get a print of the input and the output, save the 

output in a file on the hard drive or draw the gusset plate. If you select Draw, the program for 

drawing the gusset plate will begin. If you select Save, the information will be written to the 

hard drive in a folder and file name of your choice. A dialog box is used to select the folder. The 

file name will generally be the connection number. Do not give an extension for the file name. 

An extension of ".gus" will be added automatically. After saving the gusset plate you can use 

the GUSSET PLATE DRAW program at any time to draw it. If you do not save it, you only 

have one chance to draw it. It is better to save and then draw.  

Command:    Pick [AutoSD or AutoSD II] > Bracing > Gusset Plate (Brace)  

 

 

 

 

 

 

 

 

 

 

 An icon menu appears.   Another icon menu appears for orientation. 

 Pick the gusset plate type 
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After selecting the orientation, a dialog box is put on the 

screen with the gusset plate type and in the orientation 

that you picked. 

 

After selecting the options at the top and filling in all the 

empty boxes select OK at the bottom of the dialog box. 

 

You can enter 0 for #A if you want to give a specific 

clearance instead of using the "Rule of thumb” method. 

You can also input a distance. If it works with the given 

clearance it will be used. If it does not work the correct 

distance for the given clearance will be used. 

 

Another dialog box is put on the screen. Select the 

options at the top and select a brace size. The area of the 

brace selected will be displayed in the "area" box. If you 

selected an angle you can select whether you have 1 or 2 

angles. If you select 2 angles the value in the "area" box 

will be doubled and you will need to select the separation. 

 

The three boxes under “Bolt/PL Size Overrides” is for 

entering values to override the calculated values. If a side 

of the plate is bolted, you would enter the number of bolts 

to use. If a side is welded, you would enter the length of the 

plate to use. If the program calculates a smaller size than 

the one given, the size given will be used. Selecting "Other" 

under bolt value allows you to enter a "User Value" for bolt 

shear. 

 

If you edit an existing gusset plate file, these boxes will 

be filled in to force the program to re-calculate the same 

size plate. If you want to calculate the actual size and 

number of bolts needed you should delete the values in 

these three boxes. 

 

When you have entered all the information needed, select 

OK. 

 

The gusset plate is calculated, and the answers are put in 

another dialog box. You can select to Draw, Save as and 

Print at the bottom of the dialog box. If you want to make a change you can select previous to 

go back to the previous dialog box. Picking OK will save the current file and close the dialog 

box. 
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If gusset plate tear out had been a factor, a warning message would be printed at the command 

line. You would then have the option to increase the gusset plate thickness or let the program 

increase the number of rows until tear out is eliminated. 

 

If the gusset plate is welded to the brace the plate will be sized 1” bigger in the direction of the 

brace. 

 

Dimensions 5, 6, and 13 are always above the work line and 5a, 6a and 13a are always below 

the work line. If 5 & 5a, 6 & 6a or 13 & 13a are not the same, that is, your connection is not 

symmetrical about the work line, you will need to calculate a separate plate for each end of the 

brace. Gussets calculated in a quadrant that are not symmetrical should be drawn only in that 

quadrant. Otherwise, the plate will not be correct. Plates with holes that are symmetrical about 

the work line can be drawn in any position.  

 

Note: In order to calculate a gusset plate with a single line of holes offset below the work line 

you would input 5 as negative and the same absolute value as 5a. In other words, if 5a is .01 

then 5 must be -.01. 

 

PRINTING FILE  

 Below is what the print of the input and output looks like. A print like this one without the input 

or output listed along with a copy of each gusset plate type and each orientation is provided for 

your use in appendix C. They can be used by other draftsman to write in the input. Your CAD 

operator can input the information and get a print of the output to be used by the draftsman to 

detail the gusset by hand. This will be a big, time saver for those that have only one CAD station. 
 

Connection NO. 1         TYPE: 1   Quad: 1     DATE: 9-29-2012  10:24am 

   

Load on brace --------------------------: 38.9 

Total area of brace(s) -----------------: 2.40 

(+)tension (-)comp (*)both -------------: + 

    Smaller radius of gyration ---------: 1.240  

    Is brace "X" (Yes/No) --------------:   

Percent of tensil strength -------------: 50 

Percent of compressive strength --------:  

Bolt size ------------------------------: 3/4" 

Edge distance --------------------------: 1 1/2" 

Bolt value single shear ----------------: 7.50 

Bolt spacing ---------------------------: 3.0 

Grade of steel Fy = --------------------: 36 

Grade of gusset plate Fy = -------------: 36 

Bolts in (1)Single or (2)Double shear --: 1 

Thickness of brace ---------------------: 5/16" 

Thickness of gusset plate --------------: 5/16" 

Horizontal connection is ---------------: welded 

Vertical connection is -----------------: 2 clips     Setback --: 1/2" 
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Actual clearance is --------------------: 1 1/16" 

Corner is clipped 

Brace is bolted to gusset plate. 

   

     INPUT                 OUTPUT  

  

#1 : 12.0000    A: 1.0006     Load Slope: 38.9 

#2 : 10.0000    B: 1.0300     Load Horiz: 29.9 

#3 : 0.0000     C: 0.0608     Load Vert : 24.9 

#4 : 0.0600     D: 0.0415     Bolt Slope: 6 

#5 : 0.0000     E: 1.0900     Bolt Horiz: 0 

#5a: 0.0000     F: 1.0604     Bolt Vert : 4 

#6 : 0.0200     G:            Weld Slope:  

#6a: 0.0200     H:            Weld Horiz: 3/16" Min. fillet 

#7 : 0.0300     K:            Weld Vert : 3/16" Min. fillet 

#7a:                          Angle     : 39.8056 

#8 : 0.0300                   Bevel     : 10" to 12 

#9 : 0.0000                   Slope     : 15.0707 

#10: 0.0300      

#11: 0.0000 

#12: 0.0000 

#13: 0.0310 

#13a 0.0310 

   

Minimum clip angle thickness is 1/4". 

Minimum gusset plate thickness is 5/16" 
 

 

VIEWING FILE  

 To the right is a view of the file 1.gus that was saved 

from the calculation of gusset plate type 1. Pick VIEW 

.GUS FILE from AutoSD > Bracing menu to view a 

gusset file. Enter the folder name and select the file. 

This view of the file is provided for reference in case 

you need to verify an input. 

 

LIST .GUS FILES  

 This command will give a complete listing of the file 

names with the extension ".gus" in the folder that you 

enter. The ".gus" files are created when you save a 

gusset plate calculation to be used to draw a gusset 

plate. 
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EDIT GUSSET PLATE   

 This command allows you to edit an existing gusset plate file. 

 

DRAWING GUSSET PLATES 

In order to draw a gusset plate, you must first calculate one and save the output in a file (See 

"CALCULATION OF GUSSET PLATES"). When you select DRAW GUSSET PLATE from 

the menu under AutoSD > Bracing you will be asked for the folder and file name of the gusset 

plate you wish to draw. After giving a valid name you are prompted for the work point location 

and the quadrant the gusset plate is in. There are 4 quadrants. Upper right, upper left, lower left 

and lower right. The quadrant you pick does not have to be the same as the one chosen in the 

calculation program unless the connection is not symmetrical about the work line. 

 

Once a name is accepted, the program starts drawing the plate. After the outline of the plate is 

drawn and the holes are put in the plate you are prompted for the location of the horizontal 

dimensions of the plate. These dimensions are from the work point to the first hole for the brace. 

If the plate has any holes on the horizontal side for a connection of the plate to a beam you are 

then prompted for the location of the dimensions for these holes. This same procedure is repeated 

for the dimensions on the vertical side and for the dimensions on the slope. 
 

Command:     Pick [AutoSD or AutoSD II] > Bracing > Draw > Gusset Plate 

Customer folder <D:\ACAD\>: C:\SSS\95-01\MISC files 

Connection number: 1 

Reading file ... Done 

Work point location:      Pick the work point 

Pick quadrant gusset plate is in:  Upper right, upper left, lower right, lower left.  

Are you inserting gusset plate on brace <N>: Enter    If you are, the holes and dimensions  

         on the slope will not be drawn they  

Piece mark for vertical clip:     will be on the brace. 

Enter angle mark or use <aa>: Enter 

Add piece to shop bill (Y/N) <Y>: Enter 

Shop bill information on aa 

 quantity <2>: Enter 

Place shop bill text on LINE <4>:  

 Description: L3x3`8x`5 

(FT.IISS) Gage of clip: .0109 

Horiz. & vert dimensions go to (1)first, or (2)last hole <1>: Enter 

Location of horiz. dimensions for brace holes:  Pick location above or below the plate 

Location of vertical dimensions for brace holes: Pick location to the right or left the plate 

Location of dimensions for vertical holes:  Pick location to the right or left the plate 

Location of dimensions on slope:    Pick location above or below the work  

         line 

Location of arrow for plate size:    Pick one side of the plate 

Location of plate description:    Pick location 

(FT.IISS) Plate thickness <3/8">: Enter 
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Enter plate mark or use <pa>: Enter 

 quantity: 1 

Place shop bill text on LINE <5>: Enter 

Placing bevel 

Select line:       Select a point on the work line 

Select side for symbol: 

(FT.IISS) Bevel <10">: Enter 

Angle <39.8056>: Enter 

Command:        Finished. 
 

The plate size is rounded up to the nearest 1/8". The detail of the gusset plate is affected by the 

[AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. The plate below on 

the left used the option for horizontal and vertical dimensions to go to the first hole. The plate 

on the right used the option for horizontal and vertical dimensions to go to the last hole. 

 
 

 

If you want to calculate the weight of the plate, use the CALCULATE GUSSET PL WEIGHT 

command and simply pick one edge of the plate and enter the thickness. The weight will be the 

finished weight with corners clipped and blocked. The scale is affected by the [AutoSD > 

Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

DRAWING BRACES 

The brace program will draw several types of braces, "X" braces and simple braces. You should 

be able to detail a sheet of braces in about an hour. This includes calculating the gussets and 

filling out the shop bill. 

 

The different types are listed below. 

 

• Angles  - Single or double, simple or "X" 

• WT  - Flange view, simple or "X" 

• Wide flange - Web view, simple only. Flange view, simple or "X" 

• Channel  - Web view, single or double, simple or "X" 

• Pipe  - Simple or "X" 



Bracing, Chapter 8                                                  AutoSD Steel Detailing  

142 

• Tube  - Simple or "X" 

 

The gusset plate calculation program should be run first to get the necessary input such as 

number of rows and distance from work point to first hole in brace. The brace program will draw 

the brace to scale and to the actual bevel. It will calculate tail dimensions, work lengths, cut 

lengths, the intersection point for "X" braces, and number of fillers for double angle braces. 

"DRAW" will be taken out of simple single angle braces. 

 

For simple braces, the brace will be drawn in the same direction as the one you pick from the 

icon menu for orientation. For "X" braces, the braces will be drawn in the same direction as 

shown in the slide view that is used to get the input data. 
 

Command:    Pick [AutoSD or AutoSD II] > Bracing > Draw > Brace 

 

  

 

 

 

 

 

 

 

 

 

 

An icon menu appears.     Another icon appears. 

Pick the material shape.     Pick the type of brace. 

 

Customer folder </SSS/95-01/MISC files>: Enter 

Is brace double angles (Y/N): Y 

Are fillers bolted (Y/N): Y 

Is brace in compression (Y/N): N 

Select Brace Size      Select a L3 1/2 x 3 x 5/16  

(FT.IISS) Separation of angles: .0006 

Read connection file for #A1: Y If you answer "N" you must input the information manually 

Read connection file for #A2: Y 

Read connection file for #A3: Y 

Read connection file for #A4: Y 

(FT.IISS) Bolt spacing <3">: Enter 

Connection file for #A1: 1 

Draw length #A1 to scale (Y/N) <Y>: Enter 

Connection file for #A2: 1 

Draw length #A2 to scale (Y/N) <Y>: Enter 

Connection file for #A3: 1 

Draw length #A3 to scale (Y/N) <Y>: Enter 
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Connection file for #A4: 1 

Draw length #A4 to scale (Y/N) <Y>: Enter 

Bolt size:  (5)5/8"  (6)3/4"  (7)7/8"  (8)1"  (9)1 1/8"  (10)1 1/4" <6>: 

(FT.IISS) Input #8 <0">: Enter 

(FT.IISS) Input #9 <0">: Enter 

Insert point at left end:    Pick a point for the lower left end of brace. 

 

 

The main brace (shown as Brace 1 in the slide to the 

left) is drawn first. The insertion point is the lower left 

end. Brace 1 and 2 will be drawn second and third and 

their insertion point is the upper left end. 

 

 

 

 

 

 

 

The last mark was 1 

              Main mark: 1D1 

Are marks RIGHT and LEFT (Yes/No) <N>: Enter 

               Quantity: 1 

Sub assembly mark for brace: aa      

Shop bill information on mark 1D1 

Place shop bill text on LINE <11>: Enter 

Shop bill information on mark aa`H 

Sub assembly mark for filler plate: pa 

Shop bill information on mark pa 

(DECIMAL) Bolt value single shear <6.6300>: 9.9 

ASTM = (A36/A572/A588/A992) <A36>: Enter 

(FT.IISS) Thickness of center plate <3/8">: Enter 

*** For same area as brace, Width of plate should be 11 

3/4".*** 

(FT.IISS) Width of center plate using 

Load/Thickness/(0.6Fy) = <7">: Enter 

Sub assembly mark for center plate: pb   

Shop bill information on mark pb     

 

          First Brace is drawn 
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Insertion point at left end of brace #2:  

 Pick a point for the upper left end of brace. 

The last mark was 1D1 

              Main mark: 1D2 

Are marks RIGHT and LEFT (Yes/No) <N>: Enter 

               Quantity: 1 

Sub assembly mark for brace: ab 

Shop bill information on mark 1D2 

Place shop bill text on LINE <18>: Enter 

Shop bill information on mark ab`H 

Sub assembly mark for filler plate <pa>: Enter 

Shop bill information on mark pa 

          Second Brace is drawn 

Insertion point at left end of brace #3:      

 Pick a point for the upper left end of brace. 

The last mark was 1D2 

              Main mark: 1D3 

Are marks RIGHT and LEFT (Yes/No) <N>: Enter 

              Quantity: 1 

Sub assembly mark for brace: ac 

Shop bill information on mark 1D3 

Place shop bill text on LINE <24>: Enter 

Shop bill information on mark ac`H 

Sub assembly mark for filler plate <pa>: 

Shop bill information on mark pa 

Command:         Third Brace is drawn 
           

NOTE: 

• For double angles there will be a minimum of two fillers for braces over 6'-0" long and 

a minimum of one filler for braces less than 6'-0". The 6'-0" control is from hole to hole. 

• Dimensions A1, A2, A3, and A4 may be 0 (zero). 

• Number of rows of bolts may be 0 (zero). 

• Enter 5 as the same value as 5a and negative to calculate a gusset with a single line of 

holes offset from the work line. 

• The number of bolts may be different at each end of the brace. This is to allow one end 

to be bolted and the other end to be welded. 

• If the end information is read from files, one end may have a single line and the other 

end may have a double line of bolts. 

• Offsets #8 and #9 for drawing braces may be entered as positive or negative. A positive 

dimension will offset the work points in the direction shown and a negative dimension 

will offset the work points in the opposite direction. 

• #1 can be 0 to draw a single brace in the vertical position. 

• #2 can be 0 to draw a single brace in the horizontal position. 
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Welded Brace 

This is for drawing a brace with the ends mitered to fit against other members in a rectangular 

frame.  

Command:   Pick [AutoSD or AutoSD II] > Bracing > Draw > Brace 

 

 

 

 

 

 

 

 

 

 

An icon menu appears. Another icon menu appears.  A dialog box is used to enter  

Pick Welded   Pick the type of brace.   dimensions. 

  

If the lower end is on a horizontal support and not at a corner, enter #3 as a negative number that 

would cause the vertical line for #3 to fall to the left of the 

extreme end point of the brace. This will give a single cut at 

the end of the brace. This same technique can be used at each 

end for #3, #4, #5 and #6.  

  

 

Member size is selected from a 

 dialog box 

 

After entering the dimensions and 

selecting a member size and 

insertion point the brace is drawn 

and billed out. 
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HSS IN FRAME 
 

Command:   Pick [AutoSD or AutoSD II] > Bracing > Draw > HSS in Frame 

 

 

Step 1   Step 2   Step 3   Step 4 

 

This command is for drawing the tube members in a welded frame. Start with the frame as shown 

in Step 1 with the continuous members and the centerlines of the cross members drawn. Pick 

the “HSS in Frame” command and pick a cross member centerline. Enter the width of the tube 

for the cross member. It will be drawn between the continuous members as shown in Step 2. 

Complete all the cross members and then draw the centerlines of the diagonals as shown in Step 

3. Pick the “HSS in Frame” command and pick a diagonal centerline. Enter the width of the tube 

for the diagonal member. It will be drawn between the continuous and cross members as shown 

in Step 4. 

 

ROD BRACE 
 

Command:  Pick [AutoSD or AutoSD II] > Bracing > Draw > Brace > Rod w/Turnbuckle  

Rod Brace can detail a two-piece rod brace with or 

without a turnbuckle. The ends can have a clevis, 1 

nut, 2 nuts, a nut with a hillside washer, a plate with 

one hole or be left plain. Rod size is from 3/8” to 5”. 

Select a rod size and the turnbuckle list is changed to 

match the rod size, data on the turnbuckle selected is 

given in the lower right corner of the dialog box and 

a suggested clevis size along with its data is give in 

the upper right corner. 3/8” - 3/4” rods only have one 

clevis size but 7/8” and larger have more than one 

size available. 

 

Select the end conditions and a turnbuckle length. If 

a clevis is used and more than one is available, select 

the one needed. Now click on the “Calc Defaults” 

button. This will fill in some of the entries based on 

the end condition and turnbuckle selected. Verify these values and enter the remaining entries. 

#1 can be 0 to draw the brace in the vertical position. #2 can be 0 to draw the brace in the 

horizontal position. Select the pin type and pick OK to draw the rod brace. Pick Print to print 

the input. 
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Insertion point at left end: 

Main mark: 1D1 

Are marks RIGHT and LEFT (Yes/No) <N>: Enter 

Quantity: 1 

Sub assembly mark for rod @ left end: ra 

Sub assembly mark for rod @ right end: rb 

Sub assembly mark for Turnbuckle: ma 

Sub assembly mark for Clevis: mb 

Sub assembly mark for Clevis Pin: mc 

Shop bill information on mark 1D1 

Place shop bill text on LINE <4>: Enter 

Shop bill information on mark ra 

Shop bill information on mark rb 

Shop bill information on mark ma 

Shop bill information on mark mb 

Shop bill information on mark mc 
 

 

PARALLEL BRACE TOWER 
 

Command:   Pick [AutoSD or AutoSD II] > Bracing > Parallel Brace Tower  

Select 2 or 4 sides. If 4 sides are selected, H will be the vertical height and a new height will be 

calculated for the true length. Enter values for B, H, T and select the number of panels. Pick 

Calc to get the results. 

 

The results may be viewed one panel at a time. Pick Draw to draw the tower with all dimensions. 

 

Picking OK will close the dialog box. 

 

CALCULATE GUSSET PLATE (Truss)  
 

Command:   Pick [AutoSD or AutoSD II] > Bracing > Calculate Gusset PL (Truss)  

Select the plate type and orientation. Select a diagonal and vertical member and whether there 

is 1 or 2 required. If the member is a pipe or tube the program defaults to only one member 

required. Enter the load on each member or enter 0, (zero), to use the area for calculating the 

load in tension and select a grade of steel. Enter dimension “A” to check an existing plate detail 

or leave it blank to let the program calculate the minimum for “A” with the clearance given for 

#4. Enter all dimensions required and pick Calculate to get the answers. Pick Print to print the 

answers on the drawing using a leader.  

The loads on the output, and used to calculate the welds, is the greater of the load entered and 

the load calculated based on the area of the members in tension. 

Output “A” is the greater of “A” from the input column and the dimension calculated to achieve 

the given clearance. 

WS = length of weld on diagonal member. 
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WV = length of weld on vertical member. 

WH = length of weld on horizontal edge of plate. 
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Chapter 9 - Columns 
 

All programs in this chapter are under the AutoSD > Column pulldown menu, Columns toolbar 

and AutoSD II > Columns ribbon menu. 

 

This program is for detailing columns in a vertical position only. Columns can be 

detailed from a column file or they can be detailed by supplying the connections 

manually. A column file can be created when the beams are detailed that frame into 

a column or it can be created from the Elevation Generator or it can be created from 

scratch using the "Edit Col File” program. All column file names have an extension 

of “.col” and will be saved in your job sub folder “MISC files”. Column files must 

be edited before they can be used if they were created when detailing beams or from 

the Elevation Generator. The least you must do is Pick OK when the "Column 

Connection" program opens. You should, however, check the file to be sure all connections are 

listed and add holes for any bracing connections. If you edit a file and later add another 

connection from the beam program the "Column Connection" program will launch when you 

detail that column in order to update the column file. If you have wing plates in the web with 

stiffeners, the stiffeners must be listed first if you want the wing plate to extend to the stiffeners. 

 

Splices and any additional connections can be added after the column is drawn. Chain 

dimensions and tail dimensions are calculated and placed on the drawing for you.  

 

Draw left side: Checking this will draw face 

“A”. 

Draw right side: Checking this will draw face 

“C”. 

Column size: Pick the button to change the 

size of the column. You can detail wide 

flange, channel, pipe and tube columns. 

Cantilever member: If you have a beam or 

girder spanning across the top of the column 

you can enter the depth of the beam or girder. 

Picking the “Select” button allows you to 

select a beam size and will fill in the beam 

depth for you. 

Base plate: Base plates can be put on by the 

column program or they can be added later. Checking “Show edge view” will draw a base plate 

at the bottom of the column and give you the option to draw the plan view. Leaving it unchecked 

will cause the column to be drawn without a base plate. Base plates can be rotated when they 

are drawn. 

Cap plate: Cap plates can be put on by the column program or they can be added later. Checking 

“Show edge view” will draw a cap plate at the top of the column and give you the option to draw 

the plan view and add stiffeners. Leaving it unchecked will cause the column to be drawn 

without a cap plate or stiffeners. 
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Rotate cap plate in plan: Cap plates can be rotated 

to any angle between 90 and -90. 

Slope cap plate from horizontal: Cap plates can 

be sloped to any angle between 75 and -75. or to 

any bevel between 45 and -45. Picking the Help 

button will open the dialog box shown to the left. 

 

Finish note at bottom, Finish note at top: 

Checking these boxes and entering a note will 

place that note on the detail. These notes are 

independent of the customer configuration. 

Include Girt connections: Checking this option will include a string of dimensions on the right 

side for girts and add girt connections to the column connection dialog box. 

 

Stiffeners:  

Pick the image under 

Stiffeners to open the 

options for stiffeners. 

The pictures to the right 

show the various 

shapes you can 

have for stiffener 

plates. A 

stiffener will not 

be drawn on the flange of a “W” shape or 

any side of a tube or pipe if the cap extends less than the value entered for the minimum 

overhang. 

 

Column Grid | Reference: After entering the main mark and quantity you are prompted for the 

Column Grid | Reference. This is optional information that will be placed under the main mark. 

Pressing the enter key without supplying any text will omit this option. Entering text with the 

“|” character, as in “150|11”, will place the “150” grid number over the “11” reference number 

separated by a line. 

 

If you draw the column by supplying the connections manually, you have the option of drawing 

faces A and C. If you do not draw face A or C and have a connection in face A and B at the 

same elevation, the dimensions will overwrite each other. You should draw a face if you have 

any connections in that face. Face A is the left flange, B is near side web, C is right flange and 

D is far side web. Start with the lowest elevation and work your way up. When you see the 

prompt “Hole Spacing” or "From Elev. Down” or "From Elev. Up”, enter the spacing in the 

format the drawing was set up to use, i.e. (FT.IISS or millimeters for metric). 3 rows of holes at 

a spacing of 4 1/2" with the first hole starting 3" below the elevation would be entered as 

.03,.0408,.0408 or .03,2@.0408. If you do not have any holes above or below the elevation just 

press enter at the prompt. Entering 0 will put a hole at the referenced elevation. 
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If you draw the column by using a column file, the program will draw face B and one or both of 

the other two faces. When prompted for the insertion point, a highlighted box will appear. The 

outline of the box will be the limits of the picture for the column. Pressing the “+” key will 

increase the height of the box making the column taller. At maximum height the column will be 

drawn to scale and the spacing of connections will be to scale. Pressing the “-” key will decrease 

the height of the box making the column shorter but it will not be made shorter than the originally 

calculated height. Increasing the height will give you more space between elevations. This box 

will enable you to position the picture on your sheet. If part of the box goes off the screen you 

should cancel the program. Zoom out and try again until the entire box is visible. When you 

have holes, you will be asked for the "GAGE” and "MAIN GAGE”. The "GAGE" is for the 

individual connection. The "MAIN GAGE" runs the length of the column and will be 

dimensioned above the top. If the "GAGE" and "MAIN GAGE" are different the connection 

will be dimensioned with the "GAGE". 

 

Before detailing columns, you should configure your 

customer. See page 17 for CUSTOMER 

CONFIGURATION. 

 

Configuration options include location of piece mark, 

overall length to top or bottom of base plate, overall 

length to top or bottom of cap plate, and overall length 

placed above or below description. Extend wing plates 

through tube or pipe column, (Only for non-skewed 

plates). 

 

BASE PL EDGE VIEW 

CAP PL EDGE VIEW 

These two programs will draw the edge view of a plate on an existing column. They are affected 

by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 

 

BASE/CAP PLAN 

This is for creating base/cap plates and drawing the 

plan view.  

Symmetrical options: A check in these boxes will 

automatically fill out the “symmetrical” value when 

the first value is entered. 

Browse: Look in other folders for the basecap.pl file. 

Enable all: Turns on all input boxes. 

Delete: Deletes the select mark. 

Rotate 90: Rotates all input so plate will be rotated 

counter-clockwise 90 degrees. 

Save As: Saves current plate as a different mark. 
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Select: Opens a dialog box for selecting standard plate configurations. Input boxes will be 

disabled to make it easier to input for a plate type and hole pattern. 

Hole size in plan view: These options are for noting the hole size. “Omit” will not put a hole 

size. “Circle plate” will put a rectangular hidden line around the plate with a hole size. “Text 

only” will note the hole size under the plate size. This setting is separate for base and cap plates. 

 

The scale is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing 

command when drawing a plate. 

 

VIEW BASE/CAP FILE 

Base and cap plates are both saved in a file called BASECAP.PL and is in your customer job 

sub folder “MISC files”. Descriptions can be replaced, added to, edited and deleted from this 

file. This dialog box is also used by other programs to select a saved plate for detailing. 

 

If you edit a description, picking Cancel will cause you to lose all changes. Picking OK will 

save all changes to the file. Picking Browse will allow you to select a basecap.pl file or an older 

cap_base.pl file from another folder. Picking Enable All will enable all options and set the hole 

pattern to the default. Delete will remove the current selection. Rotate 90 will relocate all 

dimensions to rotate the plate counter clockwise 90o. Select lets you select a preset plate 

configuration. Save As will save the current selection as another mark. Plate marks can be saved 

as upper or lower case but is not case sensitive. You cannot save a mark pa and a mark PA. The 

mark you use to save the plate as does not have to be the piece mark used in the detail, but it is 

the default. 

 

There are two sets of input, one for the plate and one for the holes. Plate dimensions A, B, C, D 

and M must be entered. All other dimensions are optional. Leave the dimension blank if that 

option is not needed. Dimensions B, D, F, H, J, L, N and Q for Holes may be entered as a single 

dimension or as a list. Lists are dimensions separated by commas. Example: .03,.03,.03 or 

3@.03. Leave all dimensions blank if you do not want a hole at that location. 

 

If the plate is symmetrical about the horizontal or vertical center line you can put a check in the 

box for that option. Enter the dimension for one side and the other side is entered for you when 

you leave that box by pressing the tab key. If you check both horizontal & vertical, enter the 

dimensions in one corner and then “tab” through the others to fill them in automatically. 

 

The rotation of the bolt pattern is based on the column web being horizontal. 

 

SKEWED PL TOP VIEW 

This is like the program of the same name under the AutoSD > Beams pulldown menu. The 

program for columns can draw the end view of the column with the plate drawn at any angle, 

including 0 and 90. The column can be any wide flange, pipe or tube. The scale is affected by 

the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command. 
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SPLICES 

There are eight types of splices. These are 

the same splices that are shown in the AISC 

Steel Construction Manual. 

 

This program is used to add a splice detail 

to an existing column detail. 

Splices are for "CB/HP/M/S/W" shapes 

only. 

 

You can create a splice for any size column from 4" to 44" but only the following columns will 

use the guidelines set in the AISC manual. 

W8x24, 28, 31 to 67 

W10x33 to 45 and 49 to 112 

W12x40 to 50, 53 to 106 and 120 to 336 

W14x43 to 53, 61 to 82, 90 to 193, 211 to 283, 311 to 426 and 455 and over. 

When using a bolted splice, the default rows are from the guidelines set in the AISC manual for 

the column sizes listed above. 

 

EDIT COLUMN FILE 

 

This program is used to 

process or edit an existing 

column description file or 

create one from scratch. 

When you select "Edit Col 

File" from the menu this 

program is launched. 

 

Use your mouse to select 

items in the program or use 

the tab key to move forward 

and shift + tab to move 

backward. If you have 

created a description file 

from the beam program pick 

OPEN. Change the 

directories box to your 

customer job sub folder 

“MISC files”, select the file and then select Open or double click on the file. 

 

A list of elevations is shown in the Elevations box at the top of the screen. They will be listed in 

order with the lowest elevation at the bottom. The number of connections at a selected elevation 

is shown to the right of the Elevations in the Connections box. You change from one connection 
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to another at the same elevation by selecting a different number in the Connections box. The 

FACE box indicates which face the connection is on. Face A is the left flange, B is near side 

web, C is the right flange and D is far side web. 

 

New  

Creates a new empty column file. 

 

Open 

Opens an existing column file. 

 

Save 

Saves the current column file. 

 

Save as 

This will save the current file under a different name giving you a copy. This is useful when you 

have two columns that are similar. After completing the description file for one column, SAVE 

it for that column and then SAVE AS a different file name for the other column. The program 

will switch to the new copy and you can make the changes needed. 

 

Merge file 

This is used to merge two column files together. This is useful when you have more than one 

person working on beams that frame into common columns or when you create column files 

from the Elevation Generator. 

 

Column size 

Select the column size being detailed. The depth, width, flange gage and web gage are displayed 

for “W” & “C” shapes. 

 

Elevations box  

ADD will add a new elevation with one connection called “NONE”. 

CHG will change the elevation of all connections at the selected elevation if the elevation you 

change to does not already exist. CHG will change only the elevation of the connection selected 

if you change to an existing elevation. 

DEL will delete all connections and the elevation of the selected elevation. 

 

Connections box  

MOVE UP & MOVE DOWN will change the order if there is more than one connection at the 

selected elevation. Use to arrange wing plates and stiffener plates. 

ADD will add a new connection to the selected elevation. 

COPY will copy a connection from one elevation to another or to the same elevation. 
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DELETE will delete only the connection selected if there is more than one at the selected 

elevation. 

 

HINT: If you have connections differing in elevation by 2 1/2", change the lower elevation to 

be the same as the higher one and increase the first dim from elev. down by 2 1/2". This will 

reduce the clutter of dimensions when the column is detailed. 

 

The large box in the middle of the screen shows the type and dimensions for the connection. 

Conn. is a pop down list of all available connections. Pick the box or the arrow at the right end 

and the list will pop down. Select the connection desired and the appropriate fields will be 

displayed below, and a reference picture will be shown to the right. Below Conn. are the 

dimensions for the selected connection. Enter the dimensions in the format indicated in the title 

of the main screen. The example shown is FT.IISS. Press the tab key after each dimension and 

the cursor will jump down to the next dimension to enter. Dimensions for "FROM ELEV. 

DOWN" and "FROM ELEV. UP" are entered as a list of dimensions separated by commas. 

Example: .03,.03,.03,.03 or 4@.03. Selecting a value under Rows will automatically fill in the 

list of dimensions for the number of rows selected. 

 

If wing plates extend through a tube or pipe column you should list the plates that extend all the 

way through first. If you only have two connections at a given elevation and they are on adjacent 

sides, (90 degrees to each other), the connection listed first will extend through, so it should 

have the most rows. If one of the plates is skewed it must be listed last. Use the Move up and 

Move down buttons to change the order. 

 

If you want the wing plate in the web to extend upward and downward to weld to stiffener plates, 

the stiffeners should be listed first and the wing plate second. If the wing plates are listed first 

they will not extend to the stiffener plates. 

 

Import gusset 

This is used to add the hole spacing for a gusset plate 

connection that uses clips on the gusset to connect to a 

column. When selected, a file and folder dialog box 

pops up. After selecting the file another box pops up 

asking for the placement of holes. Select above or below beam and then select OK. If you select 

below beam another box pops up asking for the location of the work line. Enter the dimension 

and select OK. 

 

There are 16 different connections available to the column program. 15 are shown below. The 

16th is “NONE”. It puts an elevation line with no connections for use in allowing space for 

adding a detail later. Start by picking AutoSD > Columns > Connections. After completing one 

connection you can start another one by pressing Enter. 
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CONNECTIONS 

 

 (1) Clip Angle 

GAGE is from center of column to center of holes. 

OFFSET is from center of column to face of clip. It is the 

gap between clips if you have 2 clips.  

COL GAGE is the gage of the column. Enter 0 if the clips 

are shop welded to the column.  

 

FROM ELEV DOWN is the location of holes below the 

given elevation. Use the Rows pop down list to select the 

number of rows needed or input as a list of dimensions 

separated by a comma. Example: .03,.03,.03 or 3@.03 

FROM ELEV UP is the location of holes above the given 

elevation. Use the Rows pop down list to select the 

number of rows needed or input as a list of dimensions separated by a comma. Example: 

.03,.03,.03 or 3@.03 

 

(2) Girt Angle 

GAGE OSL is the gage of the outstanding leg. This can 

be 0 if no holes are required. OFFSET is from the 

elevation line down to the heel of the angle. HLS RIGHT 

is from center of column to center of first hole to the right. 

HLS LEFT is from center of column to center of first hole 

to the left. #1 and #2 is how far the angle will extend from 

the center line. HOLE SPACING is the spacing between 

holes input as a list of dimensions separated by a comma. 

Example: .03,.03,.03 or 3@.03 

ANGLE IS TOED Up or Down is the direction of the 

vertical leg. 

 

 

(3) Girt WT 

GAGE is the gage of the WT flange. This can be 0 if no 

holes are required.  

OFFSET is from the elevation line down to the flange of 

the WT.  

LENGTH is the length of the WT from the column center 

line. 

HOLE SPACING is the spacing of holes from the center 

of the column to be input as a list of dimensions separated 

by a comma. Example: .0608,.03 

STEM IS TOED Up or Down is the direction of the stem. 

mailto:3@.03
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(4) Joist Angle 

This is a joist bottom chord stabilizer angle. Do not use 

this connection for a seat. 

JOIST DEPTH is the distance from the elevation to the 

top of the angle. 

LENGTH is the cut length of the angle. 

ANGLE IS TOED Up or Down is the direction of the 

vertical leg. 

 

(5) Joist Plate 

This is a joist bottom chord stabilizer plate. 

HORIZ is the horizontal size of the plate. 

VERT is the vertical size of the plate. 

THICKNESS is the thickness of the plate. 

HORIZ EDGE is the horizontal edge distance for the hole. 

VERT EDGE is the vertical edge distance for the hole. 

DROP is the distance from the elevation down to the 

bottom of the plate. 

 

(6) Seat Angle 

GAGE is the distance from the center of the column to the 

hole. This can be 0 if no holes are required. 

HL C/C is the center to center of holes.  

VERT GA is the gage of the vertical leg. This should be 0 

if the angle is welded. 

VERT C/C is the C/C of holes in the vertical leg. 

LENGTH is the cut length of the angle. 

SEAT DEPTH is the distance from the elevation down to 

the top of the angle. 

STIFF THICK is the stiffener thickness if the stiffener 

option is selected.  

 

(7) Seat Plate 

GAGE is the distance from the center of the column to the 

hole. This can be 0 if no holes are required. 

HOLE SPACING is the spacing between holes input as a 

list of dimensions separated by a comma. Example: 

.03,.03,.03 or 3@.03 

HL C/C is the center to center of holes. This should be 0 

if GAGE is 0. 

HORIZ DIM is the horizontal size of the stiffener. 

VERT DIM is the vertical size of the stiffener. 

mailto:3@.03
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WIDTH is the width of the horizontal plate 

SEAT DEPTH is the distance from the given elevation down to the top of the horizontal plate. 

 

(8) Split T 

Split t can be WT, MT or ST. 

GAGE is from the center of the column to the first hole. 

OFFSET is from the center of the column to the side of 

the stem. 

COLUMN is the distance to the 2nd column of holes from 

the 1st. This is 0 or blank for one column. 

 

FROM ELEV DOWN is the location of holes below the 

given elevation input as a list of dimensions separated by 

a comma. Example: .03,.03,.03 or 3@.03.  

FROM ELEV UP is the location of holes above the given 

elevation input as a list of dimensions separated by a 

comma. Example: .03,.03,.03 or 3@.03. 

 

(9) Wing Plate 

 

GAGE is from the center of the column to the first hole. 

OFFSET is from the center of the column to the side of 

the plate. Positive goes to the right, negative to the left as 

viewed facing the side of the column the plate is on. 

THICKNESS is the thickness of the plate. 

COLUMN is the distance to the 2nd column of holes from 

the 1st. This is 0 or blank for one column. 

ANGLE is the angle from horizontal if the plate is on face 

A or C. It is the angle from vertical if the plate is on face 

B or D. 

 

FROM ELEV DOWN is the location of holes below the given elevation input as a list of 

dimensions separated by a comma. Example: .03,.03,.03 or 3@.03. 

FROM ELEV UP is the location of holes above the given elevation input as a list of dimensions 

separated by a comma. Example: .03,.03,.03 or 3@.03. 

 

If wing plates extend through a tube or pipe column you should detail the second plate that has 

a connection on the opposite side immediately after the first wing plate. If you only have two 

wing plate connections at a given elevation and they are on adjacent sides, (90 degrees to each 

other), the connection detailed first will extend through, so it should have the most rows. If a 

wing plate is skewed it must be detailed last. 

 

mailto:3@.03
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If you want the wing plate in the web to extend upward and downward to weld to stiffener plates, 

the stiffeners should be entered first and the wing plate second. If the wing plates are entered 

first, they will not extend to the stiffener plates.  

 

(10) Stiff Plate 

 

THICKNESS is the thickness of the plate. 

 

FROM ELEV DOWN is the location of stiffeners below 

the given elevation input as a list of dimensions separated 

by a comma. Example: 0,1.0112,.0308. 0 will put a 

stiffener at the elevation. 

 

FROM ELEV UP is the location of stiffeners above the 

given elevation. 0 will put a stiffener at the elevation input 

as a list of dimensions separated by a comma. Example: 1.0112,.0308. 0 will put a stiffener at 

the elevation. 

 

(11) Holes 

GAGE is the horizontal center to center of holes. 

FROM ELEV DOWN is the location of holes below the 

given elevation input as a list of dimensions separated by 

a comma. Example: .03,.03,.03 or 3@.03. 0 will put a hole 

at the elevation. 

FROM ELEV UP is the location of holes above the given 

elevation input as a list of dimensions separated by a 

comma. Example: .03,.03,.03 or 3@.03. 0 will put a hole 

at the elevation. 

 

 

(12) Flange Plate 

GAGE is the horizontal distance from center of column to 

center of the first hole. 

BEAM GAGE is gage of the beam that would bolt to the 

plate. 

THICKNESS is for both plates in this connection. 

ROWS is the number of rows of bolts in both plates. 

SPACING is the space between each bolt in both plates. 

WIDTH is the width of the plate. 

 

FROM ELEV DOWN is the location of plates below the 

given elevation. 0 will put the bottom of a plate at the 

elevation. 

mailto:3@.03
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FROM ELEV UP is the location of plates above the given elevation. 0 will put the bottom of a 

plate at the elevation. 

 

(13) Gusset Plate 

(Must have Bracing package) 

Work line of brace goes up or down. 

Select the one that suits your brace condition. 

 

“A” is the distance from the elevation up to the work point. 

“B” is the distance from the elevation down to the work 

point. You cannot have both for one connection. 0 will put 

the WP on the elevation. 

 

 

 

(14) Saddle 

GLB Size is where you can list the size of the GLB 

member. 

GAGE is the distance from the face of the plate T2 or the 

face of the column if T2 is 0 to the holes. This can be 0 if 

no holes are required. 

HL C/C is the center to center of holes. Can be 0. 

HORIZ is the horizontal length of the plates. 

VERT is the vertical length of the plates.  

WIDTH is the space between the two vertical plates. 

ANGLE is the angle from horizontal if the plate is on face 

A or C. It is the angle from vertical if the plate is on face 

B or D. 

DEPTH is the distance from the given elevation down to the top of the horizontal plate. 

PL THK T1, T2 & T3 are the thickness of the plates. T2 can be 0 of Angle is 0. 

FROM BOTTOM UP is the location of holes above the horizontal plate. Input as a list of 

dimensions separated by a comma. Example: .03,.03,.03 or 3@.03. 

 

(15) Stub 

GAGE is the gage of the flange. This can be 0 if no holes 

are required.  

OFFSET is from the elevation line down to the top of the 

stub beam 

LENGTH is the length of the from the column center line. 

HOLE SPACING is the spacing of holes from the center 

of the column input as a list of dimensions separated by a 

comma. Example: .0808,.03. 

 

 

mailto:3@.03
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Chapter 10 – Shop Bill 
 

Pulldown: AutoSD > Shop Bill > Shop Bill Text / Attributes 

Ribbon: AutoSD I > Shop bill 

 

The shop bill program will make it easy to fill out the shop bill using text or attributes. Text is 

easier to work with and you can extract both to an ASCII file where it can be used by other 

programs. The shop bill program can be easily configured for each customer that you detail for 

and you can have as many configurations as you need. The shop bill can be one column or have 

multiple bills side by side. 

 

Start a new drawing using the AutoSD.dwt template and run "setup", selecting Architect, 1" = 

1' and D- 24x36. Now select AutoSD > Shop bill from the menu and then “Insert Shop Bill”. 

Change folders to \AUTOSD\CUSTOMER and select 24x36BOM.dwg. A typical shop bill 

appears. (For METRIC, select a scale of 1:12 and paper size of D- 24x36. select the 

24x36BOM.dwg file located in \AUTOSD\BONUS\METRIC folder.) You can copy these files 

to your own job folder and edit them or create your own from scratch.  

  

Command:  Pick [AutoSD or AutoSD I] > Shop bill > Shop Bill Text / Attributes 

  A dialog box pops up. 

  Select “Unnamed - 24x36” under Shop bill and pick OK. 

 

Select/Place shop bill text on Line <1>: 5 

Main mark: 1B3 

Are marks RIGHT and LEFT (Y/N) <N>: Enter 

Quantity: 6 

Quantity for sequence 1: 2 

Quantity for sequence 2: 2 

Quantity for sequence 3: 2 

Select/Description: W14x22    Beam size. Enter S to select a member size. 

(FT.IISS) Length: 13.0508    13'-5 1/2 

Remarks:        Text is put in shop bill. 

Command: Enter      To start program again 

Select/Place shop bill text on Line <6>: Enter To accept line #6. 

Main mark: Enter      Toggles past main mark. 

eXisting/Sub assembly mark: pa    Sub mark. See note A below. 

Quantity: 6 

Select/Description: `P`3x3`4    PL 3/16 x 3 1/4 

(FT.IISS) Length: 1.0208    1'-2 1/2 

Remarks: Enter 

Command: Enter      To start program again 

Select/Place shop bill text on Line <7>: Enter To accept line #7. 

Main mark: Enter      Toggles past main mark. 
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eXisting/Sub assembly mark: aa    Sub mark. See note A below. 

Quantity: 12 

Description: L3`8x3`8x`5    L3 1/2x3 1/2x 5/16 

(FT.IISS) Length: .0808     0'-8 1/2 

Remarks: Enter      Finished  

Note A: If you enter “x” for the sub assembly mark the dialog box for “Edit Sub Mark List” will 

open allowing you to select an existing mark if you are carrying sub marks through. 

 

Zoom in to the top of the shop bill and see what happened. The text is there. 

 

The shop bill is placed on a layer called shopbill. The portion of the shop bill for sequences is 

on a layer called sequence. This layer can be frozen if sequences are not being used. 

 

CREATING THE SHOP BILL 

Quit the drawing you are in and begin a new drawing. The name of the drawing will be 

24x36BOM and is saved in the folder for this customer. "24x36BOM" is for a 24 x 36 size shop 

bill drawing. A different drawing will need to be created for each paper size, but one paper size 

can be used for any scale if the original drawing is created at a scale of 1” = 1’-0. You can use 

any legal drawing name allowing you to have more than one shop bill drawing in a single folder. 

You can also create an erection sheet and insert it the same as you would a shop bill sheet. Once 

inside the drawing editor, select SETUP then Architect, 1''=1' and D- 24x36. Use 1:12 scale for 

metric units. 

 

Create a new layer called SHOPBILL and set it as current.  

Command: LAYER 

Pick New 

Change layer name to SHOPBILL 

Pick Current 

Pick OK  

Now it is up to you to draw the shop bill using AutoCAD’s drawing commands. The only 

restriction is the drawing must be setup to a scale of 1''=1' or 1:12 for metric. 
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Put the headings at the top of the shop bill and numbers to the left of each line for easy reference. 

If you do not want the line numbers to plot put them outside the right border line. 

 

Create a new layer called SEQUENCE and set it as current.  

Command: LAYER 

Pick New 

Change layer name to SEQUENCE 

Pick Current 

Pick OK  

Now draw the sequence portion of the shop bill. You can have as many as six columns. See page 

162 for an example of the top portion of a typical shop bill. 

 

The sequence portion is placed on a separate layer so that it can be frozen or thawed as needed 

without having to create a different shop bill drawing. This layer will be thawed automatically 

if the shop bill configuration includes at least one sequence. It will be frozen automatically if 

the shop bill configuration does not include any sequences. 

 

Now that you have the shop bill drawn, let's change the color of the lines to red. You may use 

any color you want.  

Command: CHANGE 

Select objects:        Pick all lines but not the text 

# selected, # found      Do not pick the border. 

Select objects:  

PROP 

Properties /<change point>: COLOR 

New entity color <BYLAYER>: RED 

Properties /<change point>: Enter  

 

CONFIGURING SHOP BILL 

 

The items that can be configured are as follows: 

 

• Quantity of main mark 

• Main mark (1B1, 3C1, etc.) 

• Quantity of sub assembly mark 

• Sub assembly mark (aa, pa, ma, etc.) 

• Unit quantity for sub marks 

• Description (main piece and sub piece) 

• Length in feet or mm 

• Length in inches (For architectural and decimal units only) 

• Shape designation (W, L, PL, etc.) 

• Mill order I.D. number for main mark 
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• Grade 

• Remarks 

• Weight 

• Finish (For paint or galvanize) 

• Sequence quantity for main mark 

 

 

Pick Customer Configuration from the menu and pick Shop bill to change the 

settings in a configuration. Select the file you want to change, and pick Edit. Picking 

“Set Current” will save the name of the selected file in the drawing and that file will 

be used until another one is set. 

The first time you open the configuration box you will have one file in it called 

“None”, one called “Unnamed - 11x17” and one called “Unnamed - 24x36”. You 

can edit and use the last two. You can rename them or copy them and make more 

files. You can delete all files except for 2. “None” is one that cannot be deleted. If 

you have an older version that used the sbtext.cfg file you can import those files and 

use them. Older versions had separate sbtext.cfg files saved in each job folder. This 

version has all the configurations stored in one file called custbom.cfg located in 

your autosd folder. The metric version is called custbomm.cfg. You can also import 

individual configurations from other custBOM.cfg files. 

 

After you pick Edit, another dialog 

box will pop up. You will need to 

select the options you want and 

edit the location of each column. 

You can use the "PICK" button to 

select the location of each column 

or you can enter the location in 

each edit box. All values are 

entered at a scale of 1” = 1’-0” for 

ARCH or 1:12 for METRIC 

regardless of the scale of the 

drawing. You will need to have the 

shop bill drawing open to use the 

pick feature accurately. If you 

want to make small adjustments in 

a column from a known location, 

you may find it easier to adjust the 

value in the edit box. If you are 

configuring a shop bill with multiple bills set side by side, use the left most bill to locate all 

columns. 

 

Text Type:  

Select if you want to use attributes or text. 
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Sub Mark Type:  

Select the 2nd or last item here to use the sheet number as a suffix to the sub piece marks. If 

your drawing number has a suffix that begins with “-“, “_” or “ “(blank space), that character 

and all that follows will be removed from the drawing number when making it part of the sub 

mark. Instead of “pa12-REV 1” it would be “pa12”. 

 

Weigh ONE Assembly Only:  

Select this if you want the weight to be for one unit only. 

 

Describe Repeated Marks:  

Select this if you want the description filled out for all pieces with the same mark. Not selecting 

this will not put the description with a mark that has already been used in the shop bill. 

 

Carry sub marks through: 

Selecting this will save new sub marks and description in the file submark.tbl in your customer 

job sub folder “MISC files”. When you use the same mark on following drawings the description 

from the file will be used. 

 

Descriptions 

Put a space after the shape:  

Put a check in this box if you want to have a space between the shape designation and the rest 

of the description. When using “Shop Bill Text / Attributes” under “Beams” to enter a 

description in the shop bill, do not add a space after the shape if you have this box checked. A 

space will be added automatically. Putting one when you type the description will result in two 

spaces. 

 

Put a space on each side of “x”:  

Put a check in this box if you want to have a space on each side of the “x” character in the 

description. When using “Shop Bill Text / Attributes” under “Beams” to enter a description in 

the shop bill, do not add a space before or after the “x” if you have this box checked. A space 

will be added automatically. Putting one when you type the description will result in two spaces. 

 

Lines are numbered from: 

Select "Top down" or "Bottom up". 

 

Bottom of line #1 from bottom border line: 

Enter a value or pick the “Pick” button to pick a point on the drawing. 

 

Distance of ten line spaces:  

Enter a value or pick the “Pick” button to pick two points. The distance must be the distance of 

ten space or eleven lines in the BOM. 
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Limits of shop bill for extracting text:  

Enter the X and Y coordinates of the upper left and lower right extents of text that will be in the 

shop bill. If you have multiple bills side by side, select the upper left and lower right corners to 

include all bills. This is used to select the text using these two points as a window when you 

extract the shop bill information using text instead of attributes. Make sure the window does not 

include the headings. 

 

Text Height and Text Color: 

Enter the height for text in the edit box. To change the text color, pick the color swatch and then 

select the color you want. The height and color selections affect attributes as well. 

 

Multiple bills side by side 

Repeat BOM horizontally: 

Select this option if you have multiple bills side by side. Enter the number of lines for one bill 

only. For “Distance BOM to BOM”, use the “Pick distance” button and select a point on the left 

side of one bill and another point on the left side of the adjacent bill to the right. 

 

Location from left border: 

This is where you set the justification and location for each column of text. Enter a value for the 

location or pick the “Pick” button to pick a point on the drawing. 

If the main mark and sub mark are in the same column you should use a different justification 

for each. This will allow proper extraction for “.kss” files if you should have two or more main 

marks with no blank lines between them such as you might have listed as “Plain material” in the 

BOM. 

 

Print: 

Picking this will give you a print of all settings and options selected. 

 

If the Weight category is non-zero you need to select whether the weight for sub pieces is for 

one assembly only or not. You have the option of extending the total weight of all assemblies or 

for just one. 

Entering a 0 (zero) for UNIT QUANTITY, SHAPE, I.D., Number of SEQUENCES, GRADE 

or WEIGHT will cause those prompts to be deactivated and those categories will not be used. 

Entering a number other than zero will make them active. 

Entering a 0 (zero) for the location of inches will cause 

the feet and inches to be written as one number thus: 2'-

812 

 

Sequence Properties:  

If you are going to use sequences, you can have up to 6. 

Select the number of sequences under "Total Number". 

Under "Number or Letter" fill in the sequence 

designation you want to use in the prompt when asked 
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for the quantity. Give the dimensions for the location for each sequence in place of the defaults 

shown or use the "PICK" feature to select the location of each column. 

 

The configuration can be made at any scale, but the shop bill must be drawn to a scale of 1"=1' 

for ARCH or 1:12 for METRIC. 

 

TITLE BLOCK CONFIGURATION  

 

Pick Customer Configuration from the menu and 

pick Shop bill. Select the file you want to change; 

pick Edit and Title Block Configuration. 

 

This will configure a block made of attributes for 

filling out the title block quickly and easily. The 

Title Block Configuration program allows you to 

add an attribute for each item that you want to 

include in the title block information. The “Move 

up” and “Move down” buttons will move the 

prompt in the prompt list but has no effect on where 

it is placed in the drawing. If you used the tag names 

ASD_NA for Project Name, ASD_NO for Job 

Number, ASD_GR for material grade and ASD_RE for the revision mark in your title block 

attributes, this information will be included in “.kss” files when extracting for Fabtrol or 

FabSuite. 

 

Inserting the title block: 

Pick AutoSD > Shop bill > Title block. You 

get the dialog box shown to the right. Pick one 

of the prompts and then pick the “Value” box 

at the bottom to change the value of the 

prompt. The value will be put in the title block 

and all changes will be saved when you pick 

the OK button. All values saved will become 

the defaults for the next time the title block 

program is opened. Pick “Save as” to make a 

copy of the selected Job Name. You can 

rename or delete all Job Names except the Default. 

Once the title block is inserted, you can edit it with AutoCAD’s Attribute Editor by double 

clicking on one of the attributes, typing eattedit or pick Modify > Object > Attribute > Global. 

 

EDIT SUB MARK LIST 

Pulldown: AutoSD > Shop Bill > Edit Sub Mark List 

Ribbon: AutoSD I > Shop bill 
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If you configure the shop bill to use the 

sheet number as a suffix to the sub piece 

marks, (selection 1 or 3 shown below), and 

check the box "Carry sub marks through" in 

the "Shop Bill Text and Attribute 

Configuration", the description for a mark 

will carry from one sheet to the next. Each 

time you enter a sub mark, the file 

submark.tbl in your customer job sub folder 

“MISC files” will be checked to see if the 

mark has been used before. If it has, the 

description, length and remarks will 

automatically be entered in the shop bill. If 

it has not been used you will be asked to 

enter the description, length and remarks. 

After doing so they will be added to the list for future reference. 

 

Line in shop bill configuration for selecting to carry sub marks through. 

 For sub marks use (0)a,b,c (1)a1, b1 (2)aa, ab (3)aa1, ab1 (0/1/2/3) <2>: 3 

 

Note: If you select option 0 and 2 the marks will be saved to and recalled from the submark.tbl 

file only if you end the mark with a number. 

If the description, length or remark of a sub mark needs to be changed after it has been saved to 

the file submark.tbl you can change it with EDIT SUB MARK LIST. Select a mark and the 

mark, description, length and remarks are displayed in edit boxes. To change one, click on an 

edit box and make the change. You can also delete a mark and the information associated with 

it. Pick “Match current BOM” to update the list with the contents of the current drawing. If you 

select Cancel, no changes will be saved. 

 

EXTRACT SHOP BILL 

Pulldown: AutoSD >  Extract > Shop Bill 

Ribbon: AutoSD I > Shop bill > Extract Shop Bill 

 

Use this command to extract the shop bill using text or attributes and convert the extracted file 

using the template file ASD_SBL.TXT, (or your own custom template file), located in your 

AUTOSD\BONUS folder.  

 

Shop bill information will be extracted from the drawing and automatically converted to an 

ASCII text file. If you extract the current drawing the file name will be the same as the drawing 

name but will have a ".sbl" extension and will be located in the sub folder “MISC files” of the 

drawing folder. If you extract all drawings the file name will be like “Ext_2015_09_16_13-56-

24.sbl” and will be located in the sub folder “MISC files” of the drawing folder that was selected. 

File name is Ext_Year_Month_day_Hour-Minute-second.sbl 
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If you extract several drawings using the “Current drawing” option, you will have files with the 

same name as the drawing but with a “sbl” extension. You can merge these files together into 

one file. Select “Merge Extracted files” from the Extract menu and enter “S” for “sbl”. Change 

the drive and then the folder to where the "sbl" files are located. Select the files that you want to 

merge and select OK. The individual files will be deleted when merged and the new file will be 

named like “Ext_2015_09_16_13-56-24.sbl”. 

 

Warning! Attributes must not be used if you are drawing in Paper space. You can use text and 

the text in the shop bill for each sheet will be extracted if the layout name does not begin with 

“Layout”. 

 

CUSTOMIZING SHOP BILL EXTRACTION FILE  

AutoSD gives you the ability to extract the bill of material using text or attributes. Either one 

allows you to extract the data to an ASCII text file in a format that you control where it can be 

used by AutoSD to print or by other programs not supplied by AutoSD that can process a comma 

delimited file. To customize the extracted file of the shop bill you must have a template file. The 

one shown below is supplied as an example and is used by AutoSD to extract shop bills. You 

can modify this file or create your own. If you create your own it must be saved in the BONUS 

folder of AutoSD, the name must have a “TXT” extension and the name must NOT start with 

“ASD_”. If you do not create a template file, asd_sbl.txt will be used as the default. If you do 

create a template file you will be prompted to select the file each time. 

 

Extract template file \AUTOSD\BONUS\ASD_SBL.TXT 

ASD_MQ    C005000 (Main quantity) 

ASD_MM    C011000 (Main mark) 

ASD_SQ     C006000 (Sub assembly quantity) 

ASD_SM    C007000 (Sub assembly mark) 

ASD_DS     C035000 (Description) 

ASD_FT      C005000 (Feet) 

ASD_IN    C009000 (Inches) 

ASD_SH    C004000 (Shape designation) 

ASD_ID       C007000 (Mill order number) 

ASD_SE C004000 (No longer used but included to support older versions) 

ASD_SP     C007000 (Material grade) 

ASD_RM C011000 (Remarks) 

ASD_WT   C008000 (Weight) 

ASD_FN   C024000 (Finish) 

ASD_S1 C010000 (S1 - S6 are sequence numbers for main marks. 

ASD_S2 C010000 They are invisible and have no prompt.) 

ASD_S3 C010000 

ASD_S4 C010000 

ASD_S5 C010000 

ASD_S6 C010000 

ASD_Q1 C004000 (Q1 - Q6 are quantities per sequence for main marks) 

ASD_Q2 C004000 
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ASD_Q3 C004000 

ASD_Q4 C004000 

ASD_Q5 C004000 

ASD_Q6 C004000 

BL:Y     N008001 (Y coordinate to enable proper sorting) 

BL:X     N008001 (X coordinate to enable proper sorting) 

 

(The comments must not actually be part of the template file.) Each line has two fields. The first 

field is the tag name. Do NOT change any tag names. The second field contains the format for 

the data for that tag. All format fields start with a "C" denoting it as a character field except for 

the fields BL:Y and BL:X. They start with a "N" denoting numeric. The next three digits are the 

field width characters. The last three are number of decimal places. All character fields have 

"000" for the last three digits. Be sure to use a field width that is at least if the number of 

characters actually needed. If the field width is too small AutoCAD will truncate the output. 

 

CAUTION: The first fields in the extract template file MUST be spelled as shown above. They 

may be in any order and some may be left out, but the names MUST NOT be changed.  

ASD_S1, ASD_S2, ASD_S3, ASD_S4, ASD_S5 and ASD_S6 must be in the same order as 

ASD_Q1, ASD_Q2, ASD_Q3, ASD_Q4, ASD_Q5 and ASD_Q6. 

  

BL:Y    N008001 and BL:X    N008001 must be left in the file. 

 

NOTE: Do not use "tab" characters when constructing the template file. If you want to align the 

columns for readability, do so with ordinary spaces. 

 

Each line of the extracted file will contain information for each tag listed in the template file in 

the order they are listed. If all values are not used, those tags may be omitted from the template 

file. 

 

If all lines of text in the output file are blank for the values of ASD_SE, ASD_SH, ASD_Q1, 

ASD_Q2, ASD_Q3, ASD_Q4, ASD_Q5 or ASD_Q6 those fields will be left out of the print, so 

it is not necessary to remove those fields from the template file. 

 

To print the converted shop bill file, select AutoSD > Extract > Print Shop Bill and select the 

*.SBL file from your drawing sub folder “MISC files” that you want to print. The file will be 

saved as PrintSbl.txt and opened in Notepad for viewing and printing. 

 

MERGE EXTRACTED FILES 

Pulldown: AutoSD > Extract > Merge Extracted files 

Ribbon: AutoSD I > Shop bill > Merge Extracted files 

 

Use this command to merge individual files into one file. The types of files that can be merged 

are bolt list, (*.blt), shop bill, (*.sbl), SMM, (*.imp and *.csv) and Fabtrol or FabSuite, (*.kss).  
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EXTRACT  > SMM  

Pulldown: AutoSD > Extract > SMM 

Ribbon: AutoSD I > Shop bill > SMM 

 

Warning! Attributes must not be used if you are drawing in Model space and Paper space or 

just Paper space with multiple layouts. 

 

AutoSD supports Structural Material Manger sold by E.J.E. Industries, Inc. P.O. Box 268, 

Washington, PA 15301, Phone: 1-(800) 321-3955, Fax: (412) 228-7668. You can order a full 

working demo from E.J.E. Industries. 

 

Shop bill information will be extracted from the drawing and automatically converted to an 

ASCII file format that can be imported by the SMM program. If you extract the current drawing 

the file name will be the same as the drawing name but will have an ".imp" or “csv” extension 

and will be located in the sub folder “MISC files” of the drawing folder. If you extract all 

drawings the file name will be similar to “Ext_2015_09_16_13-56-24“ with an “.imp” or “.csv” 

extension and will be located in the sub folder “MISC files” of the drawing folder. The extension 

type is set in your customer configuration. “imp” is for the older fixed field format and “csv” is 

for the newer ASCII delimited file format. File name is Ext_Year_Month_day_Hour-Minute-

second.extension. 

 

If you extract several drawings using the “Current drawing” option, you will have files with the 

same name as the drawing but with an “imp” or “csv” extension. You can merge these “imp” or 

“csv” files together. Select “Merge Extracted files” and enter “C” for “csv” or “I” for “imp”. 

Change the drive and then the folder to where the "imp" or “csv” files are located. Select the 

files that you want to merge and select OK. The individual files will be deleted when merged 

and the new file will be named similar to “Ext_2015_09_16_13-56-24” with a “.csv” or “.imp” 

extension. 

 

The description of a main member is usually the member size but sometimes you will need to 

use a description such as FRAME or BRACE for the main member. When such a description is 

given the length should be left blank. A main mark with no length will be treated differently 

than a main mark with a length. 

 

The text in the shop bill for Model space and each Paper space layout will be extracted if the 

Paper space layout name does not begin with “Layout”. All output will be in one file with the 

same name as the drawing file. 

 

EXTRACT > KISS 

Pulldown: AutoSD > Extract > KISS 

Ribbon: AutoSD I > Shop bill > KISS 

Warning! Attributes must not be used if you are drawing in Model space and Paper space or 

just Paper space with multiple layouts. 
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AutoSD supports the KISS file format for material management software. 

 

Shop bill information will be extracted from the drawing and automatically converted to an 

ASCII file format that can be imported by the FabTrol or FabSuite program. If you extract the 

current drawing the file name will be the same as the drawing name but will have a ".kss" 

extension and will be located in the sub folder “MISC files” of the drawing folder. If you extract 

all drawings the file name will be like “Ext_2015_09_16_13-56-24.kss” and will be located in 

the sub folder “MISC files” of the drawing folder. File name is Ext_Year_Month_day_Hour-

Minute-second.kss 

 

If you extract several drawings using the “Current drawing” option, you will have files with the 

same name as the drawing but with a “kss” extension. You can merge these files together into 

one file. Select “Merge Extracted files” and enter “K” for “kss”. Change the drive and then the 

folder to where the "kss" files are located. Select the files that you want to merge and select OK. 

The individual files will be deleted when merged and the new file will be named like 

“Ext_2015_09_16_13-56-24.kss”. 

 

If you used the tag names ASD_NA for Project Name, ASD_NO for Job Number, ASD_GR for 

material grade and ASD_RE for the revision mark in your title block attributes, this information 

will be included in the “.kss” file. If you prefix or suffix the description with MI and the length 

is 0, MI will be used as the shape designation for miscellaneous material. Example: MI FRAME 

or FRAME MI. 

 

Order of priority for grade: The grade for each piece is retrieved from the customer's Detail 

variables found under Beams. Entering a grade in the title block for ASD_GR will override the 

customer's Detail variables setting for all grades. If the grade is listed in the BOM for a piece, 

that grade will override all other settings. 

 

The text in the shop bill for Model space and each Paper space layout will be extracted if the 

Paper space layout name does not begin with “Layout”. All output will be in one file with the 

same name as the drawing file. 

 

EXTRACT > KISS Description 

Pulldown: AutoSD > Extract > KISS Description 

Ribbon: AutoSD I > Shop bill > KISS Description 

 

Normally, an item in the description column in the bill of material must have a mark, quantity 

and length for AutoSD to included it in the KISS file. This prevents things like “ONE – 1F1 – 

Frame” from being included. Sometimes, though, you have a description, mark and quantity but 

no length that you want included. This program lets you create and modify a list of descriptions 

to check against the BOM for inclusion in KISS files. The description is not case sensitive and 

does not have to be an exact match. For example: Wagner, WAGNER and wag are all acceptable 

descriptions to include “WAGNER #1938”. If the complete description is part of the BOM it 

will be included. 
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FABSUITE *.KSS FILE 

 

Below is a list of prefixes you can use in the description in the bill of material that the Extract 

for KISS program will recognize when creating the *.kss files for FabSuite. Your material 

description may be upper or lower case. PL may be written as PL, PLATE, `P or ~P. 

 

A307 A325 A490 AB 

ABR NOSE  ABR NOSING AR PL  AL_PS 

AL_TS AL_L AA_CS AS_C 

AA_I AS_I AL_W AL_H 

AL_PL AL_PIPE ALL THD ROD ALUM BOLT 

ALUM C  ALUM CHKD PL ALUM CHK PL ALUM EXP METAL 

ALUM FB ALUM FLAT BAR ALUM GRAT  ALUM H 

ALUM I  ALUM L ALUM PIPE ALUM PL 

ALUM PS  ALUM ROD  ALUM SHEET  ALUM TS 

ALUM W  AR PL BAR  BAR JOIST 

BENT C  BENT PL BEVEL WASH BRASS FB 

BRASS FLAT BAR BOLT BUYOUT C 

CARR BOLT  CARRIAGE BOLT  CHK PL CHKD PL 

CGE BOLT  CO ASSY COMMENT  COPPER SHT 

CORR PIPE CR FB CR FLAT BAR CR HEX 

CR PL CR PURLIN CR PURLIN ACC  CR PURLIN CLEAT 

CR ROD CR SQ CR SQUARE CROSS  FRAME 

DIAPHRAGM  DHR CAP DRILL ROD ELECT PART 

EU  EUA  EUAA EUB 

EUC EUM EXP BOLT EXP METAL 

EXP METAL FLAT EXP METAL GRTG FB  FELT 

FLAT BAR FRAME GALV BOLT  GALV C 

GALV DECK  GALV L  GALV PIPE  GALV PL 

GRIP STRUT GRAT GROUSER BAR HD STUD 

HEADED STUD  HP HR FB HR FLAT BAR 

HR PIPE HR PL HSS HVY GRAT 

HYD PART IPE  IPEA IPEAA 

IPEO IPN L LAG STUD 

LAYDOWN  LEJ LIB LIW 

LOCK WASH LVL M  MISC 

MISC FAB  MC MT NON STEEL 

NS PIPE NUT PAINT PERF PL 

PIPE  PL PL GIRDER PS 

PTD DECK RAIL  RENTAL RH ANCH 

ROD ROUND RUBBER S 

SAE BOLT  SBC  SCB SCH 10 

SCH 100 SCH 120 SCH 140 SCH 160 

SCH 20 SCH 30 SCH 40 SCH 60 

SCH 80 SCREW  SCW SHIP DESC 
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SHS SP SPLICE SS BOLT 

SS EXP METAL  SS FB SS HB SSL 

SS L SS PL SS STD PS SS ROD 

SS STD PIPE  SS TS ST  STD 

SHEAR PL  STUD  STD PIPE  STRUCT EXT 

SQ SUB TOTAL SUB-TOTAL SWC 

TAPER  TB  THD ROD  TIVAR 

TRUCK PART TRUSS TS TUBE 

UB  UC DECK  UM PL UNISTRUT 

UPN W  WASH  WASHER 

WELD STUD WIRE MESH WIRE MESH ROLL WIRE MESH SHEET 

WIRE MESH TIES WMS WT X-STRG 

XX-STRG    

      

COMPILE QUANTITIES  

Pulldown: AutoSD > Extract > All drawings 

Ribbon: AutoSD I > Shop bill 

 

Warning! Attributes must not be used if you are drawing in Model space and Paper space or just 

Paper space with multiple layouts. 

 

Use this command to extract the shop bill using attributes or text from all drawings in one folder. 

If more than one drawing is selected, each drawing will be opened one at a time and the bill of 

material extracted. The text in the shop bill for Model space and each Paper space layout will be 

extracted if the Paper space layout name does not begin with “Layout”. After all drawings have 

been processed the extracted files are merged into one file and converted. The converted file 

name is "bom_qty.txt" and will be in the sub folder “MISC files” of the folder where the 

drawings are that were processed. The information written to this file is the Mark, Quantity, 

Description, Length and Grade. You have the option of combining all common marks and 

sorting like material together. Sorting will list all "W" shapes together, all "L" shapes together, 

etc. To sort by shape, the shape designation must be at the left end of the description. Shapes 

recognized to sort are as follows: HP, M, S, W, C, MC, MT, ST, WT, HSS, TS, HSS, PS, L, CF, 

FLAT BAR, BAR, UM PL, FB, PL, UM PLATE, PLATE, TUBE, SCH 40, SCH 80, SCH 120, 

XX-STRG, X-STRG, STD PIPE, PIPE, RAIL, A325, A307, A490, BOLT, ROD, REBAR, 

EXPANDED and GRAT as well as the prefix you set in the configuration for plates under FLAT 

BARS / PLATES. 

 

EXTENDING WEIGHT 

If the weight category is not 0 the weight for each piece will be calculated and written in the 

weight column. The weight is the total weight for the quantity of each piece listed. The total for 

the piece shipped is not given. You can use the command AutoSD > Calculator > Select Dim 

TO Add > Decimal from the pulldown menu or the command Miscellaneous > Select Dim to 

Add Decimal from the ribbon menu to quickly get a total if needed. Listed below are the valid 

descriptions that the weight program will recognize. 



AutoSD Steel Detailing                                                     Shop Bill, Chapter 10 

175 

 

KEY WORDS                DESCRIPTION EXAMPLES                     . 

 

A307  `W`O A307  or `W`O A307 BOLT 

A325  `W`O A325  or `W`O A325 BOLT 

A490  `W`O A490  or `W`O A490 BOLT 

BAR   BAR `W x 1`8  or  BAR `W`[  or  BAR `W`{ 

BOLT  `W`O BOLT 

C   C 8 x 11.5 

CLEVIS  # 2`8 CLEVIS  or CLEVIS # 2`8 

EXP   4.0# EXP METAL 

EXPANDED 4.0# EXPANDED METAL 

FB   FB `4 x 2 

FLAT BAR  FLAT BAR `4 x 2 

GRAT  GRAT `3 x 1`4 x 36 

HP   HP13 x 87 

HSS   HSS 6.625 x 0.5 (round pipe) 

HSS   HSS 6.625 x `8 (round pipe) 

HSS   HSS 6 x 2 x `3  (rectangular tube) 

L   L 4 x 3`8 x `5 

M   M 8 x 6.5 

MC   MC 12 x 20.7 

MT   MT 3 x 10 

`P   `P `6 x 13`4  or `P 14 GA x 13`4 

PIPE 1`8`O STD or   1`8`O PIPE or   PIPE 1`8`O  or 1`8`O STD PIPE 

PIPE   PIPE 2.5 x 0.125 (round pipe that is not in weight class) 

PLATE  PLATE `6 x 13`4 or PLATE 14 GA x 13`4 

PS   PS 1`8`O   (This will give the weight for std pipe) 

RAIL  60# RAIL   (Do not use this key word for handrail pipe) 

REBAR  #8 REBAR  or REBAR #8 

ROD  `W`O ROD 

S   S 12 x 50 

SQ   SQ `8 x `8  or SQ BAR `8 x `8 

ST   ST 6 x 15.9 

STD PIPE  1`8`O STD PIPE 

SCH 40  1`8`O SCH 40  or 1`8`O SCH 40 PIPE (Same as STD PIPE) 

SCH 80  1`8`O SCH 80  or 1`8`O SCH 80 PIPE (Same as X-STRG 

PIPE) 

SCH 120  1`8`O SCH 120 or 1`8`O SCH 120 PIPE (Same as XX-STRG 

PIPE) 

TS, TUBE  TS 3 x 2 x `4  or TUBE 3`8x3`8x`4 

TURNBUCKLE TURNBUCKLE `W x 6 

UM `P  UM `P`6 x 13`4 

UM PLATE  UM PLATE `6 x 13`4 

W   W 14 x 22 
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WT   WT 12 x 27.5 

X-STRG  1`8`O X-STRG or 1`8`O X-STRG PIPE 

XX-STRG  1`8`O XX-STRG or 1`8`O XX-STRG PIPE 

 

Key Words by Country 

 

USA  CANADA UK  EUROPE AUSTRALIA 

C  C  BT  DIL  BT 

CF  CF  C  HD  CT 

HP  DN  CT  HE  CHS 

HSS  HP  CHS  HL  EA 

L  HSS  ERW  HP  PFC 

M  L  J  HSS  RHS 

MC  M  L  HX  TFB 

MT  MC  UB  IPE  TFC 

PS  S  UC  IPEA  UA 

S  W  UBP  IPEV  UB 

ST  MT  RHS  IPN  UC 

TS  ST  SHS  L  WB 

W  WT  U  WC 

WT  TS  UAP 

  UA  UPN 

  WWF 

  WWT 

  WRF 

 

In the above examples the KEY WORD may be placed at the beginning or the end of the 

description for steel and must be placed at the beginning of the description for aluminum. Only 

Australian key words may be placed in the middle, (150UB 14). You may use upper or lower-

case letters. The dimensions for Angles, Tubes, Bars, Flat Bars and Plates may be in any order. 

The first two dimensions for GRATING may be reversed but the width must be the third 

dimension in the description. Spaces are permitted anywhere in the descriptions but not in the 

key words except where shown. In all cases the descriptions must use the custom text supplied 

by AutoSD using the backward apostrophe (`) or tilde (~) characters for fractions. If a description 

is not recognized no weight will be given. Grating is for welded steel grating only. Cross bar 

centers can be 2" or 4" and bearing bar centers can be 15/16, 1 3/16, 1 3/8, 1 7/8, or 2 3/8.  

 

The weight calculated is for non-galvanized carbon steel and aluminum shapes. When listing 

common pieces, it is customary to describe the piece completely the first time and then give just 

the quantity and mark of the piece each time after that. Each time you describe a new piece it is 

added to a list that is held in memory. When you give only the quantity and mark of a piece the 

program searches this list for the same mark. If it finds it, the weight will be extended for the 

common mark. When you end the drawing, this list is erased from memory. Therefore, the shop 

bill should be filled out completely in one drawing session for all weights to be extended. 
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See chapter 5 for the manual EXTEND WEIGHT program. 

 

MATERIAL LIST 

This file must be modified before it can be used. A 

sample file is supplied called “Unnamed” and is shown 

left. To edit the file, select AutoSD > Customer 

configuration and pick “Material list”. Select 

“Unnamed” and pick “Edit”. You can change the mark, 

length and description. You can add and delete marks. 

Each time a sub assembly mark is entered when using 

the shop bill program, the program searches this file for 

the mark. If it is found, the length and description are read from the file and automatically entered 

in the shop bill. If it is not found or you selected “None” for the material list file you must enter 

the length and description manually. Use this file to list all standard marks for clips, plates, bolts, 

etc. 

 

Note: Marks and descriptions for standard end connection angles for beams are saved in the 

customer configuration and do not need to be added to this file. 

 

If you had an older version that used the material.tbl file you can import it with the Import button. 

You can also import individual configurations from other custMAT.cfg files. 
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Chapter 11 - Trusses 
 

Pulldown: AutoSD > Bracing > Calculate > Gusset PL (Truss) 

Toolbar: Bracing 

Ribbon: AutoSD II > Bracing 

 

The TRUSS portion of the BRACE program is for calculating the size of the gusset plate, the 

length of weld and clearance dimensions at a panel of a welded truss. The top and bottom chords 

can be either wide flange shapes, angles or split tees. The truss program is supported by icon 

menus to select the type of truss, top or bottom chord and orientation. A full screen view of the 

type selected is provided for your reference in entering the necessary data.  

Command:   Pick [AutoSD or AutoSD II] > Bracing > Calculate Gusset PL (Truss) 

 

 

 

 

Input "#A": You can input a 

dimension if you are checking a 

drawing made by someone else or you 

can leave it blank. If you input a 

dimension the program will check to 

see if it works with the given clearance. 

If it does, fine. if not, the correct 

dimension for "#A" will be calculated 

and used. Either way, the answer for 

"#A" that is displayed in the output will 

be the one that works. 
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Chapter 12 - Stairs 
 

All programs in this chapter are under the AutoSD > Stair pulldown menu, Stairs / Rails Toolbar 

and AutoSD II > Stairs ribbon menu unless noted otherwise. 

 

The STAIR program uses icon menus and dialog boxes for user friendly input. You can draw 

pan stairs, bolted tread stairs and "butterfly" stairs for pre-cast treads that sit on top of the 

stringer. The orientation of the stringer can be sloping up to the right or sloping up to the left. 

Tail dimensions for bolted treads will be determined for you and put in an easy to read table or 

on the stringer detail if you select to draw the length to scale. The length must be drawn to scale 

if you want scribe lines added to the CNC file for the location of pan supports. There are many 

different pan options to choose from and you can create your own to be used by the stringer 

program with the easy to use Tread Builder. There are four top and seven bottom stringer 

conditions to choose from. You can have holes for handrail post automatically located and 

placed on the stringer. 

 

The stair stringer can be drawn to the actual length and to the actual bevel. The depth will be 

drawn to scale. 

 

Your sheet should be set up to a scale of 1" = 1'-0, (1:12 for metric)  

Command:  Pick [AutoSD or AutoSD II] > Stairs > Stringer 

 

A dialog box is used for input 

showing the top and bottom 

conditions and all the input from the 

previous stringer. The end conditions 

are changed by picking the options 

under “Connection at bottom” and 

“Connection at top”. Under “Select 

tread style” "Butterfly" is for pre-cast 

treads that sit on top of the stringer. 

These treads will be supported by flat 

bars. 

 

Use the tab key to move from one box 

to the next. Use shift + tab to move up 

to the preceding box. 

 

If the stair has 6 treads or less, the 

length will be drawn to scale 

otherwise you would need to check the box for "Draw Length to Scale" if you want to draw the 

stringer length to scale. 
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If you are saving CNC data and will have bolted bracing under the stair, the far side stringer will 

need tails from the left end and the near side stringer from the right end of material.  

 

 

 

 

 

 

 

 

 

 

An icon menu is used when you click  An icon menu is used when you click on “Select”  

on “Select” under “Connection at top” under “Connection at bottom” 

 

 

 

After entering all the required dimensions in the box above and picking OK, 

a dialog box is displayed to select the stringer sizes. Select the shape, depth 

and weight and then select OK. 

 

 

 

 

 

  

Insertion point:   A box is displayed around the cross hairs outlining the area required for the stair detail. 

Main mark: 1S1 

Are marks RIGHT and LEFT (Yes/No) <N>: Enter 

Quantity: 1 

Shop bill information on mark 1S1 

Select/Place shop bill text on LINE <4>: Enter 

 

An icon menu is displayed to select whether to apply blocks or not to the 

upper end. The left selection is for an end with no blocks in the top or bottom 

flange. You still get to enter the “minus” 

dimension. The right icon is selected to enter 

blocks. 

A dialog box is used to enter the blocks. If you select “Auto block” 

you select a beam size and enter dimension “A” for the offset from 

the floor elevation to the TOS of the support beam. The blocks 

required are calculated for you. If you select “Block top” or “Block 

bot” you enter the width and depth of the blocks from end of 

material. 

(FT.IISS) Horiz. Minus dimension at upper end <-1/8">: Enter 
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Sub assembly mark for sloping stringer: mb 

Sub assembly mark for clip at lower end: aa 

Clip is (1)NS, (2)FS, (3)BS <1>: Enter 

(FT.IISS) Gage of clip: .0112 

Select angle from dialog box 

Add piece to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark aa 

     Total sub quantity: 1 

Bolt size: (5)5/8"  (6)3/4"  (7)7/8"  (8)1" <6>: Enter 

Number of field bolts in Bottom end <1>: Enter 

(FT.IISS) Total grip less washers <5/16">: .0112 

Add another field bolt (Yes/No) <N>: Enter 

Sub assembly mark for closure plate at lower end: pa 

Add piece to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark pa 

     Total sub quantity: 1 

Sub assembly mark for upper stringer: ma 

Sub assembly mark for clip at upper end: ab 

Clip is (1)NS, (2)FS, (3)BS <1>: Enter 

Separate spacing of holes with a comma 

(FT.IISS) Gage of clip <1 3/4">: Enter  Enter gage as .02,.0112 for 1 row, 2 columns 

Select angle from dialog box 

Add piece to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark ab 

     Total sub quantity: 1 

Bolt size:  (5)5/8"  (6)3/4"  (7)7/8"  (8)1" <6>: Enter 

Number of field bolts in Top end <2>: Enter 

(FT.IISS) Total grip less washers <5/16">: .0010 

Add another field bolt (Yes/No) <N>: Enter 

Sub assembly mark for floor support angle at upper end: ac 

Floor support angle is (1) NS, (2) FS <1>: Enter 

Select floor support angle from dialog box 

Add piece to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark ac 

     Total sub quantity: 1 

The Tread builder dialog box is displayed.  Select 10GA 2-2-6-Angle 1 1/2 

Sub assembly mark for vertical support angles at top riser: ad 

Add piece to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark ad 

Sub assembly mark for horizontal support angles at top riser: af 

Add piece to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark af 

Sub assembly mark for horizontal support angles at standard pans: ag 

Add piece to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark ag 
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Pick a point in “clear” area for blowup of pan: 

Select dimension line locations: 

Quantity of this stair <1>: 

Sub assembly mark for Standard pan: ha 

The Tread builder dialog box is displayed.  Select 10GA 2-2-1-Angle 1 1/2 

Sub assembly mark for vertical support angles at bottom riser: ah 

Add piece to shop bill (Yes/No) <Y>: Enter 

Pick a point in “clear” area for blowup of pan: 

Select dimension line locations: 

Quantity of this stair <1>: 

Sub assembly mark for Standard pan: hb 

Shop bill information on mark hb 

Add upper stringer mark ma to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark ma 

     Total sub quantity: 1 

Add sloping stringer mark mb to shop bill (Yes/No) <Y>: Enter 

Shop bill information on mark mb 

     Total sub quantity: 1 

Command:        Finished.  

If the stringer had been drawn going up to the left the tail dimensions would be from the upper 

end. Either way you draw the stair the tails will be from the end selected in the main dialog box. 

If you checked the box to draw the stringer length to scale the tail dimensions for the treads will 

be put on the detail instead of in a chart. 

If you are saving CNC data and the stair length is not to scale the "tail chart" will be used by 

default. The CNC data will be associated with the tail text instead of hole entities. If you need 

to change the tail dimensions in the chart you must use the Replace Dimension command instead 

of a text editor if you saved CNC data so the CNC data will be changed. 

If you would like additional dimensions on the stair you can use the dimension command and 

use the defaults given since the end of the stair is drawn to scale. The stair is also drawn to the 

exact bevel. 

Blocks are dimensioned to end of member or to clip as set in your Beam configuration.  

Block length is based on "Clear dim added for block length" as set in your Beam configuration. 

The Beam Configuration can be set even if you did not purchase the Beam and Column package. 

Clips and plates for header connections, clips at all upper end stringer connections and clips at 

lower end of horizontal stringer are, by default, 1 column and 2 rows. You can make them 2 

columns and 1 row by entering the two gages separated by a comma when you see this prompt. 

Separate spacing of holes with a comma. (FT.IISS) Gage of clip: .02,.0112 

If you check the box “Use Linear FT for Closure plates, one mark will be used for all closure 

plates and the total length will be rounded up to the nearest foot. 

 

Handrail holes: 

Putting a check in the box to “Include Handrail holes” enables the inputs below the check box. 

A one-sided connection option is available for all post. A one-sided connection on the bottom 

and mid post will put the holes above the post. A one-sided connection on the top post will put 

the holes below the post. Entering a negative number for input “A” or “B” will put the end post 



AutoSD Steel Detailing                                                       Stairs, Chapter 12 

185 

on the landing. The connection for a post at the landing is different from the post connection on 

the sloping stringer. The one-sided option chosen on the stringer input dialog box does not apply 

to post on the landing. 

 

Files:  

Selecting “Files” opens a dialog box that allows you to save to, delete or load a stringer from 

the stair.lst file that is in your customer’s job sub folder “MISC files”. This is where you load 

the values for stringers that were exported from the Elevation Generator program. Some values, 

such as the location of holes, are not carried over from the Elevation Generator so they need to 

be checked. Once a stringer is detailed, all values become the default for the next stringer. Saving 

a stringer here allows you to recall the input when detailing the rail or Erection elevation view 

or another similar stringer. 

 

Note: 

See appendix E for forms that can be filled out by your more experienced detailer and given to 

a less experienced person for entering information into the stair program. 
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CREATING PAN TREADS with the Tread Builder 

 

1. Nose: Selecting “None. Support Only” will just draw the supports on the stringer. 

2. Cast Nosing: Put a check in the box for Drop pan if you have a cast nosing 

3. Pan Material: Pick “Select Gage” if a gage material is needed. If a gage is entered it will be used 

in the description, (optional). Leave the gage box blank to use the thickness in the description. 

Enter a thickness for the pan material, (required). Put a check in the box for Checkered Plate if it 

is Checkered Plate. 

4. Tread: Enter the tread depth. 

5. Rise: Enter the tread height. 

6. Rise icons: Pick one of the icons available. 

7. Bottom: Pick one of the icons available. 

8. Config Rise #6: Opens a dialog box for values for rise #6 for use with all treads. 

9. Bolted support: Opens a dialog box for values for bolt pattern. Saved for each bolted tread. 

10. Supports: The top option is for mitered supports. The second option will draw the horizontal or 

vertical support or both. 

11. Config: Sets the distance to the start of the supports when not mitered. 
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12. Support Type: Putting a check in the box for “None” will cause supports to NOT be drawn under 

the tread and rise. 

13. Support Location: Put a check in the box for “Tread” if you want a support under the tread. Put a 

check in the box for “Rise” if you want a support on the riser. 

14. Size (all treads): Enter the description to use for angle and bar supports. Values here are global, 

one value for all treads. All other values are saved for each tread unless noted.  

Enter the Angle and Bar size using the custom text character for fractions.  

Putting a check in the box for “Calc horiz length” will cause the horizontal support length to be 

calculated based on the tread width. 

Putting a check in the box for “Show dimensions” will cause dimensions to be placed on one set 

of supports on the stringer. 

If the top icon for Supports is selected and you putt a check in the box for “Draw blowup”, the 

program will draw a separate detail of the mitered support with dimensions at a larger scale. 

15. Enter a value for A - K as required. Putting a check in the box for “Calculate F” will let the 

program calculate the tread width from the value entered for Tread. Removing the check will 

force the program to use the value “F” for the tread width. 

16. Option E and L:   For nose type 3. 

a. Select “E” to enter dimension “E” for calculating angle “L”. 

b. Select “L” to enter the angle “L” for calculating dimension “E” 

17. File names: 

Delete:   This will delete the selected tread from the File names list. 

Import:   This will allow you to import a tread from another TRDBILDR.CFG file 

Rename:  This will allow you to rename a file name. 

Save as:   This will save an existing tread as a different file name, making a copy of it. 

Save:   This will save the current file selected. 

18. Main mark: This option will put a main mark for the tread when drawing a Tread End View. 

19. Sub mark: This option will put a sub mark for the tread when drawing a Tread End View. 

20. Draw tread: Putting a check in this box will cause the tread to be drawn. 

21. Draw blowup: Putting a check in this box will cause a larger end view detail to be drawn of the 

tread. 

 

Pick OK to draw tread. 

 

Notes: 

If you need a pan riser to be vertical from nose to bottom use Nose 4, Rise 2, bottom 7 and set 

dimension “C” to 0 

Nose type “NONE SUPPORT ONLY” is for easy placement of support angles or bars when the 

tread may be a concrete insert. 

Input G can be 0 for nose 9 if "Ref from nose" is unchecked. This will 

eliminate the upward turn at the inside edge of the tread. 

 

DIM PAN SUPPORTS 

 

This command is used to add dimensions to existing pan supports. If the 

pans are drawn you will need to zoom in real close, so you can pick the 

supports and not the pan. Your first selection is the top line of the horizontal support. Your 
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second selection is line on the front side of the vertical support that is immediately below the 

horizontal support. After picking the vertical support the command pauses to let you zoom out. 

You must zoom out far enough so that all dimensions will be in the viewing area. 

 

BOLTED TREAD END DETAIL 

This draws the end view of a bolted or welded grating tread or a bolted bent plate tread, (other). 

The scale of the detail is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale 

of Drawing command. 

  

This box is also opened by the stair stringer program when you select a grating tread. You can 

pick “Bill of material only. Do NOT draw” or you may pick cancel to omit all output from this 

program without stopping the stair detail. 

 

 

 

 

  

Insertion point at upper left corner of tread: 

Piece mark for support bar 

Enter mark or use <a>: Enter 

Shop bill information on mark T1 

Place shop bill text on LINE <16>: Enter 

Shop bill information on mark T1 

Place shop bill text on LINE <13>: Enter  

 

PAN TREAD END VIEW 

This uses the Tread Builder to select the pan and options. It 

draws the end view of a pan. If a blowup is drawn, only the pan 

will be drawn, otherwise, you can elect to show or not show 
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supports and dimensions. If you choose to show dimensions you will be asked to pick the 

location of each dimension. “Rubber band” lines for the extension lines will show you which 

dimension you are working with. 

 

STAIR TREAD / RISER CALCULATOR 

 

This is a design program used to 

calculate a tread/riser combination for a 

given total rise or total run. Four 

different codes are given to choose 

from. Each has their own standard 

maximum riser and minimum tread 

which can be changed by the user. 

Additionally, you can enter a minimum 

riser and maximum tread. The 

tread/riser combination is calculated 

using either "Rise + Run" or Rise x 

Run". The "Precision" box determines 

the increment of the tread width. The 

results are shown in the list box at the 

bottom. 

 

 

 

Pick "Change Code" and the dialog box shown to the left 

is displayed. Here you can change the values by picking 

the box you want to change and editing the contents. All 

boxes can be edited. Picking OK saves the changes and 

takes you back to the previous box. Picking Cancel does 

not save any changes. 
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STAIR ELEVATION 

 

This program is for drawing an elevation view of a stair stringer on an erection drawing. Input 

is with icon menus and dialog boxes.  

Command:  Select [AutoSD or AutoSD II] > Stairs > Erection > Stair Elevation 

 

 

 

 

 

 

Select the tread type 

Change Upper end:  

Change Lower end: 

Pick these to select an end condition from an icon menu. 

 

Slope UP 

Select “to the right” or “to the 

Left” to change the orientation of 

the stair. 

 

Draw steps only: Checking this 

option will reduce the amount of 

input required and will draw the 

treads as solid lines but will not 

draw any other part of the stair or 

rail.  

 

Treads are near side: Checking 

this option will draw the treads as 

solid lines and the flanges of a 

channel stringer as hidden. 

Leaving it unchecked will have the 

opposite effect. 

 

Use Plate for Stringer: Checking this option will let you input the depth of the stringer and will 

not have any flanges. Leaving it unchecked will allow you to select a "C" or "TS" shape. 

 

File name: This shows a list of names that were saved by the stair stringer program. Select a 

name and pick Load to set all the inputs to match the stair that created the file. Browse will let 

you select a list from another folder. Delete will delete the file selected. If you exported stringers 

from the Elevation Generator you must open the file with the Stair Stringer program to convert 

the file before it can be used by the Stair Elevation program. 
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PICK WPs: Checking this option will disable boxes for dimension #1 & #2 and the program 

will ask you to pick the upper and lower points. 

 

Start Point: You can choose to pick the lower work point or the upper work point as the starting 

point as shown in the slide picture in the dialog box above. 

 

If a block is NOT required, enter 0 for the length and depth or leave these blank.  

Pick Lower work point at finish floor: 

Pick location of Horizontal dimension: 

Pick location of overall Vertical dimension:  

 

PLAN VIEW OF STAIR 

Command:                  Pick [AutoSD or AutoSD II] > Stairs > Plan View of Stair 

 

You can draw a plan view of a stair by picking “Plan View of 

Stair” from the menu. The plan can be to scale. If you saved the 

stringer file when detailing the stringer, you pick the “Stringer 

file” buttons and have some information enter for you from the 

files. 

  

 

 

 

 

 

 

 

Section marks can be facing toward the back or toward the front. Picking “AC” will put section 

marks at “AA” and “CC” and you enter the mark you want to use at section “A” in the box 

labeled “A”. Do the same for section “C”. Enter values as required and pick OK to draw the 

plan. 
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STRINGER BRACING 

This program will detail a view of the stair, 

looking up from the bottom, detailing shop bolted 

or shop welded bracing on the underside of the 

stair stingers. Tail dimensions may go to either 

end of material or to a work point. 

 

Note: 

When detailing the stringers and saving CNC data 

you will need to have the tails coming from the 

right end of one stringer and the left end of the 

other stringer to match the stringer details. Both 

stringers and stringer bracing will have to be on 

the same drawing. 

 

 

 

 

 

 

 

 

 

Header Beam 

This program is for detailing simple header beams at stair landings. It is supplied with the Stair 

package in case you did not purchase the Beam package. It uses the configuration settings for 

beams, and will only detail channels and horizontal dimensions will always be below the beam. 

The end connections can be a single clip or holes. Internal connections are limited to holes. If 

any blocks are required, the size of the block is entered manually. Where the blocks are 

dimensioned from depends on how you have the beam variable for blocks configured. It is 

assumed that the support at each end will be the back of a channel, so the minus dimensions will 

be 0 for clip connections.  
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Command: 

Main mark: 1B1 

Are marks RIGHT and LEFT (Yes/No) <N>: 

Quantity: 1 

Header beam will be drawn with flanges toed FS 

Do you want to enter a block size (Yes/No) <N>: 

Insertion point: 

Press "+" to increase length. Press "-" to decrease length. 

Is there a stringer connection (Yes/No) <Y>: 

Pick location to draw holes for stringer connection: 

Do you have another stringer connection (Yes/No): Y 

Pick location to draw holes for stringer connection: 

Do you have another stringer connection (Yes/No): N 

Shop bill information on mark 1B1 

Select/Place shop bill attributes on LINE <36>: 4 

(FT.IISS) Thickness of connection material at LEFT end: .0006 
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(FT.IISS) Thickness of connection material at RIGHT end <3/8">: 

  

 

LANDING DECKING 

This program is for detailing the decking that covers a stair landing. The deck length can run 

either direction. If the center notch is not required, enter 0 for dimensions 4 and 5. The layout is 

drawn to scale. Separate marks are given for each piece. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LANDING FRAME 

 

This program is for detailing shop welded frames out of channels with a pan, shop attached or 

with grating field applied. Channels can be toed in or out. One channel can run past the corner, 

either vertically or horizontally or can stop even with the other. If channels are toed out and #15 

is 0 then #9 may be negative to extend the pan over the flanges. You can omit MK6 for this 

condition. MK6 can run the full length as one piece or separate pieces between MK5. 
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The thickness description for the Pan 

material that goes on top of the frame can be 

by Gage. Leaving the gage box blank will 

use the actual thickness in the description. If 

channels are toed out, you can omit MK3 

and/or MK4 from the frame for cases where 

that channel is part of the stair stringer. All 

inputs are stored and recalled the next time 

the program is run. 

 

 

 

 

 

 

 

 

LANDING GRATING 

This program is for detailing the grating that covers a stair landing. Bearing bars can run either 

direction. If the center notch is not required, enter 0 for dimensions 4 and 5. The layout is drawn 

to scale. Separate marks are given for each piece.  

 

 

 

 

LANDING PAN 

This program is for detailing the pan or plate that covers a stair landing. Stiffener angles are 

optional and can run vertical or horizontal. If the center notch is not required, enter 0 for 

dimensions 4 and 5. Stiffeners will be equally spaced. For the Gage or Thickness, enter one or 

the other but not both. This allows you to use a Gage material or a heavier plate. The layout is 

drawn to scale. 
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Chapter 13 - Rails 
 

All programs in this chapter are under the AutoSD > Rails pulldown menu, Stairs / Rails Toolbar 

and AutoSD II > Rails ribbon menu. 

 

LEVEL HANDRAIL 

The Level Handrail program will draw single and multi-line level handrails, with posts bolted 

or welded, with or without pickets, with or without toe plate, with or without grab rail, using 

angles, pipes or tubes for the rail material. The height of the rail is drawn to scale and there is 

an option to draw the post spacing to scale. The program is supported by icon menus and dialog 

boxes that guide you through the input. You select where to start drawing the rail by selecting 

the location of the upper left corner of the detail. The handrail will be drawn from left to right 

with a top view above the portion shown horizontally in the icon menu.  

 

The handrail will be drawn looking from the inside, (toe plate near side). You can recall the 

input from a previously saved handrail. 

 

The icon menu to the left shows all the possible handrail configurations. The 

one in the upper left corner will have one side. The others will have two or 

three sides as shown. Each side will have at least one post. In addition to these 

configurations, you will select one end condition from the icon menu below 

left for the extreme left and right ends. Some end conditions are for the rail to 

turn near side or far side. These turns will not have a post. If you need a 

handrail that looks like the one in the left middle without a post on the vertical 

side, you would select the upper left icon from the first icon menu and then 

select one of the ends from the icon menu below. 

 

The main mark will be placed under the horizontal portion shown in the icons above. 

 

Choose the upper left icon shown in the icon menu to the left if you want to 

end the handrail in a post with or without a return. The icons that show a top 

view with a turn will allow you to turn the handrail at the ends without a 

post. These end types may be used with any of the handrail types shown in 

the first icon menu. If you have a multi-line rail and want a single line at the 

end, beyond the post, you need to select an end that has a return. 
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A dialog box is used to get your input. Select the options 

you want and enter the dimensions that are required. The 

image in the upper left indicates which portion of the rail 

is being detailed. 

The number of rail lines must be greater than 1 in order to 

enable the picket option. Pickets can be between any two 

pair of rails but are not allowed on angle rails. 

 

Spacing #2 is the vertical distance from center line of rail 

to center line of rail. It can be entered as a single distance or as a list of distances separated by 

commas. If the number of distances is less than the number of spaces required for the # of lines, 

the last distance will be used for the remaining spaces. 

 

The # of lines and spacing #9 for ends with a return can be different from the main rail. 

T, M, B, P, D and G are for the actual outside dimension, not nominal. If you have Sch 40 rails 

and Sch 80 post of the same diameter pipe, enter different diameters for the rail and post. The 

difference can be 1/16”. This will cause the program to separate the two when filling out the bill 

of materials.  

 

Grab Rail: Include Grab Rail: Available for pipe and tube handrail only. Put a check in this box 

if you want a grab rail on the side of the handrail. 

Use End Return: Put a check in this box if you want the grab rail turned 90 degrees at the end 

and welded directly to the handrail post instead of a support bracket.  

Description: This is the description that will be used in the shop bill for the end return. The first 

time you use the Hand Rail program the words “Type it” will be displayed in this box. To add 

descriptions, pick Add and another box will pop up for you to enter a description. Pick OK in 

that box and your description will be added to the list and be displayed. If “Type it” is selected 

the program will ask for a description to use in the shop bill. If something else is selected, that 

will be used in the shop bill. Picking Change will allow you change an existing description. 

Picking Delete will allow you delete an existing description. 

 

Select OK when finished entering allots in this dialog box.  

Insertion point at top left corner of rail: 

 

If the Grab Rail option was selected, the dialog box shown on page 202 will be opened for input 

for the grab rail support bracket. 
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Select post connection Enter input C as a negative to put the clip on the left side of the post. 

 

Piece mark of toe plate 

Enter mark or use <pa>: Enter 

Section mark for post connection: A 

Piece mark of Post clip 

Enter angle mark or use <aa>: Enter 

 

Select the upper left icon to continue going straight to the next post. Select the upper right 

or the lower left icon to zigzag to the next post. Select the lower right icon to end the 

handrail or turn a corner. 

The image at the top center indicates the portion of the rail that is being detailed. 

 

 

Select configuration of rail to next post 

 

(FT.IISS) Distance to next post: 3 

Is this post connection the same as the last (Yes/No) <Y>: Enter 

 

 

 

 

 

 

 

 

Select configuration of Select the right end condition 

rail to next post 

 

Enter values for toe plate splice 

connection. Enter 0 for B to omit 

holes in toe plate. 

 

 

 

 

 

The dialog box for the right end is also used for the left end. Many of the inputs will be disabled. 

For this end type, only inputs for 5 and 6 are active. The image in the upper left corner indicates 

which portion of rail is being drawn. 
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End of rail is (Open/Splice) <O>:  

The last mark was 1RR1 

              Main mark: 1HR1 

Are marks RIGHT and LEFT (Y/N) <N>: Enter 

             Quantity: 1 

Shop bill information on 1HR1 

Place shop bill text on LINE <16>: Enter 

Description of 1 3/4" rail: 1`8`O PIPE 

Piece mark for 1`8`O PIPE 

Enter mark or use <mg>: ma  

RAMP or STAIR RAIL 

With the Ramp / Stair Rail program you can draw single or multiple line ramp or stair rails with 

or without pickets, with or without grab rail using angle, pipe or tube for the rail. For metal 

stringers the post can be bolted or welded. For ramp rails the post can be embedded or welded 

to an embed plate or bolted using a base plate or clip. For concrete step rails the post can be 

embedded or welded to an embed plate on the top of the step or on the side of the steps or bolted 

to the top of the step using a base plate. Enter 0 for dimension “A” for the welded or bolted post 

option on top of the step. Pick “on Side” under “Post location” to have the post on the side of 

the steps. These rails are drawn to scale, to the actual bevel and sloping in either direction. The 

program is supported by icon menus and dialog boxes that guide you through the input.   

Command:    Pick [AutoSD or AutoSD II] > Rails > Ramp or Stair Rail 

 

A dialog box is used to get your input. Select the 

options you want and enter the dimensions that are 

required. Some dimensions can be entered 

automatically from stair stringer input that has been 

saved. By using the list under “File name”, select a 

file and pick Load. This list shows all the stringer 

inputs that have been saved for this job. List from 

other jobs can be selected with the Browse button. 

The Delete button will delete a file from the current 

list. 

 

The number of rail lines must be greater than 1 to 

enable the picket option. Pickets can be between any 

two pair of rails. 

Spacing is the vertical distance from center line of rail to center line of rail. It can be entered as 

a single distance or as a list of distances separated by commas. If the number of distances is less 

than the number of spaces required for the # of lines, the last distance will be used for the 

remaining spaces. 

#6 and #7 can be negative to put top or bottom post on the floor instead of on the stair.  If they 

are negative, they can be to the post closest to the work point or farthest away. If they are farthest 

away, do not check the box for “Include additional post” on landing. 
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T, M, B, P and G are for the actual outside dimensions, not nominal. 

Putting a check in the box for “Mid rails are wire” will add a vertical member where the rail 

bends. Select OK when finished. 

 

 

 

 

 

 

 

An icon menu appears    

Pick the top condition A dialog box of the top condition is shown for input. 

 

The bottom icon second from the left in the menu above is where the stair rail turns at the 

landing. Input for #10 and #14 follow the same rules as Spacing in the first dialog box. If you 

have a multiple line rail and want a single line at the end, beyond the post, you need to select an 

end that has a return. 

Another icon menu appears  

Pick the bottom condition   A dialog box of the bottom condition is shown 

      for input. If #8 is the same as #6 then the rail would 

      end at the post. 

 

Pick "Bolted" if posts are bolted to the top of the stringer and enter dimensions 

for A, B and THK. Select “1 Sided @ bot” if the bottom post needs a plate with 

both bolts above the post and enter dimension for C, D and E. 

Pick "Side plate" if posts have a vertical plate at the bottom of the post that are 

welded to the outside of the stringer and enter dimensions for A, B, C and THK 

and select if the plate is on the near side, (NS), of the post or not. 

Pick "Welded", as shown, if posts are welded to the top of the stringer. 

 

 

Grab rail is Near side or Far side (N/F): N 

Insertion point:     A box is displayed around the cross hairs outlining 

       the area required for the rail detail. 

End of rail at top is (Open/Splice) <O>: Enter 

Insertion point @ section mark: 
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            Main mark: 1HR1 

Are marks RIGHT and LEFT (Y/N) <N>: Enter 

             Quantity: 1 

Shop bill information on 1HR1 

Place shop bill text on LINE <4>: Enter 

Description of 2" O.D. rail: 1`8`O STD PIPE 

Piece mark for 2`O STD PIPE 

Enter mark or use <mh>: Enter 

Description of pickets: BAR `8x`8 

Piece mark for pickets 

Enter mark or use <mk>: Enter 

Command:        Grab Rail Support 

 

 

NOTE: 

• If input #6 is negative the end post at the bottom will be on the landing. 

• If input #7 is negative the end post at the top will be on the landing. 

• If a grab rail is included and vertical input #12 is too high to work with horizontal input #11 or #13 

to the end, the grab rail will not turn horizontally but will end where it crosses input #11 or #13. 

• If the rail ends in a splice, (type 1 or 4), the rail will extend a minimum of 4” past the post or bend. 

• Number of rails must be greater than 1 to allow the option for pickets. 

• The number of rails and vertical spacing for end types 3 and 5 can be different from the center 

section of rail. 

• If you have a multiple line rail and want a 

single line at the end, beyond the post, 

you need to select an end that has a 

return, (type 3 or 5). 

• Choose end type 4, 5 or 8 if you want to 

include additional post at the floor level. 

The spacing of post is entered as a single 

distance or as a list of distances separated 

by commas, one dimension for each post 

space starting at the bottom.  

#6 and #7 can be negative to put top or 

bottom post on the floor instead of on the 

stair.  If they are negative, they can be to 

the post closest to the work point or 

farthest away. If they are farthest away, 

do not check the box for “Include 

additional post” on landing. 
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WALL RAIL - Detail 

This program will draw wall rails. 

These rails are drawn to the actual 

bevel, sloping in either direction 

and the length may be drawn to 

scale. 

 

A dialog box is used to get your 

input. Select the options you want 

and enter the dimensions that are 

required. Some dimensions can be 

entered automatically from stair 

stringer input that has been saved. 

By using the list under “File name”, 

select a file and pick Load. This list 

shows all the stringer inputs that 

have been saved for this job. List 

from other jobs can be selected with the Browse button. The Delete button will delete a file 

from the current list. 

  

Insertion point: A box is displayed around the cross hairs outlining the area required for the rail detail. 

Piece mark for wall rail support 

Enter mark or use <ma>: Enter 

Section mark for wall rail support: A 

Pick location for section: 

(FT.IISS) Enter dimension "A" for Top end 

<2 1/4">: .06 

(FT.IISS) Enter dimension "A" for Bottom 

end <6">: Enter 

Main mark: 1WR1 

Are marks RIGHT and LEFT (Y/N) <N>: Enter 

Quantity: 1 

Shop bill information on 1WR1 

Place shop bill text on LINE <4>: Enter 

Piece mark for rail. 

Enter mark or use <mb>: Enter 

Shop bill information on mark mb 

Description: 1`8`O PIPE   

Wall Rail is: “Level” or “Sloping”. Choosing “level” will draw a level length of wall rail that 

would be used above a floor. Choosing “sloping” will draw a wall rail for use on a stair or ramp. 

Slope UP:  "to the right" or "to the left". Select whether you want the rail drawn sloping up to 

the right or left. 
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Dimension 3 is to: "Top" or "Center". The height of the rail over the treads can be measured 

from the top or center line of the rail. The horizontal ends of the rail will always be measured to 

the top of the rail. 

Wall Rail is on a: “Stair” or “Ramp”: Choosing “ramp” reduces the number of options at the 

ends and the dimensions at the lower end do not include a riser for the first step of a stair. 

Dimensions are: "to rail" or "to work points". 

Choosing "to rail" allows you to enter the dimensions you want 

to use for the rail shown to the left. Choosing "to work point", 

as shown in the dialog box on the previous page, allows you to 

enter work lengths and have the program calculate the actual rail 

lengths. 

Brackets are: "Near Side" or "Far Side". Select whether you 

want the section cut at the support brackets to show them on the 

near side or far side. 

 

Wall Bracket: 

Omit all brackets: Put a check in this box if you do not want 

any wall brackets. 

#5 maximum spacing: Enter a single dimension and the total 

distance from first to last bracket will be divided evenly so the spacing does not exceed the 

dimension entered for #5. Enter a list of dimensions separated by commas, example 3,3,3.06 and 

the brackets using those exact dimensions starting at the bottom with the first dimension in the 

list. The last dimension will be repeated until the last space is smaller than the last dimension. If 

the last space is less than 24” you will be warned and given the option to change the spacing. 

Draw section: Put a check in this box if you want to draw the section of the support bracket. 

 

Wall Bracket and Use End Return: 

 

Description: This is the description that will be used in the shop bill for the wall bracket or end 

return. The first time you use the Wall Rail program the words “Type it” will be displayed in 

this box. To add descriptions, pick Add and another box will pop up for you to enter a 

description. Pick OK in that box and your description will be added to the list and be displayed. 

If “Type it” is selected the program will ask for a description to use in the shop bill. If something 

else is selected, that will be used in the shop bill. Picking Change will allow you change an 

existing description. Picking Delete will allow you delete an existing description. 

 

Pipe bends at ends: Options are “Miter”, “long radius” or “short radius”. Select how you want 

the bends to be formed at the end joints where they are 90 degrees. 

Return Bottom end to wall: Put a check in this box if you want a top view of the bottom end of 

the rail showing a return toward the wall. 

Pipe bends internal: Options are “Miter”, “long radius” or “short radius”. Select how you want 

the bends to be formed at the internal joints. 

Return Bottom end to wall: Put a check in this box if you want a top view of the bottom end 

of the rail showing a return toward the wall. 
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Draw Wall at Bottom end: Put a check in this box if you want to draw a reference line for a 

wall at the bottom end of the rail. 

Return Top end to wall: Put a check in this box if you want a top view of the top end of the 

rail showing a return toward the wall. 

Draw Wall at Top end: Put a check in this box if you want to draw a reference line for a wall 

at the top end of the rail. 

 

Select the end condition for each end of the rail by picking the icons on either side of the large 

picture in the center. Enter the dimensions as required. If the bottom end turns and goes 

horizontally and if dimension B10 is greater than B8 the first bracket at the bottom will be on 

the slope at a distance from the bend of B10 - "horizontal length". The same is true at the top 

end. 

Save rail: Check this box to save the inputs to a file. This file can be opened in the Erection 

Wall Rail program to supply the inputs for it. 

Open rail: Lets you open a file that was saved by the Wall rail program or by the Erection Wall 

Rail program and uses the inputs from that file. 

 

DETAIL PANEL 

This program will detail and bill out a mesh panel 

insert for sloping or level handrail as well as insert the 

mesh panel in an existing handrail detail. If it is 

sloping it can be detailed sloping in either direction.  

The panel can be detailed by picking the boundary 

lines or not. If you are not picking boundary lines, 

enter 0 for the bevel for a level rail panel. If you are 

picking boundary lines, the rail must be drawn to 

scale. 

 

View: Changes the direction the rail is sloped. 

Bar type: Perimeter bars can be 2-Flat bars or 

 1-”U” bar. 

Attachment of the panel to the rail can be with or 

without tabs.  

Orientation: The wire in the mesh can be horizontal, 

(0), 45 degrees, parallel to the top rail or any given 

angle. 

 

Dimension #1 can be entered as the Base or the Slope length. Select the one required by picking 

the option to the right of the #1 input box. 

 

Enter a value for all of the fields that are enabled and pick OK. 
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INSERT PICKETS 

This program will draw pickets in an existing 

handrail detail for sloping or level handrail. If it is 

sloping it can be detailed sloped in either direction. 

  

Include Dims: Check Yes to include horizontal 

dimensions. 

Pickets: Select to show only the first and last or all 

of the pickets. 

Break for Grab rail: Select Yes if you have a grab 

rail and the pickets are far side. 

No post on left side:  No post on right side: 

Check these options if the rail is open ended for a 

splice. Only one end can be open. 

P1: picket width 

P: post width 

S: clear space between pickets 

A: horizontal center to center limits of pickets. Enter a value and press the tab key. The number 

of spaces is calculated, and a default is entered for the left space. 

Left space: This is the space from the right side of the left post or picket to the left side of the 

first picket to the right. Enter a value and press the tab key and the right space is calculated and 

printed underneath. 

 

When selecting the upper and lower borders select the face of the object the pickets are welded 

to. 

When selecting the side borders select the center of the object on each side.  

Command: 

Select all boundary lines:   These may be selected in any order. 

Pick dimension line location:   Pick a point.  

 

PICKET RAIL PANEL 

This program will detail and bill out a 

picket rail panel insert for sloping or level 

handrail. If it is sloping it can be detailed 

sloping in either direction. Enter 0 for the 

bevel for a level rail panel. A small plate 

is drawn at each end of the top and bottom 

rail for attaching the rail in the field. The 

top and bottom rails may be different 

sizes and material. 
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RAIL PLAN - Erection 

This program draws the plan view of a rail from a file that was saved by the level handrail 

program. It does not put any dimensions and is drawn to the scale set by Change Scale. The rail 

detail that created the file does not need to be drawn to scale. Pressing Enter after the first rail is 

drawn opens the program up again. The insertion point is the left end as detailed. The direction 

is the direction of the rail at the extreme left end. 

 

STAIR RAIL ELEVATION - Erection 

AutoSD > Rails > Erection- Stair Rail Elevation 

 

This will draw the elevation of a stair or ramp rail 

without any dimensions. Pick Open rail to get 

the input from a file that was saved by the 

stair/ramp rail program. Pick Draw to go directly 

to drawing the rail or pick Continue to select the 

end conditions and edit the input for the ends. 

Pick Cancel if you do not want to draw the rail. 

 

NOTE: 

• This program is affected by the [AutoSD > 

Modify] or [AutoSD I > Change] > Scale of 

Drawing command. 

• The insertion point is the lower work point 

at the top outer corner of the first tread. 

 

WALL RAIL - Erection 

This program works the same as 

Wall Rail: Detail but does not put 

any dimensions. These rails are 

drawn to the scale set by Change 

Scale. 

 

A dialog box is used to get your 

input. Select the options you want 

and enter the dimensions that are 

required. 

 

Wall Rail is: “Level” or “Sloping”. 

Choosing “level” will draw a level 

length of wall rail that would be used above a floor. Choosing “sloping” will draw a wall rail for 

use on a stair or ramp. 
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Slope UP:  "to the right" or "to the left". Select whether you want the rail drawn sloping up to 

the right or left. 

Dimension 3 is to: "Top" or "Center". The height of the rail over the treads can be measured 

from the top or center line of the rail. The horizontal ends of the rail will always be measured to 

the top of the rail. 

Wall Rail is on a: “Stair” or “Ramp”. Choosing “ramp” reduces the number of options at the 

ends and the dimensions at the lower end do not include a riser for the first step of a stair. 

Dimensions are: "to rail" or "to work points". 

Choosing "to rail" allows you to enter the dimensions you want to use for the rail shown to the 

left. Choosing "to work point", as shown in the dialog box on the previous page, allows you to 

enter work lengths and have the program calculate the actual rail lengths. 

Pipe bends: Options are “Miter”, “long radius” or “short radius”. Select how you want the bends 

to be formed. 

 

Select the end condition for each end of the rail by picking the icons on either side of the large 

picture in the center. Enter the dimensions as required. If the bottom end turns and goes 

horizontally and if dimension B10 is greater than B8 the first bracket at the bottom will be on 

the slope at a distance from the bend of B10 - "horizontal length". The same is true at the top 

end. 

Save rail: Check this box to save the inputs to a file. This file can be opened in the Erection 

Wall Rail program to supply the inputs for it. 

Open rail: Lets you open a file that was saved by the Wall rail program or by the Erection Wall 

Rail program and uses the inputs from that file. 
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Chapter 14 - Ladders 
 

All programs in this chapter are under the AutoSD > Ladders pulldown menu, Ladders toolbar 

and AutoSD II > Ladders ribbon menu. 

 

Ladders can be detailed with or without cages. Ladders without cages can be wall mounted or 

sit on the floor and bolted to the wall. Some can go over a parapet and others can go in an 

elevator pit or up to a roof hatch.  

 

Ladders with cages can be roof hatch, side step near side, side step far side or step through. All 

ladders and hoops are drawn to scale and the shop bill is filled out for you.  

 

LADDERS WITH CAGE 

Pulldown: AutoSD > Ladders > Ladders 

W/Cage 

 

Change ladder types by selecting Roof, 

Side step or Step through. “# of rungs 

above Fin FL” is for Side step type. Enter 

all input as required.  

Stringer: Select Angle, Bar or Channel. If 

an angle or channel is used, pick the 

“Select” button to select the stringer size. 

If a bar is used, enter the thickness. If the 

ladder is a step through, and the stringer is a bar, put a check in the box “Bend stringer from one 

piece” if you do not want the stringer bar to be welded from two pieces.  

If the stringer is an angle or channel, put a check in the box “Stringer at step through is a bar” if 

that is what you want, otherwise, the stringer at the step through will be the same material as the 

main stringer. 

Rung: Select Rod or “Other”. The “other” option allows you to enter a different description for 

the rung and will be detailed as a “C” shape. 

Bottom clip: Put a check in the box “Include bottom clip” if required. If GA1 is 0, the hole in 

the OSL will be omitted. If GA2 is 0, the clip will be welded to the ladder. Pick the “Select” 

button to select the angle size. Put a check in the box for “Long leg outstanding” for unequal leg 

angle if required. 

Bracket Spacing: Put a check in the box “Additional Brackets” if you need more stringer 

supports and enter a value for #16. There are four ways to enter the spacing. 1) Enter 0 to have 

only one additional bracket at a distance of #16 from the bottom floor. 2) Enter a single 

dimension greater than 0, (example: 6.06), to add equally spaced brackets between the bottom 

and top brackets where the spacing is less than or equal to your input. 3) Enter multiple 

dimensions separated by a comma, (example: 4, 5, 4.06), to add brackets spaced at 4’-0, 5’-0 

and the remaining space divided equally where the spacing is less than or equal to the last 

dimension of your input. 4) Enter multiple dimensions separated by a comma with the last 
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dimension 0, (example: 4, 5, 4.06, 0), to add brackets spaced at 4’-0, 5’-0 and 4’-6 with no 

additional brackets except for the one at the top. 

Hoop Spacing: #17 is for the space from the top hoop down to the second hoop. The remaining 

distance between #13 and #17 will be divided into equal spaces where the spacing is less than 

or equal to the Max Spacing. 

Step through Options: None, Crossover, Return, Step through. 

This section has options for creating a parapet ladder. Enter available options as required. 

 

Save ladder: Check this box if you want to save all input to a *.LAD ladder file. 

Open: Pick this button to open a *.LAD file to use as the defaults for all input. 

 

After picking OK a dialog box opens for selecting the 

orientation of the support brackets. Select a bracket, enter 

the required dimensions and pick OK. An outline box is 

used to place the ladder. If the outline is too tall to fit 

between your border lines, press the minus key to reduce 

the height. Press the plus key to make increase the height 

after you have reduced it.  

After pick an insertion point and entering the main mark 

and quantity the ladder is drawn and billed out. Dialog 

boxes are then used to input the hoops and other sections. 

A rectangular outline box is used to help in placing each 

detail. The top hoop is drawn, billed out and this process is repeated for the mid hoop, Bottom 

hoop and sections. 

 

LADDERS WITHOUT CAGE 

Pulldown: AutoSD > Ladders > 

Ladders WO/Cage 

 

Change ladder types by picking a Select 

Type button for Side step or Step 

through. Enter all input as required.  If 

GA1 is 0, the hole in the OSL will be 

omitted. GA3 cannot be 0. 

 

Stringer: Select Angle, Bar or Channel. 

If an angle or channel is used, pick the 

Select button to select the stringer size. 

If a bar is used, enter a thickness. #5 is 

used for the width. If the ladder is a step through, and the stringer is a bar, put a check in the box 

“Bend stringer from one piece” if you do not want the stringer bar to be welded from two pieces.  

If the stringer is an angle or channel, put a check in the box “Stringer at step through is a bar” if 

that is what you want, otherwise, the stringer at the step through will be the same material as the 

main stringer. 
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Rung: Select Rod or “Other”. The “other” option allows you to enter a different description for 

the rung and will be detailed as a “C” shape. 

 

Floor: This option is available for the step through parapet ladder. The floor can be either 

checkered plate or rungs. The floor support can be a bar or angle. If an angle is used, pick the 

Select button to select the size. If a bar is used, enter the Width and thickness. The Rung spacing 

is for the horizontal spacing of rungs used for the floor. 

 

Bottom: Select Clip, Plain or Slot for the connection of the bottom to the floor. If an unequal 

leg clip is used, put a check in the box if the long leg is outstanding. 

 

Brackets: May be bolted of welded for parapet ladders only. Otherwise they are welded. 

 

#6 - Bracket Spacing: There are four ways to enter the spacing. 1) Enter 0 to have only the one 

bracket at the top. 2) Enter a single dimension greater than 0, (example: 6.06), to add equally 

spaced brackets between the bottom and top brackets where the spacing is less than or equal to 

your input. 3) Enter multiple dimensions separated by a comma, (example: 4, 5, 4.06), to add 

brackets spaced at 4’-0, 5’-0 and the remaining space divided equally where the spacing is less 

than or equal to the last dimension of your input. 4) Enter multiple dimensions separated by a 

comma with the last dimension 0, (example: 4, 5, 4.06, 0), to add brackets spaced at 4’-0, 5’-0 

and 4’-6 with no additional brackets except for the one at the top 

 

Save ladder: Check this box if you want to save all input to a *.LAD ladder file. 

Open: Pick this button to open a *.LAD file to use as the defaults for all input. 

Use sub marks from file: If you open a *.LAD file you can check this box to use the same sub 

marks that were used when creating the file. This allows you to duplicate an existing detail or 

make minor changes to a ladder and re-detail it using the same marks. 

 

After picking OK a dialog box opens for selecting the orientation of the support brackets. Select 

a bracket, enter the required dimensions and pick OK. An outline box is used to place the ladder. 

If the outline is too tall to fit between your border lines, press the minus key to reduce the height. 

Press the plus key to make increase the height after you have reduced it. 

 

TOP HOOP (SECT B)  

Pulldown: AutoSD > Ladders > Top Hoop (Sect B) > Side Step 

Pulldown: AutoSD > Ladders > Top Hoop (Sect B) > Step Through 

Top hoops can be drawn separately if needed. 

 

MID HOOP (SECT C)  

Pulldown: AutoSD > Ladders > Mid Hoop (Sect C) 

Mid hoops can be drawn separately if needed. 

 

BOT HOOP (SECT D)  

Pulldown: AutoSD > Ladders > Bot Hoop (Sect D) 
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Bottom hoops can be drawn separately if needed. 

 

SECTIONS  

Pulldown: AutoSD > Ladders > Sections 

Various sections can be added if needed. 

 

SECURITY GUARD  

Pulldown: AutoSD > Ladders > Security Guard 

 

Add a Security guard detail to an existing ladder detail. The guard may be made from sheet 

metal or an angle frame with wire mesh. The hinges and latch may be on either side. 

Insert reference: If you check this option a rectangle representing the outline of the security 

guard will be inserted using the lower left corner as the insertion point. You will be asked if the 

ladder detail is a front view or a side view. Pick a point on the ladder stringer near the bottom to 

insert the reference outline. 

 

ERECTION ELEVATION 

This command is for drawing the elevation view of a ladder on an erection drawing. There is a 

caged and non-caged ladder. Both can be drawn in front view or side view. All ladders can be 

drawn as a side step or step through. The programs require three points to locate the ladder. The 

first pick is the top of the upper floor. If you are drawing the side view, this pick should be the 

outside corner of the landing. The second pick is the top of the lower floor. The third pick is the 

center line of the ladder rails. 

The scale is affected by the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing 

command 
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Chapter 15 – Hip & Valley 
 

All programs in this chapter are under the AutoSD > Hip and Valley pulldown menu and 

AutoSD II > Hip & Valley ribbon menu. 

 

The HIP and VALLEY programs will design connections where the purlin is horizontal, 

(parallel to the ground), and the web is tilted, (90O to the roof plane). They will draw a complete 

layout of the purlin and rafter with section views showing detail dimensions of the connection. 

This layout will take up the entire drawing; therefore, your drawing should be blank before you 

start. Start a new drawing and run setup first, setting the drawing size to 24” x 36” and the scale 

to 1”=1’-0. Purlins can be sitting on top of the rafter or framing into the side. All views are 

drawn to scale for easy placement of the purlin connections. Easy selection of member sizes is 

made from dialog boxes. 

 

There are seven different hip and valley connections to choose from. The first three and the last 

one shown in the icon menus above have the purlin sitting on top of the rafter. The shapes for 

purlins and rafters are noted in each icon menu. 

 

The example below is the hip connection shown in the lower left corner of the icon menu above. 

 

 

 

 

 

A slide is displayed for user reference. 

 

 

 

 

 

 

  

(FT.IISS) Enter Base control dim #1: 22 

(FT.IISS) Enter Rise control dim #2: 11 

(Decimal) Enter Horiz control angle D: 45 

(Decimal) Enter Horiz control angle DD: <45.0000> Enter 
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A slide is displayed for user reference. 

 

 

 

 

 

 

(FT.IISS) Thickness of connection plate: .0006 

Enter Number of columns of holes, #5: 1 

Enter Number of rows, (Max will fit is 5), #6: 4 

(FT.IISS) Enter edge distance at end of purlin E1: .0108 

(FT.IISS) Enter edge distance on plate E2: .0108 

(FT.IISS) Enter WP to first hole, G1, |Min = 4 7/8"|: .05 

(FT.IISS) Enter WP to first hole, G2, |Min = 3 1/2"|: .0308 

(FT.IISS) Thickness of bent plate on top flange: .0002  

Some of the prompt lines in different connections will show things like |Min = 4 11/16"|, (Min 

will fit is 3 1/2"), (Min is 3 5/16") or |Use 5 1/16"|. These are prompts giving recommended 

minimum or maximum dimensions based on member sizes selected and dimensions enter before 

the prompt. They are meant to be used as guides for entering information. 

 

 

A section is cut showing the connection detail of the purlin 

giving enough dimensions to be able to detail the purlin as 

well as the connection on the rafter.  
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A complete layout is generated as shown below. Be sure to zoom in on Section “A” and examine 

this section closely for any interference.  
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In the plan view there is a scale given. In this case it is 3/16 = 1’-0. The scale will vary depending 

on the dimensions given for #1 and #2 in order to keep the drawing a certain size. You can use 

the [AutoSD > Modify] or [AutoSD I > Change] > Scale of Drawing command to set the drawing 

to this scale. After doing this you can draw a line 90 degrees to the roof plane line at one end in 

the elevation of vertical plane view and then use the offset command to lay out the purlin spacing 

in this view and project those spaces to the plan view and elevation of hip rafter view. The 

example above shows a spacing of 5’-0 starting at the eave. This will allow you to develop the 

locations of the connections on the rafter.  
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Chapter 16 - CNC Data  
 

Pulldown: AutoSD > CNC 

Toolbar: CNC 

Ribbon: AutoSD II > CNC 

 

CNC data will be attached to entities as extended data to holes and burn 

information will be attached to blocks and skewed ends if you have 

configured your customer to save CNC data. 

 

CNC data for one member is separated from another member by using 

different layers. A layer will be created with the same name as the main mark 

or sub mark and prefixed with "CNC_" when a member is detailed by the 

program. All entities with CNC data for this detail will be on this layer. If 

you copy an existing detail to make a new one you MUST create a new layer 

with the name of the layer the same as the new mark, prefixed with "CNC_", 

set it current and change all entities of the new detail to that layer. You can 

do all of this with the command "Change CNC layer" under "AutoSD > 

CNC". If the layer name does not exist it will be created, if it does exist it 

will be set current. All entities selected will be changed to the new layer 

 

Stairs offer a different problem with separating the CNC data since a stair main mark can have 

two stringers and one stringer can be made from two or more pieces. To handle these conditions 

a layer will be created for each sub piece. The layer name will be the sub piece mark prefixed 

with "CNC_". For example, if the sub piece mark is maR on sheet 43 the layer name will be 

CNC_ma and the CNC file name will be 43maR and 43maL. You can also use this layer naming 

convention for built up frames made from flange shapes. Since frames are not generated by a 

program you will need to create the layers and change the objects layer after detailing is complete 

or set the correct layer current before detailing each member. 

 

When CNC data is extracted from the drawing, a file with the same name as the main mark will 

be created to hold the CNC data for that piece. These files will be saved in a sub folder called 

“CNC Files” of the folder the drawing is in. If the main mark or sub mark for a detail with CNC 

data starts with a letter instead of a number, the CNC file name will start with the drawing 

number. The CNC file name for detail A on sheet 3 will be 3A. Marks can be rights and lefts. If 

you use "Opposite hand" for a mark, the quantity must include “`G” or “~G” for a left. 

 

Tail dimension text will be associated with the holes that the tail dimension is for. If you change 

the tail dimension text using the command "Replace Dim" under "Modify/Change" the tail 

dimension stored in the CNC data will also be changed. If you have two sets of holes and tail 

dimension text to only the first hole, the CNC data for the second set of holes will NOT be 

changed when you change the tail dimension text. You must change the tail dimension stored in 

the CNC data of the other holes with the command "AutoSD > CNC > Change Hole Data > 

Tail" or use the “Edit Data” command.  
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MAIN MARK 

The Main mark will be a block with attributes for the mark, quantity, member size and length. 

The member size and length attributes will be invisible. If you edit the member size or length 

on the description line of the detail you will also need to edit this information in the main mark 

tag by double clicking on the mark or with the command attedit or battman. 

 

Angles  Angles may be detailed in any orientation. The picture 

to the right indicates which leg is the “Upper” and which is the 

“Lower” leg. If the angle legs are not equal the description in 

the piece mark attribute must be entered as “L” Upper leg “x” 

Lower leg “x” thickness. 

 

HOLES 

The data information saved with each hole will be the face the hole is in, the gage of the face, 

which side from the face center line the hole is in, the hole size, the tail dimension, whether the 

member is a "Beam", "Angle", "Column, or Brace", which end the tail is from and which edge 

the gage is from. CNC data for "Column and Brace" is treated differently from other members 

because holes in the web are measured from the centerline and holes in the web of other members 

are measured from the flange or heel. 

 

Since the CNC data is stored in the hole entity, if you erase a hole you erase the CNC data for 

that hole. Holes with CNC data attached will be drawn using a solid polyline. Holes without 

CNC data attached will be drawn using several lines close together. This way you can tell if 

CNC data has been saved with a hole just by looking at the hole. 

 

ASSOCIATE HOLES WITH TAIL 

This program is used after you insert a hole for an existing tail dimension to tie the hole tail 

dimension CNC data to the tail dimension text. 

 

When a tail dimension is placed to a hole, the text is associated with the CNC data of the hole 

so that when the dimension text is changed the CNC data for the hole is also changed. If there 

is more than one hole associated with a tail dimension text, the CNC data for all the holes will 

be changed when the tail dimension text is changed. 

 

The following commands are shortcuts for changing one value of hole data, but multiple holes 

can be changed at one time. For a complete look at the hole data use the Edit Data command. 

 

CHANGE FACE 

This program changes the CNC data "face" value of all holes selected. The face values for beams 

are top flange, web and bottom flange. The face values for columns are left flange, web NS&FS, 

web NS, web FS and right flange. The face values for angles are upper leg and lower leg. 
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CHANGE GAGE 

This program changes the CNC data "gage" value of all holes selected. 

Beam web: gage = distance down from the top flange or up from bottom 

flange. 

Column or W brace web: gage = distance from hole to hole on each side of 

the center line of the web. 

Beam or Column flange: gage = the given gage as detailed.  

Angle: gage = the given gage as detailed. 

 

The gages in the picture shown above are 4" and 7". 

 

CHANGE OPTION 

This program changes the CNC data "option" value of holes selected. The available values are 

for: 

Tail from left end, gage from top flange    

Tail from right end, gage from top flange    

Tail from left end, gage from bottom flange 

Tail from right end, gage from bottom flange 

 

CHANGE SIZE 

This program changes the CNC data "hole size" value of all holes selected. 

 

CHANGE SIDE 

This program changes the CNC data "side" value of all holes selected. The side value for a beam 

and column flange is near side, (NS), far side, (FS) or both sides, (BS). 

The side value for a column web are left side of center line, right side of center line and both 

sides of center line. The "side" value is not used if the shape is an angle or channel. 

 

CHANGE SLOT ANGLE 

This program changes the CNC data angle value of all slots selected. 

 

CHANGE SLOT LENGTH 

This program changes the CNC data length value of all slots selected. 

 

CHANGE SLOT WIDTH 

This program changes the CNC data width value of all slots selected. 

 

CHANGE TAIL 

This program changes the CNC data "tail" value of all holes selected. 
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CHANGE HOLE TO SLOT 

This program changes the CNC data of all holes selected to slots and redraws the hole as a slot. 

You must enter the slot length, width and angle. 

 

CHANGE SLOT TO HOLE  

This program changes the CNC data of all slots selected to holes and redraws the slot as a hole. 

 

NOTE HOLES NS, FS or BS 

These are for labeling holes using a leader line. You start with the location for the arrow. The 

"NEAR" snap is automatically activated for this selection. Pick the next point for the leader line 

and continue picking points. Press Enter after selecting the last point and the note will be added 

to the end of the line. 

 

If the first leader segment crosses any lines you will be asked if you want to select lines to omit 

arrowheads. If you answer No arrows will be put at each intersection between the first leader 

segment and each line it crosses. 

 

If you are saving CNC data, you are prompted to "Select objects". You should select all the holes 

that this note references. The CNC data will be automatically updated. This note is NOT 

associated with the holes. If you change the note the hole data will NOT be updated. 

 

REPLACE TAIL DIMENSION 

Pulldown: AutoSD > Modify 

Toolbar: Change 

Ribbon: AutoSD I > Change 

This program is used to change the tail dimension text. If the text is 

associated with some holes the tail dimensions stored as CNC data for 

the holes will also be changed. The tail dimension text will only be 

associated with holes that the dimension is for. In the picture shown to 

the left, the 2'-9 1/2 dimension text is associated only with the two holes 

on the line the text is on. The other two holes have no association with 

any dimension text. If you change the dimension text you will need to 

use the command "AutoSD > CNC > Change Hole Data > Tail" to 

change the CNC data dimension stored with the other two holes at 3'-3 

1/2. The same program is also located under Modify/Change as Replace 

Dim. 

 

BURNS 

The data information saved with each burn depends on the type of burn and can be viewed and 

edited. 

 

CNC data for burns is stored with a line or a text entity. If you erase that entity you erase the 

CNC data for that burn. Most burn CNC data are stored with the horizontal length text for that 
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burn. Skewed flange, skewed web burns, contours and cutouts are stored with the line for the 

edge of the burn. 

 

The following commands are shortcuts for changing one value of burn data, but multiple burns 

can be changed at one time. For a complete look at the burn data use the Edit Data command. 

 

CHANGE ANGLE 

If this is for beveling the flange for a groove weld the choices are (+-)30 and (+-)45. If this is 

for a skewed cut across the flange or web, it is the angle normal to that surface. For skewed cuts, 

if X or Y is 0 the cut will be full width using the angle. If X and Y are not zero, the skewed cut 

will be based on X and Y and the angle will be used only to determine if it is positive or negative. 

In this case the angle could be 1 or -1. For Blocks it is the angle of the beam slope. The angle 

can be positive or negative. 

 

CHANGE BEAM END 

This changes which end of the beam the burn is on. Available choices are (1) LEFT and (2) 

RIGHT.  

 

CHANGE DEPTH “Y”  

This will change the vertical depth of the burn. 

 

CHANGE LENGTH “X”  

This will change the horizontal length of the burn. This will not change the dimension text. It 

will only change the CNC data. Use “Replace Tail Dimension” under AutoSD > CNC > Change 

Hole Data or “Replace Dimension” under Modify/Change to change both Length text and 

Length CNC data. 

 

CHANGE MARK  

This will change the piece mark associated with a scribe. 

 

CHANGE NOTCH “D”  

This will change the vertical distance from the top flange of the beam to the top edge of the burn 

for a notch in the web. 

 

CHANGE SETBACK 

This will change the distance from the clip to the end of the web. 

 

CHANGE SIDE 

This is for flange thinning burns and will change which side of the web the flange will be cut. 

Available choices are (1) NS, (2) FS and (3) Both sides.  
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CHANGE SURFACE 

This will change the surface the burn is in. Available choices are (1) Top flange or Lower leg, 

(2) Bottom Flange or Upper leg and (3) Web. 

 

CHANGE TYPE 

This will change the type of burn. Available choices are "Bevel Prep", "Beveled Flg", "Block", 

"Contour", "Cutout", "End Notch", "Flg Notch", "Flg Thinning", "Rat Hole", "Skewed Cut" and 

"Slot". 

 

CHANGE LAYER 

If you change the mark of an existing detail to make a new one you MUST create a new layer 

with the name of the layer the same as the new mark, prefixed with "CNC_", set it current and 

change all entities of the new detail to that layer. You can do all of this with this command. If 

the layer name does not exist it will be created, if it does exist it will be set current. Entities on 

layers ASD_SECT, ASD_MARK, HIDDEN and HIDEN will not change layers. These entities 

include main marks, sections marks, and hidden lines and should remain on these layers. 

 

CHECK DATA 

All Drawings: This will extract the CNC data from all selected drawings in a selected folder. 

Current Drawing: This will extract the CNC data from the current drawing. 

Single object: This will extract the CNC data from the details selected. Select the main mark 

under the detail for beams, columns and single member bracing. Select the sub mark for stair 

stringers and double angle bracing. 

 

The CNC data information will be written to a text file in a format that is easy to read. The file 

name will be CNC_CHECK.txt and will be put in the drawing sub folder “CNC Files”.  

Drawing : 1 

Mark    : 1B1 

Member  : W16X26 

Length  : 21'-10 1/2" 

Quantity: 1 

Grade: A36 

Total number of holes: 20 

 

----- Holes ------------------------------------------------------------------------------------ 

Face  Tail Dim Gage Diameter Side Tail from, Gage from 

Web  1 1/2"  3" 13/16"           Left end Top flg    

Web     1 1/2"    6"  13/16"          Left end  Top flg    

Web     1 1/2"  9"   13/16"          Left end  Top flg    

Web     4 1/2"  3"     13/16"            Left end    Top flg    

Web    4 1/2"   6" 13/16"          Left end    Top flg    
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Web     4 1/2"   9"  13/16"            Left end    Top flg    

Web  5'-11 1/2"  3"  13/16"         Left end    Top flg    

Web  5'-11 1/2"  6"  13/16"         Left end    Top flg    

Web  6'-5"   3"  13/16"         Left end    Top flg    

Web  6'-5"   6"  13/16"         Left end    Top flg    

Web  9'-5 1/2"  3"  13/16"         Left end    Top flg    

Web  9'-5 1/2"  6"   13/16"         Left end    Top flg    

Web  9'-11"   3"  13/16"         Left end    Top flg    

Web  9'-11"   6"   13/16"         Left end    Top flg    

Web  21'-6 1/4"  9"    13/16"         Left end    Top flg    

Web  21'-6 1/4"  3"    13/16"         Left end    Top flg    

Web  21'-6 1/4" 6"     13/16"              Left end    Top flg    

Web  21'-9 1/4" 6"     13/16"              Left end    Top flg    

Web  21'-9 1/4" 9"     13/16"              Left end    Top flg    

Web  21'-9 1/4" 3"    13/16"              Left end    Top flg    

 

----- Burns -------------------------------------------------------------------------------------------------- 

Type End  Surface Length X Depth Y Setback Side Angle Notch 

D  

Bevel cut Left Bottom Flange 2 ¼ ------- 0 ---- -45 -------   

Rat Hole Left Bottom Flange 3 ¾  1 7/8    0  ---- -------  -------   

Bevel cut Left Top Flange  2 ¼   -------  0  ---- 45  -------  

Rat Hole Left Top Flange  3 1 7/8  0  ---- ------- -------  

Block  Right Bottom Flange 2 ½ 1 1/8 0  ---- ------- -------  

Block Right Top Flange  2 ½ 1 1/8 0 ---- ------- -------  

 

Side: 

NS = Near side Left = Left side of center line in column web gage. 

FS = Far side Right = Right side of center line in column web gage. 

BS = Both side  

 

Extracting CNC for: 

All drawings:  The scale for plates will be asked once for each drawing and all plates on 

that drawing will be extracted to that scale. 

Current Drawing: The scale for all plates will be asked once and all plates will be extracted to 

that scale. 

Selected objects:  The scale will be asked for each plate. 

If you have several plates on one drawing and most are drawn to one scale and only one or two 

are drawn to a different scale you should extract CNC for current drawing and then extract for 

selected objects and select the one or two plates that are different from the others. Picking Cancel 

when asked for the scale will default to using the scale of the drawing. 
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EDIT Data 

This program is for editing, adding or viewing the CNC data of a single 

hole, burn, clip, ladder part, tee or plate. Column base/cap plates are 

not edited by this program. 

 

PLATES:  

There are four ways to have CNC data with plates. Common Plate, 

Scaled Plate and Column Base/Cap plate file and Gusset plate files. 

 

The common plate method can be used to add CNC data to rectangular 

plates with or without holes. The plate can be shown any view or no 

view at all. The CNC data is stored in the plate’s sub mark, so no detail is required or used so 

no “CNC_” layer is needed. 

The scaled plate method can be used to add CNC data to plates of any shape with or without 

holes. The plate must be shown in full front view to the scale of the drawing. The CNC data for 

the mark, quantity, grade and thickness are stored in the plate’s main or sub mark. The perimeter 

of the plate and all cutouts within the plate must be made with a closed polyline. All holes must 

be made with circles, donuts or closed polylines. All entities must be on a “CNC_” layer with 

the mark as the suffix. 

Column Base/Cap plate file is used to store plates for columns. CNC files can be created directly 

from this file. 

 

 

 

 

 

 

Common Plate  Scaled Plate   Scaled Plate 

or Scaled Plate 

 

Scaled plates:  

Scaled plates must be drawn to scale with a closed polyline. The program will ask you to select 

objects. Select the plate mark. The mark may be part of the description text but is not required 

to be. Example `P`6x9`Wx0’-11`R pb1. If the mark is part of the description it should be at the 

end of the text and there should not be parenthesis as part of the description. 

Wrong:  `P`6x9`Wx0’-11`R (BENT) pb1 

Right:  `P`6x9`Wx0’-11`R [BENT] pb1  `P`6x9`Wx0’-11`R [BENT]  (pb1) 

 This is typically how the gusset plate program labels a plate. If you have manually drawn this 

plate and have not created the “CNC_” layer and put the plate entities on that layer the program 

will ask you to select the plate and all holes and cutouts in the plate. Do NOT select any lines 

other than the polyline outline of the plate and holes. Any lines selected that are not polylines 

will be treated as bend lines. The last step is to add a beveled edge prep for weld if needed. 

 Plate edge weld prep: 
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Select the edge of the plate to bevel. An “X” is placed on the line 

segment selected and a dialog box opens. If the line segment 

already has weld prep data, it is shown in the dialog box. Add a 

weld prep by putting a check in the box for Bevel NS or Bevel FS 

and enter the Y and Angle values. Picking “Select edge” will save 

your input with the current line segment, close the dialog box 

while you select another line segment and reopen the box to 

display the weld prep for the new line segment. Picking OK writes 

all weld prep changes to the brace plate entity. Picking Cancel will 

cancel all changes to the weld prep. 

 

• Plates and all cutouts in plates must be made with closed polylines. 

• Round holes must be made with donuts or circles and can be concentric circles. The outer 

circle establishes the diameter and must be scaled to the desired hole size. 

• Slotted holes must be made with a closed polyline. Multiple polylines inside each other to 

“fill in” the slot must be at the same centers. 

• All details of the plate must be drawn to scale (change scale is allowed). 

• Gusset plates and their clips drawn by the brace program may be used to create CNC files. 

• The gusset plate and holes may be selected using a window to select all objects at once. 

• Lines selected that are not polylines will be treated as bend lines. 

• CNC does not need to be turned on to use this program. 

• You cannot add CNC data to a clip, ladder part, Tee or common plate by placing it on a 

“CNC_” layer because the CNC data for these parts are described completely by the CNC 

data attached to the mark and edited in a dialog box. 

 

The CNC files are saved to a file with the same name as the piece mark. The file name extension 

for CNC files is set in your customer detail configuration. These files will be saved in the sub 

folder of the drawing folder called “CNC Files”. If a member with CNC data has a sub piece 

mark such as a stair or frame or if the main mark begins with a letter, you have the option to 

prefix the piece mark with the drawing number. For the piece mark ma on sheet 43, the CNC 

file name would be 43ma. This is necessary to prevent one CNC file from being used for two 

different pieces that have the same mark. If the mark is a right and left two CNC files will be 

created, 43maR and 43maL. 

 

Burns:  

If you are adding CNC data for a burn such as a 

block, select the length dimension of the block and 

the box on the right will be displayed with the 

selected value in the Length “X” box. Pick “Assoc 

dim” next to Depth “Y” and select the block depth 

dimension. This will put the value in the Depth “Y” 

box and associate the two dimensions with the CNC 

data. If you use Replace Dimension to change the 

depth later, the depth value will be updated in the 

burn CNC data for the block.  
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Side and Angle: Side is used for flange notch, flange thinning, skewed cuts and scribe as listed 

below. Angle can be 0, positive or negative. The sign of the angle determines which way the cut 

goes for a skewed cut. Refer to the slide in the dialog box to see which way positive and negative 

angles are cut. 

 

Skewed cut on web, top or bottom flange or angle leg: There are several variations for X, Y 

and Angle that are used to determine the size and direction of this cut. In all variations the sign 

of the angle determines the location of the cut not the side. See the slides in the program. The 

side option is only important as noted below. The variations are as follows: 

• X= 0, Y = 0. (Flange cut only). If side is BS, Y is full width of flange. If side is NS or FS, 

Y is half width of flange. Y and angle are used to calculate X. 

• X= 0, Y = 0. (Web cut only). Y is full depth of web. Y and angle are used to calculate X. 

The side value determines which web gets cut for tubes only. 

• X > 0, Y = 0. (Flange cut only). If side is BS, Y is full width of flange. If side is NS or FS, 

Y is half width of flange. X and Y are used to calculate angle. Angle may be 0 or -1. 

• X > 0, Y = 0. (Web cut only). Y is full depth of web. X and Y are used to calculate angle. 

The side value determines which web gets cut for tubes only. Angle may be 0 or -1. 

• X = 0, Y > 0. Angle and Y are used to calculate X. See note 1 below. 

• X > 0, Y > 0. X and Y are used to calculate the angle. Angle may be 0 or -1 to determine 

direction of cut. See note 1 below. 

 

Note 1: If side = NS or FS there is only one operation. If side = BS there are two operations. If 

it is BS of a flange, both corners of the flange are cut, and Y must less than or equal to the flange 

width. If it is BS of a web, both webs are cut on one corner for tubes only. 

 

A 45-degree full width cut of a flange can be entered as: 

• X = 0, Y = 0, Side = BS, Angle = 45 or -45. (This is the most common way.) 

• X = flange width, Y = 0, Side = BS, Angle = 0 or -1. 

• X = flange width, Y = flange width, Angle = 0 or -1. 

• X = 0, Y = flange width, Angle = 45 or -45. 

 

Y must be greater than 0 for a chamfer cut. 

A 45-degree chamfer cut of a flange can be entered as: 

• X > 0, Y = X, Angle = 0 or -1. NS or FS cuts one corner. BS cuts both corners. 

• X = 0, Y > 0, Angle = 45 or -45. NS or FS cuts one corner. BS cuts both corners. 

 

Flange Thinning: If the member is not an angle and the angle of the flange thinning is not 0 

and the flange is thinned on both sides the end of the member is automatically skewed. 

Angle, Channel, Other: These options change the reference slide and some of the options to 

make it easier to understand how each input is used for different materials. The option selected 

is not saved as part of the burn data.  

 

Selecting the Layer button pops up a list box, (shown below), of all existing layers in the 

drawing. Select the layer with the same name as the main mark and pick OK. All CNC holes 
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and burns MUST be on a layer that has the same name as the main mark of the piece 

the hole or burn is in. This layer is created automatically when a new piece is detailed. 

If you copy an existing piece to make a new one you MUST create a new layer with 

the same name as the new main mark and change all entities of the new piece to that 

layer. The Change Layer command does all of this for you. 

 

 

 

 

The drawing to the right shows the entity 

that each burn is saved in. 

 

A rectangular slot is shown to the below.  

The Hole Diameter is 

used for the radius of the 

corners. A 1” hole 

diameter equals 1/2” 

corner radius. 

 

The drawing below shows all the burn types 

and conditions. 

 

Note: 

• A notch can have an angle other than 0 making it skewed. 
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• Any corner of a beam web can have only one of the following: Block, Flange Thin, Rat 

Hole or Beveled Flange. 

• There should be only one contour per end per web and flange but can be used with other 

burns. Because CNC data for Contours and Cutouts is described graphically by the line 

with a base angle of 0 degrees, you must enter an angle of 90 when the burn is on a column 

that is detailed standing up. If the burn is on a sloping beam or brace detailed in position the 

angle is the angle measured from a horizontal line. 

• The “X” and “Y” values that locate a cutout go to the left most point for “X” and top most 

point for “Y”. This is either a line or the intersection of two lines. If it is an intersection and 

the intersection is rounded, then it would be to the apparent intersection of the two lines. 

• All angle shapes must be detailed with the outstanding leg on top or on the left side when 

using contours or cutouts. 

 

 

 

 

 

 

 

 

 

 

The CNC data for the blocks is stored in the “X” value. The CNC data for skewed web burns is 

stored in the line where noted in the drawing.  

 

Since one entity can represent only one burn type, if you have a skewed web or flange and the 

web or flange is also beveled you will need to pick a different entity to add the Bevel prep data 

to. It can be any entity if it is on the correct layer. 

 

The size of the radius in inside corners is set in AutoSD > Customer Configuration, Detail 

variables > Edit > Beams > R value under Bevel Flanges for field welds. 

 

Scribe: This is for marking the location of a plate or clip to be shop welded to a main member. 

The tail dimension may be on either side of a plate but if you draw the main member using 

“Graphically Check CNC file” the reference tail for a scribe will always be for the left side of a 

plate regardless.  
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Clip: 

Pick an angle mark with CNC data or to add CNC 

data. For reference, the “web leg” is the leg shown. 

If holes are in both legs, then both “Outstanding leg” 

and “Web leg” check boxes must be checked. If you 

uncheck a box, the CNC data for the holes for that 

leg will be removed.  If you have holes in both legs 

you would normally have the same number of rows 

in both legs, but it is possible to have a different 

number in each leg. Example: 2 holes in the web leg 

and one hole in center of the OSL. Input #1 would 

be 0 for one hole.  

Rows: Select number of rows or enter the spacing as a list separated by a comma. Example 

.03,.03 (3 rows with a spacing of .03 is the same as 2@.03 or .03,.03). The spacing is entered in 

the box to the right of the rows. 

OK: saves the changes made to the CNC data. 

Cancel: cancels all changes and closes the program. 

 

Common plates: 

This is used to add CNC data to plain material 

plates, stiffener plates, shear plates, some base 

plates and cap plates. The CNC data is stored in 

the sub mark, so no detail of the plate is required. 

 

Pick a plate or bar mark with CNC data or to add 

CNC data.  

Select pattern: Pick this to make it easier to see 

which values need to be filled in for the plate you 

want to make. 

Enable all: Pick this to turn on all input boxes. If a value is not needed in a box, leave it blank 

or you may enter a 0.  

 

The value “M” for the thickness may be entered as the decimal thickness or as the gage but not 

both. Entering one will erase the other. Valid gages are 3 – 28. 

 

Values for B, D, F, H, J, L, N and Q for holes may be entered as a list of dimensions separated 

by a comma for multiple holes. Example: .03,.03,.03 or 3@.03. “3@” is for the number of spaces 

not the number of rows. 

Values for E, G, I and K for plate may be entered as negative to extend plate upward or 

downward. All values for holes may be entered as negative. 

Top & Bot Angle: If the plate is skewed in a sloping beam you can skew the top and bottom of 

the plate by entering an angle here. If no skew is needed leave these boxes blank or enter 0.  

Chamfer: The type of notch for chamfer is set in your customer configuration. It can be a 

clipped corner or a block. 

mailto:2@.03
mailto:3@.03
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Bends: 

Use this section if the plate is bent and you want the bend information in the CNC file. If the 

bends run vertically on the plate layout, use inputs A and B. If the bends run horizontally on the 

plate layout, use inputs C and D. Values A, Angle A, C and Angle C use a single dimension. 

Values for B, Angle B, D and Angle D may be entered as a list separated by a comma for 

multiple. Example for B: .0208,.06. Example for Angle B: 90,-90. 

An angle must be entered for each bend. Positive bends near side and negative bends far side. 

Enter a bend radius. The default radius is equal to the thickness times the bend factor set in your 

customer configuration. DXF files do not us bend angles or bend radius so you may leave the 

angles blank if you will be creating DXF files. 

 

QTY, Grade, File name: Enter a value for each. The file name is usually the piece mark with 

no extension. 

OK: saves the changes made to the CNC data. 

Cancel: cancels all changes and closes the program. 

 

 

 

 

 

 

 

 

 

 

 

The pictures above show the reference points wp1, wp2 and wp3 for locating holes. Holes shown 

in the top half of the plate are referenced from wp1, the top edge defined by dimension Cp 

between Ap and Bp. Holes shown in the lower left corner of the plate are referenced from wp2, 

the corner defined by dimension Ap and Cp. Holes shown in the lower right corner of the plate 

are referenced from wp3, the corner defined by dimension Bp and Cp. 

 

The pictures below show the input needed to create a plate with partially slopped edges at the 

top and/or bottom. All values for inputs shown must be greater than 0 except those shown equal 

to 0. (Inputs equal to 0 may be left blank.) 
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Holes:  

A slide drawing of the current selection is shown 

for reference. The value for "Detail of" can be a 

“Angle", "Beam or Stringer” or "Column or 

Brace". "Column or Brace" includes everything 

where the gage of the web is measured about the 

center line. The "Side" value is not important if the 

shape is a channel. You can change the layer the 

hole is on with the “Layer” button. The hole must be on the layer with the same name as the 

main mark the hole is in. The hole can be changed to a slot by putting a check in the box for 

“Make slot” and filling in the values or a slot can be changed to a hole by unchecking “Make 

slot”. To view the values of another hole, pick "Select Entity". You can use crossing, window 

or a point to select. Gage may be entered as a list of two numbers separated by a comma, e.g., 

.0208,.03 

 

 

Ladder: 

Pick a sub mark for a ladder part with CNC data 

or to add CNC data. Material may be angle, bar 

or channel. If the material is an angle you can 

block the flg or web leg at the top or bottom end. 

The length of the block will be the same as the 

width of the web leg shown by dimension #5. 

 

Std, Alt 1, Alt 2 and Alt 3 refer to the crossover 

bars at the top of a step through ladder. 

   

Include holes for rung is for placing evenly 

spaced holes from the bottom up. 

Include top hole is for placing a hole from the 

top for one additional rung. 

Bottom hole is for adding a hole at the bottom for bolting a clip that may be a different size 

from the hole for rungs. 

Bolted brackets: You can include any number of holes at any variable spacing with a diameter 

that can be different from other holes. The spacing is from the bottom to the top and is entered 

as a list of dimensions separated by a comma. Example: 3.06,4,4,4, or 3.06, 3@4 

OK: saves the changes made to the CNC data. 

Cancel: cancels all changes and closes the program. 

 

You can use this program to save CNC data for plain material bars, angles and channels in 

addition to ladder parts. 
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Tee: 

Pick a split Tee mark with CNC data or to add CNC 

data. The dialog box shown to the left functions in the 

same way as the dialog box for clip angles above. 

 

Rows: Select number of rows or enter the spacing as a 

list separated by a comma. Example .03,.03 (3 rows 

with a spacing of .03 is the same as 2@.03 or .03,.03). 

The spacing is entered in the box to the right of the 

rows. 

OK: saves the changes made to the CNC data. 

Cancel: cancels all changes and closes the program. 

 

EDIT DSTV FILE 

Note: You can edit most aspects of the file by changing 

values in the editor but if you want to add or change 

something not available in the editor you must draw the 

views first, edit the drawing manually that needs changing 

and convert the perimeter of the view to a polyline before 

running the DSTV file editor. 

 

The main dialog box of the DSTV editor opens. You can 

edit any of the active edit boxes shown. The other 

information is shown for reference only. You can change 

the length of the member but not the member size. The 

items that are blank in the example are reference 

information and are usually not needed. 

 

Plate thickness: 

The thickness for plates can be entered as the decimal thickness or as the gage. If you enter the 

decimal thickness the gage will not be used. If you enter the gage the actual thickness will be 

put in the decimal thickness input box. 

 

Camber: Opens the dialog box to edit the camber. You can have camber on any of the four 

faces. To add a camber, pick the Add button. Enter an X location, (the distance from the left 

most end of the member to the point of camber), and an amount of camper at that point and pick 

OK. Remove a camber by selecting one from the list labeled “X location” and pick “Remove”. 

Changing the face will refresh the “X location” list to show the camber for that face. Pick OK 

to save your changes and close the box. Pick Cancel to ignore your changes and close the box. 

 

Holes and Text: These work like Camber. To edit an existing value, select the item to change 

from the X–Y location list on the left side and enter a new value on the right side. Pick the Add 

button to add an item. The defaults are from the item selected. Pick OK to add the item, pick 

cancel to void the change.  

mailto:2@.03
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Replace all holes: This button is in the Holes dialog box. You can replace all holes on one or 

multiple faces by selecting the drawing that was created by drawing the data from the file. This 

drawing is drawn to scale and all editing to it must be to scale. If you change any holes, the 

location and size of the hole must be to scale. When selecting the drawing, all entities of all faces 

of the drawing should be selected including the text under each face. If you only need to replace 

the holes in the top face, for example, you could select just that face and holes and text that says 

TOP VIEW only if the left most end of the top face is at an “X” value of 0. That is, no other face 

extends to the left of the left end of the top face. The program will assume the “X” value of the 

left end to be 0 for calculating the “X” location of the holes. Replacing all holes will change the 

“Ref Y from” value for all holes. 

 

Powder and Punch: Opens the dialog box to edit scribe 

lines. You can have lines on any of the four faces. Each 

line has a start point and an end point. Each Set must have 

at least two points but may have more. When you open a 

DSTV file with scribe lines there will be three points per 

set or two lines. If you edit the lines by using the “Replace 

All” button to select the drawing made by the “Graphically 

Check CNC file” or from picking the “Draw” button on the 

main dialog box, the number of Sets will be increased and 

the number of points per set will be two. Each Set will have 

one line. To add a set or a point, pick the Add button and 

pick Point or Set. Enter an X and Y location, (the distance 

from the left most end of the member, X, and the distance 

from the bottom of the face, Y, to the start point or end 

point of a line), and pick OK. Remove a point or Set by selecting one from the list labeled “X 

location Y location” or “Set” and pick “Remove”. Changing the face will refresh the “X location 

Y location” list to show the points for that face. Pick OK to save your changes and close the 

box. Pick Cancel to ignore your changes and close the box.  

If you edit scribe lines in the drawing made by the command “Graphically Check CNC file” the 

lines for Powder must be on the layer KO_line and lines for Punch must be on the layer PU_line. 

Any text associated with the lines for Powder or Punch must be on the layer SI_text. 

 

Replace all: This button is in the Holes dialog box. You can replace all holes on one or multiple 

faces by selecting the drawing that was created by drawing the data from the file. This drawing 

is drawn to scale and all editing to it must be to scale. If you change any holes, the location and 

size of the hole must be to scale. When selecting the drawing, all entities of all faces of the 

drawing should be selected including the text under each face. If you only need to replace the 

holes in the top face, for example, you could select just that face and holes and text that says 

TOP VIEW only if the left most end of the top face is at an “X” value of 0. That is, no other face 

extends to the left of the left end of the top face. The program will assume the “X” value of the 

left end to be 0 for calculating the “X” location of the holes. Replacing all holes will change the 

“Ref Y from” value for all holes. 

 



CNC Data, Chapter 16                                            AutoSD Steel Detailing  

234 

Text: Opens the dialog box to edit text. You can have text on any of the four faces. To add text, 

pick the Add button. Enter an X and Y location, (the distance from the left most end of the 

member, X, and the distance from the bottom of the face, Y, to the start point of text), and the 

text at that point and pick OK. Remove text by selecting one from the list labeled “X location Y 

location” and pick “Remove”. Changing the face will refresh the “X location Y location” list to 

show the text for that face. Pick OK to save your changes and close the box. Pick Cancel to 

ignore your changes and close the box. 

 

Tolerance: This lest you add a minimum and maximum tolerance value to the member. You 

can remove a tolerance by removing one or both values and pick OK. 

 

Replace internal openings: This is for adding, removing or changing internal opening in a face. 

The “hole” must be one polyline and the size and location must be to scale. The change is made 

on the drawing that was created by drawing the data from the file. See “Replace all holes” above 

for selecting all objects. 

 

Replace perimeter cuts: This is for adding, removing or changing external cuts, blocks or copes 

in a face. The entire perimeter of the face must be one polyline and must be to scale. The change 

is made on the drawing that was created by drawing the data from the file. See “Replace all 

holes” above for selecting all objects. 

 

EDIT DXF FILE 

This program is for editing the quantity, thickness or gage and grade stored in a DXF file for 

plates. Start the program and select a DXF file. You are then prompted for the quantity, thickness 

and grade. The defaults are from the file selected. 

 

FIND CNC  

Use this program to locate entities that have CNC data attached. An “X” will be placed on each 

entity found. The “X” is a highlight and will disappear when the screen is redrawn or if you run 

the program a second time. This program makes it easy to find sub marks with CNC data if you 

are not using a separate color for CNC entities. 

 

GATHER MARKS  

 

Use this program to re-detail a piece from its 

CNC file. The CNC files will be read from the 

“CNC Files” folder of the current open drawing 

or if the current drawing is in a sub folder of the 

job folder. 

 

Example: Current drawing is in: 

"C:\customer\job 101" or 

"C:\customer\job 101\Gather Sheets "  

CNC files are read from: 
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"C:\customer\job 101\CNC Files". 

 

You can also browse to a different folder. 

 

This detail can be used to check the CNC data of the piece and can be used to create “Gather 

sheets” of sub pieces for the shop to fabricate from.  

The dialog box shown to the left will be refreshed each time the program is launched but will 

remember if a file has been drawn or put in the “Do not Draw” column. Any new files will be 

added. Any files deleted will be removed. If you do not want to draw a piece, select it and pick 

the “Do not Draw” button. To draw a piece, select it from the Mark or Description column and 

pick the “Draw” button. Multiple selections are allowed. The box will go away, and you will be 

prompted for an insertion point. After all pieces that were selected are drawn the box will open 

back up and the marks that were drawn will be moved to the “Drawn” column. If you want to 

draw the same piece again select it from the “Drawn” column and pick the “Re-Draw” button. 

 

CNC FILE FOR  

Note: All CNC files will be saved in the sub folder “CNC Files” of the drawing folder. 

 

All Drawings: This will create a CNC file for each piece on selected drawings.  

 

Current Drawing: This will create a CNC file for each piece on the current drawing. 

  

Single object: This will create a CNC file of the details selected. Select the main mark under 

the detail for beams, columns and single member bracing. Select the sub mark for stair stringers 

and double angle bracing. 

 

Base/Cap plates: This will open the column base/cap plate editor. Select a mark or create a plate 

and pick OK. A CNC file will be created for the plate selected. 

 

From *.gus file: This will create a CNC file of selected *.gus file you have saved from the 

Bracing package. 

 

GET MISSING CNC FILE NAMES 

Use this program to compile a list of all main and sub marks for which a CNC file has not been 

created or has been created but has been left out of the shop bill. You have the opton to check 

the current drawing or all drawings for missing CNC files. If you choose to check all drawings 

you must run “Compile BOM quantities” first. This creates a list of all marks in the file 

BOM_qty.txt. Then run “Get missing CNC file names” and select the BOM_qty.txt file. This 

file must be in the same folder as the CNC files you want to get the list for. A new file called 

“Missing files.txt” will be created and opened with Notepad. 
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GRAPHICALLY CHECK CNC FILE 

This will read a selected DSTV or DXF file and draw the web, top, bottom, and rear view if 

required, of the member to scale showing all holes and burns. Channels will be drawn toed near 

side and upside down. 

 

 

 

 

Shop detail of beam 

 

 

 

 

 

 

 

 

 

  

      Detail from DSTV file 

 

Holes will be labeled with an X and Y dimension. X is the distance from the center of the hole 

to the left end. Y is the distance from the reference axis. For beam web holes this is either the 

top or bottom flange. Beam, Column and Brace holes in the flange is the flange centerline. It is 

the heel for angles. Edges that are beveled will be drawn thicker. 

 

SUB MARK 

eXisting/Sub assembly mark: 

 

This command is for storing CNC data in a sub piece mark with a leader. This command does 

everything that the command Change CNC Layer does. You can select an existing mark if you 

are carrying marks through by entering an “X” to the prompt for the mark. 

 

The dialog box shown to the right is used to select the 

existing mark. If it is a new mark you are asked for the 

quantity, member size, cut length and grade. Once these 

items are entered you are asked if you want to “Add mark 

“newmark” to shop bill (Yes/No) <Y>:” After that you 

select all entities that are associated with this mark. A 

layer is created with the same name as the sub mark 

prefixed with "CNC_" and all entities selected are moved 

to this layer. The only entities that must be on the new 

layer are the holes, text and lines with the CNC data. 
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In the example shown to the left the sub mark aaR contains 

the CNC data for the quantities, length, size and grade. The 

detail is on layer CNC_aa. The holes in aaL do not have any 

CNC data stored in them. 

 

The exception to the rule of selecting all entities that are 

associated with the mark is with plates. If the plate is a plain 

rectangular shape with no holes in it, you do not need to select 

any entities. The CNC will be taken from the description of 

the plate. If the plate has any holes or cuts or is an irregular 

shape it must be drawn to scale with a closed polyline and 

then you should select the outline of the plate and all holes in 

the plate. 
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Appendix A - Installation 
 

This section provides the information required to install AutoSD Steel Detailing on your 

computer system. 

 

 

INSTALLING AutoSD STEEL DETAILING 

Installing your AutoSD Steel Detailing software is simple. Just run the installation program. All 

the necessary files will be copied to the hard drive. 

 

Windows 2000, NT, XP, Vista, Windows 7, 8, 10 

 

Put the CD-ROM in your CD-ROM drive. 

Close all open applications. 

From the Task Bar, select Start/RUN. 

Type “D:\autosd_setup” where “D” is your CD-ROM drive. 

Press enter. 

Follow the on-screen instructions. 

 

When the installation is complete you will have to configure AutoCAD or BricsCAD. 

 

Since the release of AutoSD 2012, you can run multiple versions of AutoSD at the same time 

by installing each version of AutoSD in a separate folder and creating a profile in AutoCAD for 

each version of AutoSD. 

If you’re current version of AutoSD is version 2012 or later and you want to also run 

AutoSD 2022, simply install AutoSD 2022 in a folder with a different name from where AutoSD 

version 2012 is installed. 

  

Example: 

AutoSD 2012 is installed in C:\autosd. Install AutoSD 2022 in C:\autosd 2022 

 

 

Creating a profile for installing AutoSD side by side with older version. 

 

AutoCAD: 

Open a drawing and pick Tools > Options > Profiles 

If you do not have a profile named for the current version of AutoSD, pick rename and change 

the name of the current profile to AutoSD 2012. 

  

To make a new profile, pick "Add to list". Enter the name "AutoSD 2022" and pick "Apply & 

close". 

Pick "Set Current" 

Pick the Files tab 
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Change the "Support file search path" for AutoSD to C:\autosd 2022\support 

Pick Apply 

Pick OK 

Load the AutoSD menu as noted below. 

To change from one version of AutoSD to another just pick Tools > Options > Profiles, select 

the profile you want and set it current. 

 

BricsCAD: 

Open a drawing and pick Tools > User Profile manager. 

If you do not have a profile named for the current version of AutoSD, pick Default > Copy and 

enter a profile name for AutoSD 2012. 

To make a new profile, pick "Create" or “Copy”. Enter the name "AutoSD 2022" and pick "OK". 

Pick "Set Current" 

Pick “Start” to launch BricsCAD with the new profile.  

Pick Settings > Settings 

Expand “Program options” 

Expand “Files” 

Pick the button with the three dots at the right end of "Support file search path" and add C:\autosd 

2022\support 

Pick OK 

Close the Settings dialog box 

Load the AutoSD menu as noted below. 

To change from one version of AutoSD to another just pick Tools > User Profile manager, select 

the profile you want, set it current and pick Start. 

 

AutoCAD Release 2000 - 2013 configuration 

From the pulldown menu select TOOLS and then Options or type CONFIG and press enter. A 

dialog box is displayed. 

 

Select Files 

Double click on Support file search path. 

Select Add.  Add the following line in the newly created box. 

  C:\AUTOSD\SUPPORT 

   Where: 

   C:  is the drive where AutoSD is installed. 

   AUTOSD  is the name you gave for the AutoSD folder. 

Pick the “Apply“ button. 

 

AutoCAD Release 2014 and later configuration 

From the pulldown menu select TOOLS and then Options or type CONFIG and press enter. A 

dialog box is displayed. 

 

Select the Files tab 

Double click on “Support file search path” or pick the plus sign next to it. 
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Select “Add” and add the following line in the newly created box. 

  C:\AUTOSD\SUPPORT 

   Where: 

   C:  is the drive where AutoSD is installed. 

   AUTOSD  is the name you gave for the AutoSD folder. 

Pick the “Apply“ button. 

Do not close the dialog box yet. 

 

You can add the following to your Trusted Locations to avoid constant warnings about loading 

files or you can disable the warning feature. 

 

To disable the warning feature instead of adding paths to “Trusted Locations” close the dialog 

box and type SECURELOAD at the command and press enter. Type 0 (zero) and press enter. 

 

To add folders to “Trusted Locations”: 

 

For AutoCAD LT:  

Close the current dialog box. From the pulldown menu select CADSTA > CADSTA Tools > 

TrustedPaths Manager. 

 

Full version of AutoCAD: 

Double click on “Trusted Locations” or pick the plus sign next to it. 

 

Repeat the following steps for each folder below. If you did not purchase the complete AutoSD 

Steel Detailing program, some folders will not exist, and AutoCAD will warn you of this. In 

those cases, do not include that folder. 

Pick the “ADD” button and enter the following line in the newly created box or, (to avoid 

typographical errors), pick the Browse button and select the folder. 

 

C:\AUTOSD  C:\AUTOSD\BM 

C:\AUTOSD\BONUS  C:\AUTOSD\BRACE 

C:\AUTOSD\CNC  C:\AUTOSD\COLUMN 

C:\AUTOSD\DATA  C:\AUTOSD\DATA\BACKUP 

C:\AUTOSD\HIP_VAL C:\AUTOSD\LADDER 

C:\AUTOSD\MENUS  C:\AUTOSD\RAILS 

C:\AUTOSD\STAIR  C:\AUTOSD\SUPPORT 

C:\AUTOSD\WELDS 

 

Pick the “Apply“ button. 

Close the dialog box by picking OK. 

 

BricsCAD 13 and later Pro/Platinum configuration 

Type CONFIG and press enter or pick Settings > Settings. A dialog box is displayed. 

 

Expand Program options 
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Expand Files 

Select Support File Search path 

Pick the button at the right end of the line with the three dots... 

Double click on the blank line at the bottom of the Folder List and then pick the button at the 

right end of the line with the three dots...   

Expand My Computer 

Expand Local Disk (C:) 

Expand AutoSD 

Select Support 

Pick OK 

Pick OK again 

 

Expand Templates 

Select Template 

Pick the button at the right end of the line with the three dots... 

Change folders to C:\autosd\support and select Autosd.dwt 

Pick Open 

 

Select Template path 

Pick the button at the right end of the line with the three dots... 

Change folders to C:\autosd\support 

Pick OK 

 

Loading the menu 

 

Loading the AutoSD menu: 

At the command prompt type MENULOAD or CUILOAD and press enter. 

Select AUTOSD from the “Loaded Customization groups” and pick Unload. (Existing user) 

Pick Browse. (BricsCAD: Pick button with three dots …) 

In the (AutoCAD: “Load/Unload Customization”) (BricsCAD: “Choose a Customization File”) 

box pick the arrow at the right end of the “Look in” box and select the drive where AutoSD is 

installed. In the large box, double click on AUTOSD, double click on MENUS. 

AutoCAD 2000 – 2002:  select autosd02.mnu 

AutoCAD 2004 – 2009:  select autosd.mnu (see Note below). 

AutoCAD 2010 – 2014:  select autosd.cuix 

AutoCAD 2015 and later:  select autosd15.cuix 

BricsCAD 19 and older:  select autosd.cuix   

BricsCAD 20 and later:  select autosd.cuix if you are using the light theme and autosd15.cuix 

if you are using the dark theme. 

BricsCAD note: An *.CUI file will be created from the *.CUIX file for Bricscad. Pick the *.CUI 

file if you need to load the menu file again unless you need to overwrite the CUI file with an 

update to AutoSD. 

Select Open. 

Pick Load    If a message box appears warning that loading of a 

     template file overwrites the menu source file.  Pick YES 
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to continue loading the menu file. 

For AutoCAD 2000 - 2005: 

Select AUTOSD from “Menu Groups” and pick the Menu Bar tab. 

Select where you want to place the AutoSD menu group in the Menu Bar list and pick Insert. 

Select Close 

 

Note. 

All versions of AutoCAD and BricsCAD can load the autosd.mnu file. You may need to change 

“Files of type” to “Legacy menu files (*.mnu)” at the bottom of the “Select Customization File” 

dialog box to be able to select the AUTOSD.MNU file. The MNU file does not have the ribbon 

menu in it. 

 

If you get “smiley faces” or question marks in your toolbars and have an older version of 

AutoCAD you need to do the following: 

Add C:\autosd\icons to the “Support file search path” 

Unload the autosd menu 

Re-load the proper autosd menu from c:\autosd\menus 

 

If you have BricsCAD 15 or AutoCAD 2010 or later and load the AUTOSD.CUIX or 

AUTOSD15.CUIX menu file you can use the ribbon menu in AutoSD. The RIBBON command 

turns the ribbon menu on. The RIBBONCLOSE command turns the ribbon menu off. The ribbon 

menu can be used with or without the pulldown and toolbar menus. Pulldown menus can be 

turned on and off with the command MENUBAR. Set the value to 1 to turn it on and to 0 to turn 

it off. 

 

STARTING A NEW DRAWING 

To start a new drawing, start AutoCAD or BricsCAD. If AutoCAD or BricsCAD is already 

running, select Files and New. Select "Use a Template". In the “Select a Template” window 

select autosd.dwt and pick OPEN. If autosd.dwt does not show in the template list, it can be 

found in C:\autosd\support. 

 

Select OK, Open or Finish.   

Run Setup from the AutoSD > Format pulldown menu or from AutoSD I > Utilities ribbon 

menu. A dialog box is displayed to select the units, scale and paper size. You must save the 

drawing before you can use AutoSD commands. This must be done before you start drawing. 

 

This template file is set up to a scale of 1" = 1', using architectural units on a paper size of 24 x 

36. You can create other template files by running SETUP from menu to set the units, scale and 

paper size if it is to be different. You can also insert your customer's shop bill and create a 

template for each customer. This will eliminate the need to run SETUP each time you start a 

new drawing. Pick "Files "from the menu and pick "Save As". Select "Save as file type", at the 

bottom of the dialog box, and select "Drawing template file". Change the file name and folder 

where it will be saved and pick OK. 
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Appendix B - Support Files 
 

ASD_CFG.LSP 

This file is created when you install AutoSD. It is created in your C:\autosd\support folder. 

Previous versions created this file on the root of drive C:\. That file is no longer used and may 

be deleted. Below are the typical contents of C:\autosd\support\asd_cfg.lsp 

 

(setvar "MENUECHO" 0) 

(setvar "CMDECHO" 0) 

(setq asd_drive "C:")  ; The drive AutoSD is on. 

(setq asd_dir "/Autosd/")  ; The name of the AutoSD folder. 

(setq asd_path "C:/Autosd/") ; The path of the AutoSD folder. 

(princ) 

 

If you move AutoSD you will need to edit this file to give the new location of AutoSD. 

 

SHAPE DATABASE 

The data base is designed to make it easy to change existing shape properties or add new shapes. 

The data files are in your C:\autosd\data folder. The file asd_data.cfg list the names of the files 

used for each shape. There are three lines for each country of shapes supported. An example of 

the three lines for US shapes is given below. 

 

Line 1: 

 ("US") 

Line 2:  

(("C" . "C")("HP" . "W")("M" . "W")("MC" . "C")("MT" . "WT")("S" . "S")("ST" . 

"ST") 

("WT" . "WT")("W" . "W")("CF" . "CF")("SSC" . "CF")("DSC" . "CF")("UC" . "CF")("Z" 

. "CF") 

("L" . "L")("CB" . "W")("TS" . "TS")("PS" . "PS")("HSS" . "HSS")("TB" . "TB")("CL" 

. "CL") 

("SN" . "SN")("AS_C" . "AS_C")("AA_CS" . "AA_CS")("AL_W" . "AL_W")("AL_H" . "AL_H") 

("AA_I" . "AA_I")("AL_L" . "AL_L")("AL_TS" . "AL_TS")("AL_PS" . "AL_PS")("AS_I" . 

"AS_I")) 

Line 3: 

(("C" . "us-c.dat")("HP" . "us-hp.dat")("M" . "us-m.dat")("MC" . "us-mc.dat") 

("MT" . "us-mt.dat")("S" . "us-s.dat")("ST" . "us-st.dat")("WT" . "us-wt.dat") 

("CB" . "us-cb.dat")("W" . "us-w.dat")("TS" . "us-TS.dat")("CF" . "us-cf.dat") 

("SSC" . "us-cf.dat")("DSC" . "us-cf.dat")("UC" . "us-cf.dat")("Z" . "us-cf.dat") 

("PS" . "us-ps.dat")("HSS" . "us-hss.dat")("L" . "us-L.dat")("TB" . "us-TB.dat") 

("CL" . "us-CL.dat")("SN" . "us-SN.dat")("AS_C" . "us-c_AS.dat")("AS_I" . "us-

I_AS.dat") 

("AL_W" . "us-w_AL.dat")("AL_H" . "us-h_AL.dat")("AA_I" . "us-I_AA.dat") 
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("AL_L" . "us-L_AL.dat")("AL_TS" . "us-TS_AL.dat")("AL_PS" . "us-ps_AL.dat") 

("AA_CS" . "us-cs_AA.dat")) 

 

The first line, ("US"), is the country and must not be changed. The second line list the shape 

designations and their aliases.  Example: ("shape" . "aliases"). The third line list the shapes and 

their corresponding data file. Example: ("shape" . "data file"). 

 

The following list the aliases for each shape type. 

 

C = Channels with sloped and parallel flanges 

S = Wide flange with sloped flanges 

W = Wide flange with parallel flanges 

ST = Split Wide flange with sloped flanges 

WT = Split Wide flange with parallel flanges 

TS = Hollow square or rectangular sections 

PS = Hollow round sections 

L  = Angles, equal and unequal legs 

CF = Cold formed light gage "Z" and "C" shapes 

TB  =  Turnbuckle 

CL  = Clevis 

SN  =  Sleeve nut 

 

The last section of the asd_data.cfg file labeled ("SHAPES"), as shown below, is a list of aliases 

and corresponding shapes for each country. In each list the first item is the alias and the second 

item is a list of all shapes associated with that alias. Example for US: ("W" 

("HP""M""S""W""CB")), where "W" is the alias and ("HP""M""S""W""CB") is the list of 

shapes that will be displayed in pop down boxes. "CB" is for castellated beams. 

 

("SHAPES") 

("listus" ("W" ("HP""M""S""W""CB""AL_H""AL_W""AA_I""AS_I")) ("CF" ("CF")) ("WT" 

("MT""ST""WT")) ("C" ("C""MC""AS_C""AA_CS")) ("TS" ("HSS""TS""AL_TS"))  ("PS" 

("HSS""PS""AL_PS")) ("L" ("L""AL_L")) ("CL" ("CL")) ("TB" ("TB")) ("SN" ("SN"))) 

("listcan" ("W" ("WWF""WRF""HP""M""S""W")) ("CF" ("CF")) ("WT" ("WWT""MT""ST""WT")) 

("C" ("C" "MC")) ("TS" ("HSS""TS")) ("PS" ("HSS""DN")) ("L" ("L")) ("CL" ("CL")) 

("TB" ("TB"))) 

("listuk" ("W" ("J""UB""UC""UBP")) ("WT" ("BT""CT")) ("C" ("C")) ("TS" 

("RHS""SHS")) ("PS" ("CHS""ERW"))("L" ("L")) ("CL" ("CL")) ("TB" ("TB"))) 

("listeur" ("W" ("DIL""HD""HE""HL""HP""HX""IPE""IPN""IPEA""IPEO""IPER""IPEV"))        

("C" ("U""UAP""UPN")) ("TS" ("HSS")) ("PS" ("HSS")) ("L" ("L")) ("CL" ("CL")) ("TB" 

("TB"))) 

("listaus" ("W" ("TFB""UB""UC""WB""WC")) ("WT" ("BT""CT")) ("C" ("PFC""TFC")) ("TS" 

("RHS")) ("PS" ("CHS")) ("L" ("EA""UA")) ("CL" ("CL")) ("TB" ("TB"))) 

 

Where: 

listus  is for US. 
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listcan  is for Canada. 

listuk  is for United Kingdom. 

listeur  is for European. 

listaus  is for Australian. 

 

In order to add more members of an existing shape to the data base just edit the file that contains 

the shape type using the database editor found under AutoSD > Modify > AISC database. As 

the name implies, it will only edit the shapes used in the US. Shape files for other countries will 

have to be edited manually. 

 

To add different shape types to the data base, create a file that contains the shape type definitions. 

Put the file in the autosd\data folder. Edit the file asd_data.cfg and add the new shape and alias, 

(ie: ("shape" . "alias")) to the second line of the country section. Add the shape and the 

corresponding data file name to the third line of the country section. Add the new shape 

designation to the list for its alias in the SHAPES section. 

    

A copy of the first four lines of the data file us-w.dat is shown below. The format is typical of 

all “US” data files. 

 

"D" "Wt" "MM D" "MASS" D   WT   AR   tw     Bf    Tf     T      k      r     Ix     

Sx     Rx    Iy     Sy     Ry     Zx    Zy   GAGE) 

("4" "13" "100" "19" 4.16 13 3.83 0.280 4.060 0.345 2.625 0.750 0.405 11.300 5.460 

1.720 3.860 1.900 1.000 6.280 2.920 2.250) 

("5" "16" "130" "24" 5.010 16 4.68 0.240 5.000 0.360 3.500 0.750 0.390 21.300 8.510 

2.130 7.510 3.000 1.270 9.590 4.570 2.750) 

("5" "19" "130" "28" 5.150 19 5.54 0.270 5.030 0.430 3.500 0.813 0.383 26.200 10.20 

2.170 9.130 3.630 1.280 11.60 5.530 2.750) 

 

The first line is the designation for the dimension in the column below it. This line must be the 

first line of the file and the order of numbers must be maintained. The remaining lines describe 

each shape. The entire description for a shape must be on a single line enclosed in parentheses. 

The numbers are divided into columns to make the file easy to read but in reality there only 

needs to be one space between each number. 

 

Below is the designation and definition of each column. 

 

"D"  = Nominal depth in inches enclosed in quotes. 

"WT" = Nominal weight in pounds enclosed in quotes. 

"MM D" = Nominal depth in millimeters enclosed in quotes. 

"MASS" = Nominal mass in kg enclosed in quotes. 

D  = Actual depth in inches 

WT  = Actual weight in pounds 

AR  = Area in square inches 

tw  = Web thickness in inches 

Bf  = Flange width in inches 
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Tf  = Flange thickness in inches 

T  = Clear distance on web between fillets in inches 

k  = Flange thickness plus fillet radius in inches 

r  = Fillet radius in inches 

Ix  = Moment of inertia about the x axis in inches to the 4th 

Sx  = Elastic section modulus about the x axis in inches to the 3rd 

Rx  = Radius of gyration about the x axis in inches 

Iy  = Moment of inertia about the y axis in inches to the 4th 

Sy  = Elastic section modulus about the y axis in inches to the 3rd 

Ry  = Radius of gyration about the y axis in inches 

Zx  = Plastic section modulus in inches to the 3rd 

Zy  = Plastic section modulus in inches to the 3rd 

GAGE = Common bolt gage of the flange. 

 

When adding new sizes or creating new shape files you should keep the sizes in order by depth 

starting with the smallest depth at the beginning of the file. Also, all sizes of the same nominal 

depth must be kept together. The shapes will be displayed in the selection dialog box by the 

order they appear in the data file. 
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Appendix C - Gusset Plate Details 
 

 

This appendix provides you with a copy of the slides used in the GUSSET PLATE (BRACE) 

program. They can be used for reference with the printout of the input and output and by other 

draftsman to fill out the input form shown on the following page. Once the form is filled out, it 

can be entered into the computer by your AutoSD operator to run the calculations and get a print 

of the results which can then be used by the draftsman to make the details. This will speed up 

the process of detailing braces and gusset plates by draftsman not using a computer and reduce 

check time by having accurate details. 
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GUSSET PLATE INPUT FORM 
 

CONNECTION  NO.________ TYPE _______ QUAD ________ 

 

LOAD ON BRACE .................................................. :___________ (May be 0, zero) 

MEMBER SIZE ........................................................ :___________ (May be the letter O for Other) 

TOTAL AREA OF BRACE(S) ................................ :___________ (May be 0, zero) 

NUMBER OF BOLTS .............................................. :___________ (If load and area are 0, zero) 

COMPRESSION (-) TENSION (+) BOTH (*) ……. :___________ 

 SMALLER RADIUS OF GYRATION……. :___________ (Input if MEMBER is not given and brace is - or *) 

 IS BRACE "X" <Y/N>.................................. :___________ (Input if brace is double angle and is - or *) 

BOLT SIZE:  3/4(6)  7/8(7)  1(8)…………………... :___________ 

EDGE DISTANCE.................................................... :___________ (Default is bolt diameter x 2) 

BOLT VALUE SINGLE SHEAR.............................. :___________ 

GRADE OF STEEL Fy = (36/50) ............................. :___________ 

GRADE OF GUSSET PLATE Fy = (36/50) ……. :___________ 

BOLTS IN DOUBLE SHEAR (Y/N) ...................... :___________ 

(FT.IISS) THICKNESS OF BRACE ........................ :___________ 

(FT.IISS) THICKNESS OF GUSSET PLATE.......... :___________ 

(FT.IISS) #1 …………………….............................. :___________    

(FT.IISS) #2............................................................... :___________   

(FT.IISS) INPUT "A" OR <ENTER> TO CALCULATE ……….… :___________ (Input 0, zero, or dimension 

HORIZ. CONN IS (0)WELDED (1)CLIP (2)CLIPS (3)END PLATE . :___________  (desired for "A" in order to input  

(FT.IISS) SETBACK …………………………………………………. :___________                  clearance) 

VERT CONN IS (0)WELDED (1)CLIP (2)CLIPS (3)END PLATE …:_____________  

(FT.IISS) SETBACK …... :___________ 

IS CORNER OF PLATE CLIPPED (Y/N)  :___________ 

(FT.IISS) MINIMUM CLEARANCE ....... :___________    (If dimension "A" is given) 

(FT.IISS) #3 .…. :___________ (FT.IISS) #6a …. :___________  (FT.IISS) #10 …... :___________ 

(FT.IISS) #4 .…. :___________  (FT.IISS) #7 ….. :___________  (FT.IISS) #11 …… :___________  

(FT.IISS) #5 …. :___________ (FT.IISS) #7a … :___________  (FT.IISS) #12 …… :___________  

(FT.IISS) #5a ... :___________  (FT.IISS) #8 …. :___________ (FT.IISS) #13 …… :___________  

(FT.IISS) #6 …. :___________  (FT.IISS) #9 …. :___________ (FT.IISS) #13a ….. :___________ 
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Appendix D – Truss Panel Details 
 

This appendix provides you with a copy of the slides that are used with the GUSSET PLATE 

(TRUSS) program. 
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 INDEX 

@ 

@Line, 55 

2 

2 PT vector, 55 

A 

Add Studs, 55 

Adhesive anchor, 55 

Adjust dimension, 83 

AGC logo, 51 

AISC Certified Fabricator 

logo, 51 

AISC symbol, 51 

Anchor bolt side view, 35 

Angle Beam, 125 

Arched text, 56 

Arcs, 91 

Array, 83 

arrowheads, 30 

Arrowheads to ticks, 83 

Asd_cfg.LSP, 247 

ASD_DRAW, 15 

ASD_MARK, 15 

ASD_SECT, 15 

Assembly mark, 57, 163, 177 

AutoSD.dwt, 161 

B 

Base pl edge view, 151 

Base/Cap plan, 151 

BASECAP.PL, 12 

Beam lines w/desc, 35 

Beam on plate w/AB, 36 

Beams 

Beams sloping up to the 

right, 27 

Bevel Flanges, 25 

Block style, 25 

Chamfer, 26 

Clearance for non standard 

shear bar, 26 

Clips and Stiff, 25 

Depth, 25 

Dimension blocks to, 26 

Dimension clip edge 

distance, 27 

Extension and tails at left 

end, 26 

Grade of aluminum, 27 

Grade of steel, 27 

Horizontal dimension are, 

26 

Minus dimensions framing 

into beams, 26 

Show beam properties, 27 

Show loads on end of 

beam, 27 

Show support member 

size, 27 

Use max rows in end 

connection, 27 

Wing PL block option, 26 

Bearing plate edge view, 36 

Block wall plan view, 37 

Block wall section, 36 

BMCONN.LST, 12 

Bollard, 59 

BOLT LIST, 30 

Bolted tread detail, 188 

Bolts, 21 

anchor, 56 

circle, 57 

expansion, 59 

Extract, 63 

w/N&W, 59 

Brace lines w/desc, 36 

Braces, 141 

Calculate Gusset PL 

(Truss), 147 

Draw, 141 

HSS in frame, 146 

Parallel brace tower, 147 

Rod, 146 

Welded, 145 

Break line, 50 

Brick w/block wall plan view, 

37 

Brick w/block wall section, 

37 

Brick wall plan view, 38 

Brick wall section, 37 

C 

Calc, 91 

Camber, 93 

Cap pl edge view, 151 

Clevis, 59 

Clip, 59 

CNC, 217 

Angles, 218 

Burns, 220 

Change 

Angle, 221 

Beam end, 221 

Data, 222 

Depth Y, 221 

Layer, 222 

Length X, 221 

Mark, 221 
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Notch D, 221 

Setback, 221 

Side, 221 

Surface, 222 

Type, 222 

DSTV file, 232 

Edit data, 224 

Edit DXF file, 234 

Find CNC, 234 

Gather marks, 234 

Get missing CNC file 

names, 235 

Graphically check CNC file, 

236 

Holes 

Associate holes, 218 

Change 

Face, 218 

Gage, 219 

hole to slot, 220 

Option, 219 

Side, 219 

Size, 219 

Slot angle, 219 

Slot length, 219 

slot to hole, 220 

Slot width, 219 

Tail, 219 

Note NS or FS, 220 

Holes, 218 

Main mark, 218 

Plates, 224 

Replace tail dimension, 

220 

Scaled Plates, 224 

Sub mark, 236 

Write CNC file, 235 

Column base plate w/AB, 38 

Column bubble, 50 

Column connections, 156 

Column files, 12 

Column w/bolt pattern, 39 

Columns, 27 

Compile quantities, 174 

Cone, 60 

Configure AutoCAD or 

BricsCAD, iv 

Configure AutoSD, viii 

Configuring the shop bill, 163 

Converting other drawings to 

AutoSD, 13 

Country, 21 

Crane rail, 60 

Creating pans, 186 

Creating the shop bill, 162 

Custom font, 101 

Customer configuration 

program, 17 

Customizing Shop Bill 

Extraction File, 169 

Cuts,, 110 

D 

Data files, 12 

Database editor, 85 

DDcopy, 85 

Decimal to Feet, 94 

Deck edge view, 39 

Detail label, 50, 51 

Detail panel, 205 

Dimensions 

Arc, 105 

Arc continue, 105 

Arrowheads, 104 

Bevel, 106 

Continue, 105 

Crossing, 107 

Dim Line, 105 

Dim text, 103 

Dimensioning, 103 

Linear Dimension, 104 

direction arrows, 51 

Distance, 60 

Ditto, 60 

Door frame, 61 

DSTV file extension, 12 

Dwg to SDS/2 Dxf, 14 

DXF into AutoSD, 13, 29 

E 

E.J.E file extension, 12 

Edit attribute, 86 

Edit col file, 153 

Column size, 154 

Connections, 154 

Add, 154 

Clip angle, 156 

Copy, 154 

Delete, 155 

Flange plate, 159 

Girt angle, 156 

Girt WT, 156 

Gusset plate, 160 

Holes, 159 

Joist angle, 157 

Joist plate, 157 

Move down, 154 

Move up, 154 

Saddle, 160 

Seat angle, 157 

Seat plate, 157 

Split T, 158 

Stiff plate, 159 

Stub, 160 

Wing plate, 158 

Elevations, 154 

Import gusset, 155 

Merge file, 154 

New, 154 

Open, 154 

Save, 154 

Save as, 154 

Edit sub mark list, 167 
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Editing a color configuration, 

28 

Editing a configuration, 18 

Elevation generator, 39 

Bay selection, 41 

Beams, 41 

Braces, 42 

CMU wall, 42 

Column file configuration, 

46 

Column line, 40 

El Note, 41 

End views, 43 

Girt configuration, 47 

Girts, 43 

Joist, 43 

Joist configuration, 47 

Ladders, 44 

Landing setup, 45 

Detail landing, 46 

Draw, 47 

Draw plan, 46 

Export stairs, 46 

Main elevations, 41 

Open, 40 

Save As, 40 

Stairs, 44 

NS or FS, 45 

Rails, 45 

Treads, 45 

View title, 40 

Embed Frame, 62 

Embed plate, 62 

End Connections, 111 

Bevel flanges, 113 

Bolts, 114 

Clip connection, 113 

Connection type, 112 

Degrees, 113 

Detail Beam, 111 

El is from bottom of beam, 

111 

Import column file, 113 

Loads, 114 

Seat Connection, 118 

Skewed angle, 112 

Slope in degrees, 112 

Support is hip or valley 

rafter, 112 

Support Member, 111 

T Connection, 117 

Enter, 11 

Extend weight, 94, 174 

Extract, 168 

for KISS, 171 

for KISS Description, 172 

for SMM, 171 

Shop bill, 168 

Extract bolts all drawings, 63 

Extract bolts current 

drawing, 63 

Extract sub marks all 

drawings, 63 

F 

FabSuite *.kss file, 173 

Feet to Decimal, 94 

File names, 11 

Files, 185 

Find text string, 63 

Finger shim plate, 125 

Flange gage leader note, 111 

Flat bars & plates, 22 

Flg hole, 64 

folders, 17 

Font, 16 

ASD_BKAP, 101 

ASD_FONT, 101 

FT.IISS, 9 

FT-II S/S, 10 

FT-II*SS, 10 

G 

Girts, 131 

Grid lines w/DIM, 48 

Gusset plate files, 12 

Gusset Plate Input Form, 252 

Gusset plates, 135 

Calculation, 135 

dimension A, 136 

Draw, 140 

Edit file, 140 

List file, 139 

Printing file, 138 

Viewing file, 139 

H 

Hanger, 95 

Hatch, 80 

Header beam, 192 

HIP and VALLEY, 213 

Hole size, 65 

Holes, 64 

I 

II.SS, 9 

Insert Pickets, 206 

Installing AutoSD Steel 

Detailing 

Bricscad Pro configuration, 

vi, 241 
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Joist forms, 80 

Joist lines, 48 

Joist side or end view, 48 

L 

Ladders, 49, 209 
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erection elevation, 212 
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Sections, 212 

Security guard, 212 

top hoop, 211 

with cage, 209 

without cage, 210 

Landing 

Decking, 194 

Frame, 194 

Grating, 195 

Pan, 195 

Landing, 194 

Layers, 89 

Change objects layer, 89 

Freeze layer, 89 

Isolate layer, 90 

Set layer, 90 

Thaw all layers, 90 

Leader notes, 66 

Save, 67 

Leaders, 107 

DLeader, 108 

Multi line, 107 

Quick, 107 

w/bubble, 108 

w/revision, 108 

Word wrap, 107 

Level rail, 197 
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Line weights, 29 
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Loading the menu, vi, 242 
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Line weight, 87 
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89 
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Scale of objects, 88 

Viewport Scale, 89 
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Nailer angle / chanel, 69 

Nailer holes, 70 

Nailer plate, 70 
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Object info, 70 
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Offset, 71 

& Change line type, 71 

w/Select, 71 

Osnap, 71 
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Pan tread end view, 188 

Picket Rail Panel, 206 

Pipe, 72 

Pipe end hatch, 51 

Plan view of stair, 191 
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Pour stop 
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shop attached, 72 
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Rail Erection 

Rail elevation, 207 

Wall rail, 207 

Rail Erection 

Rail Plan, 207 

Ramp rail, 200 

Rectangle, 73 

Relocate text, 88 

Replace dimension, 87 

Replace text, 88 

Reset dwg scale, 87 

Revision cloud, 52 

revision symbol, 51 
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Rolled angle, 74 
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Roof frames, 74 

Rotate crosshairs, 73 
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Safety gate, 52 

Sag rod, 133 

Scale, 13 

Scale shape, 75 

Schedule maker, 76 

Section arrows, 50 

Section label, 50, 51 

Sectional properties, 97 

Select dim to add, 98, 99 

Setting up, 14 

Shaft opening, 52 

Shape Database, 247 

Shapes, 75 

Skewed pl top view, 152 

Slot size, 65 

Splice plate, 134 

attached, 134 
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Splices, 153 

Stair plan, 52 

Stair rail, 200 

Standard clips, 24 

Standard Mtext, 77 

Standard shear bars, 23 

Starting a new drawing, 14 

Starting a New drawing, 243 

Stiffener Plate (attached), 

128 

Stiffener Plate (loose), 128 

Stringer bracing, 192 

SUBMARK.TBL, 12 
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Tags, 53 
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Tail dim, 77 

Text description, 53 

Text height and plot scales, 

16 

Text strings, 77 

Title block configuration, 167 

Top view (skewed 

connection), 130 
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Tread builder, 186 

Tread Riser calculator, 189 

Turnbuckle, 77 

U 

U Block section view, 53 

Uninstall AutoSD, ix 

UnKnown dimension, 90 

V 
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Wall rail 

Detail, 203 

Web hole, 78 
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Blocks, 78 

Clear, 79 

Leader only, 79 

Save/Restore, 79 

Settings, 79 

Symbol only, 79 

Wing plate (side view), 125 

Plate & End View of Shape, 
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Plate only, 126 

Plate only, skewed, 127 

Wood end view, 54 

Wshape.dwg, 75 
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